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1: Introduction

ABOUT THIS GUIDE

Welcome to PAC Manager, the configuration and inspection tool for working with the SNAP PAC system. This
guide shows you how to configure and work with the following Opto 22 devices using the PAC Manager
software tool

o SNAP PAC S-series controllers
«  SNAP PAC R-series controllers
«  SoftPAC controllers
«  SNAP PAC EB brains
«  SNAP PAC SB brains

NOTES:

Ifyou are using groov EPIC or groov RIO, do not use PAC Manager. Instead, use groov Manage or PAC
Control. For details, see the following:

groov EPIC User’s Guide (form 2267)

groov RIO User's Guide (form 2324)

PAC Control User's Guide (form 1700)
Allen-Bradley: If you are using SNAP PAC EB brains or SNAP PAC controllers with Allen-Bradley Logix
PLC systems, do not use PAC Manager. Instead, use the EtherNet/IP Configurator. For details, see the
EtherNet/IP for SNAP PAC Protocol Guide (form 1770). Both the software and the quide are
available on our website, www.opto22.com.

PAC Manager is available for download from our website, www.opto22.com.

Contents

This guide assumes that you have some familiarity with TCP/IP, UDP/IP, and Ethernet networking. If you are not
familiar with these subjects, we strongly suggest you consult commercially available resources to learn about
them before attempting to use these systems.

This user’s guide includes the following sections:

Chapter 1: Introduction—Information about the guide and how to reach Opto 22 Product Support. Also
includes product comparison charts.

Chapter 2: Configuring Devices—How to assign an IP address to your hardware, how to configure 1/0 units
and I/0 points, how to use I/O point features such as counters, watchdogs, and analog scaling; and how to
send configuration data to I/0 units.

Chapter 3: Configuring Optional Functions—Information on configuring security, communication
protocols like SNMP and PPP, streaming, the Scratch Pad area, and other optional functions.

PAC Manager User's Guide 1
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FOR DEVELOPERS: SNAP PAC REST API

Chapter 4: Setting Up Events and Reactions—If you are not using PAC Control, information on configuring
local reactions to local events.

Chapter 5: Reading and Writing to Specific Devices—How to read data directly from a specific controller
or I/0 unit or write directly to a controller, brain, or I/O points.

Chapter 6: Maintaining Devices—Changing IP addresses, upgrading firmware, and working with files on
the device.

Chapter 7: Troubleshooting—Tips for resolving difficulties you may encounter while working in PAC
Manager.

Appendix A: Menus—Describes the PAC Manager menu commands.
Appendix B: Dialog Boxes—Describes the features of PAC Manager dialog boxes.

Related Documentation

You may also need some of the following documentation, depending on the system you are using and how
you expect to communicate with it:

To use this See this SRes

form #
. SNAP PAC R-Series Controller User’'s Guide 1595
SNAP PAC R-series controllers OptoMMP Protocol Guide 1465
) SNAP PAC S-Series Controller User’s Guide 1592
SNAP PAC S-series controllers OptoMMP Protocol Guide 1465
SoftPAC controllers SoftPAC Software-based Controller for PC-based Control 2020

Data Sheet

. SNAP PAC Brain User’s Guide 1690
SNAP PAC EB and SBbrains s \Mp Protocol Guide 1465
PAC Control User's Guide 1700
PAC Control strategies PAC Control Command Reference 1701
PAC Control Commands Quick Reference Card 1703
Serial communication modules ~ SNAP Serial Communication Module User's Guide 1191
High-density digital modules SNAP High-Density Digital Module User’s Guide 1547

All forms are available for download from our website, www.opto22.com. The easiest way to find one is to
search on the form number.

FOR DEVELOPERS: SNAP PAC REST API

If you're a developer who'd like to use PAC Control strategy tags in communications with other devices, the
Opto 22 SNAP PAC REST API is a secure and powerful way to do just that. The APl is available in SNAP PAC
R-series and S-series controllers with PAC firmware R9.5a and higher. To configure HTTPS access to your PAC’s
RESTful server and learn how to call the AP, visit developer.opto22.com.

PRODUCT SUPPORT

If you have problems installing or using PAC Manager and cannot find the help you need in this guide or on
our website, contact Opto 22 Product Support.
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CHAPTER 1: INTRODUCTION

Phone: 800-TEK-OPTO (800-835-6786 toll-free NOTE: Email messages and phone calls
in the U.S. and Canada) to Opto 22 Product Support are
951-695-3080 grouped together and answered in the
Monday through Friday, order received.
7a.m.to 5 p.m. Pacific Time

Fax: 951-695-3017

Email: support@opto22.com

Opto 22 website: WWW.0pto22.com

When calling for technical support, you can help us help you faster if you provide the following information to
the Product Support engineer:

«  Ascreen capture of the Help > About dialog box showing software product and version (available by
clicking Help > About in the application’s menu bar).

«  Opto 22 hardware part numbers or models that you're working with.
«  Firmware version:
—  For SNAP controllers and brains: available in PAC Manager by clicking Tools > Inspect.

- For groov EPIC processors and groov RIO modules: available in groov Manage by clicking Info and
Help > About.

«  Specific error messages you saw.
«  Version of your computer's operating system.

«  For PAC Control, PAC Display, or PAC Manager, you may be requested to provide additional information,
such as log or dump files. You can find these files in a support files sub-folder:

a. OnyourWindows Desktop, double-click the PAC Project 10.4 folder.
b. Double-click Support Files.
c. Double-click on the appropriate shortcut to open the sub-folder containing the requested files.

Note: PAC Control, PAC Display, and PAC Manager create some of the sub-folders in the event of a crash. A
shortcut may not work if these programs have not crashed.

OPTO 22 PROCESSOR COMPARISON CHART

This table compares SNAP PAC controllers and brains using PAC firmware R9.5 and PAC Project R9.6 software
(or higher).

SNAP PAC Controllers SNAP PAC Brains

FEATURE

SNAP-PAC-R2-FM
SNAP-PAC-EB1-FM
SNAP-PAC-EB2-FM

SNAP-PAC-S1
SNAP-PAC-S1-FM
SNAP-PAC-R1
SNAP-PAC-R1-FM
SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2
SNAP-PAC-SB1
SNAP-PAC-SB2

Runs PAC Control strategies [ )
Maximum PAC Control charts running at once (plus host task) | 64 | 32 ‘

Al I SNAP-PAC-S2
=4l 1 SNAP-PAC-R1-B

-
[«
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OPTO 22 PROCESSOR COMPARISON CHART

SNAP PAC Controllers SNAP PAC Brains
"SW [ Standaione | Rackmounted | Ethernet | Serial
2 Flo| B[ 5|5
m . ' 0 = - N N - N
FEATURE 2% | @ (¥ | ¥ |8 |50 0 8 9
Qo (&) QO |0 QO [0OL |OO| O Q
&% | & 3% & (3% (&% |x3|% |3
oo o oo o (aa (o (oo | Q o
<< < << < <€ €K €S| < <
ZzZ 4 22 | 2 |22 |22 |22| 2 4
n n n DD | O | On [ On | OH| 0 )
Two independent Ethernet network interfaces a
(two IP addresses) ® ® e ® e
.. |Two switched Ethernet network interfaces (one °® Y
Communication |,p address) for multi-drop configuration
Total number of RS-232 serial ports b 2 4° 1 1 1 0 0 0 0
Total number of RS-485 serial ports 5 1 4° 0 0 0 0 0 1
TCP/IP, UDP/IP [ ) o o [ ) o [ ) o [ )
EtherNet/IP™ (Allen-Bradley® RSLogix® sys-
tems and others) ® ® o ® o ® o
Modbus®/TCP (slave)d [ ) () [ ) [ ) [ ) [ ) o
OPC driver support [ ) () o [ ) () [ ) () o o o
RESTful API o o [ ) o [ )
Protocols HTTP/HTTPS [ ) o ® © ([ )
OptoMMP memory-mapped protocol @° [ ) [ ) [ ) [ ) [ ) [ ) ® O
SNMP (network management) o () [ ) o [ ) o o
FTP server, file system [ ) [ ) [ ) [ ) [ ) [ )
FTP client o o () [ ) () [ )
SMTP (email client with authentication and
attachments) o ® o o ® o
Supports Node-RED via SNAP-PAC nodes and RESTful API o () [ ) o [ )
Direct access to hard drive & network drives (Dropbox®, etc.) [ )
Realtime clock a ) o e o o o e o o
Backup battery (recharges when brain has power)" o [ ) e o o [ ) e o o
Physical RAM (MB) a 32 16 16 16
RAM available for Strategy (MB) 64 16 4 - -
Battery-backed RAM (MB) 8 8 2 - --
Flash memory (MB) : 16 8 8 8
Removable data storage (microSD card slot) a 32 GB max.X 32 GB max.X
32-bit processor a o o ® O () o ® o o
Floating-point unit (FPU) a o o [ ) o [ )
Power requirements g 8-32 vDC! 5.0t0 5.2 VDC 5.0t0 5.2 VVDC
q 10 W-11.3 W max @1.2-15A @ 750 mA-1.0 A
Operating Temperature in degrees C a -20 to 60 -20 to 60 -20 to 60
Storage Temperature in degrees C -40 to 85 -40 to 85 -40 to 85
Humidity (non-condensing) a 0-95% 0-95% 0-95%
Compatible SNAP PAC EB brains . . . .
brains” SNAP PAC SB brains [ J (]
Combination controller and I/O processor [ ) o
Mounts on SNAP PAC I/O mounting rack n/a n/a [ ) [ ) o e o o
Mounts on SNAP B-series I/O mounting rack n/a n/a [ )
Maximum number of modules allowed on largest rack: ® ® p o
Any mix of 16 digital, 16 analog, and 8 serial i 1] e & o o o o o
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Digital /O point
features

SNAP PAC Controllers

CHAPTER 1: INTRODUCTION

SNAP PAC Brains

[SW | Sundaione | Rackmounted | Ethemst | Serial |

FEATURE

SNAP-PAC-S1
SNAP-PAC-S1-FM

Input latching
On/off status
Watchdog timer

High-speed counting (up to 20 kHz)?
Quadrature counting”

On-pulse & off-pulse measurementd
Frequency & Period measurement?
TPO (time-proportional output)
Digital totalizing9

n/a

Pulse generation (continuous square wave, N
pulses, on-pulse, off-pulse)

n/a

SNAP-PAC-S2

SNAP-PAC-R1
SNAP-PAC-R1-FM
SNAP-PAC-R2
SNAP-PAC-R2-FM
SNAP-PAC-EB1
SNAP-PAC-EB1-FM
SNAP-PAC-EB2
SNAP-PAC-EB2-FM

'Y X I SNAP-PAC-SB2

Analog I/0 point
features

Thermocouple linearization (32-bit floating point
for linearized values)

Minimum/maximum values

Offset and gain

Scaling

TPO (Time-proportional output)®
Output clamping

Filter weight

Watchdog timer

Analog totalizing!

Ramping'

n/a

n/a

PID logic (maximum 96 PID loops per controller or brain)

Data logging

Digital events, alarm events, serial events

Event messaging

UDP streaming of I/O data to host

1/0 point data mirroring and memory map copying

n/a

000000000000 0 © 000000000 TN 00

Qeo0000000000 0 O 00

000000000000000 06 © 000O0OCGOCGONOGNOGS LI

SKQ "o o n oW

As provided by the Microsoft Windows computer the software runs on.

SoftPAC cannot communicate through serial ports on the PC.

Serial ports are software configurable for RS-232 or RS-485.

PAC firmware >=R9.4b, 8 max connections. Lower firmware, 2 max connections.
Requires OptoOPCServer or third-party compatible OPC server.

Available with OptoOPCServer and PAC Control, through a SNAP PAC controller.
SoftPAC includes Status Read, Status Write, and Scratch Pad memory map areas.
Models manufactured before August 2007 and S1s with serial numbers 625653 and
lower have user-replaceable backup batteries. See original user's guide.

Flash memory function implemented via a file; size is limited only by disk space.
PAC firmware 9.4a and loader 6.1a or higher. S-series with microSD & manufacture
date older than 06/14 supports max. 2 GB microSD.

Units with serial numbers lower than 500,000 have an 8-24 VDC input voltage rating.
Verify voltage on the unit’s faceplate before applying power.

—~ n = O

For compatibility with legacy Opto 22 hardware, see

form #1693.
SNAP-PAC-R1s with serial numbers lower than 600,000,

and all SNAP-PAC-R1-Bs: limited to eight 4-point digital
modules per rack.

Not supported: serial, motion control, Profibus, & Wie-
gand modules.

Four-channel modules only; not high-density modules.

Requires a SNAP-IDC5Q quadrature input module.
Requires a SNAP analog TPO module (SNAP-AOD-29).
Requires a SNAP PAC controller and PAC Control com-
mands.

Does not support serial events.
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2: Configuring Devices

INTRODUCTION

Follow the steps in this chapter to assign IP addresses to Opto 22 devices on an Ethernet network. (Addressing
information for SNAP PAC SB serial brains is set on the brain itself. For details, see the SNAP PAC Brains User's
Guide, form 1690.) This chapter also includes steps for configuring I/0 unit points and features. I/0 points must
be configured before you can read or write to them.

This chapter assumes that you have already installed the hardware and software according to steps in the
device's user’s guide. (See "Related Documentation”on page 3.)

If you are using a wireless or modem connection, or if you are using event messages, email, streaming, the
Scratch Pad area for peer-to-peer communication, or SNMP for communicating with enterprise management
systems, also see Chapter 3, which shows you how to set up these optional functions. All this information goes
in the configuration file that PAC Manager uploads to I/0 units.

WHEN TO USE PAC MANAGER AND PAC CONTROL

If you will be running a PAC Control strategy on a SNAP PAC System to control I/0 units, you may be
wondering when to use PAC Manager versus when to use PAC Control. These two tools serve different
purposes, but some of their functionality overlaps.

NOTE: PAC Manager cannot be used to configure groov I/0 units or mistic I/O units.

For groov I/0 units, use groov Manage.

PAC Manager User's Guide 7
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ASSIGNING AN IP ADDRESS

< Formistic /O units, use PAC Control.

GG IR PAC Control Tasks

EET AL Configure 1/0 == Configure control =3 Program and

P adf(.iress D I/0 Unit engine (so PC running debug control
Load firmware E'} m ; PAC Control can logic
Configure communications “AD U0 Station 1 communicate with the

and events Eﬁ Paints controller)

]

|
SNAP 1/0 can be configured in PAC Manager and imported into PAC Control.
SNAP and mistic 1/0 can also be configured in PAC Control.

Choosing a Configuration Tool for SNAP I/0

About ETand E2 brain boards: You can configure E1s and E2s like any other /O unit if you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E25),
see |/O Configuration for ET an E2 Brain Boards (form 1576).

For most 1/0 units, if you are already in PAC Control, configuration is easier there and you can use the loopback
[P address for SNAP PAC R-series I/0 units controlling themselves. However, some functions for I/0 units
cannot be configured in PAC Control.

If you use PAC Manager, you can save your configuration to a file, load it to multiple I/0 units at once, and use
it for referencing points in OPC. However, you cannot use the loopback address in PAC Manager.

Choose your configuration tool based on what you need to do:

Use PAC Control for I/0O configuration if Use PAC Manager for SNAP 1/O configuration if

* You have only one I/O unit or I/O unit configurations |+ You have multiple I/O units whose configurations are

are different. exactly the same or similar.
* The strategy will run on SNAP PAC R-series 1/0 * You are using a modem connection (PPP) or SNMP.
units that are controlling themselves using the * You are using event messages or email.
loopback IP address, 127.0.0.1 « You are configuring events and reactions on the 1/O
* You are using an Ethernet network for unit in addition to strategy logic.

communications (or using a SNAP PAC controller |+ You are not using PAC Control.
with an SB brain).

The strategy handles all logic; you are not also
configuring events and reactions on 1/O units.

.

Whichever tool you use for configuring I/0, be aware of the impact if you later change configuration. For
example, if you configure I/0 in PAC Manager, and then download the configuration file to I/O units, and then
later add a point in PAC Control, remember that your configuration file won't contain the new point.

ASSIGNING AN IP ADDRESS

NOTE: Ifyou are using redundant controllers with the SNAP PAC Redundancy Option Kit and PAC Project Professional
R9.1, do not use PAC Manager to assign IP addiresses. Instead, use the PAC Redundancy Manager.
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For multiple devices,
see page 14.

CHAPTER 2: CONFIGURING DEVICES

About IP Addresses

Each Ethernet-based device (controller or brain) ships from the factory with a unique hardware Media Access
Control (MAC) address and with a default IP address of 0.0.0.0, which is invalid. Each device must have a valid
IP address and subnet mask so that it can communicate on the network.

When installed and first turned on, a SNAP PAC controller or brain sends out a BootP broadcast requesting an
IP address. You respond to the broadcast by using PAC Manager to assign a static (non-changing) IP address.
These devices must be given a fixed, static IP address, because you communicate with them using the IP
address.

Assigning IP Addresses to SNAP PAC

Before using a PC or laptop computer to assign IP addresses, perform the following checks:

«  Will your controller or brain run on a network that has a DHCP server? Dynamic Host Configuration
Protocol (DHCP) servers can automatically respond to BootP requests and assign a “dynamic”
(changeable) IP address to the requesting device, but SNAP PAC controllers and brains must have static IP
addresses. If your network has a DHCP server, Opto 22 recommends you connect the device directly to
your computer with a network cable (even if the device is a Wired+Wireless model), and then assign the
IP address. After the device has a static IP address, you can connect it to the network.

« Ifthe computer has an active wireless network connection, disable the wireless connection and connect
to your Opto 22 device via a wired connection. If you are connecting to a wireless Opto 22 device, you
will configure the wireless connection later.

« Ifthe computer has multiple network interface controller (NIC) cards, disable all of them except for the
one that will be connecting to your Opto 22 device. You can re-enable them after you complete these
steps.

«  Ifyou need to modify the computer’s network interface settings, you must be logged in with
administrative rights.

«  Temporarily disable firewalls on the computer running PAC Manager. Firewalls, such as the ones that
come with some anti-virus software programs and the built-in firewall in Windows, can prevent PAC
Manager from receiving BootP broadcasts. (Firewalls in a router should not be a problem.)

If disabling firewalls is not an option, configure a firewall exception for PAC Manager.

- To configure a firewall exception in your system’s anti-virus software, see the manufacturer’s
instructions.

- Toconfigure a firewall exception in Windows, open Control Panel > System and Security > Windows
Firewall > Allow an app or feature through Windows Firewall and add PAC Manager to the list of
allowed programs.

You can reenable the firewall (or remove the firewall exception) after you have assigned the IP addresses.

SNAP PAC controllers and brains must be assigned a unique, static IP address. If the network you're using
has a Dynamic Host Configuration Protocol (DHCP) server, either assign a static IP address before connecting
the device to the network (preferred), or disable the server. (These servers may respond to BootP requests and
assign a dynamic address.)

Wired+Wireless models: These devices have a wireless LAN interface as well as wired interfaces, but they
send a BootP request only on the wired interface. First, follow the steps below to connect to them over a wired
network and assign their primary IP address. Later, you can configure the wireless interface.

If you are adding an I/0 segment to an existing Ethernet network, your network administrator must provide

static IP addresses and subnet masks for the I/O units. If you are creating an independent, dedicated Ethernet

network just for I/0, you can choose your own addresses.

1. Make sure that the Opto 22 hardware is installed according to directions in its user’s guide, and that the
PAC Manager software is installed on the computer.

PAC Manager User's Guide 9
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5.

Make sure you know the IP address, subnet mask, and MAC address of each device that will receive an IP
address.

The MAC address is on a label on the side of the controller or brain.

SNAP PAC S-series and R-series controllers each have two separate Ethernet network interfaces;
wired+wireless models have an additional wireless interface. Each interface has its own MAC address and
must be on a separate logical network. The interface’s logical network is determined by its IP address and
subnet mask. For details, see the Simplified IP Addressing Technical Note (form 1362) or get help from
your system administrator.

Only Ethernet 1 sends a BootP request. Once you have assigned this primary IP address, you can assign
Ethernet 2 (the secondary address) and the wireless address, if applicable. To assign an address to
Ethernet 2, see page 18; for wireless configuration, see page 22.

SNAP PAC brains are different. Since their two Ethernet network interfaces act as an Ethernet switch and
share the same IP address, it doesn't matter which interface is attached to the network. The BootP
broadcast comes through both. On a wired+wireless EB brain, the wireless interface has a separate IP
address. After you assign the primary IP address for the wired network, see page 22 for wireless
configuration.

Turn on the Opto 22 device(s).

If PAC Manager isn't already open it, start it."

The PAC Manager main window opens.

8] PAC Manager - O *
File Tools View Help <«—1—Menubar

D|s|d| ¥|%n B @| <«——Toolbar

Ready A

In PAC Manager's menu bar, click Tools > Assign [P Address.

" Click the Windows Search button and type PAC Manager 10.4.
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CHAPTER 2: CONFIGURING DEVICES

The Assign IP Address dialog box opens. Any Opto 22 Ethernet-based devices without IP addresses that
are on the computer’'s network segment appear in the list of units requesting IP addresses.

Units Requesting IP Addresses
Status MAC Address IP Address Subnet Mask Hostname Gateway Addr...

Discovered  00-CC-CC-00LC-CC
Discovered  00-CC-3D-00-9E-CC

£ >
Listening for DHCP Discovers and BootP Requests

L

MAC To IP Address Mappings - (MacToIP.map)
MAC Address IP Address Subnet Mask Hostname Gateway Addr... | DNS Addre Add...

Load List...

Ll
v

JLEE

Close | Help |

If no MAC address appears, check the following:
- Isthe Opto 22 device turned on?

- lIsitcorrectly connected to the computer using a crossover cable or correctly connected to an
Ethernet switch using a straight-through cable?

- Isthe computer's network card configured with the same subnet mask as the device? See the
computer’s user’s guide for networking information.

—  Does the device already have an IP address? If you want to change the IP address, see page 201.

- Isthe device booting to the loader rather than the firmware? If so, see the device's user’s guide for
more information on STAT LED blink codes.

—  Does the computer have firewall software that blocks network broadcasts? If so, disable the firewall
software.

- Have you performed all of the checks in “Assigning IP Addresses to SNAP PAC"on page 97
Double-click the MAC address of the device in the list that matches the device you are assigning the IP
address to.

CAUTION: PAC Manager lists ALL Opto 22 devices sending BootP broadcasts. Assign IP addresses only to the
devices that are yours.

PAC Manager User's Guide 11
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The Mapping dialog box opens.

Host Mame:

= Add MAC To IP Mapping d
MAC Address: joococoooocooe v
IP Address: o .0 .0 .0
Subnet Mask: o .0 .0 .0
Gateway Address: I o .0 .0 0
DNS Address: o .0 .0 .0

|

oK I Cancel |

7. Enterthe IP Address and the Subnet Mask for the device. If the device will be communicating with a
device on another subnet, enter the Gateway (router) address. If it will communicate only on the local

subnet, leave the gateway address all zeros (0.0.0.0).

Leave the DNS address at 0.0.0.0 and the Host Name field blank.

WARNING! Each device on your network, including computers, routers, controllers, brains, and so on, must
have a unique IP address. Failure to assign unique IP addresses may cause catastrophic network or hardware
failures. If you don't know which IP addresses are safe to use, check with your system administrator.

8. When the IP address, subnet mask, and other fields are correct, click OK.
The new IP address information appears in the upper list in the dialog box, and the device's status

changes to Mapped. The address information also appears in the lower list to show that this device has

been mapped to this address.

Status changes to Mapped

8 Asgign [P Address

Units Requesting IP Addresses

| MaC Address

| IP Address

| Subnet Mask

| Hostname

(

| Gateway Addr... |

MAC To IP Address Mappings - (MacToIP.map)

An IP Address has been Mapped to this Unit, but not yet Azsigned

Assign

Sef Static IP

Assign All

L

Set All Skatic IPs

Test

MAC address data MAC Address | 1P Address | subnet Mask

| Hostname

| Gateway Addr... | DNS Addre

appears in lower pane

Close | Help |

9.  With the device still highlighted, click Assign.

PAC Manager User's Guide
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CHAPTER 2: CONFIGURING DEVICES

The address is saved to flash memory, and the status changes to IP Address Assigned.

Status changes to IP Address Assigned.

=

Units Requesting IP Addresses

Stafus MAC Address IP Address Subnet Mask Hostname

Gateway Addr

| )
Discovered 00-CC-30-00-98-CC

<

v

Unit has been permanently assigned an P Address

MAC To IP Address Mappings - (MacToIP.map)

A

O0CCLC-01CCCe 10193.53.119 255.255133.0 0000

Close | Help |

MAC Address IP Address Subnet Mask Hostname Gateway Addr... | DNS Addre Add...

0000

Load List..

v

JLEE

—  Once a device’s status becomes Assigned or Static, you can no longer change its IP address
information from this dialog box. To change the address, use Tools > Change IP Settings. (For details,

see page 201.)

—  Ifthe device's status changes from Mapped to IP Address Assigned, and then back to Mapped, and
the STAT LED on the device continues to flash (instead of steadily glowing green) this means the IP
address was not successfully assigned. This often happens when you try to assign the IP address by
using a wireless connection, rather than a wired connection. Connect to the device with a cable and
try again, and verify that you've performed all of the checks listed in “Assigning IP Addresses to SNAP

PAC" on page 9.

10. To verify that the IP address has been assigned successfully, highlight the device in the upper list and click

Test.

A command prompt window opens and the IP address is automatically tested using the PING command.

You should see a reply similar to the following:

BN C:\Windows\system32\cmd.exe

Pinging 18.192.54.118 with 32 hytes of data:
2.54.118: bytes=32 tlme =ims TTL=25%

4. h
Reply from 13 192. 54 118: hytes=32 time{ims TTL=255
Ping statistics for 18.192.54.118:

Packe Sent = 4. Received 4, Lost = @ <Bx loss>.
Rppro)_(:i.n_]ate round tl-:i.p_t:i.mes in milli H

Press any key to continuwe . . . _

If you don't see a reply, make sure the subnet mask you've assigned matches the subnet mask on your

computer.
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1.

12.
13.

For future reference, write the IP address next to the MAC address on the white sticker provided on the
device.

Repeat steps 6 through 11 for any other devices in the list that you are responsible for.

To save the list of IP address and MAC address mappings (the lower list in the dialog box) for future
reference, click the Save List button. Navigate to the folder where you want to save the file, enter a
filename, and then click Save.

The address information is saved. You can load this information into PAC Manager later if you need to see
it.

What's Next?

For a SNAP PAC R-series controller, continue to page 18 to assign an IP address to Ethernet 2.

—  Fora Wired+Wireless model, configure the wireless LAN interface (page 22). Then continue with
“Creating an 1/0 Unit Configuration File"on page 26.

For a Wired+Wireless EB brain, configure the wireless LAN interface on page 22. Then continue with
“Creating an 1/0 Unit Configuration File”on page 26.

For a SNAP PAC EB brain, continue with “Creating an 1/0 Unit Configuration File” on page 26.
For a SNAP PAC S-series controller, choose from the following:

- Toset up security on the wired network, see page 78.

- Toassign an IP address to Ethernet 2 on a wired network, see page 18.

- (Wired+Wireless models only) To configure the wireless LAN interface, see page 22.

To create PAC Control strategies to run on the controller, see the PAC Control User's Guide (form 1700).
Information on peer-to-peer communication using the Scratch Pad area of the controller can be found in
the PAC Control User’s Guide; see the “peer-to-peer communication”in the index. See also the PAC Control
Command Reference (form 1701).

To work with the controller’s file system, microSD card, and FTP, see page 217.

Assigning IP Addresses to Multiple Devices

NOTE: In order to assign IP addresses, you must be logged in with administrative rights.

If you are an OEM, integrator, or customer who has a large number of Opto 22 devices to work with at once,
you may find it easier to first create a file of MAC-to-IP address mappings, and then assign IP addresses from
the file.

Creating the Map File

1.

Make sure you have the MAC addresses for all Opto 22 devices in front of you. Also make sure you know
what IP addresses and subnet masks you are going to use for them.

The MAC address for each device appears on a white sticker or space on the device itself. To determine
the IP addresses and subnet masks to use, work with the network administrator for the Ethernet network
on which the devices will be used.

NOTE: On a SNAP PAC controller, you can assign only the primary IP address using these steps. To assign the
secondary IP address (Ethernet 2), follow steps on page 18.

Before installing the Opto 22 devices, open PAC Manager. (For instructions, see the footnote on page 10.)
From the Tools menu, click Assign IP Address.
The Assign IP Address dialog box opens.
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Upper section is used for live
assignment to devices.

Lower section shows contents
of a file containing lists of
addresses. These addresses
may or may not be actual
assignments.

CHAPTER 2: CONFIGURING DEVICES

| Assign IP Address

Units Requesting IP Addresses

Statuz MALC Address IP Address Subnet Mask Hosthame Gateway Addre:
] 1 ¢
Listening for DHCP Discovers and BootP Requests
MALC To IP Address Mappings - [MacT ol P.map)
MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address Add

FEEEE FEELY |

Load List...

-~

Cloze | Help |

The upper section of this dialog box lists all Opto 22 devices on the same network that send a BootP or
DHCP broadcast while the dialog box is open. When you are ready to assign IP addresses, this is where
you do so. For now, ignore anything that appears here.

The lower section shows the contents of a mapping file you create, either while assigning actual
addresses or in advance of assigning them. This file can be saved, changed, and reloaded at a later time
for reference or to quickly assign addresses using the upper section—but the actual addresses on
devices cannot be assigned or changed here. The important thing to remember about this lower section
is that the list does not necessarily reflect actual addresses on devices. The IP addresses in the list may not
have been assigned yet, or a device’s address might have been changed at some point and the list not
updated.

In the lower section of the dialog box, click Add.

= Add MAC Te IP Mapping =]
MAC Address:
IP Address:
Subnet Mazk; o .
Gateway Address: on.o0.0.0
DMS Address: o.o0.0.0
Host Hame:

ak | Cancel |

For the first Opto 22 device, type the correct MAC address (the first six digits are entered for you; they are
the same for all Opto 22 devices). Enter the IP address and subnet mask. Enter the Gateway address if
needed. Leave the DNS address at 0.0.0.0 and the Host Name field blank.

Double-check all numbers. When all are correct, click OK.

PAC Manager User's Guide 15
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The device's address information is listed in the lower section of the dialog box.

| Assign IP Address

Units Requesting IP Addresses
Statuz MALC Address IP Address Subnet Mask Hosthame Gateway Addre:

4 T b

Listening for DHCP Discovers and BootP Requests

MALC To IP Address Mappings - [MacT ol P.map)

FEEER EEELE |

MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address

00-40-30-01-85-9C  10.192.54.110 285.285.192.0 0.0.00 0.0.00

4 m 3 Load List...
Cloze | Help |

7. Click Add again and add additional addresses until all of them are listed in the lower section.

| Assign IP Address @
Units Requesting IP Addresses
Statuz MALC Address IP Address Subnet Mask Hosthame Gateway Addre:
4 m 3
Listening for DHCP Discovers and BootP Requests

MALC To IP Address Mappings - [MacT ol P.map)

MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address Add...
00-a0-3d-00-d4-eb  10.192.54.37 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-9d-d3  10.192.56.230 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-d5-ed  10.192.55.110 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c1-48  10.192.54.115 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c1-40  10.192.54.70 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c7-22  10.192.54.156 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-9d-c5  10.192.56.229 285.285.192.0 0.0.00 0.0.00

4 m 3 Load List...

Cloze | Help |

8. Double-check the addresses. If one is incorrect, click it to highlight it, click Modify, and make the
necessary changes.

9. To save the mapping file, click Save List. In the Save dialog box, navigate to the folder where you want to
place the file, enter a filename, and click Save.

The .map file is saved as a simple text file. This allows it to be modified in text editors such as Notepad.
10. Continue with the next section to assign the addresses.
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Assigning Addresses from the Map File

NOTE: BootP broadcasts cannot get through a firewall in the computer where PAC Manager is running. Make sure
any firewall in the computer is disabled before you try to assign IP addresses. Firewalls in a router should not be a
problem.

1. IMPORTANT: Disable all DHCP servers on the Ethernet network you are using to assign IP addresses.

If a DHCP server is enabled on the network, it may assign IP addresses before PAC Manager has a chance
to do so. If that happens, turn off power to the devices, disable all DHCP servers, and turn the devices
back on. They should broadcast again.

2. Make sure that each Opto 22 device is installed according to directions in its user's guide. Make sure the
computer you use is on the same network segment as the devices.

Turn on all the Opto 22 devices.
If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)

In the PAC Manager menu bar, click Tools > Assign [P Address.

If the .map file you want does not appear in the lower section of the Assign IP Address dialog box, click
Load List, locate the file, and open it.

The Opto 22 devices begin to appear in the upper section of the dialog box. IP address information from
the map file is copied to the corresponding MAC address in the upper section, and the status of each
device changes to Mapped.

o U A W

Status changes to Mapped. IP address information is filled in.

5| Agsign IP Address

Unity Requesting IP Addresses

Stdtus MALC Address IP Address Subnet Mask Hostname Gateway Address | DME
Mapped 00-a0-3d-00-d4-eb | 10.192.54.37 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-9d-d3 | 10.192.56.230 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-d5-ed | 10.192.55.110 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-c1-48 | 10.192.54.115 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-c1-40 | 10.192.54.70 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-c7-22 | 10.192.54.156 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-9d-c5 | 10.192.56.223 255.285.192.0 0.0.0.0 0.l

L1 ¥

diliy

Listening for DHCP Discovers and BootP Requests

MALC To IP Address Mappings - [MacT ol P.map)

MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address Add...
00-a0-3d-00-d4-eb  10.192.54.37 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-9d-d3  10.192.56.230 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-d5-ed  10.192.55.110 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c1-48  10.192.54.115 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c1-40  10.192.54.70 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c7-22  10.192.54.156 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-9d-c5  10.192.56.229 285.285.192.0 0.0.00 0.0.00

'l 1 3 Load List...

Cloze | Help |

7. Check the address information. If anything is incorrect, double-click the device in the lower list and
change it. Click Save List to save the change to the file.

The change is automatically made to the upper section.
8. When all addresses are correct, click Assign All.
The address is saved to flash memory, and the status changes to Static IP.

The devices now have their IP addresses. If you need to change an address, use Tools > Change IP Settings
(see page 201).To assign an IP address to Ethernet 2 on a SNAP PAC controller, see the steps in the next
section.
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Assigning an IP Address to Ethernet 2 (SNAP PAC Controller Only)

NOTE: This section does not apply to SNAP PAC brains; the two Ethernet network interfaces on a SNAP PAC brain have
the same IP address.

For Wired+Wireless models, see page 22 to configure the wireless LAN interface.

SNAP PAC R-series and S-series controllers have two independent Ethernet network interfaces, labeled on the
top of the controller as Ethernet 1 and Ethernet 2. The controller sends its initial BootP request from Ethernet 1,
and the IP address you assign to the controller is for this primary interface. To communicate through Ethernet
2, you must assign it a separate IP address following the steps below.

IMPORTANT: The two Ethernet interfaces will work only if they are on separate IP subnets, so the control engine can
clearly determine where to direct communication. (The subnet masks can be the same or different, but when you
perform a logical AND on the IP address and subnet mask for each interface, the two results must be different.) For

example:
IP Address: 192.168.0.12 10.0.0.5
Subnet Mask: 255.255.255.0 255.255.255.0

NOTE: Ifyou need to configure or modify settings for the network interface cards on your computer, you must be
logged in with administrative rights.

1. If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)
2. Inthe PAC Manager main window, click the Inspect button Ql

The Inspect window opens.

- Ifyou haven't used the Inspect window before, the window will not show any data.

=] Inspect Opto 22 Device — X

Device Name: I ;I Options B[\ 0 Error reading area: Timeout

[~ Status Read

Status Read |

Status Write &I

Wireless LAN ¥

Point Canfig
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System »
Scratch Pad  #
Datalog *
PID »
Events 3
Communications »
Other »

Help I™ AutoRefresh |1snnn msec
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If you have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58
Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh |
T 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
e OxFFFF F030 0008 Buay Flag 0
Paint Config 0xFFFF F030 0018 Loader Version R5.1lc
Diital Bank 0xFFFF FO30 0000 Memory Map Version 1
gita! Ban 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016
Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A
High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
g 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
5 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
HEEn 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3
ETHERENET 1 Interface
PID L 0xFFFF FO30 002E MAC Address 00-R0-3D-01-85-9C
= N 0xFFFF FO30 0034 IF Address 10.192.55.67

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

- Ifyou have configured six or more devices, the Inspect window provides two additional features:
Next and Back navigation buttons (to navigate back and forth through the alphabetized list of
devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

= Inspect Opto 22 Device

Cookie Controller

Cookie Controller

1_ [EngineRm

Status R4 ol partable :

Status wiitd SoftPAC [CRIPTION
e lerup Clea

Wireless LAN | Boler e
—— I Chamber 1 s
. Chamber 2 J
Point Config g portable der Versid
T Cookie Controller ory Map Ve
ngltal B EngineRm mware Verd
Digital Point S2fPAC mware Ver,
0xFFFF F030 00BO Firmware Very
e PP e
e

3. Inthe Device Name field, type the name for the SNAP PAC controller (or choose it from the drop-down
list). If the controller has not been defined in PAC Manager, the Add New Device dialog box appears.
Choose Direct Connection to Ethernet Device and enter the IP address of the primary Ethernet interface
(Ethernet 1). Leave the Ethernet port at 2001 unless you have changed it on the controller.

4. C(lick Status Read.
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Status information for the controller is shown in the window. Scroll down till you see ETHERNET 2
Interface. If the IP address for Ethernet 2 has not been assigned yet, the IP address information will show

all zeros.
=] Inspect Opto 22 Device - X
Device Mame: I 10.192.55.67 vl Options » | Status: | Status Read area last read at 07/05/16 09:55:07
~ Status Read
Status Read |
Status Write 0xFFFF F030 0018 Loader Version ) R5.1c A Refresh I
0xFFFF F030 0000 Memory Map Version 1
= 5 0xFFEF F030 0230 Current Boot Device Flash Memory
SEEEE | 0xFFFF F030 001C  Firmware Version 29.52
- OXFFFF F030 00RO Firmware Version Date 0570372016
Paint Config 0xFFFF F030 00B0 Firmware Version Time 15:29:32
Tl I 0xFFFF FO30 0020 Unit Type 0x00000073
Digital Point 0xFFFF FO30 0080 Unit Description SNAP-PAC-R1
0xFFFF F030 0024 I/0 Unit Hardware Revision (Month) 4
Analog Bank 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
R 0xFFFF F030 0026 I/0 Unit Hardware Revision (Year) 2008
Analog Paint 0xFFFF F030 024C I/0 Coprocessor Firmware Version L0.0a
- N OXFFFF F030 0028 Installed Ram 33554432
High Density
5 ETHERNET 1 Interface
AEED OxFFFF FO30 002E MAC Address 00-A0-3D-01-85-9C
Saatchpad  » 0xFFFF F030 0034 IF Rddress 10.192.55.67
0xFFFF F030 0038 Subnet Mask 255.255.192.0
Data Log ¥ 0xFFFF F030 003C Gateway AR-182.53.57
OXFFFF FO30 0040 DS 10.192.60.31
PID + ETHERNET 2 Interface
Secondary IP address Events v 0xFFFF FFFF FOG0 MAC Address 00-AD-3D-01-85-9D
information Ven 0xFFFF FFFF FOS0 IF Zddress 0.0.0.0
Communications ¥ 0xFFFF FFFF FO58 Subnet Mask 0.0.0.0
—_— 0xFFFF FFFF FOGE Gateway 0.0.0.0
Other Dl 0xFFFF FFFF FO70 DNS 0.0.0.0

Help | [™ Auto Refresh |15000 meec

5.  Click Status Write. Scroll down to see all the IP address fields for Ethernet 2.

= Inspect Opto 22 Device - x
Device MName: | 10,192,55.67 ;| Options » | Status: | Status Write area last read at 07/05/16 09:58:59
- Status Write
Status Read |

Status Write Address | Description | Value | ~ Refresh I
0xFFFF FO38 0260 Out Of Range Value (32-Bit) -2147483643.000
- 0xFFFF FO38 0054  Scanner Flags 0x 00000000 Apply |
Wirgless LAN  # |

0xFFFF FO38 0154 Host Name
OxFFFF FO38 0194  Domain Name

Paint Config OxFFFF F408 0004 Strategy Download Method Mormal 3|

— OxFFFF F700 2000 Turn-Around Delay for Port 0 {msec) a
Digital Bank ETHERNET 2 Interface
el | | ||merrrrrrrros 1 address 0.0.0.0
Ethernet 2 IP eyt 0xFFFF FFFFF058  Subnet Mask 0.0.0.0
) OxFFFF FFFFF058  Gateway 0.0.0.0
address fields FoEEyETs O0xFFFF FFFFFO70  DNS 0.0.0.0

v
Analog Paint

Hich Density Eperation
OptoMMP Device ~ Send Command
Restart command S Restart Device From ponern ) E——
—I Store configuration to fla:

Erase configuration from flash
»
Sratch Pad Reset to defaults and Restart Device
N microSD
g Store configuration and IP settings to microSD

FID » Erase configuration and IP settings from microSC
Erase firmware from microSD

Events e Erase strategy from micro5D
Other
icati Switch to loader mode
»
Commnicztions Clear Digital Events - Expanded configuration

Other N Clear Digital Events - Old configuration Y]
Close Help | [~ Auto Refresh I 15000 msec

6. Click the Value field for IP Address under Ethernet 2 Interface and type in the IP address. Enter the
Ethernet 2 Subnet Mask the same way. If necessary, change the Gateway. Leave the DNS as is.
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7. When all the secondary IP address fields are correct, click Apply.
The information is sent to the SNAP PAC, but it cannot communicate on the Ethernet 2 interface until it is

IP address for primary
interface (Ethernet 1)

restarted.

8. Inthe Operation Commands section, highlight Restart Device from powerup. Then click Send Command.

The SNAP PAC is restarted.

9. Checkto make sure the controller is back on line by clicking Status Read again. Click OK at the message.
Scroll down a little to see all the IP address information for Ethernet 2.

| Inspect Opto 22 Device

Device Name: | 10,192,55.57

Status Read
Status Read |

Status:

| options »

Status Read area last read at 07/05/16 10:07:17

Status Write 0xFFFF F030 0000 Memory Map Version 1 ~ Refresh |
OXFFFF FO30 0230  Current Boot Device Flash Memory
OXFFFF FO30 001C Firmware Version 29.5a
LIRSS D 0xFFFF FO30 00A0 Firmware Version Date 05/03/2016
0xFFFF F030 00BO Firmware Version Time 15:29:32
Point Config
o 0xFFFF FO30 0020 Unit Type 0x00000074
0xFFFF FO30 0080  Unit Description SNAP-PAC-R1
Digital Paint 0xFFFF FO30 0024 I1/0 Unit Hardware Rewvision (Month) 4
OxFFFF FO30 0025 1/0 Unit Hardware Revision (Day) 21
Analog Bank OXFEFF FO30 0026 1/0 Unit Hardware Revision (Year) 2008
0xFFFF F030 024C 1/0 Coprocessor Firmware Version Z0.0=2
Analog Point OxFFFF FO30 0028 Installed Ram 33554432
iciDe ity (ETHERNET 1 Interface
Ethernet 1 IP address 0xFFFF FO30 002E MAC Address 00-A0-3D-01-85-9C
information System | | |oxFFEF F030 0034 TP Rddress 10.192.55.67
T OXFFFF FO30 0038 Subnet Mask 255.255.192.0
—— — 1| |oxFFFF Fo30 003C Gateway 10.192.51.51
Datalog * 0xFFFF FO30 0040 \_DNS 10.192.60.31
'Ethernet.2 [P address g T T
information PID > 0xFFFF FEFF FO&0 MAC Addreas 00-R0-3D-01-85-3D
o SRFFFFFEFFFOSE IP Lddress 10.10.10.7
0xFFFF FEFF FOS2 Subnet Mask 255.255.255.0
Communications ¥ 0xFFFF FFFF FO68 Gateway 0.0.0.0
0xFFFF FEFF FO70 \__DNS 0.0.0.0
Other 3 v

Close Help

™ AutoRefresh | 15000  msec

10. To verify that the secondary IP address (Ethernet 2) is also communicating, make sure Ethernet 2 is
attached to the correct network. On a computer on the same subnet as Ethernet 2, open the PAC
Manager Inspect window. Enter the Ethernet 2 IP address (or a different name) in the Device Name field

and click Status Read.

The controller now shows the same information, but through the secondary interface:
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IP address for secondary

interface (Ethernet 2)

= Inspect Opto 22 Device

Device Mame: | 10.10.10.7

Status Read
Status Read |

Status:

j Options »

Status Read area last read at 07/05/16 10:07:17

- 0xFFFF FO30 0000 Memory Map Version 1 - Refresh
m 0xFFFF FO30 0230 Current Boot Device Flash Memory I—I
) 0xFFFF F030 001C Firmware Version AS.5a
Wircless LAN  + 0xFFFF FO30 00RO  Firmware Version Date 05/03/2016
E 0xFFFF F0O30 00BO Firmware Version Time 15:29:32
Point Config
- OxFFFF F030 0020 Unit Type 0x00000070
oLiEar 0xFFFF FO30 0080 Unit Description SNAP-PAC-R1
Digital Point 0xFFFF FO30 0024 I1/0 Unit Hardware Revision (Month) 4
0xFFFF FO30 0025 I1/0 Unit Hardware Revision (Day) 21
Analog Bank 0xFFFF F030 0026 1/0 Unit Hardware Revision (Year) 2008
. OxFFFF FO30 024C  I/0 Coprocessor Firmware Version R0.0&
Analog Point 0xFFFF F030 0028 Installed Ram 33554432
% ETHERNET 1 Interface
Ethernet 1 IP address Sstem > 0xFFFF FO30 002E MAC Address 00-A0-3D-01-85-5C
. f t B O0xFFFF FO30 0034 IP Lddreszs 10.192.55.67
Information I N Subnet Mask 255.255.192.0
0xFFFF F030 003C Gateway 10.192.51.51
Data Log 3 0xFFFF F030 0040 DNS 10.192.60.31
Ethernet 2 IP address (ETHERNET 2 Interface
information PID L 0xFFFF FFFF FO&0 MAC Address 00-A0-3D-01-85-3D
; 1 OxFEFFF FEFF FOSQ IP Rddreas 10.10.10.7
F=is 0xFFFF FFFF FOS8 Subnet Mask 255.255.255.0
Communications b OXFFFF FFFF FOG8 Gateway 0.0.0.0
0xFFFF FFFF FO70 _ DNS 0.0.0.0
Other 3 9]
s ‘ EE | [ AutoRefresh | 15000 msec
Configuring Wireless LAN Communication (Wired+Wireless Models Only)
This section applies only to SNAP PAC controllers and EB brains with wireless LAN interfaces (models ending in
-W).These devices send their initial BootP request from Ethernet 1, and the IP address you assign to them is for
this primary interface. To communicate through the wireless LAN interface, you must assign it a separate IP
address and configure communication following the steps below.
IMPORTANT: The wireless LAN interface will work only if it is on a separate IP subnet, so the device can clearly
determine where to direct communication. (The subnet masks can be the same or different, but when you perform a
logical AND on the IP address and subnet mask for each interface, the two results must be different.) For example, on
a SNAP-PAC-S1-W you might use the following addresses and subnet masks:
Ethernet 1 Ethernet 2 Wireless LAN
IP Address: 11.192.55.162 10.10.10.7 146.87.12.250
Subnet Mask: 255.255.255.0 255.255.255.0 255.255.255.0
NOTE: If you need to configure or modify the settings for the network interface cards on your computer, you must be
logged in with administrative rights.
1. If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)
2. Inthe PAC Manager main window, click the Inspect button [ |
The Inspect window opens.
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If you haven't used the Inspect window before, the window will not show any data.

¥ Inspect Opto 22 Device

Device Name: I

;I Options »

(=l Error reading area: Timeout

[~ Status Read
Status Read |

Status Write
Wireless LAN  #

Point Config

Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System 13
ScratchPad  »
Datalog 3
PID 3
Events »
Communications »
Other »

[~ AutoRefresh |15000 msec

If you have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

= Ir to 22 Device — *
Device Name: |1o.199.99.99 Ll Options >| Status: | Status Read area last read at 07/05/16 10:34:58
—Status Read
Status Read |
Status Write | ADDRESS DESCRIFTION VALUE ~ Refresh I
= 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
e | OxFFFF F030 0008 Buay Flag 0
Point Config | 0xFFFF F030 0018 Loader Version R5.1lc
Diital Bank 0xFFFF FO30 0000 Memory Map Version 1
gita! Ban | 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point | 0xFFFF FO30 001C Firmware Version 19.5a
0xFFFF FO30 00RO Firmware Version Date 05/03/2016
Analog Bank | 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point | 0xFFFF FO30 0020 Unit Type 0x0000007A
High Density | 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
g 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
5 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
HEEn | 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
Scratch Pad ,l 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3 |
ETHERNET 1 Interface
PID L 0xFFFF FO30 002E MAC Address 00-R0-3D-01-85-9C
= N 0xFFFF FO30 0034 IF Address 10.192.55.67
Y 9@.5\ _l AWAW

If you have configured other devices, they are listed in alphabetical order in the drop-down list.

If you have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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3.

4.

of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

= Inspect Opto 22 Device

[Cookie Contraller]
Cookie Controller
EngineRm

SASIGE Coil Portable :
[CRIPTION

Wireless LAN terup Clea
ireless

—— I Chamber 1 v Flag 1

. Chamber 2 J

Point Config g portable der Versid

= Cookie Controller ory Map Vi

HD@E' B EngineRm mware Verd

Di SoftPAC Imware Ver

igital Point T 1
0xFFFF F030 00BO Firmware Very

In the Device Name field, type the device’s name or IP address (or choose it from the drop-down list).
Click Wireless LAN and choose Wireless LAN Configure from the popup menu.

| Inspect Opto 22 Device EI & \EI

Device Name: |1D_192.50.2D ﬂ Optionz » Status: |WiFi Configuration area last read at 01/06/12 11:47:32

“ireless LAN Configuration

Addiess Diescription Walue Refiesh

Status Read

Status Wite

[ WLAN Configurafion ]
. O:FFFF FS000000  “/LAN Enable Disabled | Apply
Wirsless LN ¥ O:FFFF FS000004  WLAN Logging Logging Disabled -l

0=FFFF F800 00038 R Inactivity Reassociation Timeout [zec)

300
Paint Config Yiew Status

Metwark Black Configuration

Digital Bank. O«FFFFF700 4004 IP Address 0000

— OsFFFF F7004008  Subnet Mask 0000

Digital Point OFFFF F700400C  Primar Gateway 0000

0«FFFF F700 4010 Secondary Gateway 0000

Ainalog Bank OFFFFF700 4004 Primary DNS 0.000

. OFFFF FP004018  Secondary DNS 0000

e O:FFFF F700401C  Network Name (S51D)

High Density 0xFFFF F700 4045 Enciyption Type Mone -~

i

In the WLAN Enable line, click the arrow next to Disabled and choose Enable.
Leave WLAN Logging disabled and Rx Inactivity Timeout at the default of 300.

Under Network Block Configuration, enter the IP address and subnet mask for the wireless network.
Remember that it must be on a separate network segment from the wired interfaces on the device.

If necessary, enter the Primary and Secondary Gateway addresses. Leave the Primary and Secondary DNS
fields blank.

Type in the name of the wireless network (SSID).
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11.

12.

13.

14.
15.

CHAPTER 2: CONFIGURING DEVICES

-] Inspect Opto 22 Device

===

Device Narme: ]10 192.50.20 ﬂ Options » Status: 1WiFi Configuration area last read at 01/06/12 11:47:32
“wfireless LAN Confiquration
Status Read
7 Addiess 1 Diescription I Value ] Refrash
M wLaM Configuration
O«FFFF F800 0000 */LAM Enable Disabled = | Apply
pudiclesil ANy OWFFFF FE00 0004 ‘WLAN Looging Logging Disabled =l
0«FFFF FA00 0008 Fix Inactivity Reassociation Timeout [zec) 300
Point Config View Statug
— Metwork Block Configuration
Digital Bank OxFFFF F700 4004 IP Address 172.205.0
- - O<FFFF F700 4003 Subnet Mask 255.255.152.0
Digital Point OwFFFF FP00 4000 Primary G ateway 0.0.00
Aralog Bank 0«FFFF FFO0 4010 Secondary Gateway 0ooo
halog Ban J 0<FFFF F700 4014 Frimary DHS 0.0.00
OFFFF F700 4018 Secondary DNS 0.00.0
__enbaPant | | R 00N Netmerk Hane 155ID] WP actory
High Density 0«FFFF FFO0 4048 Enciyption Type Mone =
System 3
Scratch Pad  »
Eata Lag 3 | S
il

R f et

From the drop-down list, choose the security used on the wireless network.

Additional fields appear.

Choose the Network Key Input Type, either Hexadecimal or ASCII (WEP is normally Hex; WPA and WPA2

are normally ASCII).

Enter the Network Key (the password for the network).
This field will show the password when you enter it; however, if you inspect the device later, the field will

show only asterisks.

When all fields are complete, click Apply.
At the message asking whether you want to restart the device, click Yes.

The configuration information is sent to the device and stored to flash memory, and the device is
restarted. The WLAN LED turns orange to indicate that the interface is searching for or authenticating the
wireless network. Once the network is found, the LED turns solid green.
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16. To see connection status and signal strength, click the View Status button. (You can also see this screen
by clicking Wireless LAN > Wireless LAN Status.)

e Inspect Opto 22 Device

Device Mame: | [II§EEEEN

Options » |

Status:

=l = =]

‘wireless LAN Status area last read at 09/01/11 15:18:07

—Wireless LAN Statu:

Statuz Read |
St ke | Connection Status: Connected
Wireless LAN >| Signal Quality: Good (30 dB)
Paint Config | B
Digital Bank. | _l E
__ DigtsPoin_| 10 e em oed
Analog Bank |
= Address | Degeription | Walue | -
Analag Paint | WIRELESS ETHERMET INTERFACE I
M Derei | O4FFFF F7004004  IP Address 10.192.55.35
O4FFFF F7004008  Subnet Mask 256,255.192.0 |
O4FFFF F7003002  MAC Address 00-40-17-1E-83-47 3
Spstem 4 |
WIRELESS LAN
SortchPad ¥ | || o e pron s e Connected
Datalog | OxFFFF F700 3040 Signal To Moise Ratio [dE) 30
O4FFFF F7003014  Metwork Mame (S51D] 22-wif
FID [3 0:FFFF F700 4054 Enciyption Type WwWPAZ [AES)
0:FFFF F700300E  BSSID 00-14.01-C5-8C-88
Events 3 | 0xFFFF F700 3034 Channel # Frequency 11 £ 2462
0«FFFF F700 3038 Receive Rate (kbps] 42000
Communications ¥ |
O4FFFF F7003044  Signal Level (dBm) £5
Other * | O4FFFF F7003048  Noise Level (dBml -a7 2
Help | I~ Auto Refresh |1 5000 msec

CONNECTING WITH A SNAP PAC SB BRAIN

Most devices you communicate with using PAC Manager are Ethernet-based. That is, they have at least one
Ethernet network interface and can be reached directly over an Ethernet network that includes the computer
where PAC Manager is installed.

SNAP PAC SB brains are an exception: they have no Ethernet interface and instead communicate over a serial

network. PAC Manager can communicate with SB brains in two ways, however.

»  Through a SNAP PAC controller, via an Ethernet connection to the controller and then a serial connection
from the controller to the brain. This method is easy and does not require the brain to be located near the
computer.

«  Directly from the computer to the brain, using the computer’s serial port via a serial cable and an RS-485
adapter, such as an Opto 22 PCI-AC48 adapter card. This method is useful for configuring points and
features before brains are deployed to the field, or if you are not using a SNAP PAC controller.

For connections, see wiring instructions in the SNAP PAC Brains User's Guide (form 1690).

CREATING AN 1/0 UNIT CONFIGURATION FILE

26

About ETand E2 brain boards: You can configure E1s and E2s like any other /O unit if you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),
see /O Configuration for E1 an E2 Brain Boards (form 1576).
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CHAPTER 2: CONFIGURING DEVICES

Before you create a control strategy using PAC Control, or before you read or write to I/0 units, you need to
configure the I/0 points and features the strategy or other application will use. You can use PAC Manager to
copy a configuration or to configure all points, save the configuration to a file, and then upload the
configuration to one I/0 unit or to several at once. You do not need to be attached to the I/0 unit while you
are creating the configuration file and configuring its points.

NOTE: If you are using OPC to communicate with the /O unit, you can use the configuration file (tag file) that PAC
Manager produces as an easy way to reference points for OPC. For details, see the OptoOPCServer User’s Guide
(form 1439, available with the purchase of PAC Project Professional or OptoOPCServer).

You can start configuration in one of three ways:

If this is a new configuration, you can create a new configuration file (page 27).

If an existing 1/0 unit has the exact configuration you want, you can copy it directly to another I/0 unit
(page 28).

If you have a PAC Control strategy with similar I/O units configured, you can save them as a configuration
file (page 30) and modify the configuration. Note that this method transfers /0 unit and point
information only; any event messages, email or SNMP settings, and so on are not included when a
configuration file is exported from or imported to PAC Control. Also, 4-channel digital module and point
information is generic; you will need to reenter specific digital configurations.

Creating a New Configuration File

Configuration tree

If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)

In the PAC Manager main window, click the New button _|j| or click File > New.

In the Create New Tag Database dialog box, navigate to the location where you want the file to be. Type a
filename. Click Open.

A new configuration tree appears. (If you are familiar with PAC Control, you'll notice that this window
looks like part of a Strategy Tree.)

File Edit Tools View Help

_DIEIEIiIEIEI_I_I_I

C:\Program Files (x86)\Opto22\PAC Project 9.0\SNAP PAC Learning Center\Mair MNUM v

You can expand and collapse the folders to see or hide the I/O units and points in them. Closing the
configuration tree is the same as closing the configuration file.

To save the configuration file, click the Save button El (orin the menu bar, click File > Save).
Once thefile is saved, continue with “Adding an I/0 Unit"on page 31.
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Copying an 1/0 Unit Configuration

If you have an I/0 unit or a previously saved I/0 unitimage file with exactly the configuration you want to use,
you can copy the configuration information to another I/0 unit or to an I/O unit image file. This works with all
SNAP PAC Ethernet and serial brains.

1.

Destination ——{— Imaage Destination

In the PAC Manager menu bar, click Tools > Import/Copy 1/0 Unit.

=¥ /0 Unit Import/Capy =)
Source  ————Image Source
{* Existing IO Unit Flash Memory Read
10 Unit Mame: | 10.192.54.110 j Options ¥

" Previously Saved Ij0 Unit Image File

| =

* Send Image To /O Unit Flash Memory
IfO Unit Name: | j Options »

" Save To IjO Unit Image File

| L

For the source, choose one of the following:

- Existing I/O Unit Flash Memory: Choose an existing /0 unit. If you want to add or modify an I/0 unit,
click Options. For help, see “Add/Modify New Device” on page 243.

- Previously Saved /0O Unit Image File: Enter the name of the I/0 image file you want to use, or click the
browse button to find the file.

When the source is correct, click Read.
A success message appears when the data has been read. Click OK.
For the destination, choose one of the following:

SendImage To I/0 Unit Flash Memory. Choose an existing I/0 unit. If you want to add or modify an I/0 unit,
click Options. For help, see “Add/Modify New Device” on page 243.

Make sure you have entered the correct IP address. The configuration will overwrite anything currently in the [/O
unit’s flash memory.

Save To I/0 UnitImage File. Enter the name of the I/0 image file you want to write to, or click the browse
button to find the file.

Create New /0 Unit: Select this option to copy all the point information from a brain to create a new I/0
unit in PAC Manager. You will be prompted to enter an I/0 unit name. For more information, see
“Creating a New 1/0 Unit from an Existing One”on page 28.

When the destination is correct, click Send, Save, or Create depending on the destination type.
A success message appears when the operation has completed.

Creating a New I/0 Unit from an Existing One

The Create New I/0 Unit option on the I/0 Unit Import/Copy dialog box allows you to create a new I/0 unit by
importing point information from the flash memory of an existing I/0 unit directly into the tree structure of a
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configuration file (also known as a tag database). You can then configure, add, or delete points in the new I/0
unit just as you would with an I/O unit created from scratch.

1. Make sure to save the existing I/O unit’s configuration information to flash memory. See “Saving
Configuration to a Device's Flash Memory” on page 190.

2. Open an existing configuration file on the File menu, or create a new one. For information, see “Creating
a New Configuration File” on page 27.

3. Inthe PAC Manager menu bar, click Tools > Import/Copy I/0 Unit.
For the Image Source, choose Existing I/0 Unit Flash Memory.
5. Enter the IP address of the existing I/0 unit, and click Read.
A success message appears when the data has been read. Click OK.
6. For the destination, choose Create New |/0 Unit, and click Create.

Image Destination

" send Image To IO Unit Flash Memory M Click Create

0.0 .0.0 Port: | 2001 Timeout: | 10000

" save To IO Unit Image File

| L

7. Inthe Add 1/0 Unit dialog box that appears, enter a name for the new 1/0 unit, and click OK.
The new I/0 unit is added to the open tag database and a success message appears. Click OK.

8. (Close the I/0 Unit Import/Copy dialog box.

9. Expand the new I/0 unit to see the imported points.

Main_Process*® EI@
B[ Main_Process Tag database (configuration file)
50
e Cookies New I/0O unit
-5 Points Imported points

----- OM_, aoOvenTemperatureControl
----- D% aolConveyorspeedControl
----- I% ailvenTemperature

..... A

----- I% ailloughVesselPressure

..... L4 diChipLevelSwitch

----- I“'%“_' dilnspectionPassFailSwitch

..... HY diEStop

----- B"’—_“,' doDoughPressureControlValve
----- B"’—_“J doDoughDispenseValve

----- I doChipDispenseValve

----- 1 doRejectValve

10. Before you can save the new I/0 unit, the digital points must be assigned specific modules as follows:
a. Right-click a digital point and select Configure from the popup menu.
b. Double-click a generic digital module.
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<]

[05] Net Used -
| »

i»| Configure /O Points EI
1/ Unit: ICookies Type: | SMAP-PACR1 (analog/digital)
Modules and Points Type Features / Subty... Add... |
Generic digital =R (00] Generic Digital Input Modify |
module LW 0 giDoughLevelSwitch None
L 1§ diChipLevelSwitch None Delete |
I“'%“_' 2 dilnspectionPassFail Switch Mone
I“'%“_' 3 diEStop None Mave To... |
Bl [01] Generic Digital Output Digital Output
[ [02] SNAP-ADV-27 Analog Qutput Expand Al |
Bl [03] SNAP-AICTD Analog Input
- [04] SNAP-AIV Analog Input Collapse All |
s |

Close I Help | Calibrate, ..

¢. Inthe Edit Module dialog box, select a digital module to match the existing I/0 unit, and then click

OK.

3| Edit Module

Type:

Digital Output
Analog Input
Analog Output

Module:

SNAP-IDCS: 10 - 32 VDC/VAC
SMAP-IDCS-FAST: 2.5 - 16 VDC b
SMAP-IDC5FAST-A: 18 - 32VDC .
SNAP-IDCSD: 2.5 - 28 VDC Select a dlglta| module
SNAP-IDCSMA: 10 - 32 VDC/VAC Man/auto Switch
SMAP-IDC5-5W: Dry Contact Switch
SMAP-IDCSQ): 4 - 24VDC

SNAP-IDCSG: 35 - 75 VAC/VDC

SMAP-IDC5HT: 15-32VDC

SNAP-IDC5-5W-NC: Dry Contact Switch
SMAP-IDCSFM: 10 - 32VDC

SMAP-IDCSDFM: 2.5 - 28 VDC

SMAP-IDC-32: 10 - 32VDC

SMAP-IDC-32M: -10 - 32VDC

SMAP-IDC-32D: 2.5 - 12VDC

SMAP-IDC-32DM: -2.5 - -12VDC

SMAP-IDC-16: 10 - 32VDC

SNAP-IDC-HT-16: 15 - 28 VDC/VAC —
Generic Digital Input

SNAP-TACS: 90 - 140 VDC/VAC

SNAP-TACSA: 180 - 230 VDC/VAC

SNAP-TACSMA: 90 - 140 VDC/VAC Man/auto Switch
SNAP-TACSFM: 90 - 140 VDC/VAC -

oK I Cancel |

»

m

d. Repeat steps b and ¢ for each generic module on the new I/0 unit.
e. Close the Configure 1/0 Points dialog box.
11. Save the new I/O unit.

Creating a Configuration File from Another Strategy

If you use PAC Control and have a strategy with SNAP PAC 1/0 units already configured, you may want to
export that file and use it as a starting point, rather than creating a configuration file from scratch. The
exported file will contain all the I/0 units in the strategy. However, note the following:

« 1/0Ounit and point data is transferred; optional functions such as event messages are not.

«  Four-channel digital modules and points do not retain specific configurations but revert to generic ones.
Specific data will have to be reentered.
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You cannot save changes you make in PAC Manager back to the strategy file. Instead, you save them to a
configuration file, which can then be imported into PAC Control.

Follow these steps to create a configuration file from an existing strategy:

1.
2.
3.

In PAC Control, open the strategy that contains the I/0 units whose configurations you want to export.
In the configuration tree, right-click the I/0 Units folder and choose Export from the pop-up menu.

In the Export I/0 Units to an Opto Tag Database dialog box, navigate to the location where you want to
save the configuration file. Enter a name for the file, and click Save.

If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)
In the PAC Manager main window, click the Open button El or click File > Open.
In the Open Tag Database dialog box, locate the file you just saved and open it.

File Edit Tools View Help

ETEETREAETCYY-Y
I —

Configuration tree

7.

8.

C:\Program Files (x86)\Opto22\PAC Project 9.0\SNAP PAC Learning Center\Mair MNUM v

Expand the I/0 Units folder in the configuration tree to see the units and points that are already
configured.

Continue with the next section to add or change I/0 units.

ADDING AN 1/0 UNIT

About E1and E2 brain boards: You can configure E1s and E2s like any other I/O unit if you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the ET or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),
see /O Configuration for E1 an E2 Brain Boards (form 1576).

An I/0 unit consists of a SNAP /0 mounting rack, plus the I/O processor (brain or on-the-rack controller) and
I/0 modules mounted on it. Racks used with SNAP PAC I/O units can hold up to 16 modules.

You must add an 1/0 unit before you can configure its modules and points.
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ADDING AN /0 UNIT

Address List area

1.

Make sure the configuration file is open. On the configuration tree, double-click the I/0 Units folder to

open the Configure I/0 Units dialog box:

| Configure /O Units

MHame | Type | Part

| Address

| ‘whatchdog

| Description

Cloze I

Help |

Add...

Modify... |
Delete |

Import/Copy.... |

1/0 Paints... |
PID Loops. .. |
Modules P |
Ewerts 3 |
Scratch Pad b |
Communications b |
Others 3 |

2. To configure a new I/0 unit, click Add or double-click anywhere in the box below any listed units.

The Add I/0 Unit dialog box appears.

Add 1/0 Unit
A Mame: ||
B Dezcription: I
c Type: |swap-pac-r1 ~
D Temp: f+ Fahrenheit " Celsius
E Part: |2DD'I
F Addess: 0000
G Secondarny: I
Address List
B s |
Modify... |
Delete |
H watchdog: @ Mo (7 Yes

Cancel Help

o]
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For a SNAP PAC SB brain, skip to step 5. For an Ethernet-based unit, complete the fields as follows:

A—Name. Enter a name for the I/0 unit. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

B—Description. (Optional) Enter a description of the unit.
C—Type. Select the type of 1/0 unit from the drop-down list.
D—Temp. Choose whether temperatures will be handled in Fahrenheit or Celsius.

E—Port. Specify the communication port to use (2001, unless you have changed it for security
purposes according to instructions starting on page 78).

F—Address. Enter the IP address for the 1/0 unit.

G—Secondary. f it's a SNAP PAC R-series /0 unit with a secondary IP address, enter the secondary IP
address.

H—Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled). If you
select Yes, a new field appears; enter the Watchdog timeout value in seconds. The default timeout is 0.5
seconds. For information on watchdogs, see page 73.

The Address List area shows IP addresses of the I/0 units that should receive this configuration. If this is
the only I/0 unit to receive the configuration, don't add any addresses here. However, if you have I/0
units that are exactly alike, list all of them here. That way you can download the configuration file to all
the I/0 units at once.

a. Toaddan P address, click Add.
In the dialog box, you can add a single IP address or a range of addresses.

| Add IP Address =]

& Add one |P Address / Host Name

* |Paddess: | I . 0 . 0.0

r [
" Add arange of IP Addreszes

ok | Cancel | Help

b. Enter the IP address(es) and click OK.
The addresses appear in the Address List area.
c. Skiptostep6.
For a SNAP PAC SB brain, complete the dialog box as follows:

PAC Manager User's Guide 33



ADDING AN /0 UNIT

Add /O Unit =]
A —— Hame: || J_
B—— Description: |
C—— In= |SHAP-PAC-SB1 -
F
D—— Temp * Fahrenheit ™ Celgiuz G
E ——+ Connection: ¢ Serial Ditect % Ethemnet Passthrough : o
_ Connection: & Senial Diregt” © Ethermet Pazsthrough
Contraller N
Computer
Address:  [0.0.0.0 Port: | 2001

Serial Port; -

Serial Part: |Serial 2 -
Baud Rate: |115200 -
Baud Rate: |230400 -

Device .
Device

Senial Address: |0 W 24ire e A lﬂi

J

H——— watchdag & Mo (" Yes

0K | Cancel Help

A—Name. Enter a name for the I/0 unit. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

B—Description. (Optional) Enter a description of the unit.
C—Type. Select the type of 1/0 unit from the drop-down list.
D—Temp. Choose whether temperatures will be handled in Fahrenheit or Celsius.

E—Connection. Choose whether you are connecting to the SB brain through a SNAP PAC controller or
directly from the computer (for more information, see “Connecting with a SNAP PAC SB Brain”on
page 26).

F—Ethernet Passthrough.
- Enter the controller’s IP address. Leave the port at 2001 unless you have changed it.

—  Enter the controller’s serial port where the brain is connected. On a SNAP-PAC-S1, it's Serial 2.
On a SNAP-PAC-S2, it could be any port.

—  The baud rate on the controller must match the rate set on the brain.
—  Enter the serial address of the brain.

G—Serial Direct.

—  Enter the serial port on the computer where the brain is connected. The baud rate on the
controller must match the rate set on the brain.

—  Enter the serial address of the brain.

H—Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled). If you
select Yes, a new field appears; enter the Watchdog timeout value in seconds. The default timeout is 0.5
seconds. For information on watchdogs, see page 73.

34 PAC Manager User's Guide



CHAPTER 2: CONFIGURING DEVICES

6. When information in the Add I/0 Unit dialog box is complete, click OK.
The new I/0 unit appears in the Configure I/0 Units dialog box.

] Configure I/Q Units

| Add...

Maodify... |
Delete |

Import/Copy... |

1/0 Paints. . |

PID Loops... |

Modules 3 |

Ewvents » |

Scratch Pad  » |

Communicatians # |

Cloze Help Others 4 |

| Tupe | Port | Addressz | Wwiatchdog | Degcription

SHAPPAC...  Ethemnet 1015254, Enabled

7. Continue with the next section, “Configuring I/0 Modules and Points.”

CONFIGURING I/0 MODULES AND POINTS

About E1and E2 brain boards: You can configure E1s and E2s like any other I/O unit if you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing £1s or E25),
see /0 Configuration for E1 an E2 Brain Boards (form 1576).

Once you have added an I/0 unit, you can configure its modules and points. See the following pages for
configuration steps. For motion control modules (such as SNAP-SCM-MCH16), see the SNAP PAC Motion
Control User's Guide (form 1673).

Configuring SNAP Digital Points

About ETand E2 brain boards: You can configure ETs and E2s like any other /O unit if you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the £1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing £1s or E25),
see /O Configuration for E1 an E2 Brain Boards (form 1576).

Use the following steps to configure digital points on all digital modules supported by the brain or
on-the-rack controller.

1. Inthe Configure I/O Units dialog box, make sure the 1/0 unit for the point you are adding is highlighted.
Click the 1/0 Points button.
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CONFIGURING I/0 MODULES AND POINTS

The Configure 1/0 Points dialog box appears. The dialog box shown here is for a SNAP I/0 unit.

5] Not Used -
4| | »

Cloze I Help | Calibrate. ..

| Configure /O Points EI
10 Unit; Type: ISN.-’-‘«F'-F'.-’-‘«C-FH [analog, digital]
Modules and Points | Type | Features / Subty... « Add.. |
D0] Not Used '
! b adify...
[01] Not Used —l
[02] Mot Used Delete |
[03] Not Used
04] Not Used Mowe To...
05] Mot Used i —l
[06] Not Used Ex
pand Al
[07] Not Used —l
[08] Mot Used Collapze Al |

2. Double-click the number that represents the digital module’s position on the rack. (For help, see the
diagrams starting on page 155.)
3. Fora SNAP /0 unit, choose the module type and then the exact module part number from the list.

<> Add Module

Type:

Digital [nput
Diigital Dutput
Analag Input
Analog Dutput

hodule:

SHAP-IDCE: 10 - 32 \C

SMAPIDCE-FAST: 25 - 16WDC o
SMAPDCE-FAST-A: 18 - 32VDC

SMAP-IDCED: 25 - 28WDC

SMAP-IDCEMA: 10 - 32 VDCAAL Mandbuta Switch
SHAPDCE-5w: Dy Contact Switch

SMNAP-DCED: 4 - 24%DC

SMAP-IDCHG: 35 - FEVACADC

SMAPDCE-HT: 15 - 32VDC

SHAPDCE-Sw-NC: Dy Contact Switch
SMAP-DCEFM: 10 - 32VDC

SMAP-IDCEDFM: 25 - 28 VDT

SMAPDC-32: 10 - 32VDC

SMAPR-IDC-32M: 10- 32vDC

SMAPIDC-32D: 25-12VDC

SMAPIDC-320N; -25--12VDC

SMAPDC-16: 10 - 32VDC

SMAPDC-HT-16: 15 - 28WDCAAL —
ERU-ID-8: [nput

ErAU-ID-4: Input

Generic Digital Input

SMaP-ACE: 50 - 140DCAMAC

SMAP-ACEA: 180 - 280 WDCAMAL -

ak I Cancel

m

4. (lickOK.
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5. Backin the Configure I/0 Points dialog box, click the plus sign next to the new module to expand it.
Notice that the module icon is color-coded to reflect the type of module being configured: white for
digital DC input, red for digital DC output, yellow for digital AC input, and black for digital AC output.

Module icon

~

Expand or collapse points on
the module by clicking the +
or - sign in the box.

Points

01] Mot Used
[02] Mot Used
[03] Mot Used
04] Mot Used
03] Mot Used

< I

Cloze I

Help |

«»| Configure YO Paints E’
140 Uit IF'leprncess Tupe: |SMAP-PAC-HT [analog/digital)
Modules and Points Type Features / Subty... «
= [i [00] SNAP-IDCE: 10 - 32 VDC/VAC Digital Input Modify
L Not Used —
L {1 Not Used Delete
L 2 Not Used
T 3 Not Used Pove o

Expand All

Collapze Al
ﬂJ

Calibrate...

Ll

6. Double-click the point you want to configure.

7. Complete the fields as follows:

Add Digital Point
Mame: I A
Deszcription: I B
Type: Input > C
Tope npu | _—
Module:  [SNAPIDCS: 10 - 32VDCAAC |
Features: I Mone ;i D
Watchdog: & No (7 es E

0K I Cancel | Help

A—Name. Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

B—Description. (Optional) Enter a description of the point.

C—Type, Module. For a SNAP I/0 unit, the type and module are already filled in for you.

D—Features. To use a feature of the module, choose it from the drop-down list. (See “Using I/0 Point
Features”on page 70 for explanations of point features. Note that some features, such as pulsing and
totalizing, can be configured in PAC Manager but require PAC Control to use them.)
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E—Watchdog. (Output modules only) To configure a status the point should be set to if the
Watchdog timer on this I/0 unit expires, click Yes and choose On or Off from the drop-down list.

8. When you have completed the fields, click OK.

The new point appears in the list.

| Configure /O Points EI
1/0 Unit. |Freprocess Type: |SNAP-PAC-RT [analog/digital]
Modules and Points | Type | Features / Subty... « fdd.. |
= [ [00] SNAP-IDCS: 10 - 32 VDC/VAC Digital Input .
Maodify...
T R N R
L1 1 Not Used Delete |
L1 2 Not Used
T 3 Not Used — M
e 3 5 owe To..
[01] Net Used —l
[02] Net Used £ |
pand Al
[03] Net Used
04] Not Used Collapze Al |
05] Not Used =
4| | »
Cloze | Help LCalibrate. .. |

9. To configure more digital points, repeat the steps. To configure analog points, see page 40.

Configuring Digital Points for a G4EB2

Use the following steps to configure digital points on all G4 or Quad Pak digital modules supported by the
G4EB2 brain. The G4EB2 replaces a 32-channel brain in a mistic or Pamux system with an

Ethernet-based 32-channel digital brain that uses OptoMMP protocol. The G4EB2 brain is functionally similar
to a SNAP-PAC-EB2 brain without analog I/0 functionality. Input and output modules can be placed in any

order.

1. Inthe Configure I/O Units dialog box, highlight the digital 1/0 unit the points are on, and click 1/0 Points.
The Configure I/0 Points dialog box appears.

E=N ECR

Type: |G4EB2

(G4 zimple digil

| Features | Enable

| Ref Co... | Descrp... |

-] Configure /0 Points
EaNT G4 Digital Unit
Charinel | Hame | Type
oo Mot Used
m Mot Uzed
0z Mot Uszed
03 Mot Used
04 Mot Uzed
05 Mot Uszed
0E Mot Used
o7 Mot Uzed
08 Mot Uszed
03 Mot Uzed

Cloze I Help

Points that have not been configured yet show as Not Used.
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For G4 modules, there is one channel per module.
For Quad Pak modules, there are four channels
per module which must be grouped together as

shown. !
First 0-3 .;:J
Second 4-7 pA
Third 8-11

Fourth 12-15

Fifth 16-19 First module (channels 0-3)

Sixth 20-23

Seventh 24-27

Eighth 28-31

2. Double-click the channel number for the point you want to add.
The Add Digital Point dialog box appears.

Add Digital Point (=)
Mame: [ ——A
Drescriptior; | ——B
Type: Input =1 c
Modue  |G4DCE 10-32wDCA232vac 9 —=b L P
Eeatures: |None —"-_l—— E
Watchdog:, & Mo F
0k, | Cancel | Help
|

3. Complete the fields as follows:

A—Name. Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

B—Description. (Optional) Enter a description of the point.
C—Type. Select the type, either Input or Qutput.
D—Module. Select a module from the drop-down list.

E—Features. To use a feature of the module, choose it from the drop-down list. (See “Using I/0 Point
Features”on page 70 for explanations of point features. Note that some features, such as pulsing and
totalizing, can be configured in PAC Manager but require PAC Control to use them.)

F—Watchdog. (Output modules only) To configure a status the point should be set to if the Watchdog
timer on this 1/0 unit expires, click Yes and choose On or Off from the drop-down list.

4. When you have completed the fields, click OK.
The new point is added.
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40

5. To configure more digital points, repeat the steps.

Configuring Analog Points

About E1and E2 brain boards: You can configure E1s and E2s like any other I/0 unit if you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),

see /O Configuration for E1 an E2 Brain Boards (form 1576).

To configure points on analog modules supported by the brain or on-the-rack controller:

1. Inthe Configure I/0 Points dialog box, double-click the number that represents the analog module’s
position on the rack. (For help, see the diagrams starting on page 155

2. Fora SNAP I/0 unit, choose the module type and then the exact module part number from the list.

| Add Module

Tvpe:

[l

Digital Input
Diigital Dutput

Analog Output

Module:

SHAP-AIARMS: O-104 AC/DC
SMAP-AIARMS-: 0-10 4 AC/DC
SHAP-AICTD: ICTD Temp. Probe
SHAFP-AICTD-4: ICTD Temp. Probe
SHAP-AICTD-3 ICTD Temp. Probe
SMAP-AILC: -2 - +2 miv M Fast
SMHAP-AILC-2: -4 - +4 mv A Fast
SMAP-AIMA: -20 - +20 ma,
SHAP-AIMA-L -20 - +20 ma
SMAP-AIMA-SRC: -20 - +20 mb
SHAP-AlMA-4; -20 - +20 mé,
SMAP-AIMA-E: -20 - +20 mé,
SMAP-AIMA-32; -20 - +20 ma
SHAP-AIMAZL -1 - +1 méd,
SHaP-AIMY-4; 150 - +150 my
SMAP-AIMWZ-4: B0 - +50 my
SMHaP-AIPM: 0 - 250 VACADC
SMAP-AIPKM-3: 0 - 300WACADC
SHAP-AIPKM-3 [OId): 0 - 250 WAaCADC
SMAP-AIPM-3V: 0 - 300 VACADC
SMAP-AIPM-3 [OId]; 0 - 250°WACADC
ErU-AIPM-3V: 0 - 400 WACADC
SHAP-AIRATE: Rate [Frequency)

ok | Cancel

m

3. (lick OK.

4. In the Configure I/O Points dialog box, click the plus sign next to the new module to expand it. Notice
that the module icon is color-coded to reflect the type of module being configured: blue for analog

input, green for analog output.
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Module icon

Expand or collapse points on

CHAPTER 2: CONFIGURING DEVICES

] Configure /0 Points

[o]l e ]

X

120 Urnit: IPreprocess

Type: ISN.&F‘-F’.&C-H'I [analog/digital]

Modules and Points

Add...

Type | Features / Subty. .. «

= |j [DO] SNAP-IDCS: 10 - 32 VDC/VAC
IL,E' 0 Pump_1_5Status
=1 1 Not Used
Mot Used
Mot Used

i

2
L 4
5

the module by clicking the +
or - sign in the box.

Points A

5.

= 0 Not Used

- 24 1 Not Used
D2] Not Used
(03] Mot Used

< |
Cloze I

Help |

T4—
SN ] 011 ShAP-AV naloglput ||
=4

Digital Input Moadify...
Cournter

Delete

Mowe Ta...

Expand All

Collapze Al
_>|J

LCalibrate. ..

| REL

Double-click the point you want to configure.

Add Analog Point

Hame: I

Diescription; I

Type: Inpt =]

Module: ISNAF'-.-’-\IV-i: -10-+10%0C

=

Uritg: WOC

Zero Scale; |-1EI
Full Scale: |1D

Scaling

Default I E
LCustom... ll F

Watchdog: & Mo (7 es

[ o |

Cancel Help

6. Complete the fields as follows:

A—Name. Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the point.

C—Type, Module. For a SNAP I/0 unit, the type and module are inserted for you, but you may be able
to choose a different range or module from the drop-down list.

D—Units, Scale. Units and scaling for this module. See “Using Custom Scaling” on page 42.
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E—Scaling Default. To return the units, zero-scale value, and full-scale value to the defaults for the
module, click Default.

F—Scaling Custom. To assign custom units and values to the module, click Custom. For example, you
could scale the voltage range of a-10 to +10 VDC module to be interpreted as engineering units of liters
per second instead of volts. See “Using Custom Scaling”on page 42.

G—Watchdog. (Outputs only.) To configure a value this point should be set to if the Watchdog timer
on this I/0 unit expires, click Yes and enter the value.

7. When you have completed the fields, click OK.
The new point is added. This image shows a SNAP /0 unit.

| Configure /0 Points EI
140 Unit: |Preprocess Type: |SMAP-PACFRI [analog/digitsi)
Modules and Points Type | Features / Subty. .. « fdd... |
=] |j [00] SMAP-IDCE: 10 - 32 VDC/VAC Digital Input Madiy... |
IL,E' 0 Pump_1_5Status Courter
=1 1 Not Used Delete |
= 2 Not Used |
Iﬂd— 3 Mot Used Move To... |
=] - [01] SMAP-AIVS Analog Input
e 0 Fowmeter A | [.10-+10vOC_] |
o= 0 Flowmeter_A 10-+10VDC Expand Al
24 1 Not Used
[0Z] Mot Used Collapse &l |
[03] Not Used -
4| | 3

Cloze I Help | LCalibrate. ..

Point types and features are shown in the Features/Subtype column.
8. Toadd more analog points, repeat the steps. To add digital points, see page 35.

Using Custom Scaling

Analog modules can be set to show something other than the actual inputs or outputs. For example, you
could scale the readings of a -10 to +10 VDC input point to measure its input as zero liters per second when
the real-world reading is zero VDC, and 1000 liters per second when the real-world reading is five VDC.

Thermocouple values are not linear and cannot be scaled.

NOTE: Custom scaling has no effect on the resolution or accuracy of the module.
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In the Add Analog Point dialog box, click the Custom button in the Scaling area to open the Scale Analog
Readings dialog box.

. This example shows units scaled to liters per
Scale Analog Readings @ second. At an actual input of 0 VDC, the point
T will show 0 liters per second. At an actual input
A —— Scaled Unis: [Liters per second of 5 VDC, the point will show 1000 liters per
Lower Value second.
B—— sctwa  [-10 lvDC
CcC—— Scaled: |IJ |Liters per S&co
Upperalue
D— Actuak |5 [vDC
E——1— Scaled: |1 oo |Liters per 3EC0
ok | Cancel | Help |

Custom scaled values are floating point values:

- Foranalog input points with PAC firmware R8.0a and higher, you can use inverted scaling. Inverted
scaling means the lower value is greater than the upper value; inverted scaling can accommodate a
sensor, for example, that is wired to the SNAP module in a way that produces a negative current or
voltage.

- Foranalog output points you cannot use inverted scaling. The upper value must be greater than the
lower value.

Complete the fields as follows:
A—Scaled Units. Enter new engineering units for the module. The example uses liters per second.

B—Actual Lower Value. Enter the actual real-world lower value that the scaled lower value
corresponds to. Note that inputs typically have under-range capability, which means you can specify a
lower actual value that is less than the zero-scale value. Outputs do not have under-range capability.

C—Scaled Lower Value. Enter the new scaled lower value. This value can be any floating point value.

D—Actual Upper Value. Enter the actual real-world upper value that the scaled upper value
corresponds to. For inputs, you can specify an upper actual value greater than the full-scale value.

E—Scaled Upper Value. Enter the new scaled upper value. For outputs, this value can be any floating
point value greater than the scaled lower value. For inputs, it can be greater than or less than the scaled
lower value. This example uses 1000, which scales the output to 1000 liters per second when its actual
reading is 5 VDC.

Click OK.
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The new custom-scaled units appear in the Add Analog Point dialog box.

Notice the new units of liters per second and the
new minimum-scale (“Zero Scale”) and

Add Analog Point BES)|  maximum-scale (‘Full Scale”) values of 2000 and
+2000. The example connects a sensor with a
range of 0-1000 liters per second, but an output of
only 0-5 volts, to a SNAP-AIV module with an
Description: | output of -10to +10 volts. The figures shown reflect
the total possible range of the module, not the

Type: [ppt ] Sensor.

MHame: |Flowmeter_.t’-\

Module:  [SHAP-AIVE -10- 410WDE | Custom Module’s
scale scale
Units: Liters per secaond sealing (Liters/sec) (VBo)
_ Default Possible low —2000 ~10
Zem Scale: |-2000 ). value for module
Full Scale:  [2000 : -1000 -5
Upper & lower 0 = 0
Watchdog: & No (7 values entered
in dialog box 1000 = 5
oK Cancel Help Possible high 2000 10
value for module

Calibrating Offset and Gain

This section describes how you can manually set offset and gain or have them automatically calculated and
set for you.

NOTE: You must use the manual method (page 46) if:

«  Youdon't have access to a calibrator, or

«  The point uses inverted scaling and your device has PAC firmware R9.5b or lower. (In inverted scaling, the
lower scaled value is greater than the upper scaled value.)

Starting with the introduction of SNAP-B3000-ENET, all SNAP PAC brains (including SBs), SNAP Ethernet I/O units,
and E2 brain boards can automatically calculate offset and gain for analog input points. If a -50 mV to +50 mV
input receives signals that are slightly off (for example, not exactly -50 mV at the lowest point), the offset and gain
can be calculated so that values appear accurately when read.

Offset and gain values affect engineering units (EU). For a temperature input, engineering units are in degrees
CorF, depending on how the 1/0 unit is configured.

IMPORTANT: To calibrate the point, the I/0 unit must be turned on and attached to the network, and you must
have access to the I/O unit in order to use the calibrator. For points on a SNAP PAC SB-series brain, connect directly via
serial or through the controller via Ethernet. (See page 26 for details.)

Save the configuration to flash so that it is not lost when power is turned off. Since each calibration is for a specific
point on a specific /0 unit, the result cannot be saved to the configuration file and cannot be sent to any other I/0
unit.

First, calculate offset, and then calculate gain. The offset must be calculated at the signal corresponding to
zero engineering units (EU), and the gain must be calculated at the signal corresponding to the point’s
maximum input range value (or, for inverted scaling, the point’s minimum input range value—in inverted
scaling, the lower scaled value is greater than the upper scaled value).
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In the Configure I/0 Points dialog box, highlight the analog input point you want to calibrate.

| Configure /O Points EI@

140 Unit. |Preprocess Tupe: [SHAP-PAC-RI analog/digital]
Modules and Points | Type | Features / Subty... « |
+ [ [00] SNAP-IDC5: 10 - 32 VDC/VAC Digital Input .

Maodify...
= gl [01] SNAP-AIVS Analog Input Q
o210 Fowmeter A | [-10.-10vDC Delete
1 Not Used

[02] Not Used = Mowe Ta..

[03] Not Used

[04] Not Used

[05] Not Used e
[06] Mot Used Collapze Al
[07] Not Used -

N | 'n
Cloze | Help | LCalibrate. ..

Click the Calibrate button in the lower-right corner of the dialog box.

| Calibrate Analog Input - Flowmeter A (Module 1, Point0) [

Automatically Caloulate Set Offzet

|Jze a calibrator to input the gignal
caormespanding to zero Engineering Units Cloze

(" Gain - Use a calibrator to input the signal
caorespanding to the paint's masimunm
nominal value

MOTE: ou must set the Offset first, More >

To have the offset and gain calculated for you:

1.

On the analog input point, use a calibrator to input the signal that corresponds to zero Engineering Units
(V).

Example 1:SNAP-AIV (-10 to +10 VDC) configured with default scaling
zero EU =0VDC
Example 2: SNAP-AIV (-10 to +10 VDC) configured with custom scaling

Actual Scaled

Units VvDC PSI
Lower -10 0*
Upper +10 100

*Zero EU is 0 PSI, which corresponds to a -10 VDC field signal

Click Offset, and then click the Set Offset button.

Use the calibrator to input the signal corresponding to the maximum input range value—or for inverted
scaling, to the minimum input range value—for the configured point type.
(Ininverted scaling, the lower scaled value is greater than the upper scaled value)

For the exact values, refer to the configured Point Type or see the module's data sheet.
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Example:SNAP-AIV module; Point Type of -10 to +10 VCD:
Maximum Input Range Value = +10VDC
For inverted scaling, Minimum Input Range Value = -10VDC

4. C(lick Gain, and then click the Set Gain button.

To manually set offset and gain:
a. Click the More button.

| Calibrate Analog Input - Flowmeter A (Module 1, Point0) [

oee |

=
Cloze
~
MOTE: 'ou must zet the Offzet first. <4 Less
td anually Set

Offzet: |0 Gair: |0

b. Enter the Offset value. Click the Set Offset button.
c. Enterthe Gain value. Click the Set Gain button.

When you have finished calibrating the point, close the dialog box to return to configuring 1/0 points.

NOTE: To store offset and gain values permanently, you must save the change to flash when you send the
configuration data to the I/O unit (see page 68).

Configuring RS-232 and RS-485/422 Serial Communication Modules

NOTE: For information on connecting a Windows serial application to a remote serial device through a SNAP
Ethernet-based system, see the SNAP Serial Communication Module User’s Guide (form 1191).

(Not applicable to SB brains) RS-232 and RS-485/422 serial communication modules do not require
configuration unless you need to change communication parameters such as port numbers or baud rates.
Because these serial modules require no configuration, they do not appear in the Configure I/0 Points dialog
box in PAC Manager; you have to remember which positions on the I/O unit are filled with serial modules. For
more information on these modules, see the SNAP Serial Communication Module User's Guide (form 1191).

Default port numbers are shown on page 156. Default communication parameters are:
« 1 start bit (not configurable)

« 9600 baud
«  No parity
«  8databits
«  1stop bit

«  Nohandshaking

«  Send a test message when the module is turned on.
»  SNAP-SCM-232: No flow control

« SNAP-SCM-485-422: 2-wire mode
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Port numbers and all parameters except the last two (flow control and 2- or 4-wire mode) can be changed in

the I/0 unit's configuration file using the following steps. For flow control and 2- or 4-wire mode, see the steps

on page 48.

1. With the configuration file open, right-click the name of the I/O unit the serial module is on. From the
pop-up menu, choose Configure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units @

Address ‘Wwatchdog
Ethernet 10.192.54.110 Enabled

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules D_-,—— Modules
Events 3 button
Scratch Pad  »
4 [l | +

Communications »
Cloze | Help | Others 3

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Serial Modules from
the pop-up menu.

| Configure Serial Modules @
Statuz | todule | Fort | IP Pt | Baud F ate | Parity | [rata Bits| Stop Bitz | EOM Chars | Test Meszage | -
Dizabled 0 A
Dizabled i} B
Dizabled 1 A
Dizabled 1 B E
Dizabled 2 )
Dizabled 2 B
Dizabled 3 )
Dizabled 3 B [
Dizabled 4 A
Dizabled 4 B
Dizabled & A
Dizabled a3 B
Dizabled & A
Dizabled & B
Dizabled 7 )
Dizabled 7 B A
0K | Cancel Help

3. Click the status cell for the module number and port number whose parameters you want to change.
From the pop-up menu, choose Enabled.

The Status changes to Enabled.

4. To change a communication parameter, click the cell you want to change within the highlighted line.
Choose from the drop-down list, if there is one, or type the new value in the cell.

NOTE: The start bit is not configurable. To set flow control and 2- or 4-wire mode, see the steps on page 48.
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NOTE: EOM (end-of-message) characters apply only when using the serial module port with serial events (see
page 140). The device can check any one of up to four characters as the EOM indicator, and you enter them in
the field in hex. Example: 0x0DOA00OO looks for a 13 (hex 0D) or 10 (hex 0A).

5.  When you have finished changing parameters for serial modules, click OK to close the dialog box and
return to configuring 1/0 units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the I/0 unit

when you send the configuration data to the I/0 unit (see page 68).

Configuring Flow Control and 2- or 4-Wire Mode

IMPORTANT: You can configure flow control on a SNAP-SCM-232 and 2- or 4-wire mode on a SNAP-SCM-485-422
using PAC Manager. However, these configurations cannot be saved to the configuration file. The I/O unit that
contains the serial module must be on the same network as your computer, and the configuration is sent directly to

the I/O unit.

1. Inthe PAC Manager main window, click the Inspect button QI

The Inspect window opens.

- Ifyou haven't used the Inspect window before, the window will not show any data.

¥ Inspect Opto 22 Device

Device Name: I

;I Options »

Status:

Error reading area: Timeout

[~ Status Read
Status Read |

Status Write
Wireless LAN  #

Point Config

Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System 13
ScratchPad  »
Datalog 3
PID 3
Events »
Communications »
Other »

I Auto Refresh |15000 msec
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If you have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

= Inspect Opto 22 Device

Device Name: | 10.192.50.21

Status Read
Status Read

j Options »

Status: | Status Read area last read at 07/05/16 12:03:48

Status Write hDDRESS

DESCRIFTION

VALUE

Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System 3
ScratchPad  »
Data Log 3
PID 3
Events 3
Communications
Other 3

Close | Help |

0xFFFF F030 0004
0xFFFF F030 0008

0xFFFF F030 0018
0xFFFF F030 0000
0xFFFF F030 0230
0xFFFF F030 001C
0xFFFF F030 00RO
0xFFFF F030 00BO

0xFFFF F030 0020
0xFFFF F030 0080
0xFFFF F030 0024
0xFFFF F030 0025
0xFFFF F030 002&
0xFFFF F030 024C
0xFFFF F030 0028

0xFFFF F030 00ZE
0xFFFF F030 0034
0xFFFF F030 0038
0xFFFF F030 003C
0xFFFF F030 0040

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress
Subnet Mask
Gateway
DNS

ETHERENET 2 Interface

~ Refresh |

PUC Receiwed (0}

1}

RE6.la
1

Flash Memory

R59.5a
07/05/2016
07:58:52

0x0000007C
SHAP-FRC-51

00-A0-3D-00
10.1%2.50.2
255.255_192
10.1%2.51.5
10.1%2.60.9

-D5-0B
1

.0

a

1

™ AutoRefresh | 15000  msec

If you have configured other devices, they are listed in alphabetical order in the drop-down list.

If you have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

1_ [EngineRm
Status R4 ol partable
Status W22 T AC

Boiler
Chamber 1
Chamber 2

Wireless LAN

= Inspect Opto 22 Device

Cookie Controller

Cookie Controller

Paint Config ol portable

(CRIFTION

rerup Clea
¥y Flag 1

der Versij

= Cookie Controller ory Map Vi
HD@E' B EngineRm mware Verd
Digital Point S2fPAC mware Ver,

1 i T | i
‘fJxFFFF FO30 00BO Firmware Very
A SF S e N P e

In the Device Name field, type the name of the I/O unit (any unique name, usually the name configured
in PAC Control) or choose it from the drop-down list. (You can also enter the IP address.) Then click
Refresh.
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If the I/0 unit has not been defined in PAC Manager, the Add New Device dialog box appears. Choose
Direct Connection to Ethernet Device and enter the IP address of the device. Leave the Ethernet port at
2007 unless you have changed it on the device.

3. (lickthe Communications button and choose Serial Modules from the pop-up menu.

Information from the I/0 unit is displayed in the window.

-

e Inspect Opto 22 Device

(== =]

Device Name: [10.192.54.110

Senial Modules
Status Read

Status Write ‘

Serial Module Mumber: |0 w | Module 0is NOT a Senial Module

j Options ¥ Status: |Serial Module area last read at 0117412 12:17:28

| Refresh |

Close Help

- Address | Drescription ‘ Walue
e ¢ MODULE INFORMATION
0FFFF FOCO 0000 Module Type Digfnone [0=00]
Point Config OxFFFF FO34 7FO00 Module Subtype ]
. 0xFFFF FO34 7F02 Hardware Revision D ate Mk
Digital Bank 0xFFFF FO34 7FOE Loader Wersion MAE
o % 0xFFFF FO34 7F0&  Fimware VYersion NZ&A
Diigital Point FORT &
Analog Bank 0xFFFF FO34 8000 IP Port Mumber 22500
OxFFFF FO34 8004  Baud Rate 3600
0 0xFFFF FO34 2002 Parity Mone
__pmgPain | | O e Dasis 8
High Density 0xFFFF FO34 800&  StopBits 1
0xFFFF FO34 200C Power-up Test Message? Yes
s OxFFFF FO34 8200 EOM Character List 0x 0D 040000
el PORT B
0xFFFF FO34 8010 IP Port Mumber 225M
M OxFFFF FO34 8014 Baud Rate 3600
Datalog  * 0xFFFF FO34 8018 Parity MNone
0xFFFF FO34 8019 Data Bits 8
FID » OxFFFF FO34 8014 Stop Bits 1
OxFFFF FO24 801C Powerup Test Meszage? Yes
Events i 0xFFFF FO34 8210 EOM Character List [ OD0A0000
Communications »
Other 3

Lo |

7 AutoRefresh [16000  mesc

4. C(lickthe Serial Module Number drop-down list and choose the module’s position number on the rack to
see the module’s communication parameters.

5. Tochange a parameter, click its value in the Value column and choose from the drop-down list or enter a

new value.

NOTE: This is the only way to change hardware flow control for a SNAP-SCM-232 or 2- or 4-wire mode for a
SNAP-SCM-485-422. You can also change other parameters in this dialog box if necessary. However,

parameters changed in this dialog box are NOT saved to the configuration file.
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This example shows how to change Hardware Flow Control on a SNAP-SCM-232:

-

B Inspect Opto 22 Device

Device Name: [10.132.54.110

— Serial Modules
Status Read

Status Write: 1

Senial Module Mumber:

A:] Options ¥

Status:

(== =]

Sernial Module area last read at 011712121728

1] v1 Module Dis MOT a Serial Module

- Address I Description 1 alue ] Befresh |
AticlEs A D MODULE INFORMATION
(0=FFFF FOCO 0300 Madule Type 0z FO S0Pl
Paint Canfig OwFFFF FO3A 7F30 tMadule Subtype 1
(OxFFFF FO34 7F32 Hardware Revision Date 2003-06-06
Digital Bark (O=FFFF FO34 7F36 Loader Yersion Fi1.0e
(OxFFFF FO3A 7F34 Firrnware Yersion Fl.1e
Digital Point PORT &
(0=FFFF FO34 BOBD IP Port Number 22506
fnaboBark | | [oiFrer Fosa ops  BaudRate 5600
o (OwFFFF FO3A BOBS Parity Mone
_*’-‘"a_'@m] DWFFFF FO34 8089 Diata Bits g
Hich Dersity DWFFFF FO3 8084 Stop Bite 1
0«FFFF FO3% BOBE  Hardware Flow Contral? |No L]
(0=FFFF FO34 BOBC Power-up Test Message?
Svstem ¥ | | | OuFFFF FO348260  EOM Character List P
FORT B
_SeatehPad b | || e rosg070 1P Pot Number 20807
e OAFFFF FO34 8074 BaudRate 9600
(0xFFFF FO34 BO7S Parity MNone
FID b 04FFFF FO34 8079 Data Bits 8
(O=FFFF FO34 B07A Stop Bits 1
Ewvents 3 (0=FFFF FO34 BO7E Hardware Flow Contral? Mo
(0xFFFF FO34 BOFC Power-up Test Message? Yes
Communications b (0=FFFF FO34 8270 EOM Character List 0x 0DOA000
Other 3
Close Help I~ Auto Refresh |15000

msec

6. When you have finished changing parameters for this module, click Apply.

The configuration changes are sent to the I/O unit.

Configuring Wiegand Modules

(Not applicable to SB brains) Wiegand modules are a type of serial module. Before configuring a Wiegand
module, see the (form 1191) for more information about these modules.

1.

pop-up menu, choose Configure. The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

Ethernet

Address

‘Wwatchdog
Enabled

Help

Cloze |

I

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules :,—— Modules
button
Events 3
Scratch Pad  »
2
Communications »
Others 3
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2.

Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Wiegand Modules

from the pop-up menu.

| Configure Wiegand Modules @
iegand Module
Mumber: |0 - I Uszed
Addrezs | Dezcription | " alue
MODULE INFORMATION
0«FFFF FOCO 0000 Module Tepe Dig/rnone [Ox00)
0«FFFF FO34 8501 Module Subtype 0
0«FFFF FO34 8502 Hardware Revizion D ate M8
0«FFFF FO34 3506 Loader Version M8
O«FFFF FO34, 3504 Firmnware Wersion M8
FORT &
0«FFFF FO34 3600 IF Port Mumber 22500
0«FFFF FO34 3604 Format u] =1
0«FFFF FO34 3602 Data Length a7
0«FFFF FO34 360C Sibe Pogition |
0«FFFF FO34 3610 Site Length |
0«FFFF FO34 8614 Badge Poszition 18
0«FFFF FO34 3618 Badge Length 19
0«FFFF FO34 361C Farity Check, Mo
0«FFFF FO34 8620 Ewen Parity Position 0
O«FFFF FO34 3624 Odd Parity Pogition I
FORTE
0«FFFF FO34 3640 IF Port Mumber 225M
0«FFFF FO34 3644 Format u] =1
0«FFFF FO34 3648 Data Length a7
0«FFFF FO34 364C Sibe Pogition |
0«FFFF FO34 3650 Site Length |
0«FFFF FO34 8654 Badge Poszition 18
0«FFFF FO34 3658 Badge Length 19
0«FFFF FO34 365C Farity Check, Mo
0«FFFF FO34 86E0 Ewen Parity Position 0
0«FFFF FO34 3664 Odd Parity Pogition I
oK | Cancel Help

In the Number field, choose the Wiegand module’s position from the drop-down list. Click to put a check
mark in the Used box.

If you need to change port numbers, enter the new numbers for each port in the TCP port Number fields.

Click the Format/Value cell, and from the drop-down list, choose a standard data format (shown by its
total data length) or choose C for custom.

NOTE: O is the 37-bit Opto 22 format used in a sample PAC Control strategy available for use with Wiegand
modules. For details, see the SNAP Serial Communication Module User's Guide (form 1191).

Change the following fields if necessary to match your Wiegand hardware device:

Data Length—total length of data in the transmission

Site Position—first bit of the site code

Site Length—Ilength of the site code, in bits

Badge Position—first bit of the badge code (should be the next bit after the site code)
Badge Length—Ilength of the badge code, in bits

When data for both ports is correct, repeat from step 3 for additional Wiegand modules.

When all Wiegand modules are configured, click OK to close the dialog box and return to configuring I/0
units.
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IMPORTANT: If you changed a TCP port number, you must save the change to flash and restart the I/0O unit when you

send the configuration data to the I/0 unit (see page 68).

9. When you are ready to send all configuration data to the I/O unit, see “Sending Configuration Data to the

I/0 Unit"on page 68.

Configuring Profibus Modules

1. With the configuration file open, right-click the name of the I/O unit the Profibus module is on. From the
pop-up menu, choose Configure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

‘Wwatchdog
Enabled

Ethernet 10.192.54.

<

Cloze |

I

Help |

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules :,—— Modules
Events 3 button
Scratch Pad  »
: Communications »
Others 3

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Profibus Modules
from the pop-up menu.

3| Configure Profibus Modules @
Profibus Module
MNumber: |0 | [ Used
Addrezs | Dezcription | " alue
MODULE INFORMATION
0«FFFF FOCO 0000 Module Tepe Dig/rnone [Ox00)
0«FFFF FO34 FFOO Module Subtype 0
0«FFFF FO34 7FO2 Hardware Revizion D ate M8
0«FFFF FO34 7FOE Loader Version M8
O«FFFF FO34 7RO Firmnware Wersion M8
FORT &
0«FFFF FIO34 3000 IF Port Mumber 22500
0«FFFF FO34 3004 Baud Rate 19200 =1
0«FFFF FO34 2002 Farity Ewen
0«FFFF FO34 3009 Data Bits a
OFFFF FO34, 30048 Stop Bits 1
0«FFFF FO34 3008 Hardware Flow Control? Mo
0«FFFF FO34 800C Fower-up Test Meszage? Tes =1
0«FFFF FO34 200 EOM Character List [0 OD0&0000
Cancel Help

PAC Manager User's Guide 53



CONFIGURING I/0 MODULES AND POINTS

3. Inthe Number field, choose the Profibus module’s position from the drop-down list. Click to put a check

mark in the Used box.

4. Ifyou need to change port numbers, enter the new numbers for each port in the TCP port Number field.

5. Change the Baud Rate and EOM Character List fields if necessary to match your Profibus devices. Choose
whether to have the module automatically send a Test Message when turned on (the default is Yes).

6. When data is correct, repeat from step 3 for additional Profibus modules.

7. When all Profibus modules are configured, click OK to close the dialog box and return to configuring 1/0

units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the I/0 unit
when you send the configuration data to the I/0 unit (see “Sending Configuration Data to the I/O Unit” on page 68).

Configuring SSI (Serial Synchronous Interface) Modules

Serial synchronous interface (SSI) modules (part number SNAP-SCM-SSI) are a special type of serial module.

Unlike other serial modules, these can be used with SNAP PAC serial brains.

Before configuring an SSI module, see the SNAP SSI (Serial Synchronous Interface) Module User’s Guide (form
1931) for information you will need to configure it.

1. With the configuration file open, right-click the name of the I/O unit the SSI module is on. From the

pop-up menu, choose Configure.
The Configure /0 Units dialog box opens.

=»| Configure I/O Units

==l

| Port | Address

| Watchdag | De Add..

SHAP-PAC...  Ethernet

10.192.54.110

Enabled

Modify... |
Delete |

Import/Copy... |

1/0 Paints... |
FID Loops... |
Modules >:|—
Events 3 |
Scratch Pad  » |

Cloze I Help

2
Communications » |
Others 3 |

— Modules
button
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2. Make sure the correct 1/0 unit is highlighted. Click the Modules button and choose SSI Modules from the
pop-up menu.

| Configure S5I Modules @

551 Module

MNumber: |0 | [ Used

Addrezs | Dezcription | " alue
FORT O
0«FFFF FO34 1000 D ata Frame Length 0
0«FFFF FO34 1004 Clock Divider I
0«FFFF FO34 1008 Data Delay, Clock Cycles 0
0«FFFF FO34 100C Mozt Significant Data Bit Offzet 0
0«FFFF FO34 1070 Data Bits in the Data Frame 0 »» 24 Max. <<
O«FFFF FO34 1014 Eror Bit Offget in the Data Frame I
0«FFFF FO34 1018 Error Bit Level High Bit Indicates Enar = |
0«FFFF FO34 101C Data Encoding Binamy =1
0«FFFF FO34 1020 Enable Scanning Dizabled =1
FORT 1
0«FFFF FO34 1040 D ata Frame Length 0
0«FFFF FO34 1044 Clock Divider I
0«FFFF FO34 1048 Data Delay, Clock Cycles 0
0«FFFF FO34 1040 Mozt Significant Data Bit Offzet 0
0«FFFF FO34 1050 Data Bits in the Data Frame 0 »» 24 Max. <<
0«FFFF FO34 1054 Eror Bit Offget in the Data Frame I
0«FFFF FO34 1058 Error Bit Level High Bit Indicates Enar = |
0«FFFF FO34 1080 Data Encoding Binamy =1
0«FFFF FO34 1080 Enable Scanning Dizabled =1

Cancel

3. Inthe Number field, choose the SSI module’s position from the drop-down list. Click to put a check mark
in the Used box.

4. Configure all parameters for each port used. See the SNAP SSI (Serial Synchronous Interface) Module User’s
Guide (form 1931) to obtain the data for these fields. For each port, choose Enabled in the Enable
Scanning field.

5. Repeat for additional SSI modules.
6. When all SSI modules are configured, click OK to close the dialog box and return to configuring I/0 units.

7. When you are ready to send all configuration data to the I/O unit, see “Sending Configuration Data to the
170 Unit"on page 68.

Configuring CAN Modules

The SNAP-SCM-CAN2B provides an interface to a Controller Area Network (CAN) that allows your SNAP PAC
system to receive data from CAN devices. Before configuring a CAN module, see the SNAP SS/ (Serial
Synchronous Interface) Module User’s Guide (form 1931) for more information about these modules.

Configuration for the SNAP-SCM-CAN2B module is normally done in a PAC Control strategy using the example
subroutine from the CAN RX/TX Integration Kit for PAC Project, part number PAC-INT-CAN-RXTX, a free
download available on our website, www.opto22.com. As described below, you can also use PAC Manager to

PAC Manager User's Guide 55


http://www.opto22.com/
https://www.opto22.com/support/resources-tools/documents/1931_snap_ssi_module_users_guide-pdf
https://www.opto22.com/support/resources-tools/documents/1931_snap_ssi_module_users_guide-pdf
https://www.opto22.com/support/resources-tools/documents/1931_snap_ssi_module_users_guide-pdf
https://www.opto22.com/support/resources-tools/documents/1931_snap_ssi_module_users_guide-pdf

CONFIGURING I/0 MODULES AND POINTS

change the IP Port Number, Baud Rate, Data Masks, or Filters for the SNAP-SCM-CAN2B serial module.
However, the settings in your strategy will override the settings in PAC Manager for each module.

1.

CAN module

With the configuration file open, double-click the I/0 Units folder.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

T

| Port

| ‘Wwatchdog | De

Ethernet

Enabled

<

I

3

Cloze I Help

==l

Add...

Modify... |
Delete |

Import/Copy... |

1/0 Paints... |
FID Loops... |
Modules >:|—
Events 3 |
Scratch Pad  » |
Communications » |
Others 3 |

— Modules
button

Highlight the I/0 unit the CAN module is on. Click the Modules button and choose CAN Modules from

the pop-up menu.

Information from the I/0 unit is displayed in the window.

Click the CAN Module number dropdown list and choose the module’s position number on the rack to

see the module’s communication parameters.

number

| Configure CAN Modules @
— CAN Madule
Nurnber: I[J vI [ Used
Address | Description | Value |
PORT INFORMATION

OxFFFF FO34 2000 Port Number 22500

OxFFFF FO3A 9004  Baud Rate 250000 =
OxFFFF FO3A 9008 Dats Mask 0 0x 00000000

OxFFFF FO34 900C  Filter 0 0x 00000000

OxFFFFFO34 9010  Filter 1 0x 00000000

0xFFFF FO3A 9014  Data Mask 1 0x 00000000

OxFFFF FO3A 9018 Filter 2 0x 00000000

OxFFFF FO3A 901C  Filter 3 0x 00000000

0xFFFF FO34 9020 Filter 4 0x 00000000

0xFFFF FO3A 9024  Filter 5 0x 00000000

4. To change a parameter, click its value in the Value column.
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To change the Baud Rate on a SNAP-SCM-CAN2, choose from the drop-down list

OxFFFF FO34 9004 Baud Rate
OxFFFF FO34 9003 Data Mask 0
OxFFFF FO34 900C  Filter 0
OxFFFF FO34 9010 Filter 1
(OxFFFF FO34 9014 Data Mask 1
(OxFFFF FO34 9013 Filter 2
OxFFFF FO34 901C  Filter 3
OxFFFF FO34 9020 Filter 4
OxFFFF FO34 9024 Filter 5

To change the Filter or Data Mask values, see the next section below.
5. When you have finished changing parameters for this module, click OK.
6. Repeat the previous step for additional CAN modules.

7.  When all CAN modules are configured, click OK to close the dialog box and return to configuring 1/0
units.

8. When you're finished configuring I/0 units, close the dialog box. Choose File > Save to save the
configuration file.

9. When you are ready to send all configuration data to the I/0 unit, see “Sending Configuration Data to the
170 Unit"on page 68.

SNAP-SCM-CANZ2B Filters and Data Masks

The filters and data masks for each CAN2B module are normally configured in a PAC Control strategy using the
sample subroutines provided in the CAN RX/TX Integration Kit for PAC Project, part number
PAC-INT-CAN-RXTX. You can also use PAC Manager to configure these settings. However, the filter and data
mask settings in your PAC Control strategy will override the settings in PAC Manager for each module.

In PAC Manager the Data Masks and Filters are all set to O by default, which means that all CAN packets will be
received. If you want the SNAP-SCM-CAN2B module to provide filtering, then configure the Data Masks and
Filters.

Always start with the highest priority mask and filter, Data Mask 0 and Filter 0. Mask 0 uses Filter 0 and Filter 1,
in that order. Then Data Mask 1 uses Filters 2-5, in that order.

Address | D escription | Walue
PORT INFORMATION

OxFFFF FO34 9000 Port Mumber 22500

OxFFFF FO34 9004 Baud Rate 250000 Bl
OxFFFF FO34 9008 Data Mask 0 (x 00000000

O«FFFF FO34 900C  Filter 0 (x 00000000

OxFFFF FO34 9010 Filter 1 (x 00000000

OxFFFF FO34 9014 Data Mask 1 (x 00000000

OxFFFF FO34 9018 Filter 2 (x 00000000

OxFFFF FO34 901C  Filter 3 (x 00000000

OxFFFF FO34 9020 Filter 4 (x 00000000

OxFFFF FO34 9024 Filter & (x 00000000

-l e T R a P

Masks and filters each consist of 32 bits; in PAC Manager these are entered in hex. The mask determines how
broadly or narrowly the filter will be applied, that is, which bits of the CAN ID to pay attention to when
deciding to accept or reject a CAN packet. The following table shows how the mask and filter work together.

Mask Bit Filter Bit CAN ID Bit Accept/Reject
0 X* X* Accept
1 0 0 Accept
1 0 1 Reject
1 1 0 Reject
1 1 1 Accept

* X =Don't Care
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Bits:
Bit values:

Mask in hex:

Bits:
Bit values:

Filter in hex:

The configuration examples below show how to build the masks and filters.

These examples assume you are using module firmware 2.0b or higher.

Example 1

Suppose many CAN frames are placed on the bus at regular intervals (in no particular order). Some are
standard CAN frames; others are extended CAN frames. You are interested in only one frame, an extended CAN
frame with an Arbitration ID of: 0x14613a2C

This is the only frame you want to capture. How do you configure the Mask and Filter fields to capture it?

Parameter Value Description

A mask with all bits set means the module should consider each bit of the arbitra-

Mask 0 OX1FFFFFFF tion ID for acceptance. This makes the filter more stringent.

Since this is an extended CAN frame, you want the filter to apply to extended
CAN frames received. So bitwise OR the Arbitration ID with the Extended ID

Filter 0 0x84613A2C £ able (EXIDE) flag. This flag tells the brain that the filter should apply to
extended CAN frames. The value of this flag is 0x40000000.

Filter 1 0x0 Not used, since you are interested in only one CAN frame.

Mask 1 0x0 Not used

Filters2-5 0x0 Not used

Here are representations of the 32-bit mask and the 32-bit filter for this example:

Mask 0

31|30|29|28|27|26|25(24 (23 |22|21|20({19|18|17{16(15(14|13|12|11|10|9 (8 |7 |6 |5 |4 |3 |2 |1 |0

LOJ0 2 2 e e e e T e e A I A O I R

1 F F F F F F F

Filter 0

For data in an extended frame, set the EXIDE flag, which is bit 30. The Arbitration ID of 0x14613A2C
becomes 0x54613A2C when bit 30 is set:

s 9 o

o = &

S g 3 Arbitration ID

‘6;‘6

Z| 5l 2

31|30(29|28|27|26 (25|24 (23|22(21|20(19|18(17|16 (15|14 |13|12(11|10(9 |8 |7 |6 |5 (4 [3 |2 |1 |0

o(1(0|1|0]1]0|0|0|1[1]0 0 1 o|1]1(1 1/0(0|0(1|0|1|1(0]|0
5 4 6 1 3 A 2 C

Example 2

Building on Example 1, suppose now you decide that in addition to the extended CAN frame with Arbitration
ID 0x14613A2C you also want to capture a standard CAN frame with Arbitration ID 0x1EC.

For this second frame you have two options:
«  You could put the standard frame at Filter 1 so that both frames are using Mask 0.
»  Youcould use a different mask, Mask 1, and use Filter 2.

In either case you need to map the 11-bit (standard) Arbitration ID to the 32-bit value the module is
expecting. The module expects the 11-bit standard ID to be in bits 28—18 of the 32-bit filter. So, in terms of
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math: mask the desired 11-bit Arbitration ID with 0x7FF and then left-shift by 18 bits: ((11-bit

Arbitration ID)

& OxTFF)<<18

Using Mask 0. Mask 0 is already considering each bit in the Arbitration ID, and since we only want to look at
these two CAN frames, we could use Filter 1.

Parameter

Mask 0

Filter O

Filter 1

Mask 1

Value

0x1FFFFFFF

0x54613A2C

0x07B00000

0x0

Filters 2-5 0x0

Description

A mask with all bits set means the module should consider each bit of the arbitra-
tion ID for acceptance. This makes the filter more stringent.

Since this is an extended CAN frame, you want the filter to apply to extended
CAN frames received. So bitwise OR the Arbitration ID with the EXIDE flag.

Value of standard Arbitration ID filter after mapping it to its 32-bit value. Do not set
the EXIDE flag. In this case the lower 18 bits (the extended arbitration bits) are
excluded from the acceptance check, even though the mask would indicate oth-
erwise, since this is a standard CAN frame filter.

Not used

Not used

Using Mask 1. If Mask 0 were less stringent (fewer set bits) so it would not cause acceptance of just the
0x1EC Arbitration ID, then you could use the Mask 1 and Filter 2.

Parameter

Mask 0

Filter O

Filter 1

Mask 1

Filter 2

Filter 3-5

Value

0x1C63FFFF

0x54613A2C

0x0

0x1FFCO0000

0x07B00000

0x0

Description

A Mask with much less stringent acceptance criteria. The set mask bits are used
in the comparison with the filter, while the cleared bits are “Don't Care.”

Since this is an extended CAN frame, we want the filter to apply to extended
CAN frames received. So bitwise OR the Arbitration value with the EXIDE flag.
(Depending on the Arbitration IDs of other CAN frames on the bus, other
extended CAN frames will also be accepted, for example 0x15613A2C,
0x16613A2C, 0x17613A2C, 0x14713A2C, and so on.)

Not used

A mask stringent on the standard arbitration bits but allowing all the extended
arbitration bits.

Value of standard Arbitration ID filter after mapping it to its 32-bit value. Do not
set the EXIDE flag. This filter captures only the 0x1EC standard CAN frame.

Not used

Configuring HART Modules

HART® SNAP I/0 are a special type of serial module that provides communication with other Highway
Addressable Remote Transducer (HART) current loop devices. For more information, see the HART SNAP 1/0
Modules Data Sheet (form 2080).

1. With the configuration file open, right-click the name of the I/0 unit the HART module is on. From the
pop-up menu, choose Configure.
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The Configure /0 Units dialog box opens.

=»| Configure I/O Units

==l

| Type

| ‘Wwatchdog

| De Add..

| Port | Address

Enabled

<

I

Modify... |
Delete |

Import/Copy... |

1/0 Paints... |

FID Loops... |
Modules >:|—

Events 3 |

Scratch Pad  » |

: Communications » |

— Modules
button

Close I Help | M
2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose HART Modules from
the pop-up menu.
sp| Inspect HART Module 5
—HART Module
Murmber: ID 'I [ Used
Address | Description | value I
PORT A

OxFFFF FO34 9400 Port Number 22500

OxFFFF FO3A 9404 Primary Master g

OxFFFF FO3A 9408 Retry Limit 2

OXFFFF FO34 940C  Burst Message o

0xFFFF FO3A 9410 Promiscuous Mode g

0xFFFF FO3A 9414 Preambles Count 5

PORTE

OXFFFF FO3A 9430 Port Number 22501

0xFFFF FO3A 9434 Primary Master g

OXFFFF FO34 9438 Retry Limit z

OxFFFF FO34 943C  Burst Message 0

0xFFFF FO3A 9440 Promiscuous Mode g

OxFFFF FO3A 9444  Preambles Count 5

’TI Cancel |
3. Inthe Number field, choose the HART module’s position from the drop-down list. Click to put a check
mark in the Used box.

4. Configure all parameters for each port used.

Port Number: If you need to change port numbers, enter a new number for each port in the Port
Number field.

Primary Master: 0 = Secondary Master, 1 = Primary Master

A master is a device that is in control of the HART Bus. Either master (Primary or Secondary) can
initiate a transaction with a slave field device attached to the bus.
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If you want a permanent master connected to the HART bus, use Primary Master = 1. This allows you
to temporarily attach another master device to configure a device or troubleshoot the HART bus.

— RetryLimit:0,1,2,3,4,0r5
If the module does not receive a valid message from the slave device it is talking to, it will
automatically send up to the configured number of retries until it gets a valid response. If it does get
a valid response after the maximum number of retries, it will report back that an error occurred.

—  Burst Message: 0 = Don't report burst messages, 1 = Report burst messages
A burst message occurs in a special mode where one slave device on the HART Bus is periodically
sending data without a request generated by a master device. Burst messages can be retrieved
using the Receive HART Burst Response command in your PAC Control strategy. For more
information, see the Analog group of commands in the PAC Control Command Reference (form
1701).

- Promiscuous Mode: 0 = Don't report other master requests/responses, 1 = Report other master
requests/responses.
When enabled (1), the module reports transactions initiated by the other master on the bus,
including requests generated by the other master and responses to those requests by the addressed
slave. You can retrieve Promiscuous Mode messages using the Receive HART Burst Response
command in your PAC Control strategy. For more information, see the Analog group of commands
in the PAC Control Command Reference (form 1701).

- Preambles Count: 5 to 20
Preamble characters are sent with every message to indicate that data is about to be transmitted.
The default of 5 should work in most situations. However, you might need to increase the number if
the slave device requires more preamble characters, which is generally true of older HART devices
and can be determined using HART command 0.

5. Repeat the previous step for additional HART modules.
When all HART modules are configured, click OK to close the dialog box and return to configuring 1/0
units.
7. When you are ready to send all configuration data to the I/O unit, see “Sending Configuration Data to the
170 Unit"on page 68.

Moving a Configured 1/0 Point

You can move a configured I/O point to an empty position on the same I/O unit or on a different I/0 unit.
1. Inthe Configure I/0 Unit dialog box, highlight the unit the point is on and click I/O Points.

The Configure I/0 Points dialog box opens.
2. If necessary, expand the modules by clicking Expand All.
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COPYING AND PASTING I/0 UNITS

3. Highlight the point you want to move and click Move To.

| Move Point To

170 Units:

QK | Cancel Help

Paints:

i

[00] [00] : Pumnp_1_Status
[00][071] : Mot Uzed
[00][02] : Mot Uzed
[00] [0:3] : Mot Uzed
[07][00] : Flowwrneter_&
[017[071] : Mat Uzed
[02] [00] : Mot Uzed
[02]1[071] : Mot Uzed
[02][02] : Mot Uzed
[02][0:3] : Mot Uzed
[03][00] : Mot Uzed
[03]1[071] : Mot Uzed

(it Wy o I A RO [ e}

Lm | »

4. Inthe Points area of the Move Point To dialog box, highlight the location you are moving the point to.

Then click OK.

You return to the Configure I/O Points dialog box, and the point has been moved.

COPYING AND PASTING I/0 UNITS

You can copy configured I/0 units and paste them into the same configuration file or into another

62

configuration file.

1. Inthe configuration tree, right-click the name of the I/0O unit. On the submenu, click Copy.

2. Choose one of the following:

—  To paste the I/0 unit into the same
configuration file, right-click the I/0
Units folder and click Paste on the
submenu. The I/0 unit is pasted. As
shown in the graphic at right, the
names of the pasted 1/0 unit and
points are the same as the originals,
except with an underscore and a
number added.

—  Topaste the I/0 unit into a different
configuration file, close the first file,
and then open the file into which you
want to paste the I/0 unit. Right-click
the I/0 Units folder in the configuration
tree. On the submenu, click Paste. The
I/0 unit is pasted. To see it in the

Original unit
and points

Pasted unit
and points

MainProcess™ EI@

=I5 MainProcess

B VOUnts
. B~ Points
: ..... HH pump_1_Status

- IM‘_ Flowmeter &

(5 PDs
U e $H Memory Map Values)
( E%’ Preprocess_1
B Points

..... IL‘El Pump_1_Status 1

- IM‘_ Flowmeter A 1

configuration tree, you can click the plus sign to expand the folder.
3. Tochange the name or configuration of the pasted I/O unit, double-click it. Make the changes in the Edit

/0 Unit dialog box and then click OK.

4. To change the name or configuration of a point on the pasted unit, double-click the point’s name. Make

changes in the dialog box and then click OK.
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CONFIGURING PID LOOPS

What is a PID?

PID loops (or simply PIDs) are used to drive an input (process variable) toward a particular value (the setpoint)
and keep the input very close to that value by controlling an output. For example, consider temperature
control, where the input is a measurement of ambient temperature, the setpoint is the desired temperature,
and the output is a heater. A PID will use a mathematical formula (algorithm) that controls the output to
maintain a desired temperature, efficiently adjust to changes in setpoint, and compensate for changes in load,
such as the influx of cold air. In this example, a temperature sensor (analog input), a thermostat (analog input),
and a heater control (analog output) are components of one system, controlled by a PID loop.

This guide assumes that you are already familiar with using PIDs. PID calculations are complex and the physical
qualities of systems suitable for PID control differ greatly. This guide includes only basic information for
configuring PIDs on SNAP PAC I/O units.

SNAP PAC R-series I/0 units support 96 PID loops per I/0 unit; SNAP PAC EB and SB 1/0 units support 32 PID
loops per I/0 unit. These PIDs can control isolated systems or be part of cascaded systems where one loop
controls the setpoints or input variables of others.

NOTE: On SNAP PAC R-series, PID loops run on the I/O side, independent of any PAC Control strategy. Once it starts
running, a PID continues running until the I/0 unit loses power or the PID is set to Manual. If you subsequently
download a different strategy to the control engine, you'll receive an error message (-700) reminding you that a PID
loop is still running and that it may conflict with the new strategy. To turn off the PID loop, use Inspect mode in PAC
Manager to change the PID’s algorithm to None.

Each PID must be configured with essential parameters and then individually tuned for efficiency. You can
configure PIDs through either PAC Manager or PAC Control. For tuning PIDs, it's easier to use the graphic
tuning tools in PAC Control. (For details, see the PAC Control User’s Guide, form 1700.)

If you are not using PAC Control, it is possible to configure and tune PIDs through the 1/0 unit's memory map.
The memory map is in the OptoMMP Protocol Guide (form 1465).

For additional help with PIDs, see the OptoTutorial: SNAP PAC PID (form 1641).

Algorithm Choices

(Does not apply to groov /0 units or groov RIO modules.) When you configure a PID loop, choose one of these

algorithms?:

o Velocity (Type Q)
« ISA

o Parallel

« Interacting

Velocity (Type C) is typically used to perform velocity control. The ISA, Parallel, and Interacting algorithms are
derived from the article “A Comparison of PID Control Algorithms”by John P. Gerry in Control Engineering

“The following obsolete algorithms support PID loops configured before PAC Project R9.5. For details, see the Opto 22
KnowledgeBase article KB82058
+ Velocity (Type B) Obsolete
- ISA (Obsolete)
- Parallel (Obsolete)
« Interacting (Obsolete)

You can continue to use these obsolete algorithms, but Opto 22 recommends you use the new algorithms when
configuring new PID loops.
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(March 1987). These three equations are the same except for the tuning coefficients; converting from one
equation to another is merely a matter of converting the tuning coefficients.

Key to Terms Used in Equations

Process variable; the input to the Derivative tuning pqrameter. !n units
PV PID TuneD of seconds. Increasing magnitude
increases influence on output.
SP Setpoint Output Output from the PID
InL \ — i-
n (.)' Range of the input Err 1 The Error (PV — SP) from the previ
InHi — ous scan
OutLo Integrator. Anti-windup is applied
o tH', Range of the output Integral | after the outputis determined to be
uthL within bounds.
Gain Ppmmmmummgm@maa. PV1, PV2 PV from the previous scan and the
Unitless. May be negative. scan before that.
Integral tuning parameter. In ynlts . Actual scan time (time since previ-
Tunel of seconds. Increasing magnitude ScanTime
. . ous scan)
increases influence on output.

Equations Common to All Algorithms

Err = PV - SP

Span = (OutHi - OutLo) / (InHi - InLo)
Output = Output + FeedForward * TuneFF

Equations Common to ISA, Parallel, and Interacting
Integral = Integral + Err
TermP = Err

TermI = Tunel * ScanTime * Integral
TermD = (TuneD / ScanTime) * ( PV - PV1 )
Velocity (Type C) Algorithm

ATermp = ( PV - PV1 )

In this part of the formula, you adjust Tunel.
ATermI = Tunel * ScanTime * Err

In this part of the formula, you adjust TuneD.
ATermD = TuneD / ScanTime * ( PV - 2 * PVl + PV2 )

In this part of the formula, you adjust Gain.
Aoutput = Span * Gain * ( ATermP + ATermI + ATermD )

ISA (or “Ideal”) Algorithm
Output = Span * Gain * ( TermP + TermI + TermD )

Parallel (or “Independent”) Algorithm
Output = Span * ( Gain * TermP + TermI + TermD )

Interacting (or “Classic”) Algorithm
Output = Span * Gain * ( TermP + TermI ) * ( 1 + TermD )

NOTE: In SNAP PAC PIDs, the derivative is applied only to the process variable (the input) and not to the setpoint. This
means you can change the setpoint without causing spikes in the derivative term. These PIDs also prevent integral
windup by back calculating the integral without the derivative term. The feed forward term (“bias”) is added before
output clamping and has a tuning factor.
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1. With the configuration file open, right-click the name of the I/0 unit the PID will be on. From the pop-up

menu, choose Configure.

The Configure /0 Units dialog box opens.

=»| Configure I/O Units

| Type | Port

| Address

| Watchdag | De Add..

SHAP-PAC...

Ethernet

10.192.54.110

Enabled

Modify... |
Delete |

Import/Copy... |

1/0 Paints... |
PID Loops... :l—— PID LOOpS

Modules 3 | button
Ewvents 3 |
Scratch Pad |
4 T b
Communications # |
Cloze I Help | Others 3 |
2. Make sure the correct I/0 unit is highlighted. Click the PID Loops button.
5| Configure PID Loops [E=8 E=8 =)
140 Ui | Tupe [SNAP-PACRT [analo,
s | Marme | IhpLt | Setp... | Dutput| haode | Enable| Ref ... | Descr Add. . |
o Mot .. (o
m Mot ... HModify... |
0z Maot ...
03 Mot ... - Celete
04 Maot ... j 4'
05 Maot ...
113 Maot ...
a7 Maot ... -
4 m 3

Cloze I

Help |

3. Double-click the lowest unused PID number.
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Add PID Loop (=23
A M ame: ||
B ——1—— Deseription: |
C—1— Input |I£D Pairt ﬂ |F|Dwmeter_.t’-‘-. ﬂ [~ SquareRoot L1 D
E—— Loww Range: |0 High Range: |10
F_ 1 | Setpaint |I,’D Paint j |Flowmeter_A j
G || Output: |I£D Faint j | j
H—— Lawser Clamp: |0 Upper Clamp: |0
I | ki Change: |0 Max Change: |0
Output options for when the input i out of range
3 ™ Switch to manual mode when input goes aut of range
7 ™ Force output whe input iz aut of range [auto mode only]
I I
N
K——- Algarithrn: — |Velocity - Type © | Gain: |1 Feed Fud Initial: |0 o
L —1— Mode: |.-’-‘«utc- j Tune |: |IJ | Feed Fwd Gain: |0 i
M—— Scan Rate: |1 zec. | Tune Dt 1] J P

ok | Cancel | Help |

4. Complete the fields as follows:
A—Name. Type a unique, descriptive name for the PID.
B—Description. (Optional) Enter a description of the PID.

C—Input. Select the type of input: I/0 Point, Host, or PID Output.

—  Ifthe PID’s process variable comes from an I/0 point on the same unit, select I/0 Point. Choose the
point from the drop-down list or type a point name to configure a new point.

- Ifthe PID’s process variable comes from a PAC Control strategy, select Host. Enter an initial value for
the input.

- Ifthe PID’s process variable is the output of another PID on this 1/0 unit (a cascading control loop),
select PID Output. Choose the PID from the drop-down list.

D—Square Root. (Optional) If you chose I/0 Point or PID for step C, check this box if the error should be
calculated based on the square root of the process variable (applies to flow control systems where volumetric
flow is proportional to the square root of a signal from a flow transducer).

E—Low/High Range. Set the valid range of the process variable by entering the low range and the high
range. (See J for optional responses to out-of-range input.)

F—Setpoint. Choose the source for the setpoint: /0 Point, Host, or PID Output.

- To control the setpoint using a device such as a potentiometer, select I/0 Point; choose an I/0 point
from the drop-down list or type a new point name.
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- To control the setpoint using PAC Control or PAC Display, select Host and enter an initial value.

- Ifanother PID loop will control the setpoint, select PID Output and choose the PID from the
drop-down list.

G—Output. Choose the destination for the PID output: I/0 Point or Host. (To use the output for controlling
the setpoint or input of another PID, choose Host.)

H—Lower/Upper Clamp. Enter upper and lower clamp values to prevent the output from exceeding a
desirable range. These values should equal the range of the output point, if used. Or choose values to make
sure that the output device doesn't shut off (for example, keeping a circulation pump running regardless of
the PID output) or that the output never reaches a destructively high setting (for example, keeping a motor
below maximum).

I—Min/Max Range. (Optional) Enter minimum and maximum change values. The output won't respond
until the minimum change is reached (for example, you may not want a heater to turn on to correct a 1
degree error). Maximum change prevents too drastic a change in output (for example, you could limit the
increase in a pump’s output to prevent pipe breakage). The default for both minimum and maximum is zero,
which disables the feature.

J—Output Options. Choose how the PID should respond if the input goes out of range. If no boxes are
checked, the PID will freeze output at the current value. To have PAC Control logic or an operator respond,
check Switch to manual mode. To force the output to a specific value, check Force output and type the output
values. NOTE: If both boxes are checked (forced output and manual mode), the output will be forced and the PID put
into manual mode; but if the PID is already in manual mode, the output will not be forced.

K—Algorithm. Choose algorithm: Velocity-Type C, ISA, Parallel, or Interacting. See page 63 for more
information.

L—Mode. Choose Mode. Auto activates the PID. Manual requires that PAC Control logic or an operator
control the PID output.

M~—Scan Rate. Enter a scan rate to determine how often the input is scanned and the controller output is
calculated. Minimum value is 0.001 (1 millisecond). Scan time should be greater than system lag (the time it
takes for the controller output to have a measurable effect on the system). Also consider other PIDs and tasks
on the 1/0 unit competing for processing power.

N—Gain. Enter a positive or negative value for Gain. Heating systems usually require a negative value and
cooling systems a positive value. NOTE: Gain is usually refined during the tuning process.

O—Fd Fwd Initial and Fd Fwd Gain. (Optional) Enter Feed Forward Initial and Feed Forward Gain values
if you need to offset the controller output in your application. These values are constants that are multiplied
and added to the controller output; often they are not used in PIDs.

P—Tune I, Tune D. (Optional) Enter Integral and Derivative settings if you know the desirable settings.
However, Integral and Derivative are not essential to basic configuration and are better determined in the
tuning process.

5. Click OK.
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The new PID appears in the list.

| Configure PID Loops E\@
10 Unit; |F'repmcess ﬂ Type: |SN.-’-\F'-F'.-’-\C-FH [analm
# Mame | Input | Setp.. | Output | Mode | Enable | Ref.. | Descr =
oo Ower.. Owe.. Host Fuel. Auo.. Ena. 0O |
j| Mat ...

02 Mat ...

03 Mat ...

04 Mat ...

05 Mat ...

06 Mat ...

07 Mat ... -
1| mn 3

Cloze Help

6. When you have finished configuring PIDs, click Close.

PIDs appear in the configuration tree under the I/0 unit.

MainProcess*

=-IC) MainProcess

-3 170 Units
E-) Points

L. Pump_1_Status
A Flowmeter_A
=4 Oven_A_Temp

(=[O =)

24 Fuel_Pump
PIDs

[ |
FID

SENDING CONFIGURATION DATATO THE I/0 UNIT

Oven_A_Control]i_ PID loops

68

After you have configured 1/0 units and set up optional functions such as security, email, and SNMP from
Chapter 3, you must load the configuration file onto the I/0 unit.

You can load the configuration file into RAM only, or you can save it to flash memory at the same time. If you
don't save to flash, the configuration is lost if the I/O unit is turned off. When you save to flash, the new
configuration overwrites any configuration already in the flash memory. Note that for some functions, you
must save to flash and restart the I/0 unit for the configuration to take effect.

1. With the configuration file open, click Tools > Send Configuration to I/0 Unit.
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The Send Configuration dialog box appears.

| Send Configuration to Opto 22 Device @
Marne | D escription | Part | Address List | Send |
3 10.192.54.110
Clear Flash
Close
Help
[v Save to Flash Timeout [meec]:
[~ Restart Device 10000

The list on the left shows all the I/0 units in this configuration file. (In the case of an SB I/O unit, there is
only one.) When you click a unit, the Address List shows the serial address or IP addresses for all I/O units
associated with the highlighted unit. This is the address list you set up in the Add I/0 Unit dialog box,
shown on page 32.

2. Highlight the I/0 unit configuration(s) you want to send.
3. Highlight the IP addresses to receive the I/O unit configuration.
If you don't highlight any addresses, the configuration will be sent to the entire list.

NOTE: If you highlighted more than one unit configuration, each unit configuration will automatically be sent
to all the IP addresses associated with it.

4. If necessary, change the Timeout field.

The timeout field shows how long, in milliseconds, PAC Manager will try to communicate with the I/0
unit before returning a timeout error.

5. To save the configuration file to flash memory as well as to RAM, check Save to Flash. (If you don't save to
flash, the configuration is lost if the I/0 unit is turned off) To also restart the unit, check Restart Device.

IMPORTANT: For the following configurations, you must save to flash and restart the unit in order for
configuration to take effect:

Changes in TCP port for serial modules SNMP configuration
Email configuration PPP configuration
Data logging interval

6. Click Send.
The configuration data is sent to the I/O units whose IP addresses you chose.

Using PAC Manager to Clear Flash Memory

You can also use PAC Manager to clear configuration data from flash memory in one or more I/0 units. (This
action does not affect brain or controller firmware, strategy files, or files from the I/0 unit’s file system that may
be stored to flash.)

1. With the configuration file open, click Tools > Send Configuration to I/0 Unit.
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2. Inthe Send Configuration dialog box, highlight the I/0 unit configuration and addresses for the I/O units
you want to clear.

3. Click Clear Flash.
Configuration data in flash memory is cleared.

USING I/0 POINT FEATURES

The I/0 point features available on I/0 units depend on the combined capabilities of the I/O processor (brain
or on-the-rack controller), the module, and in some cases, the protocol used. See page 9 to determine which
features are available for the processor you are using. Note that some features (such as pulsing and totalizing)
can be configured in PAC Manager but are currently available for use only through PAC Control. For details, see
the PAC Control User's Guide (form 1700).
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The following table defines the features. Some have referenced pages for more information.

Feature

States

Latches

Counters

Quadrature
counters

Frequency
measurement

Period
measurement

Time-propor-
tional output
(TPO)

Pulse
duration
measurement

Pulse and
square wave
generation

PAC Manager User's Guide

Description

(digital input and output)—A digital point is either on or off. You can read the cur-

rent state of a digital input or write an on/off state to a digital output.

(digital input)—When the value of a digital input point changes from off to on, an
on-latch is automatically set. While the value of the point may return to off, the
on-latch remains set, as a record of the change, until you clear it. Similarly, an
off-latch is set when the value of a digital point changes from on to off, and it
remains set until cleared.

(digital input)—A counter keeps track of the number of times a digital input
changes from off to on. The count accumulates until it reaches the maximum
count available in the I/O unit or until you reset the counter to zero. For example,
to count the number of widgets produced per shift, you would clear the counter
at the start of each shift and read it at the end of each shift.

For points on a 4-channel module, the speed of the counter depends upon the
brain or controller’'s capabilities and the speed of the module used. For points on
a high-density module, counting is done in the module.

(digital input)}—A quadrature counter requires a SNAP quadrature input module,
which is attached to the encoder device. The module sends a pulse to the I/O
unit upon each change in quadrature state, and the 1/0 unit counts the pulses
and keeps track of the direction and rotation.

(digital input)—Frequency is the speed with which a digital point changes state
and is usually measured in counts per second. For example, reading the fre-
quency can help you determine the speed of rotating machinery.

(digital input)—Period refers to the elapsed time for a complete on-off-on transi-
tion on a digital point. Measurement starts on the first transition (either off-to-on
or on-to-off) and stops on the next transition of the same type.

(digital output)—Time-proportional output varies the duty cycle and the percent-
age of on time within that cycle. TPO is often combined with a PID loop and
used to control the output, for example in a heater or oven.

(digital input)—A pulse is a brief on (or off) state, usually repeated at a specific
interval. The brain can measure the first pulse, that is, the amount of time the
input stays on (or stays off).

(digital output)—A pulse turns a digital output on (or off) briefly, either once or for
a specified number of times at a specified interval. A digital square wave is a
specific pattern of on and off states, repeated continuously.

page 72

page 72

page 72

page 72

N/A
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Feature Description See

(digital and analog input)—For a digital input, a totalizer accumulates the total

amount of time that a digital input is on (or off). The on-time totalizer shows how

long the point has been on; the off-time totalizer shows how long the point has
Totalization  been off. Totalizers are often used to determine maintenance or use schedules. *

For an analog input, a totalizer accumulates readings by sampling the input

point at set intervals and storing the total value, for example to determine total

flow based on a varying flow rate signal.

(digital and analog points)—A watchdog monitors communication on the
OptoMMP port (port 2001, unless you have changed it). If nothing accesses the
port for the length of time set in the watchdog, the I/O unit automatically sets
designated digital and analog I/O points to the values you have determined.

A watchdog helps make sure that a communication failure doesn’t result in
disaster. If communication fails between the host and the 1/0 unit controlling a
process, the watchdog makes sure the process is automatically brought to a
safe state. For example, a valve could automatically close to avoid completely
emptying a tank.

IMPORTANT: A strategy running on a SNAP PAC R-series controller accesses
the points on its own rack directly, not through the OptoMMP port. Conse-
quently, reads and writes to the local I/O are not seen by the watchdog.

Watchdog page 73

(analog input and output)—Analog input and output points can be scaled as
Scaling needed. For example, you can scale a -5 V to +5 V input point to reflect 0% to page 73
100%

(analog input)—Minimum and maximum values are sometimes called peaks
Minimum and and valleys. You can read these values at any time, for example, to record mini-
maximum mum and maximum temperatures. You can also reset min/max values. For page 74
values example, if you want to record the maximum temperature at point 2 in each
24-hour period, you must reset the values after they are read each day.

(analog input)}—The I/O unit automatically converts the thermocouple junction's
Thermocouple millivolt values into temperature values, so you don’t have to. Choose the
linearization appropriate module and make sure you configure the point as the correct ther-
mocouple type (E, K, etc.) for your purpose.

(analog input)—Offset and gain calculations are used to calibrate analog points.
If a -50 mV to +50 mV input receives signals that are slightly off (for example,
not exactly -50 mV at the lowest point), the offset and gain can be

calculated so that values will appear accurately when read.

Offset and gain page 74

(analog output)—Clamping limits values that can be sent to analog output points
so they do not go above or below a specific value. For example, if you are using
Clamping a 0-10 VDC output module, but the device attached to one of its points can han-  page 74
dle a maximum of only 5 VDC, you can set an upper clamp of 5 VDC for that
point. The values for upper and lower clamp are set in engineering units.

(analog output)—Some devices attached to analog outputs should not be
abruptly stepped up or down, because a sudden change might damage the .

Ramping equipment or cause other problems. Instead, you can gradually ramp the device
up or down to the desired value.
(analog points)—Proportional integral derivative (PID) loops are used to drive
PID loop an input toward a particular value (the setpoint) and keep the input very close to a0e 63
control that value by controlling an output. PID loops are often used in temperature con- pag
trol.
Average filter (analog inputs)—A filter weight smooths analog input signals that are erratic or page 74

weight change suddenly.

* Requires PAC Control and a SNAP PAC controller for use. For details, see the PAC Control User's Guide
(form 1700).

Some 1/0 point features are discussed in the following sections.
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States (Digital Points)

You can read the ON or OFF state of a digital input point or write to a digital output point to turn it on or off.
This feature is automatic and needs no configuration.

Latches (Digital Points)

Latching is available on both 4-channel and high-density digital points. It is automatic and needs no
configuration. Using memory map values, you can read the on-latch or off-latch state of a digital point, and
you can clear latches.

Counters (Digital Points)

Any SNAP digital input can be used as a counter. Note the differences in counting between 4-channel and
high-density digital modules:

SNAP 4-channel digital counters SNAP high-density digital counters

SNAP-PAC-R1 (-B, -FM, -W)
SNAP-PAC-R2 (-FM, -W)
SNAP-PAC-EB1 (-FM, -W)
SNAP-PAC-EB2 (-FM, -W)
SNAP-PAC-SB1
SNAP-PAC-SB2

SNAP-PAC-R1 (-B, -FM, -W)
Processor compatibility SNAP-PAC-EB1 (-FM, -W)
SNAP-PAC-SB1

Counting is done on...  ...the brain ...the module

High speed (depends on speed of mod-

ule; modules available up to 20 KHz) Low speed (up to 50 Hz)

Counting speed

« Each point to be used as a counter » Configure points only if using PAC

must be configured. Control.
» Counters start as soon as configured. < Counters are always counting.
Configuration and Use - Counters can be Started, Stopped, » Counters can be Read or Read &
Read, and Read & Cleared. Cleared.
» Counters cannot be Started or
Stopped.

G4EB2—Any digital input can be used as a counter. Counters must be configured. They start as soon as they
are configured and can be Started, Stopped, Read, and Read & Cleared.

Use PAC Control digital point commands to work with counters.

Quadrature Counters (Digital Inputs)

/0 units with the following I/0O processors support quadrature counters for quadrature encoder devices:
«  SNAP-PAC-RT

«  SNAP-PAC-R1-B

«  SNAP-PAC-EB1

+  SNAP-PAC-SBI1

A quadrature counter requires a SNAP quadrature input module (SNAP-IDC5Q), which is attached to the
encoder device. The module sends a pulse to the processor upon each change in quadrature state, and the
processor counts the pulses and keeps track of the direction and rotation. For each axis, the counter counts up
if Phase A leads Phase B; it counts down if Phase A lags behind Phase B. Each axis can have counts from 0 to
2,147,483,647.
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If your encoder device has an index feature, you can use two separate digital input points as indexes, one for
each axis. The index automatically resets the count, and it shows what the count was when the index was
triggered. Counts are sometimes lost, due to noise or encoder problems, for example; with the index, you can
see whether the count varies too much.

Watchdog (Digital and Analog Points)

To configure a watchdog, set the watchdog when configuring the //O unit. Then when you configure a digital
or analog output point, you can choose the status or value the point should be set to if the watchdog timer
expires.

About E1and E2 brain boards: You can configure E1s and E2s like any other /O unit if you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),
see /O Configuration for E1 an E2 Brain Boards (form 1576).

Scaling (Analog Points)

You can scale analog input or output points to match your needs. For example, you can scale a
-5V to +5 Vinput point to reflect 0% to 100%. Point types may be unipolar or bipolar.

Examples of Unipolar Points
4-20 mA analog output
0-10 A RMS analog input

Examples of Bipolar Points
-25mVto +25 mV analog input
-10to +10VDC analog output

Unipolar and bipolar points are scaled in the same way, with the lowest reading reflecting the low scale and
the highest reading reflecting the high scale. Here are two examples:

Unipolar Input Point Bipolar Input Point
Low scale High scale Low scale High scale
Actual reading 0 mA 20 mA -5V ov +5V
Scaled for percentage 0% 100% 0% 50% 100%
Scaled for counts* 0 +25,000 -25,000 0 +25,000

*Counts for input points always range -25,000 to +25,000.

Unipolar Output Point Bipolar Output Point
Low scale High scale Low scale High scale
Actual reading 4 mA 20 mA -10 VDC 0VvDC +10 VDC
Scaled for percentage 0% 100% 0% 50% 100%
Scaled for counts* 0 4,095 0 2,047.5 4,095

*Counts for output points always range 0—4,095.
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NOTE: With PAC firmware version 8.1 and higher, you can also use inverted scaling. For example:

OmA 20mA
742 fom -27 fpm

Minimum and Maximum Values (Analog Points)

Starting with the introduction of SNAP-B3000-ENET, all SNAP PAC brains (including SBs), SNAP Ethernet 1/0
units, and E2 brain boards automatically keep track of minimum and maximum values on analog points. You
can read and clear these values using PAC Manager's Inspect mode.

Offset and Gain (Analog Points)

Starting with the introduction of SNAP-B3000-ENET, all SNAP PAC brains (including SBs), SNAP Ethernet I/0 units,
and E2 brain boards can automatically calculate offset and gain for analog input points. If a -50 mV to +50 mV
input receives signals that are slightly off (for example, not exactly -50 mV at the lowest point), the offset and gain
can be calculated so that values appear accurately when read.

Offset and gain values affect engineering units (EU). For a temperature input, engineering units are in degrees
Cor F, depending on how the I/0 unit is configured.

IMPORTANT: To calibrate the point, the I/0 unit must be turned on and attached to the network, and you must
have access to the l/O unitin order to use the calibrator. For points on a SNAP PAC SB-series brain, connect directly via
serial or through the controller via Ethernet. (See page 26 for details.)

Save the configuration to flash so that it is not lost when power is turned off. Since each calibration is for a specific
pointon a specific I/O unit, the result cannot be saved to the configuration file and cannot be sent to any other I/0
unit.

First, calculate offset, and then calculate gain. The offset must be calculated at the signal corresponding to
zero engineering units (EU), and the gain must be calculated at the signal corresponding to the point’s
maximum input range value (or, for inverted scaling, the point's minimum input range value—in inverted
scaling, the lower scaled value is greater than the upper scaled value).

For details, see “Calibrating Offset and Gain Using the Default Method” on page 174.
If you don't have access to a calibrator, or if the point uses inverted scaling and your device has PAC firmware
R9.5b or lower, see “Calculating Offset and Gain Using the Two-Point Method”on page 176.

If you are using Modbus/TCP, you will need to calculate the offset and gain yourself. Then you can write offset
and gain values to the I/0 unit. For details, see page 44Calibrating Offset and Gain.

Clamping (Analog Points)

SNAP 1/0 units with analog capability and SNAP PAC SB brains can clamp values sent to analog output points
so they do not go above or below a specific limit. For example, if you are using a 0-10 VDC output module,
but the device attached to one of its points can handle a maximum of only 5VDC, you can set an upper clamp
of 5VDC for that point. The values for upper and lower clamp are set in engineering units. (See “Configuring
1/0 Modules, Points, and Features”on page 157.)

Average Filter Weight (Analog Points)

SNAP PAC I/0 units and SNAP PAC SB brains can use a filter weight to smooth analog input signals that are
erratic or change suddenly. The formula used for filtering is Y = (X - Y )/W +Y, where Y is the filtered value, X is
the new unfiltered value, and W is the filter weight.
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This graph shows the effect of filter weights (W) 2, 5, and 10 on a step input signal:

Y = (X-Y)/IW+Y
Filter Response for Different values of 'W'

As this graph shows, the
larger the filter weight (W)
you use, the smoother the
analog signal.

Afilter weight of zero turns off the calculation. Values less than or equal to 0.5 are changed to zero, since those
values would cause an unstable signal.

Filtering is applied to values that are in engineering units, including minimum and maximum values. Filtering
does not apply to values that are in counts. Set filter weight when configuring the analog point. Use the PAC
Manager Inspect window to set filter weight (see “Configuring I/O Modules, Points, and Features”on

page 157). If you are using PAC Control, you can also set filter weight in your control strategy using the
command Set Analog Filter Weight.
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3: Configuring Optional
Functions

INTRODUCTION

Chapter 2 showed you how to configure I/0 unit points and features. This chapter includes instructions for
setting up the following optional functions:

Setting up network security (wired network) page 78
Logging data page 87
Sending event messages via email, SNMP, a stream packet, or a serial module page 92
Using SNMP for communicating with enterprise management systems page 96
Configuring DNS Servers page 99
Sending email page 100
Using the Scratch Pad area for peer-to-peer data sharing page 102
Streaming data page 104
Mirroring I/0 point data page 107
Copying memory map data page 109
Configuring Modbus options page 112
Setting system date and time page 116
Communicating serially with devices attached directly to a controller page 118
Using PPP for communicating via modem with the device page 123

In most cases, you use the same configuration file in PAC Manager to set up optional functions as you did to
configure I/0 units, so the complete configuration information can be uploaded to I/0 units all at once.
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SETTING UP NETWORK SECURITY (WIRED NETWORK)

78

For network security on a wireless LAN, see “Configuring Wireless LAN Communication (Wired-+Wireless
Models Only)”on page 22.

You can use PAC Manager to set up security on a wired network for an Opto 22 SNAP PAC Ethernet-based
device. You can limit access to specific computers or other devices on the network. You can also limit access to
specific protocols used with the Opto 22 device, such as SNMP (below). You can require a password for using
FTP (see page 79). In addition, you can protect a PAC Control strategy so that it runs without possibility of
interference from a host (page 81).

Limiting Access to Specific Computers

You can limit access to the controller or I/0 unit based on the IP address of the computer or other host device
attempting to communicate with it. You specify the IP addresses that may access the controller or I/0 unit.
Anyone on a computer or other host device with an acceptable IP address has access.

Work with your network administrator to make sure you are specifying the correct IP addresses. See
“Configuring Ethernet Security on an /0 Unit"on page 82 or “Configuring Ethernet Security on a Standalone
Controller”on page 85 for instructions.

Limiting Access to Specific Protocols

You can also limit access to specific protocols the controller or I/0 unit uses. These protocols can travel
simultaneously over the Ethernet/TCP/IP link and set up sessions, or ports, on the device:

«  File transfer protocol (FTP), used for exchanging files between the device and a computer (applies to
SNAP PAC R-series, S-series, and SoftPAC only)

«  Modbus/TCP protocol, used by Modbus/TCP software and hardware

«  OptoMMP, the IEEE 1394-based memory map protocol, used by most other tools for interfacing with the
SNAP device

«  Simple network management protocol (SNMP), used to communicate with SNMP-based enterprise
management software

For security purposes, you can hide or disable one or more of the protocols by changing the port number
from its default. The following table shows these default ports.

NOTE: If you change any port number, you must restart the device before the changes will take effect.

Protocols for Default Ports:

Protocol Used by Default Port
FTP PCs for file exchange 21
SNMP enterprise management system 161
Modbus/TCP Modbus/TCP software and hardware 502
OptoMMP PAC Manager and most other tools 2001

Preventing Access. For example, suppose you want to prevent any device from accessing a controller using
FTP.To do so, you would change the port number for the FTP protocol from the default of 21 to zero. Since
zero is an invalid port, no device could access the controller using FTP.

Limiting Access. If you wanted to limit FTP access, you could change the port number from 21 to a
non-reserved number between 1 and 65,535 (see list of reserved port numbers, below). If you change the
number, anyone (or any application) that needs to access the controller using FTP can do so by adding the
changed port number to the controller’s IP address. For example, if the controller's IP address is 10.22.56.3 and
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the port number is changed to 85, you would enter the following to access the controller:
10.22.56.3:85

Reserved Port Numbers

If you change port numbers, do not use any number in the following list. These numbers are reserved for
Opto 22 firmware:

Port Used by Port Used by
20 FTP 2222 EtherNet/IP (UDP for 1/O)
21 FTP 22000 Reserved
25 SMTP 22001 PAC Control/ioControl Host
67 BootP Server 22002 PAC Control Background Downloading
68 BootP Client 22003 Reserved
161 SNMP 22004 PAC Control User Chart
162 SNMP Traps 22005 PAC Control User Chart
502 Modbus/TCP 22500-22531 | Serial Communication Modules
2001 OptoMMP Host 23567 PAC Controller Redundancy
2002 OptoControl Peer 44818 EtherNet/IP (TCP & UDP Explicit messages)
2003 OptoControl Peer 50000-50999 | PAC controller internal use

For more information, see “Configuring Ethernet Security on an /0 Unit”on page 82 or “Configuring Ethernet
Security on a Standalone Controller”on page 85.

Configuring the PAC as an HTTP/HTTPS Server

In addition to working as a client (for example, to send email) SNAP PAC R-series or S-series controllers with
PAC firmware R9.5a or higher include a built-in HTTP/HTTPS server and a REST API. The PAC listens for HTTP
and HTTPS requests, and then sends 1/0 point or strategy variable data to the client that requested it. The
complete SNAP PAC REST APl and instructions to get started are on developer.opto22.com.

To prevent unauthorized access, the HTTP/HTTPS server feature in PAC R-series or S-series controllers is
disabled by default. To configure the server in your controller, you enable either HTTPS or HTTP protocol on
the controller and configure a listening port for TCP communication.

IMPORTANT: Opto 22 strongly recommends using HTTPS for secure, encrypted access to your controller.
Use HTTP for testing purposes only.

In PAC Manager, click Tools > Inspect, or click the Inspect button @

2. Inthe Inspect Opto 22 Device window, enter the IP address for the R- or S-series controller you want to
configure, or select it from the list.

3. (lickthe Communications button, and then choose Network Security from the pop-up menu.
In the WEB SERVER section:
a. (Change the default value of TCP Listen Port (address OxFFFF FO3A 0014).
Typically, port 443 is used for HTTPS, and port 80 is used for HTTP.
b. Verify the value of HTTPS (address OxFFFF FO3A 007C).
—  For HTTPS, the value should be Enabled.
—  For HTTP, change the value to Disabled.
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C.

Click Apply to save the changes.

=] Inspect Opto 22 Device

Device Name: IOpho 22 Controller

LI Options >I

Status: I Metwork Security area last rea

—Metwork Security
Status Read i

Status Write |
Wireless LAN  » |

Point Config |
Digital Bank |

Address I Description I Value
0xFFFF FO3A 0004 OptoMMP 2001
0xFFFF FO3A 0003 Modbus 502
0xFFFF FO3A 000C SNMP 161
0xFFFF FO3A 0010 FTP 21

R E R B iy B 25

WEB SERVER
0xFFFF FO3A 0014 TCP Listen Port 443
(xFFFF FO3A 007C HTTPS Enabled
Tr=ESEH

Digital Point |

Mt gt o

5. Toimmediately enable the HTTP/HTTPS server feature, reboot the controller so that the changes take

effect.

=] Inspect Opto 22 Device

Device Name: IOpho 22 Controller

LI Options ¥ I Status: IRestart Device from poy

0xFFFF FO38 0054

Analog Point |

High Density I Operation

—Status Write

Status Read I

Status Write I Address I Description |
OxFFFF FO38 0004  Always BootP/DHCP On Powerup i

Z OxFFFF FO38 0008 Degrees F/C

WirelessLAN ¥ | 0xFFFF FO38 0010  Comm Watchdog Time (msec), 0 = Disable 8

0xFFFF F038 0014 TCP Minimum Retransmission Timeout {msec)

Point Config | OxFFFF FO38 0018 TCP Initial Retransmission Timeout {msec)
0xFFFF FO33 001C  TCP Retransmission Attempts

Digital Bank | 0xFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable

= 3 OxFFFF F0O38 0294 Digital Feature Scan Interval (msec)

Digital Paint | 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec)

Analog Bank | OxFFFF FO38 0298 Out Of Range Value (16-Bit)
0xFFFF FO38 02B0  Out Of Range Value (32-Bit)

Scanner Flaas

f( Restart Device from powerup
3
o 'I Store configuration to flash
A, H, f A

~ Send Command I

o

ScratchPad  » |

Data Log >l
L e

Reset to defaults
microSD

&anfigurati

and Restart Device

d IP ings to mi

Send Command

Once you've configured the PAC as a server, the next step is to use a browser (for example, Google Chrome™ or
Microsoft Internet Explorer®) to access the PAC and set up the administrator password and APl accounts. After
that, authorized users can use the SNAP PAC REST API to access data in the controller. For details, see

developer.opto22.com.

Requiring a Password for FTP

You can configure security so that anyone who wants to access the device using FTP is required to enter a
username and password. If you are using the Opto iPAC app for iPhone, iPod Touch, or iPad, we strongly

recommend you require a password

See “Configuring Ethernet Security on an 1/0 Unit"on page 82 or “Configuring Ethernet Security on a
Standalone Controller” on page 85 for instructions.
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Protecting a PAC Control Strategy from Interference

You can set up a standalone or on-the-rack controller to run a stable strategy without the possibility of
interference from a host. This means that no one can alter or stop the strategy using PAC Control or PAC
Terminal; but it also means that PAC Display cannot communicate with the control engine.

To protect a PAC Control strategy from interference, finalize the strategy, download it, save it to flash memory,
and then set the autorun flag. (For the steps, see the PAC Control User’s Guide, form 1700.)

Then, follow the steps in the next section to change the Control Engine port number from the default of
22001 to zero, and save that setting to flash as well. The strategy will automatically run when power is turned
on, but a host cannot communicate with it.

If you need to change the Control Engine port number back to 22001, you can do so in PAC Manager, because
PAC Manager uses the OptoMMP protocol to communicate with the controller.

Turning Off EtherNet/IP

If you are not using the EtherNet/IP protocol on a SNAP PAC device, you can turn the protocol off. Note that
you must restart the device after this change.

Since this procedure sends the configuration directly to the device, the device must be on the same network
as your computer.

1. Inthe PAC Manager main window, click the Inspect button Q A

=

Device Name: | 10.199.99.99 j Options » Status: | Status Read area last read at 07/05/16 10:34:58

Status Read
Status Read
Status Write ADDRESS DESCRIPFTION VLLUE s Refresh |

T D 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed FOC Beceiwved (0}
0xFFFF FO30 0008  Busy Flag 0
Point Config OxFFFF FO30 0018 Loader Version B5.1lc |
. 0xFFFF FO30 0000 Memory Map Version 1
Digital Bank 0xFFFF FO30 0230 Current Boot Device Flash Memory |
Digital Point OxFFFF FO30 001C Firmware Version L9.5a
0xFFFF FO30 00RO Firmware Version Date 05/03/2016

Analog Bank 0xFFEFF FO30 00BO Firmware Version Time 1529232
Analog Point 0xFFFF FO30 0020 Unit Type 0x00000074

High Density 0xFFFF FO30 0080 Unit Description SNAP-ELRC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
OxFFFF FO30 0025 I/0 Unit Hardware Revision (Day) 21
System  * 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
SaatchPad  » OxFFFF FO30 024C I1/0 Coprocessor Firmware Version 40.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 4
ETHERNET 1 Interface

PID 4 0xFFFF FO30 002E MAC Bddress 00-A0-30-01-85-5C

= N OxFFFF FO30 0034 IF Address 10.192.55.47

2. Inthe Device Name field, type the name or IP address of the controller (or choose it from the drop-down
list).
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3. (lick Communications and choose Network Security from the submenu. Scroll down till you see

ETHERNET/IP.
| Inspect Opto 22 Device - x
Device Name: ‘ 10.192.55.67 j Options ¥ Status: | Network Security area last read at 07/05/16 10:42:09

Metwork Security
Status Read

Status Write Address | Description ‘ Value ‘ ~ Refresh |
0xFFFF FO3D 0000 FTP Username
T D OxFFFF FO3D 0040  FTP Password Apply
BROADCAST FILTER
OxFFFF FO3A 0070 Stop incoming broadcasts Mo Ea|
Point Config IP FILTERS
0xFFFF FO3A 0020 Filter 0 - Address 0.0.0.0
Digital Bank OxFFFF FO3A 0024 Filter 0 - Mask 0.0.0.0
. . 0xFFFF FO3A 0023 Filter 1 - Address 0.0.0.0
Digital Point OxFFFF FO34 002C  Filter 1-Mask 0.0.0.0
Analog Bank 0xFFFF FO3A 0030 Filter 2 - Address 0.0.0.0
OxFFFF FO3A 0034 Filter 2 - Mask 0.0.0.0
Analog Point OxFFFF FO3A 0038 Filter 3 - Address 0.0.0.0
OxFFFF FO3A 003C Filter 3 - Mask 0.0.0.0
High Density OXFFFF FO3A 0040 Filter 4- Address 0.0.0.0
0xFFFF FO3A 0044 Filter 4 - Mask 0.0.0.0
System N 0xFFFF FO3A 0048 Filter 5 - Address 0.0.0.0
0xFFFF FO3A 004C Filter 5 - Mask 0.0.0.0
ScratchPad  * 0xFFFF FO3A 0050 Filter & - Address 0.0.0.0
OxFFFF FO3A 0054 Filter & - Mask 0.0.0.0
Datalog * OxFFFF FO3A 0058 Filter 7 - Address 0.0.0.0
OxFFFF FO3A 005C Filter 7 - Mask 0.0.0.0 %
PID 3 OxFFFF FO3A 0060 Filter 8 - Address 0.0.0.0
OxFFFF FO3A 0064 Filter 8 - Mask 0.0.0.0
Events L4 0xFFFF FO3A 0068 Filter 9 - Address 0.0.0.0
0xFFFF FO3A 006C Filter 9 - Mask 0.0.0.0
Communications # ETHERNET/IP
T 5 OxFFFF FO3A 0078 EtherMet/IF Protocal Enabled k3|

Close | Help | I" AutoRefresh | 15000  msec

4. Inthe Value column, click the down arrow and choose Disabled.
To enable EtherNet/IP again, choose Enabled.

5. Click Apply to send the configuration change to the device.

Click Status Write. In the Operations Commands section, highlight Store configuration to flash. Click Send
Command.

7. Inthe same section, highlight Restart Device from powerup. Click Send Command.
The change is stored to flash memory and the device restarts.

Configuring Ethernet Security on an 1/0 Unit

Use these steps for an Ethernet-based I/0 unit on a wired network. For security on a wireless LAN, see page 22.
For a SNAP PAC S-series standalone controller, use the steps on page 85.

1. In PAC Manager, click the Open button g (orin the menu bar, click File > Open).
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In the Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

ﬂ PAC Manager - Main_Process
File Edit Tocols Wiew Help

| Dl *|%a @

-1 Main_Process

=M /0 Units
-2 Line_1

-2 Preprocess

[ N4

Ready
In the configuration tree, right-click the name of the I/0 unit on which you want to set up security and

3.
choose Configure from the pop-up menu.

*

Name | Type | Part | Address | watchdog | Description Add... |
Li SNAP-PAC... Ethernet 10.192.55... Disabled
10.192.55... Disabled Madify... |

= Configure /0 Units

ine_1
SNAP-PAC... Ethernet

Preprocess

Events 4 |
ScratchPad |
Communications H—— Communications
s D | button

Close I Help
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4. C(lick the Communications button and choose Network Security from the pop-up menu.

#=# Configure Network Security d
[ Used

Address | Description Value ~
PORTS

OxFFFF FO3A 0004 OptoMMP 2001

OxFFFF FO3A 0008 Modbus 502

OxFFFF FO3A 000C  SNMP 161

OxFFFF FO34 0010 FTP 21

OxFFFF FO3A 0074  Control Engine 22001
WEB SERVER

0xFFFF FO3A 0014 TCP Listen Port a

OxFFFF FO3ADO7C  HTTPS Enabled =l
FTP LOGIN

OxFFFF FO30D 0000 FTP Username

OxFFFF FO3D 0040 FTP Password
BROADCAST FILTER

0xFFFF FO3A 0070 Stop incoming broadcasts Mo K|
IP FILTERS

0xFFFF FO3A 0020 Filter 0 - Address 0.0.0.0

0xFFFF FO3A 0024 Filter 0 - Mask 0.0.0.0

0xFFFF FO3A 0028 Fiter 1- Address 0.0.0.0

0xFFFF FO3A 002C  Filter 1-Mask 0.0.0.0

0xFFFF FO3A 0030 Filter 2 - Address 0.0.0.0

0xFFFF FO3A 0034 Filter 2 - Mask 0.0.0.0

0xFFFF FO3A 0038 Filter 3 - Address 0.0.0.0

0xFFFF FO3A 003C  Filter 3 - Mask 0.0.0.0

0xFFFF FO3A 0040 Filter 4 - Address 0.0.0.0

0xFFFF FO3A 0044 Filter 4 - Mask 0.0.0.0

0xFFFF FO3A 0048 Filter 5 - Address 0.0.0.0

0xFFFF FO3A 004C  Filter 5 - Mask 0.0.0.0

0xFFFF FO3A 0050 Filter 6 - Address 0.0.0.0

0xFFFF FO3A 0054 Filter 6 - Mask 0.0.0.0 v

oK | Cancel

5. Ifthereis no check markin the Used box, click the box to place a check mark there.
6. To limit access to a specific protocol, change the Port number in the Value column.

CAUTION: Ifyou change the Control Engine port to zero, a strategy that is alreadly in the control engine will
still run, but PAC Display, PAC Control, and other hosts will not be able to communicate with it. See “Protecting
a PAC Control Strategy from Interference” on page 81.

7. To use the built-in HTTP/HTTPS server on a SNAP PAC R-series or S-series controller, see “Configuring the
PAC as an HTTP/HTTPS Server”on page 79.

8. Tosetupan FTP login, enter the Username and Password to be required from anyone who uses FTP to
access the device.

9. To limit access to specific computers, set up to ten filter addresses and filter masks.
The filter address is the IP address that is allowed to access the I/0 unit; the filter mask indicates a range of
allowed addresses. If only one IP address may access the I/0 unit, enter 255.255.255.255 for the filter
mask. If a range of IP addresses may access the I/0 unit, enter a mask that reflects the subnet range.
For example, if only IP address 1.2.3.4 may access the I/O unit, enter 1.2.3.4. as the filter address and
255.255.255.255 as the filter mask. If any IP address that starts with 1.2.3 may access the I/0 unit, enter
1.2.3.4 (or 1.2.3.1, or any address in the range) as the filter address and 255.255.255.0 as the filter mask.

NOTE: For troubleshooting purposes, you can use the Broadcast Filter value to temporarily turn off incoming
broadcasts to the I/0 unit. Normally you would NOT want to do this; a BootP response, for example, is an
incoming broadcast.
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10. When you have finished configuring security, click OK.
11. Configure other optional functions, or return to the PAC Manager main window and click the Save button
ﬂ to save the configuration file.

IMPORTANT: If you changed a port number, you must restart the device when you send the configuration to the
/0 unit. Otherwise the port change will not take effect.

When you are ready to upload the configuration file to the I/0 unit, see “Sending Configuration Data to the |/0
Unit"on page 68.

Configuring Ethernet Security on a Standalone Controller

These steps are for a wired network. For security on a wireless LAN, see page 22.

Since this procedure sends the configuration directly to the controller, the controller must be on the same
network as your computer.

NOTE: Ifyou change a port number, you must restart the device in order for the port change to take effect.

1. Inthe PAC Manager main window, click the Inspect button Q .
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

=

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58

Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh | |

) 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}

WirelessLAN ¥ OxFFFF F030 0008 Buay Flag 0 |
Paint Config 0xFFFF F030 0018 Loader Version R5.1lc |
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1 |

0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3

ETHERENET 1 Interface

PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
. , OXFFFF FO30 0034 IP Address 10.192.55.67

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons

and Most Recently Used list

are displayed when you have
six or more devices configured.

Wpto 22 Device

Device Name{ | afslslTel gl =g

|_ |[EngineRm i
| Cail Portable

| |SofPAC CRIPTION

e lerup Clea
Wireless LAN | Boler =

—— I Chamber 1 s
. Chamber 2 J
Point Config g portable der Versid
= Cookie Controller ory Map Vi
Digital Ban? EngineRm SRy
Di SoftPAC Imware Ver

igital Point = 1
0xFFFF F030 00BO Firmware Very

2. Inthe Device Name field, type the name or IP address of the controller (or choose it from the drop-down

list).

3. Click Communications and choose Network Security from the submenu.

=¥ Inspect Opto 22 Device

Device Name: | 10.192.55.67

Network Security
Status Read

j Options

- X

Status: | MNetwark Security area last read at 07/05/16 11:11:21

Status Write Bk s

. 0xFFFF FO3A 0004
deEEln D 0xFFFF FO34A 0008
Point Config OxFFFF FO3A 0010
OxFFFF FO3A 0074

Digital Bank
— 0xFFFF FO3D 0000
Digital Paint O%FFFF FO3D 0040
FIE RS OxFFFF FO34 0070
0xFFFF FO34 0020
High Dersity 0xFFFF FO3A 0024
0xFFFF FO34 0028
Ge= T OxFFFF FO3A 002C
OxFFFF FO3A 0030
Feelziza D 0xFFFF FO3A 0034
g OxFFFF FO3A 0038
Datalog  * 0xFFFF FO3A 003C
0xFFFF FO34 0040
PID » 0xFFFF FO3A 0044
Events  » 0xFFFF FO3A 004C
0xFFFF FO34 0050
Communications ¥ OxFFFF FO3A 0054
OXFFFF FO3A 0058
Other 4 0xFFFF FO3A 005C

Close | Help |

| Description ‘ Value ‘ - Refresh |
PORTS
OptoMMP 2001 Apply
Modbus 502
OxFFFF FO3A 000C SNMP 161
FTP 21
Control Engine 22001
FTP LOGIN
FTP Username
FTP Password
BROADCAST FILTER
Stop incoming broadcasts Mo |
IP FILTERS
Filter 0 - Address 0.0.0.0
Filter 0 - Mask 0.0.0.0
Filter 1- Address 0.0.0.0
Filter 1-Mask 0.0.0.0
Filter 2 - Address 0.0.0.0
Filter 2 - Mask 0.0.0.0
Filter 3 - Address 0.0.0.0
Filter 3 - Mask 0.0.0.0
Filter 4 - Address 0.0.0.0
Filter 4 - Mask 0.0.0.0
OxFFFF FO3A 0043 Filter 5 - Address 0.0.0.0
Filter 5 - Mask 0.0.0.0
Filter & - Address 0.0.0.0
Filter 6 - Mask 0.0.0.0
Filter 7 - Address 0.0.0.0
Filter 7 - Mask 0.0.0.0 e

™ AutoRefresh | 15000  msec

4. To limit access to a specific protocol, change the Port number in the Value column.

CAUTION: Ifyou change the Control Engine port to zero, a strategy that is already in the control engine will still
run, but PAC Display, PAC Control, and other hosts will not be able to communicate with it. See “Protecting a PAC

Control Strategy from Interference” on page 81.

5. TosetupanFTP login, enter the Username and Password to be required from anyone who uses FTP to

access the device.
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6. To limit access to specific computers, set up to ten filter addresses and filter masks.

The filter address is the IP address that is allowed to access the controller; the filter mask indicates a range
of allowed addresses. If only one IP address may access the controller, enter 255.255.255.255 for the filter
mask. If a range of IP addresses may access the controller, enter a mask that reflects the subnet range.

For example, if only IP address 1.2.3.4 may access the controller, enter 1.2.3.4. as the filter address and
255.255.255.255 as the filter mask. If any IP address that starts with 1.2.3 may access the controller, enter
1.2.3.4 (or 1.2.3.1, or any address in the range) as the filter address and 255.255.255.0 as the filter mask.

NOTE: For troubleshooting purposes, you can use the Broadcast Filter value to temporarily turn off incoming
broadcasts to the controller. Normally you would NOT want to do this; a BootP response, for example, is an
incoming broadcast.

7. When all the values are correct, click Apply to send the configuration to the controller. If you changed a
port number, also restart the controller:

a. (lick the Status Write button in the upper left.
b. Inthe Operation Command list, highlight Restart Device from powerup.
c. Click Send Command.

The device is restarted and a Success message appears.

LOGGING DATA FROM MEMORY MAP ADDRESSES

You can use a SNAP PAC R-series, EB, or SBI/O unit to log data from up to 64 memory map addresses. The data
from all addresses goes into the same data log file, which you can view from PAC Manager. For Ethernet-based
/0 units, data from this composite file can also be emailed to someone at a time interval you set. For a
complete list of memory map addresses, see the OptoMMP Protocol Guide (form 1465).

NOTE: Ifyou are using SNAP PAC-R with PAC Control, you may prefer to log data in a different way. For more
information about the controller’s file system, see page 217 and the PAC Control User's Guide (form 1700).

Note that SNAP PAC brains cannot save logged data if power to the unit is cycled.

Configuring Data Logging
1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

5] PAC Manager - Main_Process — O X
File Edit Tocols Wiew Help

Dlese| ¥|%al o g5 e
= = e s

-1 Main_Process
&6 [

-2 Line_1

-2 Preprocess

Ready [ N2

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up data logging
and choose Configure from the pop-up menu.

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Events » |
ScratchPad  » |

Communications » Others

__ others—— button
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Click the Others button and choose Data Logging from the pop-up menu.

== Cenfigure Data Logging d

Log Point

Mumber: |0 | [ Used

Since emails
Address | Description | Value | include values
= from all memory
OXFFFFF3000700  E-mail Enabled for all data logging No x| ) mapaddressesset
DxFFFF F300 0704  Number of Datalog entries per E-mail 0 up for data
TRIGGER logging, entries in
OxFFFF F300 0000 Trigger ON Dx 00000000 00000000 this section apply
OxFFFF F300 0008  Trigger OFF Dx 00000000 00000000 Il data loaain
LOGGING tog 99ing
OxFFFF F300 0010 Address of value to log 0x FOADOOOO points.
OxFFFF F300 0014  Data Format Float (0x686) =l
0xFFFF FOAD 0000 Current Value MfA
OxFFFF F300 0018 Logging interval in miliseconds (0 =log once) 5000

oK | Cancel %

Choose the lowest empty Log Point number from the drop-down list and click to put a check mark in the
Used box.

NOTE: To reduce scanning time, the I/O unit stops scanning log points when it reaches an unused data logging
number. Make sure you use these numbers in order, starting with the lowest.

(Not applicable to SB brains) To have the data log emailed, click the Value column cell and enable email.

Also enter the number of data entries in the log you want each email message to contain.

A maximum of 140 log entries can go in each email. Remember that email applies to all points that are

logged, since all the data goes into one file.

In the Value column, click the cell and then enter the Scratch Pad On mask and Off mask to trigger this

data log point. Also enter the memory map address of the data you want to log and choose the format of

data in that address. Finally, enter how often data should be logged for this address, in milliseconds (to

log data just once, enter 0).

When all values are correct, click OK. Repeat from step 5 for additional log points.

Remember to also configure email to indicate where the data log should be sent. See page 100.

Configure other optional functions, or return to the PAC Manager main window and click the Save button
L | tosave the configuration file.

IMPORTANT: If you have changed the data logging interval, you must save the configuration file to flash
memory and restart the /0 unit for the configuration to take effect.

When you are ready to upload the configuration file to the I/O unit, see page 68.

Reading the Data Log

The data log is a single file that records data from all the memory map addresses you have configured to log
data from (see steps starting on page 87). The data from up to 64 memory map addresses can be logged, and
all logged data is recorded in one file. The log file holds up to 300 lines of data; when it is filled, new entries
replace the oldest ones.

This composite log file can be viewed through PAC Manager. (On Ethernet-based /0 units, it can also be
emailed to someone at regular intervals you set.) Each line in the log file consists of the date and time stamp,
the memory map address the data is coming from, the type of data, and the data itself.
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1. Toview logged data, click the Inspect button Q in the PAC Manager main window.
2. Inthe Device Name field, enter the name of the /O unit or choose it from the drop-down list.
Click Data Log and choose Data Logging Samples from the pop-up menu.

25/ Inspect /0 Unit

Device Mame: |SB brain j Options ¥ Status: |0 ata Logging Sample area last read at 10/03/07 16:48:16
R Diata Logging Samples
e # Addresz  YYVY-MM-DD HH:MM:35.hh  Src Addr  Type Data » Refresh |
- - 0 F3020000 2006-10-09 14:31:36.04  FOAOO300  Float 25.412872
Point Config 1 F3020014 2006-10-09 14:31:39.04 FOADO300 Float 28.379028
Digital Bark 2 F3020028 2006-10-09 14:31:40.04  FOAO0300  Float 25.345215
3 F302003C 2006-10-09 14:31:41.04  FOAO0300  Float 28.277527
Digital Paint 4 F3020050 2006-10-09 14:31:42.04  FOAODD300  Float 25.277527
5 F3020064 2006-10-09 14:31:43.05 FOAO0300  Float 28.226748
Analag Bank 6 F3020078 2006-10-09 14:31:44.05 FOA00300 Float 28.209839
7 7 F302008C 2006-10-09 14:31:45.05  FOAO0300  Float 25.192932
Esiog R & F3020040 2006-10-09 14:31:46.05 FOAD0300  Float 28. 159088
High Drensity 9 FIDZO0E4 2006-10-09 14:31:47.05  FOAO0300  Floar 28. 108307
B o 10 F30200CE 2006-10-09 14:31:45.05  FOADO300  Float 25.125244
11 F30200DC 2006-10-09 14:31:49.05  FOAOO300  Float 25.074493
Seratch Pad  » 1z F30200F0 2006-10-09 14:31:50.05  FOAOO300  Floac 28.0575EE
13 F3020104 2006-10-09 14:31:51.05  FOAOO300  Floatc 25.057558
Datalog  » 14 F3020118 2006-10-09 14:31:52.05  FOADO300  Float 28.023712
B R 15 F3020120 2006-10-09 14:31:53.05  FOAOOZ00  Floar Z8.ONGENG
16 F3020140 2006-10-09 14:31:54.05  FOAOOZ00  Float 27.554523
e 17 F3020154 2006-10-09 14:31:55.05  FOAOO300  Floac z7.9z2211
lg F3020168 2006-10-09 14:31:56.05  FOAQO300  Float 25.074493
Communications b 1o F302017C 2006-10-09 14:31:57.05  FOAOOZ00  Float 28.142151
Other i 20 F3020190 2006-10-09 14:31:58.05  FOAQO300  Float 25.209833
21 F3020144 2006-10-09 14:31:59.05  FOAOO300  Float 28.277527
v
Cloze Help

The log includes the following information:

Column Notes

Address of the data item within the data log itself. Data is logged in memory map

Address addresses F3020000-F302175C. Each data item takes 20 bytes.

YYYY-MM-DD Date the data was logged

HH:MM:SS.hh Time the data was logged

Src Addr Memory map address the data came from

Type Format of the data

Data Data from the memory map address. NOTE: -nan means “not a number” and indi-

cates that data is not in the form of an IEEE float.

Clearing All Data from the Log

1. Inthe PAC Manager main window, click the Inspect button Q
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

=

Device Name: | 10.199.59.99

Status Read
Status Read

Status:

j Options »

Status Read area last read at 07/05/16 10:34:58

Status Write
Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density
System 3
ScratchPad  »
Data Log 3

FID 3

—

ADDRESS

DESCRIFTION

VALUE

~ Refresh |

0xFFFF F030
0xFFFF F030

0004
0008

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

0018
00oo
0230
001c
00RO
00BO

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

00z0
0080
0024
0025
00z2é
024C
002g

0xFFFF F030 00ZE
0xFFFF F030 0034

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
29.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

If you have configured six or more devices, the Inspect window provides two additional time-saving

features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons

and Most Recently Used list
are displayed when you have
six or more devices configured.

Wpto 22 Device

Device Name{ | afslslTel gl =g

Cookie Controller
EngineRm

Coil Portable
SoftPAC

Status R

Status Wiits

Boiler
Chamber 1
. Chamber 2
Point Config g portable

Wireless LAN

(CRIFTION

rerup Clea
¥y Flag 1

der Versij

= Cookie Controller ory Map Vi
HD@E' B EngineRm mware Verd
Digital Pc\irxsof-ﬂ)""\C mware Ver:
‘fJxFFFF FO30 00BO Firmware Very

A N, . Py —

i |
|

In the Device Name field, type the name (or IP address) of the I/O unit or choose it from the drop-down

list. Click Status Write.
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@ Inspect Opto 22 Device

Device Name: | 10,192.55.67

Status Write
Status Read

Status Write
Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density
System 3
ScratchPad  »
Data Log 3

PID 3

Events 3

j Options »

Status: | Status Write area last read at 07/05/16 11:15:33

Operation

Store configuration and IP settings to micraSD & send Command
Erase configuration and IP settings from microSC

Erase firmware from micraSD

Erase strategy from microSD
ther

Switch to loader mode

Clear Digital Events - Expanded configuration

Clear Digital Events - Old configuration

Clear Alarm Events configuration

Clear PPP configuration

Clear E-mail configuration |}
Clear PID Loops configuration

Communications ¥ I
————

Other 3

Close |

Clear Data Logging Samples
command

Clear Data Logging samples
Send powerup dear ]

Help |

Address | Description | Value - Refresh |
OxFFFF FO33 0004 Always BootP/DHCP On Powerup Mo =

0xFFFF FO33 0008 Degrees FfC Degrees F =1 Apply
OxFFFF FO38 0010 Comm Watchdog Time {msec), 0 = Disable 1]

OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250

OxFFFF FO33 0018  TCP Initial Retransmission Timeout (msec) 3000

0xFFFF FO38 001C  TCP Retransmission Attempts 5

OxFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000

OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1

OxFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000

OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000

OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147483646.000

OxFFFF FO38 0054  Scanner Flaas Ox 00000000 v

7 Auto Refresh | 15000  msec

3. Inthe Operation Commands list, scroll down and click to highlight Clear Data Logging Samples. Click

Send Command.

The data log is cleared and a Success message appears.

CONFIGURING EVENT MESSAGES

(Not available on SNAP PAC SB brains.) You may need to send a message—uvia email, data streaming, SNMP, or
a serial module—from an I/0 unit or a controller when a specific event occurs. For example, you could send a
message if a digital point is on, if an analog point reaches a certain value, if a specific string is received through
a serial module, or if a variable contains a specific value. You can send one type of message or more.

NOTE: You must be using a PAC Control strategy or PAC Manager R9.0a or higher to configure event messages in this
way. In the PAC Control strategy, your flowchart monitors the event and triggers the message using the command
Set /0 Unit Event Message State. Messages must be configured before they can be used in PAC Control.

Ifyou are NOT using a PAC Control strategy or are using a PAC Manager version less than R9.0, you cannot configure
event messages in a configuration file. You must configure them using Inspect mode. See page 142.

Follow these steps to configure up to 128 event messages for use with a PAC Control strategy.
1. In PAC Manager, click the Open button = (or in the menu bar, click File > Open).
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
ﬂ PAC Manager - Main_Process
File Edit Tocols Wiew Help

| Dl *|%a @

-1 Main_Process

=M /0 Units

-2 Line_1

-2 Preprocess

Ready N
In the configuration tree, right-click the name of the I/0 unit on which you want to set up event

messages and choose Configure from the pop-up menu.
For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an I/O unit

of the type Generic OptoMMP Device with the loopback address (127.0.0.1).

= Configure /0 Units *

Name | Type | Part | Address | watchdog | Description Add... |
||_|

ine_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Ethernet 10.192.55... Disabled Modify. .. |

Preprocess SNAP-PAC...

Events
button

Close I Help
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4. (lick the Events button and choose Event Messages from the pop-up menu.

é Configure Event Messages >

# | Message Mame | Message Text | ~ Modify... |

0
1
2
3
4
5
6
7
8
9
10
11 4
Close I Help |
5. Highlight an empty message number in the list and click Modify.
=5 Add Event Message 20 ¥
A —— Message Name: ||
B ————— Message Text:
C ——— Scratch Pad Trigger OM Mask: 0x I 00000000 00000000

SaatﬁPadTriggerOFFMask:Oxl 00000000 00000000

D ——— [ Streaming —SNMP Trap

IDisabIed vI Period (sec): I 0 IDisabIed ;I—— H

E —— E-mail Period (sec): IU
IDisabIed vI Period (sec): I 0
Trap Type: I a

F ———— [~ Serial Module

Priarity: IH' h vI
IDisabIed vI Serial Ports Mask: Ox I ty g

G —— MemMap Copy Destination

IDisabled vI MemMap Address: Ox I Period (msec): I a
IF Address: I . . . Part: 2001

0K I Cancel | Help |

6. Complete the fields as follows:
A—Message Name. Enter a name for the message.

B—Message Text. For an email or serial message, and optionally for an SNMP message, enter the
message text. Message text is not sent in the streaming packet.
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C—Message text is limited to 127 characters. You can place data from the I/0 unit's memory map into
the message by using a plugin (see page 95). If you are sending a serial message, make sure the text is
formatted so the serial device that receives it will understand it.

D—Scratch Pad. To trigger bits in the Scratch Pad, enter the On and Off masks to set.

E—Streaming. To send a stream of data as the message, choose Enabled from the drop-down list.
Enter how often in seconds to send the stream (0 sends it only once).

F—E-mail. To send an email message, choose Enabled from the drop-down list. Enter how often in
seconds to send the email (0 sends it only once).

G—Serial Module. To send a message through a serial module to a serial device, choose Enabled from
the drop-down list. Enter a mask representing the modules and ports to receive the message.

H—Mem Map Copy Configuration. To copy memory map data, see page 109.

I—SNMP Trap. To send an SNMP trap as the message, choose Enabled from the drop-down list. Enter
how often to send the trap (0 sends it only once). Also enter the trap type (determined by your SNMP
management software). If you are using SNMP with outgoing PPP and want the trap stored in the I/O
unit until the next communication, set Priority to Low. If you want the I/0 unit to immediately dial out
and send the trap, set Priority to High.

NOTE: SNMP messages must be acknowledged. If the Period is set to more than zero, the alarm will continue to
be sent until the trap is acknowledged and the Scratch Pad trigger is reset to zero.

In PAC Control, you can use the command Set I/0 Unit Event Message State to build the acknowledgment into
the flowchart logic.

In PAC Manager, you can acknowledge the trap and reset the Scratch Pad by using Inspect > Events > Event
Messages (change State to Acknowledged and reset Scratch Pad bits).

7.  When all fields are correct, click OK.
8. When you have configured all event messages, click Close.
9. Foreach type of message you configure, make sure you also set up basic configuration:

Serial: page 46
SNMP: page 96
Email: page 100
Streaming: page 104

10. Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/0 unit, see “Sending Configuration Data to the /0
Unit"on page 68.

USING PLUGINS

Several plugins are available for use in event messages and memory map copying. The following table guides
you in using them.

To do this Use this plugin In these places See

Include the pattern string from a

, .
) L ! str Serial messages age 92
serial communication module. St — 9 pag
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To do this Use this plugin In these places See

Show which serial port sent the pat-

i )
tern string. $! port Serial messages page 92

Include data from a memory map

address.

X = type of data (S=string representa-

tion of the data, D=integer, F=float, SIX YYYYYYYY
P=IP address, B=4 binary bytes)

YYYYYYYY = memory map address

(see examples below)

Event messages page 92
Memory map copying page 109

Number emails with a sequence ID $! segid Email messages page 92

Turn digital points on or off using a bit

mask &#x00000000__ Memory map copying page 109

NOTE: Foremail messages, message text including plugins must be 127 bytes (characters) or less. The message length
after all plugins have been expanded into their data values must be 255 bytes or less.

Examples

Including Data from Memory Map Addresses

For the complete list of memory map addresses, see the appendix in the OptoMMP Protocol Guide
(form 1465).

Here are a couple of examples:

To include the on/off state of a switch on module 0, point 3, you would put this in the message:
$!D F08000CO_

To include the temperature of an ICTD input on module 4, point 0, you would use:
$!F_FOA00400

Sending Binary Data in Event Messages

To send binary data in the text of an event message, begin with s#x and end with . You can include any
number of ASCII hex digits up to the 127-byte limit for the message field. You can also include multiple &tx
plugins. This plugin is resolved after all other plugins have been resolved, and only just before sending the
contents of the message field out of the specified serial ports. Examples:

To include an embedded null (one binary character):
&dtx00_

To include a number of binary characters:

§#x0a0dCF0034

CONFIGURING SNMP

(Not available on SB brains) The Simple Network Management Protocol (SNMP) is used to communicate
with an SNMP-based enterprise management system, such as Computer Associates' Unicenter®,
Hewlett-Packard’s OpenView®, or IBM's Tivoli®, over Ethernet. These enterprise management systems can
manage analog, digital, or serial devices through a SNAP PAC controller or /0 unit just as they manage
computer equipment on the Ethernet network.
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SNMP Traps

You can set up the controller or I/0 unit to send messages to the management system in the form of SNMP
traps. The device can send three kinds of traps:

«  Authentication trap—sent when a host requests data that is outside its access permissions
«  Cold start trap—sent whenever the I/0 unit is turned on
«  Exception trap—sent in reaction to an event; an exception trap is a type of event message.

Authentication and cold start traps can be enabled using the steps in this section. To configure exception
traps, see “Configuring Event Messages”on page 92.

SNMP Access Privileges

Community groups control access to SNMP information from the controller or 1/0 unit. When you set up a
community group, you determine its privileges to read, write to, and receive traps from the system.

In order to receive traps, a host must be a registered management host and be part of a community group that
has access privileges for traps. Once a registered management host becomes part of a community group, that
group is no longer available to non-registered hosts. It includes only the hosts registered to it.

To set up community groups, follow the steps in this section. You can define up to eight community groups.

Configuring the SNMP Agent

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it.

5 PAC Manager - Main_Process - O d
File Edit Tools Wiew Help

| Dl *|%ala &

ot |
A/D

Preprocess

Ready [ N4

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up SNMP and
choose Configure from the pop-up menu.

PAC Manager User's Guide 97



CONFIGURING SNMP

For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an 1/0 unit
of the type Generic OptoMMP Device with the loopback address (127.0.0.1).

= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 3 |
Events 3 |

Communications Communications

Others 3 | button

Close I Help |

4. Make sure the correct I/O unit is highlighted in the list. Click the Communications button and choose
SNMP from the pop-up menu.

= Configure SNMP Agent by
—System Traps
A— SysMame: I Version: |v1Tra|:| vl —F
B SysLomtion:l Destination Ilﬁz — G
[™ Authentication Trap H
C ——— GSysContact: I [ Cold Start Trap
D _ Community Groups
#l String | Read | Write | Trap | ~
u]
1
2
3 w

E — Management Hosts

#l Community String | Host IP Address | ~
0
1
2
3 W

oK I Cancel Help

5. Complete the fields as follows:

A—SysName. Enter the name assigned to the I/0 unit as a managed node within the SNMP
management system.

B—SysLocation. Enter the physical location of the I/0 unit.
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C—SysContact. Enter the ID of the contact person for the I/0 unit.

D—Community Groups. To set up the Community Groups you need, highlight a line in the list. Click
the String cell within the line and type the name of the group. Then click in the Read, Write, and Trap cells
and choose Yes or No from the drop-down list to indicate whether that group has privileges to read,
write, and receive traps.

E—Management Hosts. To set up Management Hosts, highlight a line in the list. Start with hosts on
the local network first, because the system sends messages to hosts in numeric order. Click the
Community String cell and enter the name of the community group the host belongs to. Click the Host IP
Address cell and enter its IP address, including the dots (for example, 10.192.55.60).

F—Version. From the drop-down list, choose the version of SNMP you are using.

G—Destination Port. 162 is the default port for SNMP traps. If you know that your application will use
a different port, enter the number of that port here.

H—Authentication/Cold Start Trap. To enable authentication or cold start traps, click the box to
check it.

6. When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/0 unit, save it
to flash memory, and restart the I/0 unit.

7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/0O unit, see “Sending Configuration Data to the I/0O
Unit"on page 68.

CONFIGURING DNS SERVERS

If you want to use host names in PAC Control comm handles or in SMTP messaging configuration, use the
DNS Resolver to designate one or two DNS servers to resolve host names into IP addresses. The servers are
queried one at a time in the order listed.

1. InInspect mode, click the Communications button and choose DNS Resolver from the pop-up menu.

| Inspect Opto 22 Device EF =] '@

Device MName: | 10,192.54.110 j Options * Status: |SSI Module area last read at 06/14/12 13:40:24

—DNS Resolver
Status Read

= Address | Description | Walue | | Refresh
SN OWFFFFFE100100  Retries 1
- O«FFFFFE10 0104 Timeout 2 Apply
Wireless LAN  # DNS Address Servers In Use
O4FFFFFE100300  DNS Address Server #0 0000

Point Config OxFFFF FE10 0304 DNS Address Server #1 0.0.00
Digital Bank .
,?._‘m__zl Y il Sl r"'m“ .,.,f" . ;“""‘ el

0.0.0.0 indicates that the DNS
server is not being used.

2. Toadd a DNS server address or to change the Retries or Timeout, click the appropriate value in the Value
column. When you have finished changing values, click Apply.

3. When you have finished changing values, click Apply.
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The values are sent to the controller and stored to flash memory. Then you are prompted to restart the
controller.

4. Restart the controller to use the new configuration.

CONFIGURING EMAIL

(Not available on SBbrains) You can send an email message or page someone in response to an event. Follow
the steps in this section to set up email parameters. See “Configuring Event Messages” on page 92 to set up
the message itself.

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

5] PAC Manager - Main_Process — O X
File Edit Tocols Wiew Help

| Dl *|%a @

-1 Main_Process
(=™l /O Units
-2 Line_1

-2 Preprocess

Ready [Nz

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up email and
choose Configure from the pop-up menu.

100 PAC Manager User's Guide



CHAPTER 3: CONFIGURING OPTIONAL FUNCTIONS

For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an I/O unit
of the type Generic OptoMMP Device with the loopback address (127.0.0.1).

= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 4 |
Events 4 |
ScratchPad  # |
Communications H—— Communications
s D | button

Close I Help |

4. Make sure the correct I/O unit is highlighted in the list. Click the Communications button and choose
E-mail from the pop-up menu.

=+ Configure E-mail >
—SMTP Server
A —Paddess:| | . . . Port: | 25
B —— Timeout (milliseconds): |30000

—E-mail Header

c | From: I
D — 1 Te: I
E— Subject: I

0K I Cancel | Help

5. Complete the fields as follows:
A—IP Address. Enter the IP address and port number of the Simple Mail Transfer Protocol (SMTP)
server the I/0 unit will use to send email. You should be able to get this information from your network

administrator.

B—Timeout. Enter the length of time in milliseconds the I/0 unit should wait for a response from the
email server. The default is 30,000.

C—From. Enter a valid email address that will identify the I/0 unit to the person who receives the email.

D—To. Enter the email address of the person who will receive the email.
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E—Subject. Enter a phrase that will indicate the purpose of the email to the person receiving it. Note
that this subject line applies to all email messages sent by this I/O unit. Plugins can be used in this field.
For example, if a similar email will be sent at intervals (such as an email of the data log), you can use the
seqid plugin to put a sequence number at the end of each subject line. This plugin is in this format:
$! segid
So, for example, if you enter Process Data Log $! segid  inthe subject field, the first
email message will have a subject line of Process Data Log 0, the next message will have a
subject line of Process Data Log 1,and so on. Forinformation on other plugins, see “Using
Plugins”on page 95.
6. When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/O unit, save it
to flash memory, and restart the /O unit.

7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
Hl to save the configuration file.

When you are ready to upload the configuration file to the I/0 unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

SETTING UP INITIAL VALUES IN THE SCRATCH PAD AREA

102

Before you use this section, read “Event/Reaction Concepts”on page 127.

To set initial Scratch Pad values and save them as part of the configuration file, follow these steps. (To see
Scratch Pad values or change them in real time, see “Reading and Writing to the Scratch Pad Area”on
page 184.)

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

5] PAC Manager - Main_Process — O X
File Edit Tocols Wiew Help

Dles|d| X|ae B g el
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-1 Main_Process
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Ready [Nz

3. Ifyouare using a SNAP PAC S-series or SoftPAC controller, configure an I/O unit to represent the controller
for Scratch Pad purposes. Configure this I/0 unit as a Generic OptoMMP Device, using the loopback
address (127.0.0.1). (Do not add any points or configure other features.)
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4. Inthe configuration tree, right-click the name of the I/O unit on which you want to configure the Scratch
Pad and choose Configure from the pop-up menu.

= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 3 |
Events 3 |
Iy Scratch Pad
o | button
Communications »
Others 3 |

Close I Help |

5. Make sure the correct I/0 unit is highlighted in the list. Click the Scratch Pad button and choose Bits,
Integers, Floats, or Strings from the pop-up menu.

Scratch Pad Bits

=% Configure Scratch Pad Bits X
[~ Used

Address | Description | Value |
DIRECT ACCESS

0xFFFF FOD& 0000 Scratch Pad Bits Ox Q0000000 20000000
MOMO ACCESS

0xFFFF FODE 0400 OM Mask Ox Q0000000 20000000

0xFFFF FODE 0403 OFF Mask Ox Q0000000 20000000

oK I Cancel

1. Clickto put a check mark in the Used box.

2. Click the cell in the Value column to set initial values for either the bits in the Direct Access area or the
MOMO masks in the MOMO Access area.

3. Click OK.
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Scratch Pad Integers, Floats, or Strings

The Configure Scratch Pad Floats dialog box is shown as an example. The dialog boxes for strings, 32-bit
integers, and 64-bit integers are similar.

s

=] Configure Scratch Pad Floats

Used | Address | Value | A selact Al
o OxFFFFFODS 2000 @

O OxFFFF FODA 2004 Unselect All
Oz 0xFFFF FODS 2008
Os OxFFFF FODA 200C Clear Al
4 0xFFFF FODS 2010
Os OxFFFF FODA 2014
Os 0xFFFF FODS 20183
Oz OxFFFF FODA 201C
s OxFFFF FODE 2020
(] OxFFFF FODA 2024
[ 1w  oxFFFF FODE 2028
[] 11 OxFFFF FODS 202C
[112  0xFFFF FODE 2030
[0 13  OxFFFFFODS 2034
[ 14  oxFFFFFODE 2038
[] 15  0xFFFF FODS 203C
[ 1  0xFFFF FODE 2040

oK | Cancel

o o o o o o o oo oo oo o oo

1. Foreach integer you want to use, click to put a check mark in its box in the Used column. Click the cell in
the Value column and enter the initial value.

2. Repeat for each integer. When all integers have been set, click OK.

CONFIGURING STREAMING

104

(Not available on SB brains) Most Ethernet communication involves the two-step process of request and
response. A faster way of getting information from the I/0 unit, however, is by streaming data. Streaming does
not use TCP/IP; it uses the User Datagram Protocol (UDP/IP) instead.

NOTE: Because Modbus/TCP runs on TCE not UDR streaming data via Modbus/TCP is not possible. However, you can
stream to a non-Modbus host at the same time you are using the Modbus/TCP protocol for another purpose.

Streaming is a fast way to get continuous data from the I/O unit and is ideal for data acquisition applications.
When it streams, the system sends data at regular intervals to specified IP addresses. You set up the interval,
the IP addresses to receive the data, and (optionally) the port number. The system sends the data at the
specified interval. The communication is one-way; the system does not wait for a response.

CAUTION: If you stream to multiple IP addresses, and one or more of the streaming targets is either offline or not
running the application that receives the stream, delays may occur. If a target is offline, the 1/0 system will stop
streaming while it tries to resolve the IP address. If the application is not running on the computer that receives the
stream, the computer will send the I/0 system an error message; if the stream occurs frequently, the additional error
messages can slow down the network.

Streaming involves two steps: setting up parameters on the /0 unit for streaming, and receiving data in your
application. Follow the steps in this section to set up the parameters. For information on receiving data in your
application, see the OptoMMP Protocol Guide (form 1465).
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In PAC Manager, click the Open button El (orin the menu bar, click File > Open).
In the Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

5 PAC Manager - Main_Process - O d
File Edit Tools Wiew Help

| Dl *|%ala &

=-IC) Main_Process
E| @ /0 Units

i
H-qap Line_1

:
-7p Preprocess

Ready [ N4

In the configuration tree, right-click the name of the I/0 unit on which you want to set up streaming and
choose Configure from the pop-up menu.

= Configure /0 Units *

Name | Type | Part | Address | watchdog | Description Add... |

SNAP-PAC... Ethernet 10.192.55... Disabled
SNAP-PAC... Ethernet 10.192.55... Disabled Modify. .. |

Events >|

(o= 7

MI— Communications
s ’| button

Coss | Hep |

Make sure the correct 1/0 unit is highlighted in the list. Click the Communications button and choose
Streaming from the pop-up menu.

PAC Manager User’s Guide 105



CONFIGURING STREAMING

#=#| Configure Streaming *
A Enable Streaming: _ = Target Device Information
B Port: 5001 —E
Enable If0 Mirroring:  |Ma -
Stream Target #1: . . . — F
Source Memory Map Information Stream Target #2: ; . .
C— | Interval (miliseconds): | 1000 Stream Target #3: : . :
Stream Target #4: . . .
D —— | {* Use Default Streaming Area

Stream Target #5: l—
Ii Stream Target #6: l—
Iﬂi Stream Target #7: l—
Stream Target #3: l—

" Specify Streaming Area

0K | Cancel | Help |

5. Complete the fields as follows:
A—Enable Streaming. To enable streaming, choose Yes from the drop-down list.

B—Enable I/0 Mirroring. /0 mirroring is a separate function. It's generally not a good idea to use
both streaming and mirroring on the same I/0 unit. See “Mirroring 1/0 Point Data”on page 107 for more
information.

C—Interval. Enter how often in milliseconds you want the I/0 unit to send the streamed data. If you
are configuring streaming to use only as an event message, set the streaming interval to 0. Zero means
that the stream will be sent only once.

D—Use Default Streaming Area. To stream all addresses in the Streaming section of the I/0 unit's
memory map, click Use Default Streaming Area. For more information, see the memory map appendix in
the OptoMMP Protocol Guide (form 1465). (Note that the Streaming section does not include data from
high-density digital modules.)

To stream only part of the Streaming section, or to stream a different part of the memory map, click
Specify Streaming Area. Enter the starting address in the Memory Map Address field (the address must be
entered in hex), and enter the size in bytes of the data to stream in the Size Of Data field.

E—Port. Enter the port on the computers or devices that receive the streamed data. Your application
must refer to this port number. Use the default of 5001 unless you know it is already being used for
another purpose.

F—Stream Target. Enter the IP addresses of up to eight devices to receive the streamed data.

6. When all fields are correct, click OK.

7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
g to save the configuration file.

When you are ready to upload the configuration file to the I/0 unit, see “Sending Configuration Data to the I/O
Unit"on page 68.
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MIRRORING 1/0 POINT DATA

(Not available on SB brains) Mirroring 1/0 point data is a way to automatically change all the points on one I/0
unit to match all the points on another I/0 unit. A simple example of mirroring is controlling whether lights in
one facility are on or off by having them mirror the on or off status of switches in another facility.

Mirroring reads the current analog bank values (in Engineering Units) and the current digital bank status
(4-channel digital modules only, not high-density digital modules) of the points on a system and writes the
data to the same point numbers on a second system. The reading and writing occurs as often as you specify.
In our lighting system example, the status of switches in Facility A could be read every minute and
automatically written to the lights in Facility B. When someone turns on the switches in Facility A, the lights in
Facility B would automatically be turned on within a minute.

It's generally not a good idea to use both mirroring and streaming on the same I/0 unit. If you do use both,
streaming target #1 will receive both mirroring and streaming packets; the streaming packets are ignored, but
they unnecessarily add to network traffic.

NOTE: Due to the size limit of the mirroring packet, mirroring for digital points occurs on the first 32 points of the I/0O
unitonly (points on the modules in positions 0-7). Mirroring cannot be used with high-density digital modules.

Follow these steps to set up I/0 point data mirroring:
1. In PAC Manager, click the Open button El (orin the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

5] PAC Manager - Main_Process — O X
File Edit Tocols Wiew Help
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3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up mirroring and
choose Configure from the pop-up menu.

= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 4 |
Events 4 |
ScratchPad  # |
Communications H——— Communications
otrers_»| button

Close I Help |

4. Make sure the correct I/O unit is highlighted in the list. Click the Communications button and choose
Streaming from the pop-up menu.

=% Configure Streaming d

A —— Enable Streaming: Im vI ~ Target Device Information
B Port: I 5001 - D
Enable I/O Mirroring:  |No -
Stream Target #1: I . . . —E
—Source Memory Map Information ——————— Stream Target £2; I . ) .
C —— | Interval (miliseconds): I 1000 Stream Target #3: I . . .
Stream Target #4: I . . .
Stream Target #5: I . . .
" Spedify Streaming Area
Stream Target #&: I . . .
Memilap Address; Dxl
IU— Stream Target #7: I . . .
Stream Target #3: I . . .

(% Use Default Streaming Area

Size of Data:

oK I Cancel | Help |

5. Complete the fields as follows:
A—Enable Streaming. Streaming is a separate function. It's generally not a good idea to use both
streaming and mirroring on the same I/O unit. See “Configuring Streaming” on page 104 for more
information.

B—Enable I/0 Mirroring. To enable mirroring, choose Yes from the drop-down list.

C—iInterval. Enter how often in milliseconds the data should be mirrored.
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D—Port. Enter the port number. This is the primary port number used to communicate with the I/0
unit. The default shown is 5001; enter 2001 instead. (Exception: if you changed the MMP port for security
reasons, use the number you changed it to.)

E—Stream Target. Enter the IP address of the I/0 unit to receive the mirrored data.

CAUTION: Since all digital and analog points are mirrored, make sure that the points on the second I/O unit are
configured to accept the values that will be written to them.

6. When all fields are correct, click OK.
7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/0O
Unit"on page 68.

COPYING MEMORY MAP DATA

(Not available on SB brains) You can use memory map copying to do the following:
«  Copydata on the same I/O unit
«  Copy data to a memory map location on another unit

Copying Binary or Memory Map Data on the Same I/0 Unit

You can copy data on the same I/0O unit, for example to write the value of an analog point to another analog

point.
1. Follow the steps in “Configuring Event Messages” on page 92 until you reach the Add Event Message #
dialog box.
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#=# Add Event Message #0 X

Message Mame: ||

Message Text:

Scratch Pad Trigger ON Mask: 0x | 00000000 00000000

Scratch Pad Trigger OFF Mask: 0x | 00000000 00000000

Streaming SMNMP Trap

Disabled  ~ Period (sec): | 0 |Disabled |

E-mail Period (sec): |0
Disabled - Period (sec): | 0
Trap Type: a

Serial Module

Priority: High
Disabled - Serial Ports Mask: 0x 2

MemMap Copy Destination

Disabled »| MemMap Address: 0x Period (msec): |0
IP Address: . . . Port: 2001

0K | Cancel | Help |

2. Complete the fields as follows:
A—Message Name. Enter a descriptive name for the message.

B—Message Text. In the Message Text section, enter a plugin containing a memory map address to
write from (the source address), in the following format:

$!B_FOB00000 _

$! indicates the start of the plugin fo?n?;at Address  _ indicates the end of the plugin

or a four-byte constant, in this format:

&#x00000001

Constants must be written in exactly four bytes (8 characters).

While the data format indicator in the plugin can be other types (D=integer, F=float, B is typically used
for memory map copying. The other types copy a string representation of the data, since plugins are
primarily used for generating messages and emails.

C—MemMap Copy Destination. In the MemMap Copy Destination area, choose Enabled from the
drop-down list. Enter the Memory Map Address you are copying to (the destination address) as an
eight-digit hex number (the last eight digits of the address, for example, F0B00040). In the Period field,
enter how often to send the data, in milliseconds.

Since the points you are copying to are on the same I/O unit, type 0.0.0.0 forthe IP Address, and
ignore the TCP port field.
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3. When all fields are correct, click OK.
4. Configure other optional functions, or return to the PAC Manager main window and click the Save button
El to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the /0
Unit"on page 68.

Copying Binary or Memory Map Data to a Different I/0 Unit

You can also copy data to an address on a different system. Configure the event message in the source system

(the one you are copying from), but make sure that any points you are affecting on the destination system are

configured to accept the data.

1. Follow the steps in “Configuring Event Messages” on page 92 until you reach the Add Event Message #
dialog box.

=5 Add Event Message 20 ¥

Message Name: I |

Message Text:

Scratch Pad Trigger OM Mask: 0x I 00000000 00000000

SaatﬁPadTriggerOFFMask:Oxl 00000000 00000000

—Sireaming —SNMP Trap

IDisabIed - I Period (sec): I 0 IDisabIed ;I

—E-mail Period (sec): I a
IDisabIed vI Period (sec): I 0
Trap Type: I a

—Serial Module

Priarity: IH' h vI
IDisabIed vI Serial Ports Mask: Ox I ty g

IDisabled vI MemMap Address: Ox I Period (msec): I a
IF Address: I . . . Part: 2001

0K I Cancel | Help |

2. Complete the fields as follows.

A—Message Name. Enter a descriptive name for the message.
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B—Message Text. In the Message Text section, enter a plugin containing a memory map address to
write from (the source address), in the following format:

$!B_FOB00000 _

e

$! indicates the start of the plugin fo?na:;at Address  _ indicates the end of the plugin

or a four-byte constant, in this format:
&#x00000001
Constants must be written in exactly four bytes (8 characters).

While the data format indicator in the plugin can be other types (D=integer, F=float, B is typically used
for memory map copying. The other types copy a string representation of the data, since plugins are
primarily used for generating messages and emails.

C—MemMap Copy Destination. In the MemMap Copy Destination area, choose Enabled from the
drop-down list. Enter the Memory Map Address you are copying to (the destination address) as an
eight-digit hex number (the last eight digits of the address, for example, FOB00040). In the Period field,
enter how often to send the data, in milliseconds.
Also enter the IP Address and TCP port for the 1/0 unit whose point you are copying to (the destination
system). TCP port is usually 2001.

3.  When all fields are correct, click OK.

4. Configure other optional functions, or return to the PAC Manager main window and click the Save button
ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

CONFIGURING MODBUS OPTIONS

112

(Not available on SB brains) If you are using Modbus/TCP to communicate with a SNAP PAC device, see the
Modbus/TCP Protocol Guide (form 1678).

Using PAC Manager, you can change the Modbus float format. In addition, if you need to read or write data in
areas of the device's memory map that are not included in the Modbus memory map (shown in the protocol
guide), you can use PAC Manager to determine the Modbus Unit ID and Register Address that are equivalent
to the memory map address you want to use.

Changing Modbus Float Format
1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

ﬂ PAC Manager - Main_Process
File Edit Tocols Wiew Help

| Dl *|%a @

-1 Main_Process

=M /0 Units

-2 Line_1

-2 Preprocess

Ready [ N2

In the configuration tree, right-click the name of the I/O unit on which you want to change Modbus float

format and choose Configure from the pop-up menu.
For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an I/O unit
of the type Generic OptoMMP Device with the loopback address (127.0.0.1). (Do not add any points.)

*

MName | Type | Port | Address | Watchdog Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
10.192.55... Disabled Modify... |

Preprocess SMAP-PAC... Ethernet

= Configure /0 Units

Communications
button

Close I Help
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4. C(lick the Communications button and choose Modbus from the pop-up menu.

= Configure Modbus d
[ Used
Address | Description | Value |
MODEUS
OxFFFF FO39 0000 Modbus 32-bit Float Format Big Endian =1

oK | Cancel | Advanced

5. Clickto place a check mark in the Used box. In the Value column, click the value shown for float format.
Choose the format you want from the drop-down list.

NOTE: Word swapped is still Big Endian, but places the most significant bit in the most significant register.

6. When the value you want is shown, click OK.
7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
L | tosave the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

Determining Modbus Unit ID and Register Address

If you need to read or write data to the device’s memory map in areas not included in the Modbus memory
map, you can use PAC Manager to convert memory map addresses to Modbus Unit ID and Register Addresses,
or vice versa. For more information, see the Modbus/TCP Protocol Guide (form 1678).
1. Determine the device’s memory map address (or the Modbus Unit ID and Register Address) you want to
convert.
To find out the memory map address, you can use the memory map appendix in the OptoMMP Protocol
Guide (form 1465), or you can copy and paste the address from the Inspect dialog box in PAC Manager.
2. Inthe PAC Manager main window, with a configuration file open, right-click an 1/0 unit and choose
Configure from the pop-up menu.
3. Inthe Configure I/O Units dialog box, click the Communications button and choose Modbus from the

POpP-Up Menu.
= Configure Modbus d
[~ Used
Address Description | Value |
MODBUS
0xFFFF FO39 0000 Modbus 32-bit Float Format Big Endian k|

oK | Cancel | Advanced
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4. (lick the Advanced button to see the rest of the dialog box.

= Configure Modbus

*
™ Used
Address | Description | Value |
MODBUS
OxFFFF FO39 0000 Modbus 32-bit Float Format Big Endian =1

r Address Conversion

Opto 22 Memory Map Address (Valid range FOO0 0000 to F1EB FFFE)
To convert to Modbus address

Forexample: FoD&8 1000

|'||1|1|'||0|0|l}|0 ‘l]‘llﬂll 110|010 010|oll 0]0|0ln 010|oln 0]0|0E|
8 bits 16 bits
011011000 000100000000000

5

Convert to decimal Convert to decimal
108
Add2  +2
Medbus: UnitlD 110 Register Address 2048
For applications that use Register Number
instead of Register Address, convert
the address to a Register Number: Add1  +1
Medbus: UnitlD 110 Register Number 2049
Note:Modbus Reg start at 1,but the ponding Register Add)
startat 0. For e, Register Number 2049 is at Register Address 2048.

db it ID: I
MemMap Address: Oxl 4 | }l ::giS::rUnltID l—

x| o |

To convert an I/0 unit memory map address to a Modbus Unit ID and Register Address, type the last
eight digits of the I/0 unit's memory map address in the MemMap Address field.

Make sure there are no spaces in the address (for example, type F0300020).
Click the right-arrow button I_}l )
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The equivalent Modbus address appears. Note that the Modbus numbers are decimal.

= Configure Modbus *
[~ Used
Address Description Value |
MODEBUS
OxFFFF FO39 0000 Modbus 32-bit Float Format Big Endian =1

Address Conversion

Opto 22 Memory Map Address (Valid range FOO0 0000 to F1EB FFFE)
To convert to Modbus address

Forexample: FoD&8 1000

|'||1|‘||'||l]|0|0|0 1|‘I|D|l ‘l|0|0|0 0|0|0|l 0|0|0|0 0|0|0|0 0|0|0|E|
8 bits 16 bits
011011000 000100000000000

Convert to decimal Convert to decimal
108
Add2  +2
Medbus: UnitlD 110 Register Address 2048

For applications that use Register Number
instead of Register Address, convert

the address to a Register Number: Add1  +1 Memory map
Modbus  UnitlD 110 Register Number 2049 address (in hex)
N Modbus Regi Numi start at 1, but the c ponding Reqi A
start at 0. For example, Register Number 2049 is at Regi ress 2048,
Modbus UnitID: | 5 .
Geml\"lap Address: 0x | FO0753E4 4| ) Equwa\ent Modbus
e 8554 address (decimal)

oK | Cancel | Basic

7. To convert from Modbus to a memory map address, type the Unit ID and Register Address and click the
left-arrow button.

The equivalent memory map address appears.

SETTING UP SYSTEM DATE AND TIME

SNAP PAC devices have a built-in clock. The clock is set at the factory before the device is shipped to you. If
necessary, you can set the date and time on an 1/0 unit by following these steps. (For a SNAP PAC S-series
controller, see “Reading System Date and Time”on page 184.)

NOTE: If you are using PAC Control and want to synchronize the I/O unit’s time with your computer’s time, don't use
these steps, instead, follow the instructions in the PAC Control User's Guide (form 1700).

1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).
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In the Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

ﬂ PAC Manager - Main_Process
File Edit Tocols Wiew Help

| Dl *|%a @

-1 Main_Process

=M /0 Units
-2 Line_1

-2 Preprocess

[ N4

Ready
In the configuration tree, right-click the name of the I/O unit on which you want to set the time and date

3.
and choose Configure from the pop-up menu.

*

Name | Type | Part | Address | watchdog | Description Add... |
Li SNAP-PAC... Ethernet 10.192.55... Disabled
10.192.55... Disabled Madify... |

= Configure /0 Units

ine_1
SNAP-PAC... Ethernet

Preprocess

Others

_otes v button

Close I Help
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4. C(lick the Others button and choose Date and Time from the pop-up menu.

= Configure Date And Time d
[ Used

Address | Description Value
TIME

0xFFFF FO35 0000 Hours 08

0xFFFF FO35 0000 Minutes oo

0xFFFF FO35 0000 Seconds oo

0xFFFF FO35 0000 Hundredths of a Second 0o
DATE

0xFFFF FO35 0000 Month 01

0xFFFF FO35 0000 Day 01

0xFFFF FO35 0000 Year 2003

oK | Cancel

5. Clickto put a check mark in the Used box. Enter the correct time and date values in the Value column.
Click OK.

6. Configure other optional functions, or return to the PAC Manager main window and click the Save button
ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

CONFIGURING DIRECT COMMUNICATION TO SERIAL DEVICES

118

Applies to SNAP PAC controllers only.

Serial connectors are located on the top of SNAP PAC controllers. For the type, number, and function of serial
ports on each device, see the device's user guide. Depending on the device, these ports may be used for
several purposes:

«  Maintenance, such as loading new firmware (see page 203).
«  Point-to-Point Protocol (PPP) communication via modem (see page 123).
«  Connection to serial I/O units (PAC-S only).

«  Sending or receiving data directly from a serial device, such as an RFID or barcode reader, a weigh scale,
or any intelligent device with a serial port. For this use, communication occurs through PAC Control
communication handles. (For more information, see “Communication Commands"in Chapter 10 of the
PAC Control User's Guide (form 1700).

NOTE: This section shows you how to configure the controller to talk serially with devices directly connected to it.
Serial devices attached to an I/0 unit through serial communication modules on the rack are configured differently.
See page 46.

Follow steps in the next section for on-the-rack controllers; see page 120 for standalone controllers.

Configuring Serial Ports on an On-the-Rack Controller

Use these steps for SNAP PAC R-series.
1.  InPAC Manager, click the Open button g (orin the menu bar, click File > Open).
2. Inthe OpenTag Database dialog box, navigate to the configuration file and double-click it to open it.
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3. Inthe configuration tree, right-click the name of the I/O unit on which you want to configure direct serial
communications and choose Configure from the pop-up menu.

= Configure /0 Units X
Mame Type Port Address Watchdog Description Add...
Line_1 SMAP-PAC... Ethernet 10,192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify...

Delete
Import/Copy...

10 Points...

PID Loops...
Modules 3
Events 3

Communications Communications

Others 3 button

Close | Help |

4. C(lick the Communications button and choose Communication Port Control from the pop-up menu.

i ™y
é Cenfigure Communication Port Control d
[ Used
Address | Description | Value |
COMMUNICATION PORT @
0xFFFF FO31 0400 Control Function For Communication Port 0 PFP j
OxFFFF FO31 0404 Logging For Communication Port 0 Dizabled =1
0xFFFF FO31 1100 Mode For Communication Port 0 R5232 j
COMMUNICATION PORT 1
0xFFFF FO31 0408 Control Function For Communication Port 1 Mone j
OxFFFF FO31 040C Logging For Communication Port 1 Dizabled =1
OxFFFF FO31 1104 Mode For Communication Port 1 R5232 j
COMMUNICATION PORT 2
0xFFFF FO31 0410 Control Function For Communication Port 2 Mone j
-

Because a configuration file could be built for any controller or brain PAC Manager supports, this window
shows the possible ports and settings for all devices. Only a few apply to R-series PACs.

5. [Ifthereis no check mark in the Used box, click the box to place a check mark there.
Ports shown in the window are as follows:

- Port 0 =RS-232 connector on controller’s top
—  Ports 1, 2, and 3 = Not used on the R-series controller
6. If Port Ois used for modem communication, do the following:

a. Inthe Value field for Control Function for Communication Port 0, choose PPP from the drop-down
list.

b. Inthe Logging for Communication Port field, leave logging Disabled unless you are troubleshooting
serial communication (see page 231).

NOTE: Logging adds significant overhead to serial communication; do not enable it unless you need to.
7. If Port Ois directly connected to a serial device, do the following:
a. Inthe Control Function for Communication Port 0 value field, choose None from the drop-down list.
b. Inthe Logging for Communication Port field, leave the value field set to Disabled.
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Although you can use this log file for troubleshooting, when the control function is set to None, the
log file logs only characters received by the PAC Control strategy. It is better to have PAC Control log
the data rather than using the log file. The log file adds significant overhead to communication. (For
more about the log file, see page 231)

c. Inthe Mode for Communication Port O field, leave the value set to RS232. (The R-series controller
does not support RS-485.)

8. When you have finished configuring the port, click OK.
9. Configure other optional functions, or return to the PAC Manager main window and click the Save button
il | to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

Configuring Serial Ports on a Standalone Controller

These steps apply to SNAP PAC S-series controllers.
1. In the PAC Manager main window, click the Inspect button @
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

=

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58

Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh |

e D 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
0xFFFF FO30 0008 Busy Flag a
Paint Config 0xFFFF F030 0018 Loader Version R5.1lc
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3

ETHERENET 1 Interface

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

% Inspect Opto 22 Device
Device Name] | afJsl =Relslyyis| =g Opti
|_ |[EngineRm i

| Cail Portable

: SoftPAC [CRIPTION
S lerup Clea
Wireless LAN | Boiler FI;

——————Chamber 1 s
. Chamber 2 4
Point Confid o portable der Versig
T Cookie Controller ory Map Ve
Bl Balq]EngineRm mware Verg
Digital Poini-20fPAC mware Verg
0xFFFF F030 00BO Firmware Very

2. Inthe Device Name field, type the name (or IP address) of the controller (or choose it from the
drop-down list). Click Communications and choose Communication Port Control from the submenu.

= Inspect Opto 22 Device — *

Device Mame: ‘ 10.192.50.21 j Options # Status: | Comm Port Control area last read at 07/05/16 12:04:58

Communication Port Contral
Status Read
Status Write Address | Description | Value Refresh |
COMMUNICATION PORT 0

- OxFFFF F0310400  Control Function For Communication Port 0 PPP =l Apply
Wireless LAN o N - . <

xFFFF FO31 0404 Logging For Communication Port 0 Disabled =1

COMMUNICATION PORT 1
m OxFFFF FO31 0408 Control Function For Communication Port 1 MNone Ja|
OxFFFF FO31 040C Logging For Communication Port 1 Disabled ~l

Digital Bank COMMUNICATION PORT 2
R . 0xFFFF FO31 0410 Control Function For Communication Port 2 MNone j
Digital Point 0xFFFFFO310414  Logging For Communication Port 2 Disabled =

Analog Bank
Analog Point
High Density

System 3
ScratchPad
Data Log 3
PID 3
Events 3
Communications »
Other 3

Close | Help | I~ AutoRefresh | 15000  msec

The Inspect window shows the ports and features that apply to the controller you're inspecting. The
example above is for a SNAP-PAC-S2, which has four ports. The following table shows how ports are
labeled on the top covers of S1 and S2 controllers.

Port = SNAP-PAC-S1 = SNAP-PAC-S2
0 SO Serial 0
1 S1 Serial 1
2 S2 Serial 2
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Port = SNAP-PAC-S1 = SNAP-PAC-S2

3 -- Serial 3

If you are using a modem, do the following:

a.

In the Control Function for Communication Port field for the port the modem is attached to, choose
PPP from the drop-down list. Note that the lowest numbered port with PPP function configured is
the only port that can be used for PPP. See page 123 for more on setting up PPP.

In the Logging for Communication Port field, leave logging Disabled unless you are troubleshooting
serial communication (see page 231). Logging adds significant overhead to serial communication;
do not enable it unless you need to.

If you are using ports on a PAC-S2 to connect to serial I/0 units, do the following for each port:

a.
b.

In the Control Function for Communication Port value field, choose None from the drop-down list.
In the Mode for Communication value field, choose the connection type, termination, and bias from
the drop-down list.

In the Logging for Communication Port field, leave the value field set to Disabled.

Although you can use this log file for troubleshooting, when the control function is set to None, the
log file logs only characters received by the PAC Control strategy. It is better to have PAC Control log
the data rather than using the log file. The log file adds significant overhead to communication. (For
more about the log file, see page 231)

For each port that is directly connected to a serial device, do the following:

a.
b.

In the Control Function for Communication Port value field, choose None from the drop-down list.
In the Logging for Communication Port field, leave the value field set to Disabled.

Although you can use this log file for troubleshooting, when the control function is set to None, the
log file logs only characters received by the PAC Control strategy. It is better to have PAC Control log
the data rather than using the log file. The log file adds significant overhead to communication. (See
page 231.)

(PAC-S2 only) In the Mode for Communication value field, choose the connection type, termination,
and bias from the drop-down list.

When you have finished configuring the ports, click Apply.
Configuration data is sent to the controller.
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7. Click the Status Write button on the left side of the Inspect window. In the Operation Command list,
highlight Store configuration to flash.

=] Inspect Opto 22 Device — x
Device Name: | 10.192,50.21 Ll Options ¥ | Status: | Status Write area last read at 07/05/16 12:06:40
 Status Write
Status Read |

Status Write Address | Description | Value - Refresh
OxFFFF FO38 0004  Always BootP/DHCP On Powerup No Bl
e D | 0xFFFF FO33 0008 Degrees F/C Degrees C = Apply

0xFFFF FO338 0010  Comm Watchdog Time (msec), 0 = Disable 1]
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout {msec) 250
Paint Config | 0xFFFF F038 0018  TCP Initial Retransmission Timeout (msec) 3000
0xFFFF FO38 001C  TCP Retransmission Attempts 3
Digital Bank | 0xFFFF FO33 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
= s OxFFFF FO38 0294 Digital Feature Scan Interval {msec) a
Digital Point | OxFFFF FO33 0050 Max Analog and High Density Digital Scan Interval (msec) 0
Analog Bank | 0xFFFF FO33 0298  Out Of Range Value (16-Bit) 0.000
0xFFFF FO38 02B0  Out Of Range Value (32-Bit) 0.000

Analog Paint | 0xFFFF FO38 0054 Scanner Flaos 0x 00000000 A
High Density | Operation
OptoMMP Device ~  send Command |
s | |
seaarad | | | gEgriomo ok
M mius'gosrz configuration and IP settings to microSD

PID » Erase configuration and IP settings from microSC
Erase firmware from microSD

Events » | Erase strategy from microSD
Other
- Switch to loader mode
3
MI Clear Digital Events - Expanded configuration
Other » | Clear Digital Events - Old configuration W

cose | nep | I~ AutoRefresh [15000  msec

8. (lick Send Command.
The port configuration data is stored to flash memory and a Success message appears.

CONFIGURING PPP

Use this section only if you have SNAP PAC R-series I/0 units installed at remote locations or in other places
where an Ethernet network is not available, and you are using modems to communicate between the device
and a computer. You can set up communication so that the device can dial in to a computer, so that
computers can dial into the device, or both.

NOTE: Ifyou are using PPP with a SNAP PAC S-series controller, see instructions in the controller user’s guide.

IMPORTANT: After you have followed the steps in this section to configure PPP on the I/O unit, see the I/0 unit’s user’s
qguide for information on attaching the modem to the system and setting up Windows dial-up networking or remote
access server on the computer.

Configuring PPP on the 1/0 Unit
1. Inthe PAC Manager main window, click the Open button @ or choose File > Open.
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

File Edit Tools View Help

|s(d| 2 ule) @)

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up PPP and
choose Configure from the pop-up menu.

| Type | Port | Address | ‘Wwatchdog | De Add...

Ethernet 10.192.54.110 Enabled
Modify... |
Delete |

Import/Copy... |

1/0 Paints... |
FID Loops... |
Modules 3 |
Events 3 |
Scratch Pad  » |

Communications » Communications

Others 3 | button

4. Make sure the correct I/0 unit is highlighted in the list. Click the Communications button and choose PPP
from the pop-up menu.
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-_';'l Configure PPP @
General PPP Serial Port
| | Local IP Address: L1680 . 1 Connection Timeout: |6l3
Baud Rate: |19200 -
Subnet Mask: . . . Echo Request Period: | 10
B R — Max Authentication Retries: | 3 Echo Request Retries: | 3 (i Mane :lv
odem Strings \ DataBits: |3 hd
Initialization: | ATEDO"Mrsmsries ]
D Stop Bits: 1 -
Listen: | ATS0=1"Mes J
Hanaup: | [T  E T - Flow None -
[
F Incoming PPP Outgoing PPP
Incoming Connections: Disabled Outgoing Connections: |Disabled | Inactivity Timeout: | 30
Set As Default Gateway: Mo - Use Local IP Address: No +| Max Connect Time: |0
Inactivity Timeout: 30 Set Az Default Gateway: |No +| Max Dial Retries: u]
Login: Login: Retry Interval: a
Password: Password: Disable Time: 0
Remote IP Address: | 192 . 168 . 0 . 2 Phone Number: [ PPP Link Always Connected
OK | Cancel | Help |

5. Complete the fields as follows:

A—Local IP Address. Enter the Local IP Address for the PPP interface on the 1/O unit. Enter the local Subnet
Mask only if you are using classless IP addressing. If you are not using classless IP addressing, leave the Subnet
Mask at zero, and the 1/O unit will calculate the subnet mask.

IMPORTANT: The network address for the PPP interface must be different from the network ID for the Ethernet
interface. (The network address is obtained by ANDing the IP address and the subnet mask.)

B—Max Authentication Retries. Enter the maximum number of times a login/password combination
can be retried.

C—Connection Timeout and Echo Request. Change these values if necessary to establish and
maintain the connection.

D—Modem Initialization String. Change the modem initialization string, listen string, and hangup
string if necessary. Make sure you use the setting to ignore DTR signal in the modem initialization string:

The default modem initialization string is AT&DO"M~~~~

Consult the command reference that came with your modem to determine the correct initialization
command strings. A sample modem initialization string might look like this:

AT&F"M~~AT&D0&KO"M~~AT&WO "M~~AT&YO"M~~

The &F command sets the modem back to factory defaults. The AM tells the Ethernet I/O unit to insert a
carriage return. The ~ tells it to insert a 500ms pause. The &WO writes the current settings to NVRAM profile O
on the modem. The &Y0 instructs the modem to use NVRAM profile 0 after resetting.

This initialization string is just a sample; command strings for your modem may differ.

E—Outgoing PPP. If the 1/0 unit will send outgoing calls, complete the Outgoing PPP section:
«  Choose Enabled from the drop-down list.
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In the Use Local IP Address field, choose Yes to have the I/0 unit use the Local IP Address you entered for
the PPP link; choose No to have the remote device assign the I/O unit an IP address for the PPP link. The
default is No.

If you want the I/0O unit to use the device the I/0 unit is calling as the default gateway for all
communication, choose Yes for Set As Default Gateway. The default is No.

Enter the Login and Password the 1/0 unit should use for authentication when it calls the remote device.
In the Phone number field, enter the number the modem should dial for outgoing calls from the I/0 unit.

Change the following fields if necessary:

Inactivity Timeout—If the 1/0 unit sends no packets and receives no packets for this number of seconds
after the PPP session is negotiated, the modem will hang up. The default is 30.

Max Connect Time—The maximum amount of time in seconds an outgoing PPP connection can stay
connected after successful negotiation. Default is zero, which disables the timer.

Max Dial Retries—The number of times the 1/0 unit will redial if the first attempt fails. Default is zero.
Retry Interval—The number of seconds the I/O unit will wait before trying to redial after the first attempt
fails. Default is zero.

Disable Time—If the maximum connect time or maximum number of retries has been reached, the
outgoing PPP dialer waits this number of seconds before doing anything. Default is zero.

PPP Link Always Connected—If you want outgoing PPP to always be connected, so there is no need for
the I/0 unit to dial out, check this box.

F—Incoming PPP. If the |/0 unit will receive incoming calls via modem, complete the Incoming PPP
section:

Choose Enabled from the drop-down list so the modem will listen for incoming calls.

If you want the I/0O unit to use the device calling the I/0 unit as the default gateway for all
communication, choose Yes for Set As Default Gateway. The default is No.

Change the Inactivity Timeout if necessary. The default is 30.

Enter the Login and Password the I/0 unit should accept for incoming calls.

In the Remote IP Address field, enter the IP address the I/O unit should give to devices that dial into the
I/0 unit and ask for an address. This address must be on the same subnet as the local IP address.

Enter a modem listen string to make sure the modem automatically answers calls. The default modem
listen string is ATS0=1~M~ , which instructs the modem to answer any incoming calls on the first ring.
Again, refer to your modem’s command reference for the correct listen string.

When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/0 unit, save it
to flash memory, and restart the I/0 unit.

NOTE: Ifthe serial port you are using for PPP was previously used for a direct connection with a serial device, you
must use PAC Manager's Inspect window to reset the port configuration from None to PPP. See page 118 for
more information.

Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/0 unit, see “Sending Configuration Data to the I/O
Unit"on page 68. For information on attaching the modem to the system and setting up Windows dial-up
networking or a remote access server, see the SNAP Ethernet-Based I/0 Units User’s Guide (form 1460) or the
SNAP PAC R-Series Controller User’s Guide (form 1595).
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4: Setting Up Events and
Reactions

INTRODUCTION

Events and reactions are automatic responses to conditions monitored by SNAP PAC I/O units. The monitored
conditions, called events, and the responses to them, called reactions, can be simple or complex. An example
of a simple event/reaction is turning on a fan in response to a rise in temperature. Complex event/reactions
may involve multiple events and multiple reactions, with a time delay in between. For example, you could set
up a temperature limit as an event that triggers a warning light, and a higher temperature limit as an event
that sets off an audible alarm and sends an email message.

CAUTION: Event/reactions you set up using these instructions in this chapter operate on the /0 side of a SNAP PAC
R-series controller, independently of any PAC Control strategy running on the processor’s control side. If you are using
PAC Control with a SNAP PAC R-series I/0 system, do not use this chapter. Instead, use the flowchart logic in the PAC
Control strategy to handle reactions to events. The only reason you might set up event/reactions that operate
independently on the /0 side of the controller would be a need for very fast reactions. If that is the case, be very careful
that the event/reactions you set up do not conflict with PAC Control logic.

The chapter introduces you to the Scratch Pad and other basic event/reaction concepts. It also shows you how
to use PAC Manager to configure the following:

«  Digital event/reactions (see page 131)

«  Alarm event/reactions (see page 137)

«  Serial or Wiegand event/reactions (see page 140)
«  Event messages (see page 142)

EVENT/REACTION CONCEPTS

This section describes using the Scratch Pad to track events and alarms, and types of events, alarms, and
reactions.

The Scratch Pad

Event/reactions are available on SNAP PAC R-series, SNAP PAC EB and SB brains, SNAP Ultimate, and SNAP
Ethernet I/0 units. SNAP Simple I/0 units and E1 and E2 brain boards do not have event/reaction capability.

CAUTION: Event/reactions occur on the I/O side of a SNAP PAC R-series or SNAP Ultimate controller, independently of
any PAC Control strategy running on the control side. If you are using PAC Control, it is best to use flowchart logic to
handle reactions to events. If you do set up event/reactions, be very careful that they do not conflict with PAC Control
logic.
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groov 1/0 units, groov RIO modules, SNAP PAC controllers and brains contain Scratch Pad areas within their
memory maps. Scratch Pad areas can be used for two main purposes:

« Asaplace to hold data being transferred from one peer to another on the network
« Asavirtual notebook for keeping track of events and alarms

The Scratch Pad is user-defined, meaning that you define and use its addresses to fit your needs, and you can
redefine them whenever necessary. The Scratch Pad area includes four sections to accommodate different
types of data: bits, strings, floats, and integers.

«  The Scratch Pad bits section is a 64-bit mask.

«  The Scratch Pad strings section is a table of 64 elements. Each element can hold 128 characters or 128
bytes of binary data.

«  The Scratch Pad float section is a table of 10,240 elements; each float is four bytes.
«  The Scratch Pad 32-bit integer section is also a table of 10,240 four-byte elements.
«  The Scratch Pad 64-bit integer section is a table of 1024 eight-byte elements.

NOTE: Scratch Pad float and 32-bit integer tables are not made up of contiguous addresses in the memory map; each
tableis in two address sections. You won't notice this if you are using PAC Control Scratch Pad commands, but if you
are addressing these tables in another application, check the memory map appendix in the OptoMMP Protocol
Guide to make sure you have the correct addresses for the table elements you want.

Using Scratch Pad Bits for Events and Alarms

When Scratch Pad bits are used to track events and alarms, the 64 bits in the mask do not represent channel
numbers. Instead, they represent whatever you decide they should be. For example, you might decide that
bit 1 in the Scratch Pad will indicate a temperature level in Vat #12 (if the temperature reaches 48 °C, bit 1 is
turned on). Bit 2 might indicate the status of Pump A (if the pump is off, the bit is off; if the pump is on, the bit
ison).

Because you can use Scratch Pad bits to keep track of events and alarms, you can set up reactions based on a
variety of conditions. In the example above, you could set up a reaction on an EB brain that sends a stream
packet if bit 1is on and bit 2 is off.

Cascading Events, Alarms, and Reactions

Scratch Pad bits are really a way to set up cascading events and reactions (that is, a series of events and
reactions dependent on each other). For example, the first event in the cascade could be the temperature in
Vat #12 reaching 40 degrees, and the reaction to it is setting Scratch Pad bit 1. The second event in the
cascade is that Scratch Pad bit #1 is set, and the reaction to that is some other action. A cascade of any number
of events and reactions can be configured, as needed.

USING EVENT/REACTIONS
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(Does not apply to groov I/0 units.) Event/reactions are available on SNAP PAC R-series, SNAP PAC EB and SB
brains, SNAP Ultimate, and SNAP Ethernet I/O units. SNAP Simple I/0 units and E1 and E2 brain boards do not
have event/reaction capability.

CAUTION: Event/reactions occur on the I/0 side of a SNAP PAC R-series or SNAP Ultimate controller,
independently of any PAC Control strategy running on the control side. If you are using PAC Control, it is best
to use flowchart logic to handle reactions to events. If you do set up event/reactions, be very careful that they
do not conflict with PAC Control logic.
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CHAPTER 4: SETTING UP EVENTS AND REACTIONS

Types of Events, Alarms, and Reactions

NOTE: groov I/0 units and SB brains do not support serial events and reactions nor reactions requiring an Ethernet
network, such as sending email.

The event or reaction can consist of one or a combination of the following. The reaction can take place
immediately or after a delay.

Events:

«  On/off state of a digital channel on a 4-channel module

«  State of on-latch or off-latch for a digital channel on a 4-channel module

«  On/off state of a digital channel on an HDD (high-density digital) module

«  State of an on-latch or off-latch fora digital channel on an HDD module

«  High orlow value of an analog channel (in engineering units)

«  Number on a digital counter or high or low number on a quadrature counter
«  Analog channel value or quadrature counter that is outside allowable range
«  State of a bit in the Scratch Pad bits area

«  State of a bit in the Scratch Pad integer 64 area

«  Specific string received by a serial module

Reactions:

«  Turn on/off digital channel

«  (lear on-latch or off-latch

«  Copy data from one memmap location to another

« logdata

«  Tumnon or off a bit in the Scratch Pad bits area

« Turnon or off a bit in the Scratch Pad integer 64 area
«  Send a stream packet

«  Send an email message

«  Send a string through a serial module to a serial device
«  Send an SNMP trap

Note that the memory map section formerly called Timers, which provided digital events with a delay
between an event and the reaction to it, has been expanded in firmware 8.1 to include additional options
such as latches and HDD modules. All new digital events should be configured in Digital Events - Expanded to
take advantage of the new flexibility.

Digital events you already configured still exist in Digital Events - Old. Timers you already configured still exist
in Digital Events - Expanded.
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The following table details steps for configuring events and reactions. See page references for more. A
flowchart following the table summarizes Alarm and Serial event and reaction configuration.

Event Reaction Configuration Steps See
Turn digital point on/off (on ) .
same 1/O unit) Configure Digital Events - Expanded page 131
Turn digital point on/off (on dif- | 1. Configure Digital Events - Expanded—set Scratch Pad bit
. ; . . page 131
ferent 1/O unit) 2. (Email message only) Configure Email
) ) . page 100
. o OR (Streaming only) Configure Streaming ace 104
If digital point is on/off Log data (SNMP only) Configure SNMP P ag - 96
OR 3. (Except data logging) Configure Event Messages—send pag
Copy memory map data message or data a0e 92
OR (Data logging) Configure Data Logging and configure page 87
Send message (stream, e-mail, Email (optional) pa ge 100
serial, or SNMP trap). pag
Tum digital point an/off (on 1. Configure Alarm Events (high alarm or low alarm)—set
same I/O unit) Scratch Pad bit page 137
' 2. Configure Digital Events - Expanded—turn on/off point page 131
1. Configure Alarm Events (high alarm or low alarm)—set
) ) Scratch Pad bit
If analog point value (Engi- | Tyrn digital point on/off (on dif- |2. (Optional for a delay) Configure Digital Events - page 137
neering Units) goes above | fgrent I/0 unit) Expanded— use the alarm Scratch Pad bit as the event,
or below a specified value OR set the time delay, and set a Scratch Pad bit after the page 131
o OR Copy memory map data delay page 100
If d'g_'t_al counter reaches a OR 3. (Email message only) Configure Email page 104
specified value Log data (Streaming only) Configure Streaming page 96
OR (SNMP only) Configure SNMP
Send message (stream, email, |4. (Except data logging) Configure Event Messages—send page 92
serial, or SNMP trap). message or data based on alarm bit or delay bit page 87
(Data logging) Configure Data Logging based on alarm bit | page 100
or delay bit and configure Email (optional)
Turn digital point on/off (on 1. Conflgure Alarm Events (deviation alarm)—set Scratch
same 1/O unit) Pad bit page 137
2. Configure Digital Events - Expanded—turn on/off point page 131
1. Configure Alarm Events (deviation alarm)—set Scratch
- . . Pad bit
Turn digital point on/off (on dif- . ) - age 137
If analog point value (Engi- | ferent I?O ur?it) ( 2. (Optional for a delay) Configure Digital Events - Pag
neering Units) or quadrature OR Expanded— set time delay and set a Scratch Pad bit after page 131
counter goes outside an Copy memory map data the delay . _ page 100
allowable range 3. (Email message only) Configure Email page 104
Loa data (Streaming only) Configure Streaming a0e 96
9 (SNMP only) Configure SNMP pag
OR . )
. | 4. (Except data logging) Configure Event Messages—send
Send message (stream, email, . . . page 92
. message or data immediately or based on delay bit
serial, or SNMP trap). . ) L . page 87
(Data logging) Configure Data Logging immediately or page 100
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Event Reaction Configuration Steps See
Turn digital point on/off (on 1. Configure Serial Events—set Scratch Pad bit page 140
same |/O unit) 2. Configure Digital Events - Expanded—turn on/off point page 131
1. Configure Serial Events—set Scratch Pad bit
2. (Optional for a delay) Configure Digital Events - page 140
Expanded— set time delay and set a Scratch Pad bit after
Send SNMP trap the delay page 131
3. Configure SNMP page 96
4. Configure Event Messages—send trap immediately or page 92
based on delay bit
If a specific string is Send one-time email 1. Conf!gure Serigl Events—send email page 140
received by a serial module 2. Configure Email
Turn digital point on/off (on dif- 1 Conflgure SliEl Events—s.et Scr?t‘?h Pad bit page 140
. 2. (Optional for a delay) Configure Digital Events -
ferent 1/O unit) A .
OR Expanded— set time delay and set a Scratch Pad bit after page 131
Copy memory map data the delay age 100
Py fy map 3. (Email message only) Configure Email pag
OR ) ) . page 104
(Streaming only) Configure Streaming
Log data - )
OR 4. (Except data logging) Configure Event Messages—send —
. message or data immediately or based on delay bit
SO MESSEEE (EIEE, S, (Data logging) Configure Data Logging immediately or e
or multiple emails) 99ing 9 99ing Y page 100

based on delay bit and configure Email (optional)

The following flowchart summarizes Alarm and Serial event and reaction configuration.

Configure Alarm Event or
Serial Event details. >
Reaction is Scratch Pad bit.

v

Should reaction
occur immediately?

No

Configure Event Message

Yes | (If used) Configure or Data Logging.
»| Email, Streaming, » Eventis Alarm or Serial
or SNMP. Scratch Pad bit, or delay

Scratch Pad bit.

A

Configure Digital Events — Expanded.
Trigger is Alarm or Serial Scratch Pad bit.
Set delay time.

Set a new Scratch Pad bit as the reaction.

CONFIGURING DIGITAL EVENTS AND REACTIONS

In a digital event, the I/O unit monitors one or more inputs, outputs, and Scratch Pad bits for a match to a
specific pattern (the event). When the pattern is matched, the I/O unit reacts in a predetermined way. The
reaction can turn digital points on or off and can also set bits in the Scratch Pad. You can configure up to 512
digital events and reactions for SNAP PAC controllers and brains.

Digital event/reactions can be as simple as turning on a light (reaction) when a door opens (event). They can

also be very complex, depending on your needs. For example, suppose you need to monitor a critical group of
switches. If switches 1,2, and 3 are all off at once, you want to turn on an emergency light and sound an alarm.
You can set up a digital event for the state of the three switches, and a reaction that automatically turns on the

emergency light and alarm.

In addition to digital states, events can include alarm or other conditions noted in the Scratch Pad. For
instance, to regulate the temperature of a room, you might set up an alarm event that turns on a bit in the
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Scratch Pad when the temperature reaches 78° F (see “Configuring Alarms and Reactions”on page 137). Then
you would set up a digital event/reaction to turn on a fan when that Scratch Pad bit is on.

NOTE: Ifyou want to turn on or off digital points that are located on a different /0 unit, you can do so by using the
memory map copying feature. See “Copying Memory Map Data” on page 109 for details.

Digital Point and Scratch Pad Masks

Both events and reactions are in the form of a mask. Digital point masks represent 64 possible digital states;
you choose whether these are point states or on-latch or off-latch states. Scratch Pad masks represent
whatever you decide each bit should be.

For each digital event/reaction, you set up two to eight masks: up to four for the event and up to four for the
reaction.

For the event: The table below shows possible triggers for the event, in the form of four masks. You can
configure only Trigger #1, only Trigger #2, or both. If you configure both, both must be true for the event to be
true. Choose the trigger(s) you want to use; then set up the masks.

Trigger #1 Trigger #2

On mask Off mask On mask Off mask
Digital Point State Digital Point State Digital Point State Digital Point State
Digital Point On Latch Digital Point On Latch Digital Point On Latch Digital Point On Latch
Digital Point Off Latch Digital Point Off Latch Digital Point Off Latch Digital Point Off Latch
HDD Point State HDD Point State HDD Point State HDD Point State
HDD Point On Latch HDD Point On Latch HDD Point On Latch HDD Point On Latch
HDD Point Off Latch HDD Point Off Latch HDD Point Off Latch HDD Point Off Latch
Scratch Pad Bits Scratch Pad Bits Scratch Pad Bits Scratch Pad Bits
Scratch Pad Integer 64 Scratch Pad Integer 64 Scratch Pad Integer 64 Scratch Pad Integer 64

For the reaction: This table shows possible reactions, again in the form of four masks. You can configure
only Reaction #1, only Reaction #2, or both. When the event occurs, all configured reactions will take place.
Choose the reaction(s) you want to occur, and then set up the masks.

Reaction #1 Reaction #2

On mask Off mask On mask Off mask
Digital Point States Digital Point States Digital Point States Digital Point States
Clear Digital Point On/Off Clear Digital Point On/Off Clear Digital Point On/Off Clear Digital Point On/Off
Latches Latches Latches Latches
HDD Point States HDD Point States HDD Point States HDD Point States
Clear HDD Point On/Off Latches Clear HDD Point On/Off Latches | Clear HDD Point On/Off Latches Clear HDD Point On/Off Latches
Scratch Pad Bits Scratch Pad Bits Scratch Pad Bits Scratch Pad Bits
Scratch Pad Integer 64 Scratch Pad Integer 64 Scratch Pad Integer 64 Scratch Pad Integer 64

NOTE: Trigger #1 does NOT control Reaction #1, Trigger #2 does not control Reaction #2. Instead, all the masks work
as a group. All the event masks must be a match for the I/O unit to set the reaction(s), and if the event occurs, any
and all reactions will be set. Ifit doesn’t matter whether a specific point or bit is on or off, leave its value at zero in both
the on mask and the off mask.

When you configure events and reactions, the masks are in hex notation. If you are setting up a Digital On
mask for points 0-7, for example, you might do so as follows:

Module position: 1 0
Point number:| 3 2 1 0 3 2 1 0
State:{ On | — | On | On | - - — | On

Binary notation:| 1 0 1 1 0 0 0 1

132 PAC Manager User's Guide



CHAPTER 4: SETTING UP EVENTS AND REACTIONS

Hex notation: B 1

For more information on mask data format, see page 196. See the following pages for a step-by-step example
to set up event/reactions.

You can also configure the 1/0 unit to send a message as a reaction to digital events. See page 92.

How Digital Events Trigger Reactions

Reactions to digital events can be level-triggered (occur continuously) or edge-triggered (occur once). The I/0
unit continually checks the digital state to see if it matches the event, and the I/O unit sends the reaction as
soon as the state matches the event. If you configure the reaction to occur continuously, the I/0 unit
continues to send the reaction until the state changes. If you configure it to occur once, the reaction is sent
only once.

In either case, however, if the state changes so that it no longer matches the event, the I/0 unit does NOT
reverse the reaction.

Example: Digital Event/Reaction

For example, suppose you have set up an event/reaction to turn on a light when a door is open. As soon as the
event occurs (the door opens), the I/0 unit sends the reaction (turn on the light).

When the door is shut, the I/0 unit stops turning on the light, but it does NOT turn the light off. To turn off the
light when the door is shut, you need to set up a second event/reaction.

Suppose the input for the door’s status is on point 0 on the module in position 0, and the output for the light
is on point T on the module in position 1. Here are the two event/reactions to turn on the light when the door
is open, and turn off the light when the door is shut:

Event #0: IF|Mod 0 Pt 0 (Door) is OFF (Open)
Reaction #0: THEN | Turn Mod 1 Pt 1 (Light) ON

Event #1: IF|Mod 0 Pt O (Door) is ON (Closed)
Reaction #1: THEN | Turn Mod 1 Pt 1 (Light) OFF

Since this example is a simple one-to-one correspondence, it is pretty easy to set up.
1. If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)
2. (lickthe Open button L& | or choose File > Open.
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3. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

5] PAC Manager - Main_Process — O X
File Edit Tocols Wiew Help

Dl *nie @) 6l el

= e~
-1 Main_Process
=W /0 Units

-2 Line_1

-2 Preprocess

Ready [ N2

4. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up digital events
and choose Configure from the pop-up menu.

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

1/O Points... |

PID Loops... |

Modules >|
__ Evens —vf— Fvents
button

=== 0

Coss | Hep |

5. For processors with firmware 8.1 or higher, click the Events button and choose Digital Events - Expanded
from the pop-up menu.

If your processor has firmware 8.0 or lower, expanded digital events are not available; choose Digital
Events - Old. Choices are more limited with older firmware; see tables on page 73.
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IMPORTANT: If you configured digital events in a version of PAC Manager prior to 8.1, you will find them in
Digital Events - Old. If you configured timed events in a PAC Manager version prior to 8.1, you'll see them here in
Digital Events - Expanded.

Configure Digital Events - Expanded *
g g p

Event

Mumber: |0 | [ Used

0xFFFF FOD4 0000
DxFFFF FOD4 0008
DxFFFF FOD4 D044
0xFFFF FOD4 0010

ON Mask
OFF Mask

IUse which data for trigger #27
ON Mask

Address | Description | Value |
EVEMT

OxFFFF FOD4 004C Event Enable /Disable Enabled |

OxFFFF FOD4 0044 IUse which data for trigger #17 Digital Point State =1

0% 00000000 00000000
0% 00000000 00000000
Digital Point State =1
0% 00000000 00000000

0xFFFF FOD4 0018 OFF Mask Ox 00000000 00000000
OxFFFF FOD4 0040 Length of Delay Before Reaction (msec.) 0
REACTION
0xFFFF FOD4 0044 Reaction Occurs Continuously j
OxFFFF FOD4 0044 IUse which data for reaction #17 Digital Point State =1
0xFFFF FOD4 0020 0N Mask Ox 00000000 00000000
0xFFFF FOD4 0023 OFF Mask Ox 00000000 00000000
OxFFFF FOD4 0044 IUse which data for reaction #27 Digital Point State =1
0xFFFF FOD4 0030 0N Mask Ox 00000000 00000000
0xFFFF FOD4 0033 OFF Mask Ox 00000000 00000000
oK | Cancel

In the drop-down list, choose the lowest unused Event Number. Click to place a check mark in the Used
box.

NOTE: To reduce scanning time, the I/O unit stops scanning digital events when it reaches an unused event.
Make sure you use event numbers in order, starting with the lowest.

Configure the Event by clicking in the Value column and entering a value or choosing from the
drop-down list.

a. Choose Enabled.
b. Choose which digital data to use as the trigger; in this example it is Digital Point State.
c. Leave the Digital ON mask all zeros. Enter the Digital OFF mask for the open door.

Remember that the masks are in hex notation. Here’s how you might figure out the Digital ON mask
to turn on the light:

Module position: 15 — > 1 0
Digital point:| 3 | 2 | 1 0| —p | 3| 2 1 03|21 0
State:| - | —- | - | - | —p | - | - |On| - | - | - | - | -
Binary notation:| 0 0 0 0| —p 0 0 1 0 0 0 0 0
Hex notation: 0 — 2 0

You don't need to enter anything for Trigger #2, because the open door is the only dependency for
this event.

d. Ifyouwant adelay between the event and the reaction, enter the delay in milliseconds.
Configure the Reaction.
a. Choose whether the reaction should occur once or continuously; for this example, it's continuously.
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b. Choose the digital data and/or Scratch Pad bits to use for the reaction, and enter the masks.
Here’s how the Event and Reaction sections might appear for the door/light example.

=5 Configure Digital Events - Expanded

Event

Number: |0 v| ¥ Used

*

OxFFFF FOD4 0040

OxFFFF FOD4 0044
OxFFFF FOD4 0044
OxFFFF FOD4 0020
OxFFFF FOD4 0028
OxFFFF FOD4 0044
OxFFFF FOD4 0030
OxFFFF FOD4 0033

o]

Length of Delay Before Reaction {msec.)

REACTICM
Reaction Occurs
se which data for reaction £17

i}

Continuously
Digital Point State

Address | Description | Value |

EVENT
OxFFFF FOD4 004C Event Enable Disable Enabled = ..
OxFFFF FOD4 0044 Use whi iager £17 icital Pai = Event: Digital OFF
0xFFFF FOD4 0000 COM Mask 03 00000000 00000000 mask— door on
DxFFFF FOD4 0008 OFF Mask 03 00000000 00000001 mod 0 pt 0 s
0xFFFF FOD4 0044 Use which data for trigger £27 Digital Point State
OxFFFF FOD4 0010 ON Mask 03 00000000 00000000 open.
OxFFFF FOD4 0013 OFF Mask O3 00000000 00000000

=

OM Mask
OFF Mask

O 00000000 00000020
Ox 00000000 00000000

j— Reaction: Digital

Use which data for reaction #27
OM Mask
OFF Mask

Cancel |

Digital Point State
O 00000000 00000000
Ox 00000000 00000000

ON mask—turn
on light at mod 1
pt1.

-

9. Now choose Event Number 1 from the drop-down list and click Used. In the Event and Reaction sections,
enter the Digital ON mask for the closed door and the Digital OFF mask to turn off the light.

= Configure Digital Events - Expanded

Event

Number: |1 v| [V Used

¥

0xFFFF FOD4 00CO

0xFFFF FOD4 00C4
0xFFFF FOD4 00C4
OxFFFF FOD4 00AD
0xFFFF FOD4 00AB
0xFFFF FOD4 00C4
OxFFFF FOD4 00B0
OxFFFF FOD4 00BS

o]

Length of Delay Before Reaction {msec.)

REACTICON
Reaction Occurs
Use whi jon 17
OM Mask
OFF Mask

O 00000000 00000000
[u}

Continuously

O 00000000 00000000
Ox 00000000 00000020

Address | Description Value |

EVENT
OxFFFF FOD4 00CC  Ewvent Enable/Disable Enabled = .
OxFFFF FOD4 00C4  Use which data for trigger #12 Digitl Point State | Event: Digital ON
0xFFFF FOD4 0080 OM Mask O 00000000 Q0000001 mask— door on
OXFFFF FOD4 0088 OFF Mask 03 00000000 00000000 mod 0 pt 0s
0xFFFF FOD4 00C4 Use which data for frigger £27 Digital Point State closed
0xFFFF FOD4 0090 OM Mask (O 00000000 Q0000000 :
0xFFFF FOD4 0093 CFF Mask

=

Reaction: Digital

Use which data for reaction %22
OM Mask
OFF Mask

Cancel

10. Click OK.

Both event/reactions are configured.
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11. Configure other event/reactions, or return to the PAC Manager main window and click the Save button
[=l | to save the configuration file.

CONFIGURING ALARMS AND REACTIONS

A reaction can also be set up as a response to an alarm. You can configure alarms for analog points or digital
counters. For example, you could monitor the pressure in a tank and set up an alarm if it rises above a certain
level, or you could trigger an alarm when a specific number of boxes on a conveyor have passed through a
beam sensor. For each alarm, you configure a suitable reaction.

For analog points, alarms are based on the analog input value. For digital points, alarms are based on the
counter value (applies to points on 4-channel digital modules only). For each point, you can configure any or
all of the following alarms:

«  Deviation alarm—sets a range on either side of the current value that is acceptable; beyond that range,
the reaction occurs. For example, suppose you are monitoring temperature. If the current value is 80 and
you set a deviation limit of 6, the reaction will not occur unless the value drops below 74 or rises above
86.

If you have an Alarm Event that is configured as a deviation alarm, in order to capture that an alarm
occurred you need to set a scratch pad bit (such as bit 0) as the reaction of the alarm event. Also, you
need to create another event, such as a Digital Event - Expanded, that triggers based on that scratch pad
bit. The Digital Event would set a different scratch pad bit (such as bit 1) to be used for other logic or
events. For example, digital event 0 sees set bit 0 and sets bit 1. Now bit one remains set until cleared. Set
bit 1 can be used to start a timer that clears bit 1 when it expires. Bit 1 could also trigger an event
message that requires acknowledgment.

NOTE: When a reaction occurs, the deviation limit stays the same, but the value that set off the reaction
becomes the new deviation value. In this example, if the temperature drops to 73, the reaction occurs. Six is still
the deviation limit, but now 73 is the deviation value; another reaction will not occur unless the value drops
below 67 or rises above 79.

«  High-limit alarm—sets a fixed upper limit. If the analog value or counter is higher than the high limit,
the reaction occurs.

«  Low-limit alarm—sets a fixed lower limit. If the analog value or counter is lower than the low limit, the
reaction occurs.

How Alarms Trigger Reactions

Reactions to alarms are edge-triggered, not level-triggered, and when the alarm state changes, the reaction is
automatically reversed. The I/0 unit sends the reaction just once, as soon as the alarm occurs (at the “edge” of
the alarm). The I/0 unit does not send the reaction again until the alarm occurs again. If the alarm stops,
however, the I/0 unit reverses the reaction.

For example, suppose you set up a high-limit alarm that turns on a Scratch Pad bit that will turn on a fan if the
temperature goes over 70°. As soon as the alarm state occurs (the temperature goes over 70°), the I/O unit
sends the reaction (turns on the bit to turn on the fan). If the temperature remains above 70°, the I/0 unit does
not continue to turn on the fan bit; the bit just stays on.

When the temperature falls back below the high limit (70° minus whatever deadband you have set), the I/0O
unit automatically reverses the reaction by turning the Scratch Pad bit off. (To turn the fan off, you would have
to set up a reaction for the off bit, turning the fan off)

Notice that the reaction and its reversal are absolute; they do not depend on the pre-alarm condition. For
example, if the bit to turn on the fan was already on at the time the temperature rose above 70°, the reaction
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would turn the bit on even though it was already on. When the temperature fell back below 70°, the 1/0 unit
would not return the fan bit to its pre-alarm condition (on); it would turn the bit off.

Example: Alarms Event/Reaction

1. Inthe PAC Manager main window, with a configuration file open, right-click the name of the /O unit on
which you want to set up alarm events. Choose Configure from the pop-up menu.

= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |

PID Loops... |

Modules 3 |
Events Events
button

Communications » |

Others 3 |

Close I Help
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Click the Events button and choose Alarm Events from the pop-up menu.

== Configure Alarm Events d
Alarm
Mumber: |0 | [ Used

Address | Description | Value |
DEVIATIOM ALARM

0xFFFF F110 0000 In Alarm State? MNfA

0xFFFF F110 0004 Enable Disable Alarm Disabled k|

0xFFFF F110 0008 Middle of deviation range 0.000000

0xFFFF F110 000C Deviation Amount (Scaled Units) 0.000000

0xFFFF F110 0010 Scratch Pad Bits ON Ox Q0000000 20000000

0xFFFF F110 0018 Scratch Pad Bits OFF Ox Q0000000 20000000
HIGH ALARM

0xFFFF F110 0020 In Alarm State? MNfA

0xFFFF F110 0024 Enable Disable Alarm Disabled k|

0xFFFF F110 0028 Limit (Scaled Units) 0.000000

0xFFFF F110 002C Limit Deadband (Scaled Units) 0.000000

0xFFFF F110 0030 Scratch Pad Bits ON Ox Q0000000 20000000

0xFFFF F110 0038 Scratch Pad Bits OFF Ox Q0000000 20000000
LOW ALARM

0xFFFF F110 0040 In Alarm State? MNfA

0xFFFF F110 0044 Enable Disable Alarm Disabled k|

0xFFFF F110 0048 Limit (Scaled Units) 0.000000

0xFFFF F110 004C Limit Deadband (Scaled Units) 0.000000

0xFFFF F110 0050 Scratch Pad Bits ON Ox Q0000000 20000000

0xFFFF F110 0058 Scratch Pad Bits OFF Ox Q0000000 20000000
ADVAMNCED VALUE SELECTION

0xFFFF F110 0060 Address of value to check Ox FOAQDDOD k|

OxFFFF F110 0064 Iz Value a Float? Yes hd
CURRENT VALLUE

0xFFFF FOAD 0000

Value being alarmed

x|

Cancel |

In the drop-down list, choose the Alarm Number you want to use (by default, it is the same number as
the point the alarm will monitor). Click Used.

The alarm number can be any unused number, but it is best to use the point number, since by default
that point's memory map address and value are shown in the Value Being Alarmed field.

If you need to set two or more alarms on the same point, however, you can do so. For additional alarms,
choose a different alarm number, configure the alarm, and enter the memory map address for the point
in the Advanced Value Selection section. (A complete list of memory map addresses is in the OptoMMP
Protocol Guide, form 1465.)

Find the section for the type of alarm you want to use (deviation, high, or low). In the Value column, click
the Enable/Disable Alarm cell and choose Enabled from the drop-down list. Click in other cells to set
deviation or alarm limits. For high and low alarms, also set the deadband for the limit.

A deadband is an allowable variation in the limit to account for signal noise. If the signal fluctuates
slightly, the deadband limit keeps the I/0 unit from sending out another alarm.

For each alarm, also configure the reaction in two parts:
- Scratch Pad bits that should be turned on

- Scratch Pad bits that should be turned off

See "The Scratch Pad” on page 127.

(Optional) If you are setting two or more alarms on the same point, use the Advanced Value Selection
area to enter the memory map address for the point to monitor, and indicate whether the value on that
point is a float.

Repeat from step 3 for additional alarms. When you have finished configuring alarms, click OK.
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8. (lick the Save button @ to save the configuration file.

CONFIGURING SERIAL OR WIEGAND EVENTS AND REACTIONS

If you are using Opto 22 serial communication modules—RS-232, RS-485/422, or Wiegand—uwith SNAP PAC
/0 units, you can configure a serial or Wiegand event to send a serial message, to send an SNMP trap, or to
turn bits in the Scratch Pad on or off when a specific string is received from one or more modules.

Before you configure serial events and reactions, make sure you have configured the serial modules (page 46).

1. Inthe PAC Manager main window, with a configuration file open, right-click the name of the I/O unit on
which you want to set up serial or Wiegand events and choose Configure from the pop-up menu.

= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |

PID Loops... |

Modules 3 |
Events Events
button

ScratchPad  » |

Communications » |

Others 3 |

Close I Help |

2. (lick the Events button and choose Serial Events from the pop-up menu, or if you are configuring events
for a Wiegand serial communication module, choose Wiegand Events.

é Cenfigure Serial Events d
—Event
Mumber: I[J vl [~ Used

Address | Description | Value |
EVENT

0xFFFF F154 0000 Serial Ports Mask Ox Q0000000

0xFFFF F154 0010 Pattern String (wildcards allowed - e.q. *,7)
REACTION

0xFFFF F154 0033 Resulting String (plug-ins allowed)

0xFFFF F154 000C SMMP Trap Period (seconds) 0

0xFFFF F154 0008 SMMP Specific Trap Type 0

OxFFFF F154 0EB0  SNMP Trap Priority High =

0xFFFF F154 OF00 Disable SNMP Trap Mo Ea|

0xFFFF F154 0050 Scratch Pad Bits ON Ox Q0000000 20000000

0xFFFF F154 0068 Scratch Pad Bits OFF Ox Q0000000 20000000

0xFFFF F154 0070 Enable E-mail Message Disabled k|

oK I Cancel
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The example above shows the Configure Serial Events dialog box; the Wiegand Events dialog box is
similar.

In the drop-down list, choose the lowest unused Event Number. Click Used.

NOTE: To reduce scanning time, the /O unit stops scanning serial events when it reaches an unused event. Make
sure you use event numbers in order, starting with the lowest.

In the Event section, enter a mask in hex notation indicating the serial ports to monitor.

The I/0 unit monitors all ports set as “on”bits in the mask (on = 1; off = 0). If the string is received from
any of those serial ports, the event triggers the reaction. For example, suppose you have serial modules in
positions 1 and 2 on the rack. (Other kinds of modules are in positions 0 and 3.) The following table
shows how you might figure out the mask to monitor three of these serial ports:

Module position: | ¢— 3 2 1 0
Serial port: - - B A B A _ _
Default TCP port number: - — | 22505|22504 | 22503 | 22502 | - -
Monitor? (Y or N): - - Y N Y Y - -
Mask (binary notation): 0 0 1 0 1 1 0 0
Mask (hex notation): 2 C

The complete hex mask you would enter to monitor these ports is: 0000002C.

Enter the pattern string the event should match.

The string is limited to 40 characters. Wildcards (* and ?) can be used.

In the Reaction section, do any or all of the following:

a. Tosend textinan SNMP trap or a one-time email message, complete the Resulting string field.

If you send a string, it is limited to 126 characters. You can place data from the serial module or the
/0 unit's memory map into the string by using any or all of the following plugins:

$! str_ Includes the pattern string in the resulting string.
$! port Shows which serial port sent the pattern string.
SIX YYYYYYYY Includes data from a memory map address. See “Using Plugins”on

page 95 for more information.

For example, a resulting string that includes the pattern string, the serial port that sent it, and the
text Overload would look like this:

$! str $! port Overload
b. To send an SNMP trap, also enter how often in seconds to send the trap (use zero to send it only
once), and enter the trap type. Remember to configure email (page 100).

Trap types are determined by your SNMP management system.

c. Tosend a one-time email notification, also enable E-mail Message. Make sure to configure email
(page 100).
To send multiple emails, don't enable email here. Instead, turn on a Scratch Pad bit (step e) and set
up the email when you configure event messages (page 92).

d. Tosend aserial message out a serial port, don't put the message here. Instead, turn on a Scratch Pad
bit (step e) and set up the serial message when you configure event messages (page 92).

e. Toset Scratch Pad bits, enter masks for the bits to turn on and the bits to turn off when the serial
event occurs.

Repeat from step 3 for other serial events and reactions. When you have finished configuring serial
events and reactions, click OK.

Click the Save button ﬂ to save the configuration file.
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If you are using PAC Control or PAC Manager 9.0 or higher, configure event messages in the

142

configuration file as shown on page 92.

If you are not using PAC Control or are using a PAC Manager version less than 9.0, you cannot
configure event messages in a configuration file. Instead, use PAC Manager's Inspect mode and follow the
steps below. Note that event messages are not available on SB brains, since messaging requires an Ethernet

connection.

1. Inthe PAC Manager main window, click the Inspect button Q
—  Ifyou have not used the Inspect window before, the window will not show any data. Select your

controller from the drop-down list.

- If you have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.

= Inspect Opto 22 Device

Device Name: | 10.192.50.21

Status Read
Status Read
Status Write

Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density
System 3
ScratchPad  »
Data Log 3

Events 3
Communications
Other 3

Close |

FID

3

Status:

j Options »

Status Read area last read at 07/05/16 12:03:48

hDDRESS DESCRIFTION VALUE ~ Refresh |

0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}

0xFFFF FO30 0008 Busy Flag a

0xFFFF F030 0018 Loader Version RE6.la

0xFFFF FO30 0000 Memory Map Version 1

0xFFFF F030 0230 Current Boot Device Flash Memory

0xFFFF F030 001C Firmware Version R59.5a

0xFFFF FO30 00R0 Firmware Version Date 07/05/2016

0xFFFF F030 00BO Firmware Version Time 07:58:52

0xFFFF FO30 0020 Unit Type 0x0000007C

0xFFFF FO30 0080 Unit Description SNAP-FAC-51

0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 11

0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 22

0xFFFF FO030 002§ I/0 Unit Hardware Revision (Year) 2005

0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a

0xFFFF FO30 0028 Installed Ram 33554432
ETHERENET 1 Interface

0xFFFF FO30 002E MAC Rddress 00-A0-3D-00-D9-0B

0xFFFF FO30 0034 IF Address 10.192.50.21

0xFFFF FO30 0038 Subnet Mask 255.255.182.0

0xFFFF FO30 003C Gateway 10.192.51.50

0xFFFF FO30 0040 DNS 10.192.60.91
ETHERENET 2 Interface W

EY | ™ AutoRefresh | 15000  msec

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

= In

Status Rga

Status Wiits

Wireless LAN

spect Opto 22 Device

Cookie Controller
Cookie Controller
EngineRm

Coil Portable

Chamber 1

Chamber 2

Paint Config ol portable

(CRIFTION

rerup Clea
¥y Flag 1

der Versij

= Cookie Controller ory Map Vi
HD@E' B EngineRm mware Verd
Digital Point S2fPAC mware Ver,

1 i T | i
‘fJxFFFF FO30 00BO Firmware Very
A SF S e N P e

In the Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down

list).

Click Events and choose Event Messages from the submenu.

| Inspect Opto 22 Device

Device Name: | 10.182.55.67

Event Message
Status Read

Status Write |

j Options »

Event Message Mumber: |0 -

Status:

Event Message area last read at 07/05/16 13:31:00

Wireless LAN  »

Point Config
Digital Bank
Digital Paint
Analog Bank
Analog Point
High Density

System 3
Scratch Pad  #
Data Log 3
PID 4
Events 3
Communications ¥
Other 3

Close |

Address | Description Value |
MESSAGE
0xFFFF F120 0040 Message Text
0xFFFF F120 9000 Most Recent Message Sent
0xFFFF F120 0000 State Inactive a|
0xFFFF F120 0004 Scratch Pad Trigger ON O 00000000 00000000
0xFFFF F120 000C Scratch Pad Trigger OFF O 00000000 00000000
STREAMING
0xFFFF F120 0014 Enable Stream Packet Disabled =1
0xFFFF F120 0018 Stream Period (seconds) ]
E-MAIL
0xFFFF F120 001C Enable E-mail Message Disabled =1
0xFFFF F120 0020 E-mail Period (seconds) 0
SERIAL MODULE
0xFFFF F120 0033 Enable Serial Module Message Disabled R
0xFFFF F120 003C Serial Ports Mask O 00000000
SNMP
OxFFFF F120 0024 Enable SMMP Trap Disabled R
0xFFFF F120 0023 Trap Period (seconds) 0
0xFFFF F120 002C Trap Type 1]
OxFFFFF120 0030  Priority High =1

0xFFFF F120 3000
0xFFFF F120 8004
0xFFFF F120 8008
0xFFFF F120 800C

Help |

MEMMAP COPY DESTINATION
MemMap Address
IP Address of Destination
Port
Period (milliseconds)

O 00000000
0.0.0.0

i}

i}

Refresh |
Apply

™ Auto Refresh | 15000  msec

From the drop-down list, choose the lowest unused message number.
Unused message numbers have no asterisk.

For an email or serial message, or optionally for an SNMP message, enter the message text.

Message text is not sent in the streaming packet. Message text is limited to 127 characters. You can place
data from the I/O unit’s memory map into the message by using a plugin (see page 95). If you are
sending a serial message, make sure the text is formatted so the serial device that receives it will

understand it.
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10.

11.

12.
13.
14.

15.

Enter two masks indicating the Scratch Pad on and off bits that should trigger the message.
For help in figuring out the masks, see “Digital Point and Scratch Pad Masks”on page 132.

Streaming section: To send a stream of data as the message, choose Enabled from the drop-down list.
Enter how often in seconds to send the stream (0 sends it only once).

For information on streaming, see page 96.

E-mail section: To send an email message, choose Enabled from the drop-down list. Enter how often in
seconds to send the email (0 sends it only once).

Serial Module section: To send a message through a serial module to a serial device, choose Enabled from
the drop-down list. Enter a mask representing the modules and ports to receive the message.

Information in “Configuring Serial or Wiegand Events and Reactions”on page 140 may be helpful.

SNMP section: To send an SNMP trap as the message, change Disabled to Enabled. Enter how often to
send the trap (0 sends it only once). Also enter the trap type (determined by your SNMP management
software). If you are using SNMP with outgoing PPP and want the trap stored in the I/0 unit until the next
communication, set Priority to Low. If you want the I/O unit to immediately dial out and send the trap, set
Priority to High.

For information on SNMP, see page 96.

NOTE: SNMP messages must be acknowledged. You can do so in your application or in PAC Manager's Inspect
window: in the Message section, change the State to Acknowledge and click Apply.

Memmap Copy Destination section: To copy memory map data, complete this section using information
from "Copying Memory Map Data”on page 109.

When all fields are correct, click Apply.
Repeat from step 4 to configure additional event messages.
For each type of message you configure, make sure you also set up basic configuration:

Serial: See page 46
SNMP: See page 96
Email: See page 100
Streaming: See page 104

When you have finished configuring all event messages and any additional configuration required for
them, in the PAC Manager Inspect window, make sure the IP address shown is the correct one. Then click
the Status Write button in the upper-left part of the window.
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16. In the Operation Commands list, highlight Store configuration to flash.

= Inspect Opto 22 Device

Device Mame: I 10.192.50.11 ;I Options # | Status: | Status Write area last read at 05/02/16 16:30:29
~Status Write
Status Read |
Status Write Address | Description | Valug
OxFFFF FO38 0004 Always BootP /[DHCP On Powerup Mo |
Wircless LAN > OxFFFF FO38 0008 Degrees FfC Degrees F =1 Apply |
| OxFFFF FO33 0010 Comm Watchdog Time (msec), 0 = Disable 0
0xFFFF FO38 0014  TCP Minimum Retransmission Timeout {(msec) 250
Point Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
OxFFFF FO33 001C  TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO33 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
= s OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Digital Point OxFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bank OxFFFF FO38 0298  Out Of Range Value (16-Bit) -32768.000
0xFFFF FO38 02B0  Out Of Range Value (32-Bit) -21474336438.000
0xFFFF FO38 0054  Scanner Flaas 0x 00000000

Analog Point

High Density
System 3
ScratchPad
Data Log 3
PID 3
Events 3
Communications ¥
Other 3

Operation

OptoMMP Device

~ Send Command |

Restart Device from powerup
Store configuration to flash
Erase configuration from flash k
Reset to defaults and Restart Device

micraSD
Store configuration and IP settings to microSD
Erase configuration and IP settings from microSC.
Erase firmware from microSD
Erase strategy from microSD

Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration W

™ Auto Refresh |15000 msec

17. Click Send Command.
The configuration data is stored to flash memory and a Success message appears.

IMPORTANT: For the following configurations, you must also restart the unit for configuration to take effect:

Changes in TCP port for serial modules SNMP configuration
Email configuration PPP configuration
Data logging interval

18. If you have configured any of these items, in the Operation Commands list, highlight Restart /O Unit
from powerup. Click Send Command.

The I/0 unit is restarted and a success message appears.
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5: Reading and Writing to Specific
Devices

INTRODUCTION

This chapter shows you how to read and write to a SNAP PAC controller or I/O unit directly by using PAC
Manager's Inspect window. In addition to reading and writing specific values, you can configure points and
functions using the steps in this chapter. However, these configurations cannot be saved to a
configuration file.

Because all reads and writes using the steps in this chapter are sent directly to the controller or I/O unit, the
device you are reading from or writing to must be on the same network as your PC or laptop computer. For a
SNAP PAC SB brain, you can read or write to the brain through a SNAP PAC S-series controller, or you can
connect the computer directly to the brain using a PCI-AC48 adapter card and a serial cable. For more
information on these connections, see the SNAP PAC Brains User's Guide (form 1690).

CAUTION—Ifyou are using PAC Control: When you read and write to specific devices using the instructions in this
chapter, the reads and writes occur independently of PAC Control strategy logic. If you are using PAC Control, you
normally use the flowchart logic in the PAC Control strategy to read and write to the I/O unit. It's not a problem to
read directly, but if you use the instructions in this chapter t to write to an I/O unit, be very careful that your actions
do not conflict with PAC Control logic.

As you use PAC Manager’s Inspect window, you'll notice that the starting memory map address for each item
is shown. This can be a handy way to determine addresses you need for programming or configuration. You
can also highlight an address and right-click it to copy it; then you can paste it where you are using it.

You can also copy and paste part or all of the data you read in the Inspect window. Just highlight the data you
want to copy and use standard Microsoft Windows commands such as Ctrl+C to copy the data, and Ctrl+V
to paste it into a text, email, or other file.

READING BASIC DEVICE INFORMATION

1. If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)

2. Inthe PAC Manager main window, click the Inspect button @ (orin the PAC Manager menu bar, click
Tools > Inspect).

The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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3.

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

=

Device Name: | 10.199.59.99

Status Read
Status Read

Status Write

j Options # Status: | Status Read area last read at 07/05/16 10:34:58
ADDRESS DESCRIFTION VALUE ~ Refresh |

= R 0xFFFF F030
Wireless LAN 0xFFFF FO30
Point Config 0xFFFF F030
— 0xFFFF FO30
EREIE 0xFFFF FO30
Digital Point (Lmaley anEh
0xFFFF F030

Analog Bank 0xFFFF F030
Analog Point 0xFFFF F030
i i 0xFFFF F030
ELIEEE 0XFFEF FO30
R 0xFFFF F030

HEED 0XFFEF FO30
N 0xFFFF F030
0xFFFF F030

Data Log 3

PID * 0xFFFF FO30

0xFFFF F030
iyl 3

0004
0008

0018
00oo
0230
001c
00RO
00BO

00z0
0080
0024
0025
00z2é
024C
002g

00ZE
0034

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
29.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons

and Most Recently Used list
are displayed when you have
six or more devices configured.

Wpto 22 Device

Device Name{ | afslslTel gl =g

Cookie Controller
EngineRm

Coil Portable
SoftPAC

Status R

Status Wiits

Boiler
Chamber 1
. Chamber 2
Point Config g portable

Wireless LAN

(CRIFTION

rerup Clea
¥y Flag 1

der Versij

i |
|

= Cookie Controller ory Map Vi
HD@E' B EngineRm mware Verd
Digital Pc\irxsof-ﬂ)""\C mware Ver:
‘fJxFFFF FO30 00BO Firmware Very

A N, . Py —

i

In the Device Name field, type the name (or IP address) of the controller or I/O unit (or choose it from the

drop-down list). Click Status Read.
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Information from the device is displayed in the window.

¥ Inspect Opto 22 Device

Date and time data was last read

)

Click to update data

_ X

Device Mame: | 10.192.55.67

Status Read

Status Write
Wireless LAN  »

Paint Canfig
Digital Bank
Digital Paint
Analog Bank
Analog Point

High Density

System 3
ScratchPad

Data Log 3

|
o

|

Events 3
Communications ¥

Other »

Close

j Options ¥

Status: | Status Read area last read at 07/05/16 13:30:03 i

Status Read
hDDRESS DESCRIPTION VALUE A Refresh |
0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PFUC Receiwved (0)
O0xFFFF FO30 0008 Buay Flag 1]
0xFFFF F030 0018 Loader Version R5.1c
0xFFFF FO30 0000 Memory Map Veraion 1
0xFFFF FO30 0230 Current Boot Device Flash Memory
OxFFFF F030 001C Firmware Version A9.%a
0xFFFF F030 00R0 Firmware Versicn Date 05/03/2016
0xFFFF F030 00BO Firmware Version Time 15:29:32
0xFFFF FO30 0020 Unit Type 0x0000007R
OxFFFF FO30 0080 Unit Description SNAP-ERC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF FO30 0025 I/0 Unit Hardware Revision (Day) 21
0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
0xFFFF FO30 024C I/0 Coprocessor Firmware Version A0.0a
OxFEFF FO030 0028 Installed Ram 33554432
ETHERNET 1 Interface
0xFFFF FO30 002E MRAC Rddress 00-A0-3D-01-85-9C
0xFEFF FO30 0034 IF Rddress 10.192.55.67
O0xFFFF FO30 0038 Subnet Mask 255.255.192.0
0xFFFF FO30 003C Gateway I.192.51.51
0xFFFF FO30 0040 DNS 10.192.60.31
ETHEENET 2 Interface W
Help | [~ AutoRefresh | 15000  msec

Scroll down to see all of the information. Data is current as of the date and time shown in the Status field
at the top right corner of the window. (Note that date and time are from the computer, not from the I/0
unit.) To update data, click the Refresh button. See the next two pages for help in interpreting data.

Interpreting Status Data

The following table may help you interpret the information you see in the Status Read window. Some items
may not appear, depending on the Opto 22 device you are using. Some of this information can be changed
(see page 152). Much of it is used only for troubleshooting. If you have additional questions about status data,

contact Product Support (see page 4).

The term “device”is used in this table to refer to a SNAP PAC brain or controller.

Description Explanation

Since a powerup clear (PUC) is automatically sent by the device whenever it is turned

Powerup Clear Flag PUC needed

Busy Flag
Loader Version
Memory Map Version

Current Boot Device

on, this value should show PUC Received.

Zero means the device is not busy and can process your requests.

Revision number of the device’s loader. The loader is like a basic input/output system

(BIO

S).

Revision number of the device’s memory map

(PAC-R and PAC-S only) Whether the PAC booted from its Flash memory or from a

microSD card
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Description Explanation

Firmware
Firmware
Firmware

Unit Type

Version
Version Date

Version Time

Unit Description

I/0 Unit Hardware Revision (Month)

I/0 Unit Hardware Revision (Day)

I/O Unit Hardware Revision (Year)

I/O Coprocessor Firmware Version

Installed Ram

Product Serial Number

Address

Baud Rate

Number of Framing Errors

Number of FIFO Overrun Errors

Communications Debug Flag

MAC Add

ress

IP Address
Subnet Mask

Gateway
DNS or N

ame Server

Ethernet 2 MAC Address

Ethernet 2 IP Address
Ethernet 2 Subnet Mask

Ethernet 2 Gateway
Ethernet 2 DNS

Wireless LAN MAC Address

WLAN IP

Address

WLAN Subnet Mask
WLAN Primary Gateway

WLAN Secondary Gateway
WLAN Primary DNS
WLAN Secondary DNS
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Revision number of the device’s firmware, and the date and time of the revision

Hex code indicating the device type.

Part number of the device (brain or controller)

Version date of the device’s hardware

(Applicable to rack-mounted controllers and brains manufactured starting in 2016.)
Revision number of the I/O coprocessor firmware. If the value is 0 (zero) or A0.Oa,
your device does not have an I/O coprocessor.

For more information, see the SNAP PAC I/O Coprocessor Firmware Readme.

Number of bytes of RAM in the device

(SB brains only) Barcoded product number inside the brain
(SB brains only) Current serial address of the brain

(SB brains only) Current baud rate of the brain

(SB brains only) A serial transmission error; normally zero. If it's not zero, verify baud
rate or check for noise on the serial bus.

(SB brains only) Normally zero. Any value other than zero indicates that serial charac-
ters are being dropped.

(SB brains only) A value of 1 indicates that Communication Error Blink Codes are
enabled. See the brain user’s guide for details.

Unique hardware Media Access Control (MAC) identifier for the device, assigned at
the Opto 22 factory. MAC addresses for all Opto 22 devices start with 00-A0-3D.

IP address, subnet mask, and default gateway for the device on the Ethernet network.
You assign these numbers; see page 8.

Not currently used; leave at 0.0.0.0
(SNAP PAC controllers only) Unique hardware Media Access Control (MAC) identifier
for the second Ethernet interface on the device.

(SNAP PAC controllers only) IP address, subnet mask, and default gateway for the
second

Ethernet interface on the device. You assign these numbers; see page 18.

(SNAP PAC controllers only) Not currently used; leave at 0.0.0.0

(Wired+Wireless devices only) Unique hardware Media Access Control (MAC) identi-
fier for the device’s wireless LAN interface.

(Wired+Wireless devices only) IP address, subnet mask, and gateways for the wire-
less LAN interface on the device. You assign these numbers; see page 22.

(Wired+Wireless devices only) Not currently used; leave at 0.0.0.0
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Description Explanation

Always BootP/DHCP On Powerup

Degrees F/C!

Comm Watchdog Time (msec)1

Out of Range Value (16-bit)

Out of Range Value (32-bit)

Scanner Flags

4-Channel Digital Scan Count'

Analog & High Density Dig Scan Count'

Milliseconds Since Powerup

Elapsed Time Since Powerup

TCP Minimum RTO (msec.)

TCP Initial RTO (msec.)

TCP Retransmits

TCP Idle Session Timeout (msec.)
TCP Idle Session Timeout Count
Ethernet Errors: Late Collisions
Ethernet Errors: Excessive Collisions

Ethernet Errors: Others

Smart Modules Present’

PID Loops Supported

A value of 0 (the normal setting) means the device sends a request (a BootP or DHCP
request) for an IP address only if its IP address is 0.0.0.0. A value of 1 means the
device sends a BootP or DHCP request every time it is turned on. See page 8 for more
information.

Whether temperatures on the I/O unit are handled in Fahrenheit or Celsius. Set when
you configure the 1/0O unit (page 31). Celsius is the default.

If the 1/0 unit has a watchdog, the watchdog timeout in milliseconds. Set when you
configure the I/O unit (page 31). Default is 0 (no watchdog).

Only for SNAP PAC analog input modules that return 16-bit values. If a value goes out
of range, this number appears as the value. Default is -32,768. Can be changed; see
page 152.

Only for SNAP PAC analog input modules that return 32-bit values, such as the
SNAP-AIRATE-HFi and SNAP-AIRTD-8U modules. If a value goes out of range, this
number appears as the value. Default is -2147483648. Can be changed; see

page 152.

Shows scanner and control engine options. Value can be any of the following or a
combination of them, in hex. See “Scanner Flags” for more information.

1 = Alarms are being processed in the digital scanner rather than the analog scanner.
2 = Analog/HDD scanner is disabled. (Disables scanning of high-density digital mod-
ules as well as analog modules.)1

4 = Digital scanner is disabled."

8 = (applies to all standalone and on-the-rack controllers) PAC Control engine is
stopped.

1

Shows the number of times the processor (brain or on-the-rack controller) has
scanned the digital points for 4-channel digital modules on the 1/O unit. Can be used
for benchmarking.

Shows the number of times the processor has scanned the analog and high-density
digital module points on the 1/0O unit. Can be used for benchmarking.

Milliseconds since the last time the device was turned on. Value rolls over after
4,294,967,295 ms, which is equal to 49.71 days.

Time since the device was last turned on. Time is shown in the format
days:hh:mm:ss

TCP communication settings; see page 229.

Number of times the device closed the session because it was idle.

Values other than 0 may indicate network problems. See page 231.

Mask in hex showing location of analog, serial, and high-density digital modules on the
rack. Module 15 is in bit position 15; module 0 is in bit position 0. (For help in under-
standing masks, see “Mask Data” on page 196.)

Maximum number of PID loops possible on the device (96 on PAC-R, EB, and SB
brains). See page 63.
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Description Explanation

Digital Modules Supported

Arcnet Reconfigs Detected'

Arcnet Reconfigs Initiated by I/0 Unit’
Arcnet Transmit Attempts Since Powerup1
Arcnet ACKs'

Arcnet Timeouts'

Arcnet Other (node not found, etc.)’

Arcnet Timeout Value (msec.)’

Arcnet Receive Interrupts1

Ethernet MAC Resets Since Powerup

Dig. Output Point Resets Since Powerup1'2

Dig. Interrupt Failures Since Powerup'

Analog & High Density Digital Scanner’

4-Channel Digital Scanner’

Module X - Times Discovered'

Number of 4-channel digital modules supported (0, 8, or 16).

Added in PAC firmware 8.1; older firmware doesn’t include this address. Useful for
SNAP-PAC-R1 and SNAP-PAC-R1-B.

Due to B-series rack limitations, R1-Bs support 4-channel I1/0

modules only in the first 8 rack positions.

R1s with serial numbers below 600,000 support 8 digital modules in the first 8 rack
positions; newer R1s support 16.

Indicates that a smart module has been added, removed, or reset. (ARCNET is used
on the rack for communication between the processor and analog, serial, or high-den-
sity digital modules.) NOTE: If the rack contains only 4-channel digital modules, ignore
this value.

Error on the rack’s ARCNET bus. Not a concern unless it happens frequently.

Refers to the ARCNET bus on the rack. May be useful in troubleshooting communica-
tion to analog, serial, or high-density digital modules.

Caused by EMI, RFI, or other electrical noise.

Related to digital counters. May have missed counts. Contact Opto 22 Product Sup-
port.

(milliseconds per scan) Average length of time the processor takes to scan all analog
and high-density digital points on the rack. Based on the last 100 scans (last 50 scans
for points on high-density digital modules, as they are included in every second scan).
A value of -1 means the scanner is not running.

(milliseconds per scan) Average length of time the processor takes to scan all 4-chan-
nel digital points on the rack, based on the last 100 scans. A value of -1 means the
scanner is not running.

How many times the processor has rediscovered a smart module (analog, serial,
high-density digital). Normal value is zero; values over 1 may indicate that a module is
resetting.

1 Does not apply to SNAP PAC S-series and SoftPAC controllers

Changing Status Data

The following items in the Status Read/Status Write windows can be changed in PAC Manager if the device

supports them.

Always BootP/DHCP on Powerup

Degrees F/C

Comm Watchdog Time

TCP Settings

Digital Feature Scan Interval
Max Analog and High Density Digital Scan Interval
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Out of Range Value (16-bit)

Out of Range Value (32-bit)
Scanner Flags

Domain Name

Strategy Download Method
Turnaround Delay
Communication Error Blink Codes
Ethernet 2 Interface Settings
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1. Inthe PAC Manager main window, click the Inspect button Q .
The Inspect window opens.
If you haven't used the Inspect window before, no data is displayed in the Status Read pane.

2.

If you have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

If you have configured other devices, they are listed in alphabetical order in the drop-down list.

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58
Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh |
= 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
e OxFFFF F030 0008 Buay Flag 0
Paint Config 0xFFFF F030 0018 Loader Version R5.1lc |
Diital Bank 0xFFFF FO30 0000 Memory Map Version 1 |
gita! Ban 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016
Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A
High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
g 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
5 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
HEEn 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3
ETHERENET 1 Interface
PID L 0xFFFF FO30 002E MAC Address 00-R0-3D-01-85-9C
= N 0xFFFF FO30 0034 IF Address 10.192.55.67

If you have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons

and Most Recently Used list
are displayed when you have
six or more devices configured.

Wpto 22 Device

Device Name

Cookie Controller

1_ [EngineRm
Status R4 ol partable :
. |SoftPaC [CRIPTION
Status Wiitd Boider
Wireless LAN | Boler I =
—— I Chamber 1 s
. Chamber 2 J
Point Config g portable der Versid
T Cookie Controller ory Map Ve
HD@E' B EngineRm mware Verd
Digital Point S2fPAC mware Ver,
] ‘fJxFFFF FO30 00BO0 Firmware Very
s lieR i Nkt i o

PAC Manager User's Guide

In the Device Name field, type the name of the device (or choose it from the drop-down list).

153



READING BASIC DEVICE INFORMATION

3. Click Status Write.

| Inspect Opto 22 Device - *
Device Mame: | 10.192.50.12 j Options » Status: | Status Write area last read at 05/02/16 16:56:15
Status Write
Status Read |
Status Write Address | Description | Value A Refresh |
0xFFFF FO33 0004  Always BootP/DHCP On Powerup

Wirgless LAN ¥
Paint Config

0xFFFF FO38 0008
0xFFFF FO33 0010
OxFFFF FO38 0014
0xFFFF FO38 0018

Degrees FJC

Comm Watchdog Time (msec), 0 = Disable
TCP Minimum Retransmission Timeout (msec)
TCP Initial Retransmission Timeout {msec)

Mo =1
Degrees F B3 Apply
[u]

250
3000

0xFFFF F038 001C TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
OxFFFF FO3& 0294 Digital Feature Scan Interval (msec) i
Digital Point 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Anslog Bank DxFFFF F033 0298 Out Of Range Value (16-Bit) -32768.000
OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147433648.000
Scanner Flags 0x 00000000 e
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Analog Paint 0xFFFF FO38 0054
High Density Operation
OptoMMP Device
Restart Device from powerup
3
HEEn Store configuration to flash
Erase configuration from flash
L3
Sl Reset to defaults and Restart Device
» microSD
D Store configuration and IP settings to micraSD
PID b Erase configuration and IP settings from microSC
Erase firmware from microsD
Events b Erase strategy from microsD
Other
Switch to loader mode
L3
Communications Clear Digital Events - Expanded configuration
Other 3

Clear Digital Events - Old configuration ]

~ Send Command

™ AutoRefresh | 15000  msec

[tems that can be changed are listed in the upper section of the dialog box. To change one, click its Value
field and either choose from the drop-down list or enter the new value as described below:

Always BootP/DHCP on Powerup (All devices): If you change this field to Yes, the current IP address
becomes temporary and the device will send a BootP broadcast the next time it is turned on. If you
change this field to No, the current IP address is saved to flash memory and becomes a static IP address.

Degrees F/C and Comm Watchdog Time (I/O units only): Changes settings for the whole I/0 unit.
IMPORTANT: Set Degrees F/C before configuring temperature inputs. If some inputs are already
configured, reset their Upper and Lower Scaled Units after changing Degrees F/C.

TCP settings: CAUTION: Before changing TCP settings, see page 229.

Digital Feature Scan Interval and Max Analog and High Density Digital Scan Interval (/O units
only): Default is 1000 milliseconds for analog and 1 milliseconds for digital. You can decrease the scan
interval (to make it scan more frequently) to make sure the scanner isn't slowed or stopped by heavy
communication on the network. You can also shut down the scanner immediately by changing its scan
interval value to -1 (does not require restarting the 1/0 unit). As of PAC firmware version 8.1, analog
modules with more than 4 points are scanned no faster than every 30 milliseconds, and analog modules
with four or fewer points are scanned no faster than every 6 milliseconds, to maintain synchronization
with the module. Note that scan interval changes revert to default values when power is lost, unless you
save your changes to flash.

Out of Range Value (16-Bit) and Out of Range Value (32-Bit): Set the value that an analog input
module returns when a signal is above or below a defined range. If the default out-of-range value is
potentially a valid in-range value, you can enter a different value to indicate an out-of-range condition.
Most SNAP analog input modules use the 16-bit out-of-range value, which has a default value of -32,768.
Analog input modules that return a 32-bit value (such as the SNAP-AIRATE-HFi and SNAP-AIRTD-8U
modules) use the 32-bit out-of-range value, whose default value is -2147483648.

Scanner Flags: To change the way scanners work or stop/start the control engine, enter one or a
combination of the following values in hex.

— (/0 units only) To process alarms in the digital scanner rather than the analog scanner, enter 1.
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— (/0 units only) To disable the analog scanner, enter 2.
- (I/0 units only) To disable the digital scanner, enter 4.
- (PAC-R only) To stop the PAC Control engine runtime, enter 8.

For example, if you have a SNAP-PAC-R1 I/0 unit with digital I/O only and are not using a PAC Control
strategy, you can get faster reactions to events by entering 1 + 2 + 8, which would be 0x00000008B. NOTE:
You must save to flash and restart for this change to take effect.

Strategy Download Method (SNAP PAC controllers only): Choose Background to enable background
downloading. (For details, see the PAC Control User’s Guide, form 1700).

Turnaround Delay (controllers or brains with serial ports): Enter how long the controller or brain should
wait to send a response to serial communication. Default is zero (no delay).

Communication Error Blink Codes (SB brains only): For troubleshooting, choose Enabled from the
drop-down list to see communication error blink codes. (See the Troubleshooting section in the brain
user's guide for details.) Be sure you turn off blink codes after troubleshooting; they will degrade
performance.

Ethernet 2 IP Address information (SNAP PAC controllers only): See “Assigning an IP Address to Ethernet
2 (SNAP PAC Controller Only)"on page 18 for information.

4. When you have finished entering changes, click Apply.

Most changes take effect immediately. If you change the Scanner Flags, secondary IP address
information, or strategy download method, however, you must store the configuration to flash and
then restart the controller or brain. See also “Assigning an IP Address to Ethernet 2 (SNAP PAC Controller
Only)"on page 18.

Referencing I/0 Points

The following sections show input and output point numbers for I/0 units.

For SNAP serial communication modules, see page 156. You will also need the SNAP Serial
Communication Module User's Guide (form 1191).

CAUTION: Make certain you are using the correct rack for the processor. Using an incompatible rack can cause
severe damage to the brain or controller.

SNAP PAC Racks

Use any of these racks With any of these processors

222&&&22&4% SNAP-PAC-R1, SNAP-PAC-R1-FM, SNAP-PAC-R1-W
APPACROKS SNAP-PAC-R2, SNAP-PAC-R2-FM, SNAP-PAC-R2-W
SNAP-PAC-EB1, SNAP-PAC-EB1-FM, SNAP-PAC-EB1-W

gmﬁ:iﬁgﬁgiff“" SNAP-PAC-EB2, SNAP-PAC-EB2-FM, SNAP-PAC-EB2-W
SNAP-PAC-SB1

SNAP-PAC-RCK12-FM
SNAP-PAC-RCK16 SNAP-PAC-RCK16-FM SNAP-PAC-SB2

SNAP PAC mounting racks can hold up to 4, 8, 12, or 16 Opto 22 SNAP I/O modules. Point features and
modules supported vary by processor; see the processor's data sheet for specifications.

Each module contains 1 to 32 channels (points), depending on the module. Examples of modules are shown
in the following diagram.
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Module position 0, 4-ch digital:

Channels: n

T

Module position 6, high-density
digital:

Channels: n

Module position 8, analog:

Channels) 2 g 1 5143|210

|||

J

Module position 12, analog:

Channels: “

i
i

Module position 14, serial:

Ports:

S

[
1

Serial Modules
NOTE: Serial modules cannot be used with SNAP PAC SB brains.

SNAP-SCM-232, SNAP-SCM-485, SNAP-SCM-485-422, and SNAP-SCM-W2 modules each have two serial ports,
A and B. Profibus modules (SNAP-SCM-PROFI) have one serial port.

To establish an Ethernet connection between the SNAP PAC I/O unit and a serial module, you use the IP
address of the I/0 unit the module is on, plus the TCP port number for the module’s serial port. The following

PAC Manager User's Guide



CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

table shows default port numbers for each port in each position on the largest rack. For a Profibus module, use
the Port A port number.

MO(.:II:Ile Port TCP port Number Moqlfle Port  TCP port Number
Position Position
0 A 22500 8 A 22516
B 22501 B 22517
] A 22502 ° A 22518
B 22503 B 22519
A 22504 A 22520
2 10
B 22505 B 22521
3 A 22506 1 A 22522
B 22507 B 22523
A 22508 A 22524
4 12
B 22509 B 22525
A 22510 A 22526
5 13
B 22511 B 22527
A 22512 A 22528
6 14
B 22513 B 22529
A 22514 A 22530
7 15
B 22515 B 22531

These port numbers can be changed if necessary. See page 46 for instructions.

CONFIGURING 1/0 MODULES, POINTS, AND FEATURES

Before you can read or write to I/O points, you must configure point types and point features. You can do so
using PAC Manager’s Inspect window. Remember, however, that configurations you set in the Inspect window
cannot be saved to a configuration file. They are sent directly to an individual I/O unit. To use a configuration
file, see “Chapter 2: Configuring Devices,” especially “Configuring I/O Modules and Points” on page 35.

Point Types Requiring Configuration

The SNAP PAC I/0 processor can recognize analog, serial, and high-density digital modules, and it assumes a
default configuration for all points on those modules. Any module position not occupied by an analog, serial,
or high-density module is assumed to be a 4-channel digital input module.

You'll need to configure the following point types:
« Alldigital output points on 4-channel digital modules. Use point type 180.

«  Analog points that do not use the default point type for the module. For example, if the points on a
SNAP-AIRTD module are 120 Ohm Nickel 3-wire RTDs (=80 to +260 °C), they must be configured,
because the default for that module is 100 Ohm Platinum 3-wire RTDs (-200 to +850 °C). Point types for
analog modules are shown in the tables beginning on page 160. Default point types are indicated.
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Point Features Requiring Configuration

Point features vary based on the processor and the module. The following point features are not automatic
and must be configured for each point that uses them:

«  High-speed digital input counters and quadrature counters
«  Digital and analog watchdogs
«  Analog scaling, clamping, offset and gain, and average filter weight

See “Using 1/0 Point Features” on page 70 for a description of features.

Configuring Analog and Digital Points and Features

1. .Inthe PAC Manager main window, click the Inspect button Q| }
The Inspect window opens.

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58

Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh |

) 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
WirelessLAN ¥ OxFFFF F030 0008 Buay Flag 0
Paint Config 0xFFFF F030 0018 Loader Version R5.1lc
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3

ETHERENET 1 Interface

PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
. , OXFFFF FO30 0034 IP Address 10.192.55.67

2. Inthe Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down
list). Click Point Config.
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Module position number \
Point numbers for this module are
shown in yellow.

Point zero is currently being read
here. Since this is not an analog
point, analog values are grayed

CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

%] Inspect Opto 22 Device - X

out.

To update values, click the Refresh
button. To modify values, change
the parameters (if applicable) and
click Apply.

vice Mame: | 10,192,50,12 j m Status: | Point Configuration area last read at 05/02/16 17:00:48
Paint Configuration
Status Read
- S : Choose a module
Status iWite [Modie 0) 1 2 3[4 5 6 78 © 10 11]12 13 13 15 Types  AOV-5(0xE3)
" Step 2: Choose a point on the selected module
Wireless LAl : — Type: O to 10 VDC Single (0x85)
Point 0 1 2 3|4 5 6 7(8 9 10 11112 13 14 15 ) eazpire: None (0x00)
Point Canfig 16 17 18 19|20 21 22 23|24 25 26 27|28 2% 30 31/ pame: a012Vout_000D
Digital Bank
igital Ban Address | Description [ value | Refresh
Digital Boint__| ALL POINTS
0xFFFF FO10 0000 Module Type Apply
Analog Bank 0xFFFF FO10 0004 Point Type b
OxFFFF FO10 0008 Point Feature

0xFFFF FO10 0024
0xFFFF FO10 0028
0xFFFF FO10 0030

Analog Point
High Density

Watchdeg Output Value
Watchdog Enabled
Point Name

Disabled
aolVout_0000

=

ANALOG ONLY
System b 0xFFFF FO10 000C Offset
0xFFFF FO10 0010 Gain
ScatchPad  * OXFFFF FO10 0014 Upper Scaled Units 10.000
0xFFFF FO10 0013 Lower Scaled Units 0.000
Datalog  * 0xFFFF FO10 0020 Filter Weight (0=disable) 0.000
BID » 0xFFFF FO10 00BC Upper Clamp
0XFFFF FO10 00B8 Lower Clamp 0.000

Events 3
Communications »
Other J

[ AutoRefresh | 15000  msec

Module position numbers are shown near the top of the page; point numbers for multi-point modules
are shown below. For more information on locating modules and points, see “Referencing I/O Points”on
page 155.

Click the module position and the point number you want to view or configure.

4. Choose or enter the following as necessary for the point.

a. Choose the point type from the drop-down list.

For help, see "Point Type Configuration Tables”on page 160 and “Using I/O Point Features” on
page 70.

b. Configure digital input counters in the Point Feature field as shown below:

0x00000000 Disables all digital point features

0x00000001  Enables and starts counter on digital input

0x00000004  Simple quadrature counter input (requires SNAP quadrature input module)

0x00000041  Quadrature counter input with index (requires SNAP quadrature input module)

c. Forautomatic reaction to analog or digital watchdogs, enable the watchdog and enter the value
that the output point should be set to if the watchdog is tripped.

d. (Analog points only) To set offset and gain for the point manually, enter values in those fields. (To
have the processor compute offset and gain, see “Calibrating Offset and Gain Using the Default
Method”on page 174.)

e. (Analog points only) Set upper and lower scaled units, filter weight, and upper and lower clamps as

necessary. (For help, see “Using I/0 Point Features”on page 70.)

When all lines are correct, click Apply to send the configuration to the I/O unit.

All other points on the same module are automatically configured with the same features and the same
point name.

7.

Click another point on the same module and change its point name and features as necessary.
Repeat steps for each module you need to configure.
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To save configuration to flash memory, see “Saving Configuration to a Device's Flash Memory”on
page 190.

Point Type Configuration Tables

The following tables help you configure points by showing the part number, the point type in decimal and in
hex, and the module type in hex (module type is read-only). For analog modules, tables also include the
number of points per module, the unit of measurement for the module, and its range.

Digital Input and Output Modules page 160
Analog Input Modules page 160
Analog Output Modules page 166

Digital Input and Output Modules

Module & Description Point Type (Dec) Point Type (Hex) Module Type (Hex)
Digital input module® 256 100 00
Digital output module* 384 180 00

* Does not apply to SNAP high-density digital modules, which are recognized by the processor.

Analog Input Modules

Use this data for configuring point types and features (see page 157). If a module has multiple listings, the
default point type is shaded.

— = K
M) X X 3
[} [}
a =z £ 8 S ® =
o o g = 2 2 2 2 o
o o 92 £ c 8 ] c
Part Number & 2 o o © 9 o ®
|Z' |Z' > O = = (2] (/7] =
Description - - o 3 ) S = =
© °© o = o o 3 5 >
E £ 3 ¢ 2 5 - = 6
@®© @®© ° ﬁ
5 & = <
(&) (&) o
SNAP-AIARMS: 0-10 AAC/DC 71 47 71 2 A 0.0 0.0 10.0 11.0
SNAP-AIARMS-i: 0-10 AAC/DC 71 47 29 2 A 0.0 0.0 10.0 11.0
SNAP-AIARMS-i-FM: 0-10 AAC/DC 71 47 29 2 A 0.0 0.0 10.0 11.0
SNAP-AICTD: ICTD Temp. Probe 4 4 04 2 DegreesC -273.0 -40.0 150.0 150.0
SNAP-AICTD-4: ICTD Temp. Probe 4 4 42 4 DegreesC -273.0 -40.0 150.0 150.0
SNAP-AICTD-8: ICTD Temp. Probe 4 4 4C 8 DegreesC -273.0 -40.0 150.0 150.0
SNAP-AILC: -2 to +2 mV/V Fast 34 22 0B 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC: -2 to +2 mV/V Slow 36 24 0B 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC: -3 to +3 mV/V Fast 35 23 0B 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC: -3 to +3 mV/V Slow 37 25 0B 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC: Filter of 1st channel 0 0 OB 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -3 to +3 mV/V Fast 35 23 0C 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -3 to +3 mV/V Slow 37 25 0C 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -4 to +4 mV/V Fast 34 22 0C 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -4 to +4 mV/V Slow 36 24 0C 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: Filter of 1st channel 0 0 0C 2 Percent -110.0 -100.0 100.0 110.0
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T R % 3
= = EE g 5 > o o o
Part Number & § § § @ E, & g 3 g
Description ; ; 5 ;‘ 3 g 3 2 5
E £ 3 B g 5 3 & &
(S}
SNAP-AIMA: -20 to +20 mA 64 40 64 2 mA -220 -200 20.0 22.0
SNAP-AIMA: 0 to +20 mA 2 2 64 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA: 4 to +20 mA 3 3 64 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA2-i: -1 to +1 mA 85 55 27 2 mA -1.1 -1.0 1.0 1.1
SNAP-AIMA-i: -20 to +20 mA 64 40 22 2 mA -220 -200 20.0 22.0
SNAP-AIMA-i: 0 to +20 mA 2 2 22 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-i: 4 to +20 mA 3 3 22 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-iH: 4 to +20 mA 3 3 2A 2 mA 3.2 4.0 20.0 24.0
SNAP-AIMA-iSRC: -20 to +20 mA 64 40 26 2 mA -220 -200 20.0 22.0
SNAP-AIMA-ISRC: 0 to +20 mA 2 2 26 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-iSRC: 4 to +20 mA 3 3 26 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-iSRC-FM: -20 to +20 mA 64 40 26 2 mA -220 -200 20.0 22.0
SNAP-AIMA-iSRC-FM: 0 to +20 mA 2 2 26 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-iSRC-FM: 4 to +20 mA 3 3 26 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-4: -20 to +20 mA 64 40 40 4 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-4: 0 to +20 mA 2 2 40 4 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-4: 4 to +20 mA 3 3 40 4 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-8: -20 to +20 mA 64 40 4A 8 mA -220 -200 20.0 22.0
SNAP-AIMA-8: 0 to +20 mA 2 2 4A 8 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-8: 4 to +20 mA 3 3 4A 8 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-32: -20 to +20 mA 64 40 4D 32 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-32: 0 to +20 mA 2 2 4D 32 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-32: 4 to +20 mA 3 3 4D 32 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-32-FM: -20 to +20 mA 64 40 4D 32 mA -220 -200 200 22.0
SNAP-AIMA-32-FM: 0 to +20 mA 2 2 4D 32 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-32-FM: 4 to +20 mA 3 3 4D 32 mA -22.0 4.0 20.0 22.0
SNAP-AIMV-4: -150 to +150 mV 66 42 44 4 mV -165.0 -150.0 150.0 165.0
SNAP-AIMV-4: -75 to +75 mV 68 44 44 4 mV -825 -75.0 75.0 82.5
SNAP-AIMV2-4: -50 to +50 mV 9 9 45 4 mV -55.0 -50.0 50.0 55.0
SNAP-AIMV2-4: -25 to +25 mV 67 43 45 4 mV -275 250 250 27.5
SNAP-AIPM (channel 0 only) 70 46 OA * ACVRMS 0.0 0 250 275
SNAP-AIPM (channel 1 only) 71 47 OA * ACARMS 0.0 0 10 11.0
SNAP-AIPM (channel 2 only) 82 52 0A *  True power n/a n/a n/a n/a
SNAP-AIPM (channel 3 only) 83 53 0A *  Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3 (channels 0, 4 & 8) 70 46 49 * ACVRMS 0.0 0 300 330
SNAP-AIPM-3 (channels 1, 5 & 9) 71 47 49 * ACARMS 0.0 0 5 55
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SNAP-AIPM-3 (channels 2, 6 & 10) 82 52 49 *  True power n/a n/a n/a n/a
SNAP-AIPM-3 (channels 3, 7 & 11) 83 53 49 *  Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3 (channels 12 & 13) 86 56 49 *  True power n/a n/a n/a n/a
SNAP-AIPM-3V (channels 0, 4 & 8) 100 64 48 * ACVRMS 0.0 0 300 330
SNAP-AIPM-3V (channels 1, 5 & 9) 89 59 48 * VACfromCT 0.0 0 0.333 0.366
SNAP-AIPM-3V (channels 2, 6 & 10) 90 5A 48 *  True power n/a n/a n/a n/a
SNAP-AIPM-3V (channels 3, 7 & 11) 90 5A 48 * Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3V (channels 12 & 13) 184 B8 48 *  True power n/a n/a n/a n/a
SNAP-AIRATE: Rate (Frequency) 69 45 69 2 Hz 0.0 0.0 25000.0 27500.0
SNAP-AIRATE-HFi: Rate (0.1 s data 68 44 2B 2 Hy 2 2 500,000 500,000
freshness)
SNAP-AIRATE-HFi: Rate (1 s data 69 45 2B 2 Hz 20 20 500,000 500,000
freshness)
SNAP-AIRTD: 100 Ohm Pt 3-wire 10 OA 10 2 DegreesC -200.0 -200.0 850.0 850.0
SNAP-AIRTD: 100 Ohm Ni 3-wire 46 2E 10 2 DegreesC -60.0 -60.0 250.0 250.0
SNAP-AIRTD: 0-400 Ohms, Lead 15 OF 10 2 Ohms 0 0 400 440
Compensated
SNAP-AIRTD: 120 Ohm Ni 3-wire 48 30 10 2 DegreesC -80.0 -80.0 260.0 260.0
SNAP-AIRTD-10: 10 Ohm Cu 3-wire 14 OE OE 2 DegreesC -180.0 -180.0 260.0 260.0
SNAP-AIRTD-10: 0-25 Ohms, Lead 15 OF OE 2 Ohms 0 0 25 275
Compensated

SNAP-AIRTD-1K: 1000 Ohm Pt 3-wire 92 5C OF 2 DegreesC -200.0 -200.0 850.0 850.0
SNAP-AIRTD-1K: 1000 Ohm Ni 3-wire 93 5D OF 2 DegreesC -60.0 -60.0 250.0 250.0
SNAP-AIRTD-1K: 1000 Ohm Ni 3-wire 94 bSE OF 2 DegreesF -50.0 -50.0 275.0 275.0
SNAP-AIRTD-1K: 04000 Ohms, Lead

15 OF OF 2  Ohms 0 0 4000 4400
Compensated
SNAP-AIRTD-8U: 0-8000 Ohms - Fixed 155 9B 55 8  Ohms 0 0 8000 8800
f(')\iAlf -AIRTD-8U: 1000 OhmNi3-wire @ 14, g 55 § DegreesF 46 46 1489 1489
STAP-AIRTD-BU-10000MMNISWIe @ 181 g5 55 8 DegreesC 40 40 135 135
SNAP-AIRTD-8U: 1000 Ohm Pt @ 0°C 180 B4 55 8 DegreesC  -200 200 850 850
SNAP-AIRTD-8U: 120 OhmNi @ 0°C 179 B3 55 8 DegreesC  -80  -80 260 260
SNAP-AIRTD-8U: 100 OhmNi @ 0°C 178 B2 55 8 DegreesC  -60 60 250 250
SNAP-AIRTD-8U: 100 OhmPt@ 0°C 177 B1 55 8 DegreesC  -200 200 850 850
SNAP-AIRTD-8U: 10 Ohm Cu 176 BO 55 8 DegreesC  -60 60 355 355
SNAP-AIRTD-8U: 0-8000 Ohms -Auto 171 AB 55 8  Ohms 0 0 8000 8800
SNAP-AIRTD-8U: 0-4000 Ohms -Auto 170 AA 55 8  Ohms 0 0 4000 4400
SNAP-AIRTD-8U: 0-2000 Ohms -Auto 169 A9 55 8  Ohms 0 0 2000 2200
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SNAP-AIRTD-8U: 0-1000 Ohms - Auto 168 A8 55 8 Ohms 0 0 1000 1100
SNAP-AIRTD-8U: 0-800 Ohms - Auto 167 A7 55 8 Ohms 0 0 800 880
SNAP-AIRTD-8U: 0—400 Ohms - Auto 166 A6 55 8 Ohms 0 0 400 440
SNAP-AIRTD-8U: 0—200 Ohms - Auto 165 A5 55 8 Ohms 0 0 200 220
SNAP-AIRTD-8U: 0—100 Ohms - Auto 164 A4 55 8 Ohms 0 0 100 110
SNAP-AIRTD-8U: 0-80 Ohms - Auto 163 A3 55 8 Ohms 0 0 80 88
SNAP-AIRTD-8U: 0—40 Ohms - Auto 162 A2 55 8 Ohms 0 0 40 44
SNAP-AIRTD-8U: 0-20 Ohms - Auto 161 A1 55 8 Ohms 0 0 20 22
SNAP-AIRTD-8U: 0—10 Ohms - Auto 160 A0 55 8 Ohms 0 0 10 1
SNAP-AIRTD-8U: 0—4000 Ohms - Fixed 154 9A 55 8 Ohms 0 0 4000 4400
SNAP-AIRTD-8U: 0-2000 Ohms - Fixed 153 99 55 8 Ohms 0 0 2000 2200
SNAP-AIRTD-8U: 0-1000 Ohms - Fixed 152 98 55 8 Ohms 0 0 1000 1100
SNAP-AIRTD-8U: 0—-800 Ohms - Fixed 151 97 55 8 Ohms 0 0 800 880
SNAP-AIRTD-8U: 0—400 Ohms - Fixed 150 96 55 8 Ohms 0 0 400 440
SNAP-AIRTD-8U: 0—-200 Ohms - Fixed 149 95 55 8 Ohms 0 0 200 220
SNAP-AIRTD-8U: 0—100 Ohms - Fixed 148 94 55 8 Ohms 0 0 100 110
SNAP-AIRTD-8U: 0-80 Ohms - Fixed 147 93 55 8 Ohms 0 0 80 88
SNAP-AIRTD-8U: 0-40 Ohms - Fixed 146 92 55 8 Ohms 0 0 40 44
SNAP-AIRTD-8U: 0-20 Ohms - Fixed 145 91 55 8 Ohms 0 0 20 22
SNAP-AIRTD-8U: 0-10 Ohms - Fixed 144 90 55 8 Ohms 0 0 10 1
SNAP-AITM: -150 to +150 mV 66 42 66 2 mV -165.0 -150.0 150.0 165.0
SNAP-AITM: -75 to +75 mV 68 44 66 2 mV -825 -75.0 75.0 82.5
SNAP-AITM: Type E Thermocouple 19 13 66 2 DegreesC -270.0 -270.0 1000.0 1000.0
SNAP-AITM: Type J Thermocouple 5 5 66 2 DegreesC -210.0 -210.0 1200.0 1200.0
SNAP-AITM: Type K Thermocouple 8 8 66 2 DegreesC -270.0 -270.0 1372.0 1372.0
SNAP-AITM-i: -150 to +150 mV 66 42 20 2 mV -165.0 -150.0 150.0 165.0
SNAP-AITM-i: -75 to +75 mV 68 44 20 2 mV -825 -75.0 75.0 82.5
SNAP-AITM-i: Type E Thermocouple 19 13 20 2 DegreesC -270.0 -270.0 1000.0 1000.0
SNAP-AITM-i: Type J Thermocouple 5 5 20 2 DegreesC -210.0 -210.0 1200.0 1200.0
SNAP-AITM-i: Type K Thermocouple 8 8 20 2 DegreesC -270.0 -270.0 1372.0 1372.0
SNAP-AITM-4i: -150 to +150 mV 66 42 32 4 mV -165.0 -150.0 150.0 165.0
SNAP-AITM-4i: -75 to +75 mV 68 44 32 4 mV -825 -75.0 75 82.5
SNAP-AITM-4i: -50 to +50 mV 9 9 32 4 mV -55.0 -50.0 50.0 55.0
SNAP-AITM-4i: -25 to +25 mV 67 43 32 4 mV -275 -25.0 25.0 275
SNAP-AITM-4i: Type B Thermocouple 24 18 32 4 DegreesC 42.0 42.0 1820.0 1820.0
SNAP-AITM-4i: Type C Thermocouple 32 20 32 4 DegreesC 0.0 0.0 2320.0 2320.0
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SNAP-AITM-4i: Type D Thermocouple 33 21 32 4 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM-4i: Type E Thermocouple 19 13 32 4 DegreesC -270.0 -270.0 1000.0 1000.0
SNAP-AITM-4i: Type G Thermocouple 31 1F 32 4 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM-4i: Type J Thermocouple 5 5 32 4 DegreesC -210.0 -210.0 1200.0 1200.0
SNAP-AITM-4i: Type K Thermocouple 8 8 32 4 DegreesC -270.0 -270.0 1372.0 1372.0
SNAP-AITM-4i: Type N Thermocouple 30 1E 32 4 DegreesC -270.0 -270.0 1300.0 1300.0
SNAP-AITM-4i: Type R Thermocouple 17 11 32 4 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-4i: Type S Thermocouple 23 17 32 4 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-4i: Type T Thermocouple 18 12 32 4 DegreesC -270.0 -270.0 400.0 400.0
SNAP-AITM-8: -75 to +75 mV 68 44 4F 8 mV -82.5 -75.0 75.0 82.5
SNAP-AITM-8: -50 to +50 mV 9 9 4F 8 mV -55.0 -50.0 50.0 55.0
SNAP-AITM-8: -25 to +25 mV 67 43 4F 8 mV -27.5 -250 25.0 275
SNAP-AITM-8: Type B Thermocouple 24 18 4F 8 DegreesC 42.0 42.0 1820.0 1820.0
SNAP-AITM-8: Type C Thermocouple 32 20 4F 8 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM-8: Type D Thermocouple 33 21 4F 8 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM-8: Type E Thermocouple 19 13 4F 8 DegreesC -270.0 -270.0 1000.0 1000.0
SNAP-AITM-8: Type G Thermocouple 31 1F 4F 8 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM-8: Type J Thermocouple 5 5 4F 8 DegreesC -210.0 -210.0 1200.0 1200.0
SNAP-AITM-8: Type K Thermocouple 8 8 4F 8 DegreesC -270.0 -270.0 1372.0 1372.0
SNAP-AITM-8: Type N Thermocouple 30 1E 4F 8 DegreesC -270.0 -270.0 1300.0 1300.0
SNAP-AITM-8: Type R Thermocouple 177 1 4F 8 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8: Type S Thermocouple 23 17 4F 8 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8: Type T Thermocouple 18 12 4F 8 DegreesC -270.0 -270.0 400.0 400.0
SNAP-AITM-8-FM: -75 to +75 mV 68 44 4F 8 mV -82.5 -75.0 75.0 82.5
SNAP-AITM-8-FM: -50 to +50 mV 9 9 4F 8 mV -55.0 -50.0 50.0 55.0
SNAP-AITM-8-FM: -25 to +25 mV 67 43 4F 8 mV -27.5 -250 25.0 275
SNAP-AITM-8-FM: Type B Thermocouple 24 18 4F 8 DegreesC  42.0 42.0 1820.0 1820.0
SNAP-AITM-8-FM: Type C Thermocouple 32 20 4F 8 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM-8-FM: Type D Thermocouple 33 21 4F 8 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM-8-FM: Type E Thermocouple 19 13 4F 8 DegreesC -270.0 -270.0 1000.0 1000.0
SNAP-AITM-8-FM: Type G Thermocouple 31 1F 4F 8 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM-8-FM: Type J Thermocouple 5 5 4F 8 DegreesC -210.0 -210.0 1200.0 1200.0
SNAP-AITM-8-FM: Type K Thermocouple 8 8 4F 8 DegreesC -270.0 -270.0 1372.0 1372.0
SNAP-AITM-8-FM: Type N Thermocouple 30 1E 4F 8 DegreesC -270.0 -270.0 1300.0 1300.0
SNAP-AITM-8-FM: Type R Thermocouple 17 11 4F 8 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8-FM: Type S Thermocouple 23 17 4F 8 DegreesC -50.0 -50.0 1768.0 1768.0
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SNAP-AITM-8-FM: Type T Thermocouple 18 12 4F 8 DegreesC -270.0 -270.0 400.0 400.0
SNAP-AITM2: -50 to +50 mV 9 9 09 2 mV -55.0 -50.0 50.0 55.0
SNAP-AITM2: -25 to +25 mV 67 43 09 2 mV -27.5 -250 25.0 275
SNAP-AITM2: Type B Thermocouple 24 18 09 2 DegreesC 42.0 42.0 1820.0 1820.0
SNAP-AITM2: Type C Thermocouple 32 20 09 2 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM2: Type D Thermocouple 33 21 09 2 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM2: Type G Thermocouple 31 1F 09 2 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM2: Type N Thermocouple 30 1E 09 2 DegreesC -270.0 -270.0 1300.0 1300.0
SNAP-AITM2: Type R Thermocouple 177 11 09 2 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM2: Type S Thermocouple 23 17 09 2 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM2: Type T Thermocouple 18 12 09 2 DegreesC -270.0 -270.0 400.0 400.0
SNAP-AITM2-i: -50 to +50 mV 9 9 21 2 mV -55.0 -50.0 50.0 55.0
SNAP-AITM2-i: -25 to +25 mV 67 43 21 2 mV -27.5 -250 25.0 27.5
SNAP-AITM2-i: Type B Thermocouple 24 18 21 2 DegreesC 42.0 42.0 1820.0 1820.0
SNAP-AITM2-i: Type C Thermocouple 32 20 21 2 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM2-i: Type D Thermocouple 33 21 21 2 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM2-i: Type G Thermocouple 31 1F 21 2 DegreesC 0.0 0.0 2320.0 2320.0
SNAP-AITM2-i: Type N Thermocouple 30 1E 21 2 DegreesC -270.0 -270.0 1300.0 1300.0
SNAP-AITM2-i: Type R Thermocouple 17 1M 21 2 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM2-i: Type S Thermocouple 23 17 21 2 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM2-i: Type T Thermocouple 18 12 21 2 DegreesC -270.0 -270.0 400.0 400.0
SNAP-AIV: -10 to +10 VDC 12 C 12 2 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV: -5 to +5 VDC 1 B 12 2 VDC -5.5 -5.0 5.0 55
SNAP-AIV-i: -10 to +10 VDC 12 C 23 2 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-i: -5 to +5 VDC 1 B 23 2 VvVDC -5.5 -5.0 5.0 5.5
SNAP-AIV-4: -10 to +10 VDC 12 C 41 4 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-4: -5 to +5 VDC 1 B 41 4 VDC -5.5 -5.0 5.0 5.5
SNAP-AIV-8: -10 to +10 VDC 12 C 4B 8 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-8: -5 to +5 VDC 1 B 4B 8 VDC -5.5 -5.0 5.0 5.5
SNAP-AIV-32: -10 to +10 VDC 12 C 4E 32 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-32: -5 to +5 VDC 11 B 4E 32 VDC -5.5 -5.0 5.0 5.5
SNAP-AIV-32-FM: -10 to +10 VDC 12 C 4E 32 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-32-FM: -5 to +5 VDC 11 B 4E 32 VvVDC -5.5 -5.0 5.0 5.5
SNAP-AIV2-i: -100 to +100 VDC 72 48 24 2 VDC -110.0 -100.0 100.0 110.0
SNAP-AIV2-i: -50 to +50 VDC 73 49 24 2 VDC -55.0 -50.0 50.0 55.0
SNAP-AIVRMS: 0-250 VAC/VDC 70 46 70 2 VAC/VDC 0.0 0.0 250.0 275.0
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SNAP-AIVRMS-i: 0-250 VAC/VDC 70 46 28 2 VAC/VDC 0.0 0.0 250.0 275.0
SNAP-AIVRMS-i-FM: 0—250 VAC/VDC 70 46 28 2 VAC/VDC 0.0 0.0 250.0 275.0
SNAP-AIR40K-4: 0 to 40K Ohms 74 4A 43 4 Ohms 0 0 40,000 44,000
SNAP-AIR40K-4: 0 to 20K Ohms 75 4B 43 4 Ohms 0 0 20,000 22,000
SNAP-AIR40K-4: 0 to 10K Ohms 76 4C 43 4 Ohms 0 0 10,000 11,000
SNAP-AIR40K-4: 0 to 5K Ohms 77 4D 43 4 Ohms 0 0 5000 5500
SNAP-AIR400K-8: 0 to 400K Ohms 105 69 54 8 Ohms 0 0 400,000 440,000
SNAP-AIR400K-8: 0 to 400K Autorange 188 BC 54 8 Ohms 0 0 400,000 440,000
SNAP-AIR400K-8: 0 to 200K Ohms 106 6A 54 8 Ohms 0 0 200,000 220,000
SNAP-AIR400K-8: 0 to 100K Ohms 107 6B 54 8 Ohms 0 0 100,000 110,000
SNAP-AIR400K-8: 0 to 50K Ohms 108 6C 54 8 Ohms 0 0 50,000 55,000
SNAP-AIR400K-8: 0 to 40K Ohms 74 4A 54 8 Ohms 0 0 40,000 44,000
SNAP-AIR400K-8: 0 to 20K Ohms 75 4B 54 8 Ohms 0 0 20,000 22,000
SNAP-AIR400K-8: 0 to 10K Ohms 76 4C 54 8 Ohms 0 0 10,000 11,000
SNAP-AIR400K-8: 0 to 5K Ohms 77 4D 54 8 Ohms 0 0 5000 5500
SNAP-AIR400K-8: 0 to 4K Ohms 38 26 54 8 Ohms 0 0 4000 4400
SNAP-AIR400K-8: 0 to 2K Ohms 39 27 54 8 Ohms 0 0 2000 2200
SNAP-AIR400K-8: 0 to 1K Ohms 40 28 54 8 Ohms 0 0 1000 1100
SNAP-AIR400K-8: 0 to 500 Ohms 41 29 54 8 Ohms 0 0 500 550
SNAP-pH/ORP: -1 to +1 VDC 78 4E 25 2 VvDC -1.1 -1.0 1.0 1.1
SNAP-pH/ORP: 0-14 pH 79 4F 25 2 pH -1.4 0.0 14.0 154
SNAP-pH/ORP: -0.5 to +0.5 VDC 80 50 25 2 vDC -0.55 -0.5 0.5 0.55
SNAP-PID-V 99 63 DO 4 Percent 0 0 100.0 110.0

* The SNAP-AIPM module monitors one device from channel O (volts) and channel 1 (amps). Channels 2 and 3
return calculated values. The SNAP-AIPM-3 and SNAP-AIPM-3V monitor three phases from channels 0,4, & 8
(volts) and channels 1,5, & 9 (amps). All other channels return calculated values. See the SNAP AIPM Modules
Data Sheet (form 1453) for details.

Analog Output Modules

Use this data for configuring point types and features (see page 157).
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SNAP-AOA-3: 4-20 mA 131 83 83 1 mA 4.0 4.0 20.0 20.0
SNAP-AQV-5: 0-10 VDC 133 8 85 1 VDC 0.0 0.0 10.0 10.0
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SNAP-AOA-23: 4-20 mA 163 A3 A3 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iSRC: 4-20 mA 163 A3 B3 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iSRC-FM: 4-20 mA 163 A3 B3 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iH: 4-20 mA 163 A3 AB 2 mA 4.0 4.0 20.0 20.0
SNAP-AQOV-25: 0-10 VDC 165 A5 A5 2 vDC 0.0 0.0 10.0 10.0
SNAP-AOV-27: -10 to +10 VDC 167 A7 A7 2 vbC  -100 -10.0 10.0 10.0
SNAP-AOA-28: 0-20 mA 168 A8 A8 2 mA 0.0 0.0 20.0 20.0
SNAP-AOVA-8: 0-5 VDC 144 90 CF 8 VDC 0.0 0.0 5.0 5.0
SNAP-AOVA-8: 0-10 VDC 145 91 CF 8 VvDC 0.0 0.0 10.0 10.0
SNAP-AOVA-8: -5 to +5 VDC 146 92 CF 8 VvDC -5.0 -5.0 5.0 5.0
SNAP-AOVA-8: -10 to +10 VDC 147 93 CF 8 VvDC -10.0  -10.0 10.0 10.0
SNAP-AOVA-8: 4-20 mA 148 94 CF 8 mA 4.0 4.0 20.0 20.0
SNAP-AOVA-8: 0-20 mA 149 95 CF 8 mA 0.0 0.0 20.0 20.0
SNAP-AOD-29: TPO 5-60 VDC 169 A9 A9 2 Percent nla 0.0 100.0 n/a
SNAP-AOD-29-HFi: TPO 2.5-24 VDC 131 83 B9 2 Percent nla 0.0 100.0 n/a

Configuring Serial Modules in the Inspect Window

(Not available on SB brains) Using the Inspect window you can change many previously configured

parameters for a serial module. However, keep in mind that any changes you make in the Inspect window are

sent directly to the controller or I/O unit and cannot be saved to a configuration file. Therefore, you should

save the configuration to flash memory. For instructions, see “Saving Configuration to a Device's Flash

Memory”on page 190. To use a configuration file, see Chapter 2: Configuring Devices.

1. Inthe PAC Manager main window, click the Inspect button Q .

2. Inthe Inspect Opto 22 Device window, type the IP address of the I/0 unit (or choose it from the
drop-down list).

3. (lick Communications and then click the type of module from the submenu.

4. Choose the module’s position number from the drop-down list.
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= Inspect Opto 22 Device — X
Device Mame: | 10.192.55.67 LI Options » Status: |5erial Module area last read at 05/04/16 11:32:19
Data for this module is ~Serial Modules
h inth ind Status Read e
shown inthe window. \Serial Module Number: _ vl Module 5 is a Serial Module )
Status Write
Address | Description | Value | Refresh |
i 3
Wirsless LAN MODULE INFORMATION
- OxFFFF FOCO 0500 Module Type RS232 (0xFO) Apply |
Point Config | OxFFFF FO3A 7F50  Module Subtype 1 (Revision A)
> 0xFFFF FO3A 7F52 Hardware Revision Date 2003-06-08
Digital Bank | OxFFFFFO3A 7F56  Loader Version R10e
- . 0xFFFF FO3A 7F5A Firmware Version Rl1e
Digital Point | PORT &
0xFFFF FO3A 8040 Port Number 22510
Analog Bank
ﬂl OXFFFF FO3AB0A4  BaudRate 3600
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Analog Point | OxFFFFFO3A B0AS  Parity Mane
0xFFFF FO3A 80A9 Data Bits 8
High Density | 0xFFFF FO3A 80AA Stop Bits 1
0xFFFF FO3A B0AE  Hardware Flow Control? Mo
System » | 0xFFFF FO3A B0AC Power-up Test Message? ‘fes
0xFFFF FO3A 8240 EOM Character List Ox 0DOADDOD
ScratchPad  » | PORT B
0xFFFF FO3A 80B0 Port Number 22511
Data Log 3 | 0xFFFF FO3A 80B4 Baud Rate 9600
0xFFFF FO3A B0B8 Parity

Lefofe e e s

MNone jna

PID 2 OxFFFFFO3A B0BS  Data Bits ] 3

OxFFFF FO3A B0BA  Stop Bits 1 i

Events » | OxFFFF FO3A BOBE  Hardware Flow Control? No =

L 0xFFFF FO3A 80BC Power-up Test Message? Yes jna
Communications ¥ | OxFFFFFO3A 8280  EOM Character List Ox DD0AOO0D

Other >|
Help [ AutoRefresh | 15000  msec

For help in understanding or changing data, see the following sections:
“Configuring RS-232 and RS-485/422 Serial Communication Modules”on page 46
- "Configuring Wiegand Modules”on page 51

- “Configuring Profibus Modules”on page 53

- "Configuring SSI (Serial Synchronous Interface) Modules”on page 54
- "Configuring CAN Modules”on page 55

- “Configuring HART Modules”on page 59

See also the SNAP Serial Communication Module User's Guide (form 1191).

5. To save configuration to flash memory, see “Saving Configuration to a Device’s Flash Memory”on
page 190.

Configuring, Viewing, or Changing PID Loops

For information about PID loops, see page 63. PIDs are normally configured in a configuration file following
the steps on page 65. However, you can also configure, view, or change them using PAC Manager's Inspect
window. (Remember that changes made here cannot be saved to a configuration file.)

1. Inthe PAC Manager main window, click the Inspect button Bl
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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If you have configured other devices, they are listed in alphabetical order in the drop-down list.

Status:

j Options »

Status Read area last read at 07/05/16 10:34:58

DESCRIFTION

VALUE

~ Refresh |

Device Name: | 10.199.59.99
Status Read
Status Read
Status Write NS
- R 0xFFFF FO30 0004
WEEES 0xFFFF FO30 0008
Point Config 0xFFFF FO30 0018
— 0xFFFF FO30 0000
EREIE 0xFFFF FO30 0230
Digital Point 0xFFFF F030 001C
0xFFFF FO30 00RO
Analog Bank 0xFFFF F030 00BO
Analog Point 0xFFFF FO30 0020
i i 0xFFFF FO30 0080
ELIEEE 0xFFFF FO30 0024
R 0xFFFF FO30 0025
HEED 0XFFFF FO30 0026
———— 0xFFFF FO30 024C
0xFFFF FO30 0028
Data Log 3
PID * 0xFFFF FO30 002E
- R 0xFFFF FO30 0034

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
29.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

If you have configured six or more devices, the Inspect window provides two additional time-saving

features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons

and Most Recently Used list
are displayed when you have
six or more devices configured.

2.

Wpto 22 Device

Device Name{ | afslslTel gl =g

Cookie Controller

EngineRm

ST Coil Portable i

Status wiitd SoftPAC [CRIPTION
Wireless LAN | Boter I Eles
—— I Chamber 1 s
. Chamber 2 J
Point Config g portable der Versid
T Cookie Controller ory Map Ve
Digital Ban EngineRm SRy
Digital Point 221 PAC méare Ver.
% ‘fJxFFFF FO30 00BO0 Firmware Very
s lieR i s, i o

list). Click PID and choose PID Loops from the submenu.
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Information for this PID loop is

shown in the window.

= Inspect Opto 22 Device

Device Name: | 10,192.55.67

v| options »

Status:

PID Loop area last read at 05/04/16 11:35:31

Analog Point
High Density

System 3

Other 3

0xFFFF F200 0034
0xFFFF F200 0000
0xFFFF F200 0004
0xFFFF F200 0008
0xFFFF F200 000C

NWFFFFE F210 (n44.

Status Flags Off Mask

Current Value Of Error

Current Value Of P (Gain)
Current Value Of I {Integral)
Current Value Of D {Derivative)

MemMan Address Far Tnmot

0

v ANAAANAN

PID Loops
Staty
PID Loop Number: 0 - )
Status Write |
T D Address | Description Value | ~ Refresh |
ireless STATUS
- 0xFFFF F210 0064 Current Value Of Input Apply
Point Config 0xFFFF F210 0063 Current Value Of Setpoint
> 0xFFFF F210 000C Current Value Of Output 0.000000
Digital Bank OxFFFFF210 0008 Current Value Of Feed Forward 0.000000
Dicital Point 0xFFFF F210 0000 Last Scanned Value Of Input 0.000000
aital Fain OxFFFF F210 0004 Last Scanned Value OF Setpaint 0,000000
0xFFFF F200 0028 Scan Counter 0
pasico Bk OXFFFFF200 002C  Status Flags 00000000
OxFFFF F200 0030  Status Flags On Mask 00000000

ScratchPad ¢ 0xFFFF F200 0010 Current Value Of Integral
TUNING

Datslog OxFFFFF210 0010 Gain 0,000000

0xFFFF F210 0014 Tune I {Integral) 0.000000

PID 3 0xFFFF F210 0018 Tune D (Derivative) 0.000000

0xFFFF F210 001C Feed Forward Gain 0,000000

Events b CONFIGLRATION

. 0xFFFF F210 0050 Algorithm MNaone Ikl
Communications ¥ OxFFFF F210 0054  Mode Automatic e}

OxFFFF F210 0038 Scan Time (seconds) 1.000000

v

™ AutoRefresh | 15000  msec

From the drop-down list, choose the PID loop number you want to configure, view, or change.
Existing PID loops are indicated by an asterisk (*) next to the number.
To configure or change the PID, click inside the cell in the Value column and type the new value or

choose it from a drop-down list, if one is available. When you have finished making changes, click Apply
to send them to the 1/0 unit.

NOTE: If you are using PAC Control, it is easiest to tune PID loops in your PAC Control strategy running in Debug
mode. For details, see the PAC Control User's Guide (form 1700).

For information on memory map addresses and what they contain, see the OptoMMP Protocol Guide (form
1465).

READING AND WRITING TO POINTS
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You can use PAC Manager to read or change I/0 point values. You must configure points before you can
read or write to them.

CAUTION: Ifyou are using PAC Control, reading and writing is normally done in the PAC Control strategy logic or
in Debug mode. If you use the steps in this section to write to an I/O unit, be very careful you do not interfere with
strategy logic.

1. Inthe PAC Manager main window, click the Inspect button Q .
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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If you have configured other devices, they are listed in alphabetical order in the drop-down list.

Status:

j Options »

Status Read area last read at 07/05/16 10:34:58

DESCRIFTION

VALUE

0004
0008

0018
00oo
0230
001c
00RO
00BO

00z0
0080
0024
0025
00z2é
024C
002g

00ZE

Device Name: | 10.199.59.99
Status Read
Status Read
Status Write ADDRESS
- OXFFFF FO30
Wireless LAN  » 0xFFFF FO30
Point Config 0xFFFF FO30
- OXFFFF FO30
EiFak 0XFFEF FO30
Digital Paint O0xFFFE FO30
OXFFFF FO30
Analog Bank 0xFFFF F030
Analog Point 0xFFFF F030
) ) OXFFFF FO30
A 0xFFFF F030
R OXFFFF FO30
HEEn 0xFFFF F030
=i D OXFFFF FO30
OXFFFF FO30
Data Log 3
PID 4 0xFFFF FO30
. , OXFFFF FO30 0034

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
29.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

~ Refresh |

If you have configured six or more devices, the Inspect window provides two additional time-saving

features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons

and Most Recently Used list
are displayed when you have
six or more devices configured.

list).

¥ Inspect Opte 22 Device
Device Name] | afJsl =Relslyyis| =g Opti
1_ [EngineRm i
| Cail Portable
: SoftPAC [CRIPTION
S lerup Clea
Wireless LAN | Boiler , FI;
——————Chamber 1 s
. Chamber 2 4
Point Confid o portable der Versig
T Cookie Controller ory Map Ve
Bl Balq]EngineRm mware Verg
Digital Poini-20fPAC mware Ver
| ‘fJxFFFF FO30 00BO Firmware Very
e w_n - R P anin?

In the Device Name field, type the name (or IP address) of the 1/0 unit (or choose it from the drop-down

Click Digital Point or Analog Point, depending on the type of point you want to read or write to. For

digital points, see “Reading and Writing to Digital Points.” For analog points, see page 173.

Reading and Writing to Digital Points

NOTE: For points on high-density digital modules, you can read or write to individual points using the steps in this
section. To read or write to all points at one time, see “Reading and Writing to SNAP High-Density Digital Points”on

page 181.
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Digital Input Points

Here’s an example showing a SNAP digital input point. Module position numbers are shown near the top of
the Inspect Opto 22 Device window, with the point numbers for each module listed just below the position
number. For more information on locating modules and points, see “Referencing I/0 Points”on page 155.

Module position number
Point numbers for this
module. Paint 1 is currently
being read here.

To update values, click the
Refresh button.

Since point 1is an input point,
you can turn countingonand
off or clear counters and
latches. 7

é Inspect Opto 22 Device

Device Name: | 10.192.55.67

LI Options bl

Status:

Digital Paint area last read at 05/04/16 11:39:56

Status Read

Status W

rDigital Point

Step 1: Choose a module

Wirgless LAN  » |

[Modde (D) 1 2

34 5 &

7] 8

Step 2: Choose a point on the selected module

9 10 1112 13 14

Type: Dig/none (0x00)

oIt ﬂ_n- 2 3

4 5 B

9 10 1112 13 14

Type: Digital Input (0x 100)
Feature: Mone (0x00)
diChipLevelSwitch

Point Config ] 0 21 22 23|24 25 26 27|28 29 30 31 pome:
Digital Bank —Read Area
Digital Point Address | Description | Value | Refresh |
: K STATUS
FTEEEET OxFFFFFOB00040  Point State OFF
Analog Point LATCHES
o9 0xFFFF FOB0 0044 On-Latch ON
High Density 0xFFFF FOB0 0048 OffLatch ON
COUNTER
0xFFFF FOS0 004C Active 1]
FEED OxFFFFFO30 0050 Data 0
ScratchPad  »
—Wirite Area =
Data Log »
Cukput Counter Clear:

PID 3

Events 3

Communications

Other 3

Turn Cn | 0xFOS0 0040

Turn OFf 0xFO30 0

Counter On | 0xFOS0 0043
Counter Off | 0xFO90 004C

ﬂl 0xFOFD 0004

On-Latch

Offiatch 0xFOFD 0204

0xFOFD 0104

Close Help |

™ Auto Refresh I 15000 msec

1. Click the point number you want to read or write to.

The current values for that point number appear in the Read Area. The Status data at the top right corner
of the window shows the date and time values were last read. The Read Area and the Write Area change
depending upon the point type.
2. Toturn counting on or off or to clear counters and latches, click the buttons in the Counter State and
Clear areas near the bottom of the window. (For more information on these features, see page 72.)

Your changes are immediately sent to the I/0 unit, and the window is updated to reflect your changes.

Digital Output Points

The following example shows a digital output point.
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Current values for point 1 on

this digital output module.
Click the Refresh button to
update values.

Change point state on an

output point by clickinga——"]

button in the Write Area.

CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

é Inspect Opto 22 Device

Analog Point |
High Density |

System 3 |
ScratchPad |

Device Name: | 10.192.55.67 ;I MI Status: | Digital Point area last written and read at 05/04/16 11:42:36
r Digital Point
Status Read |
- Step 1: Choose a module
SErEAE | [Modie [0 1 2 3|4 5 6 7]8 8 1 11]12 13 14 15 Type: Dig/none (0x00)
" Step 2: Choose a point on the selected module
Wireless LAN >| ~ Type:  Digital Qutput (0x180)
Point U’ 1 2 3|4 53 6 7|8 9 IEI 11112 13 14 13 Faabire: None (0x00)
Paint Canfig | 16 17 18 19|20 21 22 23|24 25 26 27|28 23 30 31  pgme: doDoughDispenseValve
Digital Bank | ~Read Area
DigitaH-Poimt II Address [ Description [ value | ﬁl
: K STATUS
s e | OxFFFF FOB0 0140 Point State o

—_— Turn Off | 0xF050 0144 Counter OFf | 0xF0S0 014C
Communications ¥ |

Other 3 |

[ Write Area =
Data Log 3 |
Output Counter Clear:
cesmnnd 0XF0900140 | Courter on | 0xF0S0 0148 Counter | 0xFOF0 0014
il 3

OnrLatch 0xFOFD 0114
Off-Latch 0xFOF0 0214

w |

[~ Auto Refresh |1suuu msec

1. Click the point number you want to read or write to.

2. The current values for that point number appear in the Read Area. The Status data at the top right corner
of the window shows the date and time values were last read. The Read Area and the Write Area change

depending upon the point type.

3. Toturn an output point on or off, click a button in the Write Area.

The change is immediately sent to the I/O unit, and the window is updated.

Reading and Writing to Analog Points

Analog Input Points

This example shows an analog input point. Module position numbers are shown near the top of the Inspect
Opto 22 Device window, with the point numbers for each module listed just below the position number. For
more on locating modules and points, see “Referencing I/0 Points”on page 155.
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Module position number

Point numbers for this

= Inspect Opto 22 Device (UDP) - *

Device Name: | R1 Controller j Cptions » Status: | Analog Point area last read at 09/23/16 12:02:32

Analog Point
Status Read ~
B T
- Step 1: Choose a module (i) More Info
SR [Modde [0 T =@+ 5 6 7]8 5 10 1112 13 14 15 Type:  AICTD (0x09)

_ Wireless LAN  » Step 2: Choose a point on the selected module - . ©09)
i 1 - F— ype: CTD (0x
module. Point 1 is currently 0 Y 2 3)4 5 5 7I8 8 10 1112 13 18 15 peqpre: None (0x00)
being read here. Paint Config 16 17 18 19|20 21 22 23|24 25 26 27|28 29 30 31  pgme: ai0venTemperature

Click the Refresh button to
update values.

Since point 1is an input point,
m,a.mj‘/ Events »

maximum values or set offset Communications¥ |

you can clear minimu

and gain.

The Two-Point Method

Read Area

D
% Address | Description | Value | Refresh |
Digital Point OxFFFF FO26 3000 Scaled Units
0xFFFF FO26 3004 Counts
Analog Bank OxFFFF FO26 3008  Min. Value (Scaled Units)
- OxFFFF FO26 300C  Max. Value (Scaled Units)
Analog Point 0xFFFF FO26 3024 Raw Counts
High Density
System 3
ScratchPad  »

Data Log 3

Write Area

Clear: Offset and Gain

Min. Value L BxPUID 4900 Step 1t Use a calibrator to input the sign@l that

corresponds to zero Engineering Units (i} Mare Info

=]
Max. Val 0xFO1D 4304
@ Step 2:  Calcand Set Offset
Step 3: Use a calibrator to input the signal that

corresponds to the maximum input range value
(positive scaling), or the minimum input range value
(negative scaling) (i) Mare Info

A Other 3 0.00000
Step4:  Calcand Set Gain

allows you to enter a real-world  }
Two-Point Method

range of values
for offset and gain.

v

Close | Help | [™ AutoRefresh | 15000  msec

1. Click the point number you want to read or write to.
The current values for that point number appear in the Read Area.
2. Toclear minimum and maximum values, click the buttons in the Clear area (see page 74 for information).

3. Tosetoffset and gain, use the default method (described below), or click the Two-Point Method and
follow the steps on page 176.

Your changes are immediately sent to the I/0 unit, and the window is updated to reflect your changes.

Calibrating Offset and Gain Using the Default Method

You adjust an analog point’s offset and gain to ensure that the measured values are accurate.
This section describes how to have the offset and gain automatically calculated and set for you.

NOTE: See “Calculating Offset and Gain Using the Two-Point Method” on page 176 if:

- You don't have access to a calibrator, or

- The point uses inverted scaling and your device has PAC firmware R9.5b or lower. (In inverted
scaling, the lower scaled value is greater than the upper scaled value.)

Starting with the introduction of SNAP-B3000-ENET, all SNAP PAC brains (including SBs), SNAP Ethernet I/0 units,
and E2 brain boards can automatically calculate offset and gain for analog input points. If a -50 mV to +50 mV
input receives signals that are slightly off (for example, not exactly -50 mV at the lowest point), the offset and gain
can be calculated so that values appear accurately when read.

Offset and gain values affect engineering units (EU). For a temperature input, engineering units are in degrees
Cor F, depending on how the I/0 unit is configured.
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IMPORTANT: To calibrate the point, the I/0 unit must be turned on and attached to the network, and you must
have access to the l/O unitin order to use the calibrator. For points on a SNAP PAC SB-series brain, connect directly via
serial or through the controller via Ethernet. (See page 26 for details.)

Save the configuration to flash so that it is not lost when power is turned off. Since each calibration is for a specific
point on a specific I/O unit, the result cannot be saved to the configuration file and cannot be sent to any other I/0

unit.

First, calculate offset, and then calculate gain. The offset must be calculated at the signal corresponding to
zero engineering units (EU), and the gain must be calculated at the signal corresponding to the point's
maximum input range value (or, for inverted scaling, the point’s minimum input range value—in inverted

scaling, the lower scaled value is greater than the upper scaled value).
In Inspect mode, click the Analog Point button.
Click the module and analog input point you want to calibrate.

1.
2.

Module —
Point — |

Offset and
Gain buttons

45| Inspect Opto 22 Device (UDP)

Device Name: [R1 Controller

;I Options DI

— =

Status: | Analog Point area last read at 09/23/16 12:02:32

3.
(

— analog Point
Status Read _ -~
Step 1: Choose a module (i1 More Info
SenEuiis —~[Modue [0 1 =z BEMl 24 5 & 78 o 10 11|12 13 14 15 Type:  AICTD (0x04)
i Step 2: Choose a point on the selected module
W £ b - = - Type:  ICTD (0x04)
|| Point CI’ 1_. 2 3 4 5 6 -1 9 IIEI 11. 12 13 i—? iS Feature: None (0x00)
Point Ca 15 17 18 13|20 21 22 23 25 26 27|28 29 30 31  pome:  aiDvenTemperature
—Read Area
ElElErs Address | Description | value | Refresh I
Digital Point OxFFFF FO26 3000 Scaled Units 102,026
0OxFFFF FO26 3004  Counts 15434.000
Analog Bank OxFFFF FO26 3008 Min. Value (Scaled Units) 0,000
0OxFFFF FO26 300C Max. Value (Scaled Units) 108.422
Analog Point OxFFFF FO26 3024 Raw Counts -1
High Density
—Write Area
System »
_ sisten v Output Yalues: Clear: Offset and Gain
Scratch Pad  #
Dutput Scaled (0xFO24 30000; Min. Value | OxFO1D Step 1: Use a calibrator to input the Slgﬂ§| that
Data Log [3 I w0z.026 Apply corresponds to zero Engineering Units (31 More Info
Max. Valu XFO1D 4904
PID 3 Step 2:  Calc and Set Offset I
Cubput Counts (0xFO24A 30047
Events 3 I 18434.000 Apply | Step 3: Use a calibrator to input the signal that
corresponds to the maximum input range value
Communications » TPO Period (0xFOZ4 ) {positive scaling), or the minimum input range value
(negative scaling) (i More Info
Other » I 0.00000 Apply |
Step 4+ Calc and Set Gain I
Two-Point Method |
~
close | nep | [~ AutoRefresh | 15000 msec

EU).

On the analog input point, use a calibrator to input the signal that corresponds to zero Engineering Units

Example 1:SNAP-AIV (-10 to +10 VDC) configured with default scaling
zero EU=0VDC
Example 2: SNAP-AIV (-10 to +10 VDC) configured with custom scaling

Actual Scaled

Units VDC
Lower -10
Upper +10

PSI
0*
100

*Zero EU is 0 PSI, which corresponds to a -10 VDC field signal

4. C(lick the Calc and Set Offset button.
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5. Use the calibrator to input the signal corresponding to the maximum input range value—or for inverted
scaling, to the minimum input range value—for the configured point type.

(Ininverted scaling, the lower scaled value is greater than the upper scaled value.)
For precise values, refer to the configured Point Type or see the module's data sheet.
Example:

SNAP-AIV module; Point Type of -10 to +10 VCD:

Maximum Input Range Value = +10VDC

For inverted scaling, Minimum Input Range Value =-10VDC

6. Click the Calc and Set Gain button.

NOTE: To store offset and gain values permanently, you must save the change to flash when you send the
configuration data to the I/O unit (see page 68).

Calculating Offset and Gain Using the Two-Point Method

You adjust an analog point’s offset and gain to ensure that the measured values are accurate.
«  Offset represents the low scale offset from the correct value.
«  Gain represents the slope of the scaling equation.

The two-point method allows you to use any real-world range of Engineering Units to calculate offset and
gain. Use this method when it isn't convenient or possible to input a signal that equates to either the
zero-scale or full-scale engineering units for a module’s point type. Also, you must use the two-point method
if the analog point you're calibrating uses inverted scaling and you're using PAC firmware R9.5b or lower. (PAC
firmware R9.5¢ and higher can automatically calculate offset and gain for analog points that use inverted
scaling.)

When using the two-point method, choose two points that are as far apart as possible.

1. [fitisn't already open, open the Inspect Opto 22 Device window for the point you want to calibrate (Tools
> Inspect | Analog Point button).

2. (Click the Two-Point Method button in the Offset and Gain area in the bottom-right corner of the Write
Area.

NOTE: You may have to scroll down to see the button.

Offset and Gain

b
L

|
|
!

Step 1: Use a calibrator to input the signal that
corresponds to zero Engineering Units (i) More Info

Step 2:  Calcand Set Offset

Step 3: Use a calibrator to input the signal that
corresponds to the maximum input range value
(positive scaling), or the minimum input range value
(negative scaling) (3} More Info

Step4:  Calcand Set Gain

wl— — Two-Point Method button

{
i ™ AutoRefresh | 15000  msec

3. Use a calibrator to input a signal corresponding to the low end of the desired range.
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For example, a SNAP-AIV module has a range of =10 to +10 VDG, so you might choose a range of 1.0 to
8.0 if it's convenient. In that case, you would use the calibrator to input a low end of 1.0 VDC on the input
point.

NOTE: For best results, choose two points that are as far apart as possible.

4. Note the signal’s value on the calibrator and type this value in the Expected Value field.
Write Area
Low Values
Step 1: Use calibrator to input a
signal corresponding to the low
end of the desired range.
fﬂtsﬁtikszr;;xxr:?llﬂufegginse |
to this signal.
Expected Value:
ExpectedValue ——f
Step 3: Read the value the
input is currently returning in
response to this signal.
Actual Value:
Read
For best results, choose a low and high point as far apart as possible. Default Method
Read button
5. Click the Read button to read the value that the input point is returning in response to this signal. This
value appears in the Actual Value field.
6. Use the calibrator again to input a signal corresponding to the high end of the desired range.
Using the SNAP-AIV example in step 2, for the high end you would use the calibrator to input 8.0 VDC on
the input point.
7. Type the Expected Value for the high-end value, and then click Read.
8. (lick the Calculate button to calculate the offset and gain.
9. (lick Send Values to send the offset and gain to the device.
10. Save the settings to flash memory to make sure that the data is not lost when power to the device is

turned off. See “Saving Configuration to a Device's Flash Memory” on page 190.

Analog Output Points

The following example shows an analog output point.
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Current values for point 1
on module 2.To update
values, click the Refresh
button.

Change the value on an

output point by using  —]

the Write Area.

= Inspect Opto 22 Device — X
Device Name: | 10.192.55.67 ;I Options # | Status: | Analog Point area last read at 05/04/16 11:46:30
— Analeg Paint
Status Read | N A
- Step 1: Choose a module (i) More Info
SESWAE [Modue [0 1 2 3[4 5 & 78 9 10 11]12 13 14 15 Tyse:  AOV-27 (0xA7)

Step 2: Choose a point on the selected module
Wireless LAN  » | - 1 +/- 10 VDC Dual (0xAT)

.
Pont [ OB 2 3% 5 6 7|8 5 0 1112 13 1 15 peoere bl 0]
Point Config | 16 17 18 19|20 21 22 23|24 25 26 27|28 23 0 31 pomer  soConveyorSpeedControl
Read Area
Digital Bark |
L Address |Descr\Etion |\|'a|ue | Refresh I
Sigitat-Faimrt—t OXFFFF F026 2040 Scaled Units 5,000
— OXFFFF F025 2044 Counts 204,000

Analog Bank | 0xFFFF FO26 2048 Min. Value (Scaled Units) MaM
- OxFFFF FO26 204C  Max. Value (Scaled Units) MaN
Analog Paint OxFFFF FO25 2064 Raw Counts -1
High Density |
[ Write Area
System » | Offset and Gain
Output Values: Clear:

Step 1: Use a calibratar ta input the signal that

ScratchPad  » | -
Output Scaled (0xFO2A 2040): rlim, Value | 0xF01D 460C carresponds ko zera Endinesting Units (3) More Info
Data Log L3
| Ly I 5.000 Apply | Max, Value | 0xFO1D 4510 Step2: | (Calc and Set Offset |

D 3
Output Counts (OxFO24 2044):
—_— e ( ) Step 3: Use a calibrator to input the signal that
Events L4 | 204.000 Apply | correspands ko the maximurn input range value
{positive scaling), or the minimurn input range value
Communications » | TRO Period (OxFO2A 2040 (negative scaling) (i) More Info

Other L4 | IU.UUUUU Apply | Step 41 Calc and Set Gain | w
Clase | Help | ™ Auto Refresh | 15000 msec

1. Click the point number you want to read or write to.
The current values for that point number appear in the Read Area.

2. To change the value of an output point, enter the value in the Write Area (either Scaled or Counts) and
click Apply.
The change is immediately sent to the I/O unit, and the window is updated.

Reading Analog and Digital Banks

You can use PAC Manager to read a bank of points at one time. (Currently it is not possible to write to a bank of
points using PAC Manager.) You must configure points before you can read them.

NOTE: Bank reading cannot be done on digital or analog modules containing more than four points. To read or write
to all points on a high-density digital module, see page 181.

1. Inthe PAC Manager main window, click the Inspect button Bl
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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If you have configured other devices, they are listed in alphabetical order in the drop-down list.

Status:

j Options »

Status Read area last read at 07/05/16 10:34:58

DESCRIFTION

VALUE

~ Refresh |

Device Name: | 10.199.59.99
Status Read
Status Read
Status Write NS
- R 0xFFFF FO30 0004
WEEES 0xFFFF FO30 0008
Point Config 0xFFFF FO30 0018
— 0xFFFF FO30 0000
EREIE 0xFFFF FO30 0230
Digital Point 0xFFFF F030 001C
0xFFFF FO30 00RO
Analog Bank 0xFFFF F030 00BO
Analog Point 0xFFFF FO30 0020
i i 0xFFFF FO30 0080
ELIEEE 0xFFFF FO30 0024
R 0xFFFF FO30 0025
HEED 0XFFFF FO30 0026
———— 0xFFFF FO30 024C
0xFFFF FO30 0028
Data Log 3
PID * 0xFFFF FO30 002E
- R 0xFFFF FO30 0034

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
29.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

If you have configured six or more devices, the Inspect window provides two additional time-saving

features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

2.
list). Click Digital Bank or Analog Bank.

See also:

Wpto 22 Device

Device Name{ | afslslTel gl =g

Cookie Controller

EngineRm

ST Coil Portable i

Status wiitd SoftPAC [CRIPTION
Wireless LAN | Boter I Eles
—— I Chamber 1 s
. Chamber 2 J
Point Config g portable der Versid
T Cookie Controller ory Map Ve
Digital Ban EngineRm SRy
Digital Point 221 PAC méare Ver.
% ‘fJxFFFF FO30 00BO0 Firmware Very
s lieR i s, i o
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In the Device Name field, type the name (or IP address) of the 1/0 unit (or choose it from the drop-down
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Digital Bank Window

=] Inspect Opto 22 Device

Remember that values for points on high-density digital modules are not included.

Device Mame: | 10.192.55.67

Digital Bank Read
Status Read

Status Write
Wireless LAN  #

Point Config
Digital Paint
Analog Bank
Analog Point
High Density

System »
ScratchPad
Data Log 3

FID

Events 3
Communications ¥
Other 3

Close

3

Values are current as of the Status date and time.

Click Refresh to update values.

\_

~| options » Status: | Digital Bank area last read at 05/02/16 16:07: ?x

Help

ADDEESS

0xFFFF F040
0xFFFF F040
0xFFFF F040
0xFFEF F040

ADDEESS

0x00000000 0000000C
0x00000000 O0FCCCFA
0x00000000 O0FCCCFA
0x00000000 00000000

0xFFFF F040
0xFFFF F040
0xFFFF F040
0xFFEF F040
0xFFFF F040
0xFFFF F040
0xFFFF F040
OxFFEF F040
0xFFFF F040
0xFFFF F040
0xFFFF F040
0xFFEF F040
0xFFFF F040
0xFFFF F040
0xFFFF F040
OxFFEF F040
0xFFFF F040

|

DESCRIPTION VALUE
[ufa]ula] State of Digital Points
000g State of On-Latches
0010 State of Off-Latches
00ls Active Counters

MODULE POINT COUNTER VALUE
0100 0 0 1
0104 1} 1 0
0108 a 2 a
010c 0 3 ]
0110 1 4 ]
0114 s 5 ]
0118 1% ] a
011c 1 7 ]
0120 2 g 0
0124 2 9 0
0128 2 10 a
0i1zc 2 11 ]
0130 il 12 ]
0134 3 13 ]
0138 & 14 a
013C 3 15 ]
0140 4 16 0

™ Auto Refresh | 15000  msec

~

You can copy part or all of the data in this window and paste it into another file, such as a text file or email. Just
highlight what you want to copy, right-click it, and choose Copy from the pop-up menu (or use Ctrl+C). To
highlight all data in the window, right click in the window and choose Select All.

Data Formats. Most digital bank data is in the form of a mask. For example, the State of Digital Points value

shown in the previous figure is this mask:

0x00000000 00000COOC

This mask shows, in hex, the state of all 64 possible points (maximum rack of 16 modules with four points per
module). The lowest points are on the right:

Hex:| O 0 0 0 0 0 0 0 0 0 0 0 0 0 0 C
Binary:| 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 1100
Points:| 30 | 3-0 | 3-0 | 30 | 30 | 30 | 30 | 3-0 | 30 | 30 | 30 | 3-0 | 3-0 | 3-0 | 3-0 | 3-0

Modules:| 15 14 13 12 1 10 9 8 7 6 5 4 3 2 1 0

In this case, all points are OFF except for points 2 and 3 on the module in position 0, which are ON. For more
help in interpreting bank data, see page 197.

Bank counter data, however, uses unsigned 32-bit integers; for help in interpreting counter data, see page 197.
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Analog Bank Window
Values are current as of the Status date and time.
Click Refresh to update values.

l

=] Inspect Opte 22 Device x— *
Device Name: I 10.192,50.15 ;I Options + I Status: IAnang Bank area last read at 05/02/15 16:00:18
—Analog Bank Read
Status Read |

wl LDDRESS MODULE  POINT  VALUE -
= 0xFFEF F026 0000 O
SRR ’l 0xFFFF F026 1000 1
0xFFFF F026 2000 2
Paint Config | 0xFFFF FO26 2040 2

= 0XFFEF F026 3000 3
L'Ba”kl 0xFFFF FO26 3040 3
Digital Paint | 0xFFFF FO26 4000 4
OXFFFF F026 4040 4

5

&

7

7

8

g

Analog Bank OXEFEF 026 5000
_ OXFFEF F026 G000
Analog Point | 0xFFFF FO26 7000
. . OXEFEF F026 7040
IR, OXEFEF 026 8000
: OXFFEF 026 9000
St | 0xFFFF F026 9040 9
e ,l OXFFFF FO26 A000 10
OXFFEF F026 A040 10
Data Log >| 0xFFFF F026 BOOO 11

0xFFFF F026 B040 11
PID L 0xFFFF F026 C000 12

T OxFFFF F026 DOOO 13
| OxFFFF F026 EOO0 14
Communications ,l OxFFFF F026 E040 14
OXFFFF F026 FOOO 15

Other >| OxEFFFF F026 FO40 15

o= | FEE I [ AutoRefresh |15000 msec

L e B e I Y
=]
=1
(=1

For help in interpreting analog point data, see “IEEE Float Data” on page 198.

Reading and Writing to SNAP High-Density Digital Points

In PAC Manager, you can read or write to points on high-density digital modules in two ways: one at a time
using the Digital Point button (see page 171), or all at once as shown below.

1. Toread or write to points on high-density digital modules, click the Inspect button @l in the PAC
Manager main window.
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2. IntheInspect Opto 22 Device window, type the Device Name (or IP address) of the I/O unit (or choose it
from the drop-down list). Click High Density.

23 Inspect Opto 22 Device

Device Mame: ]FH controller Li Oplions ¥ Status: ]ngh Denzity Digital Module area last read at 10/04/07 13:08:07
T e Hiagh Drensity Digital Module:
tatus Rea
Module Humber: 1_ | Standard Module Type: Dig/none (0=00]
Skatus Write: ]

Address ] Diescription ] Walug I Refresh
Point Config

Digital Bank. 4‘
Diigital Paint
Analog Bank
Analog Point Foint | State [ OndLatch DffLaich | Counler
Swpstem »
Scratch Pad  »
Datalog »
FID 4
Ewents »
Communications ¥
Other +

Close Help

3. (lick the module number for the point you want to read or write to.
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SNAP High-Density Digital Input

For an input module, the current states and latches appear, both as bitmasks in hex and individually for each
point. Counter values appear in the Counter column.

=2 Inspect Opto 22 Device

Device Mame: ]FH controller Li Options ¥ Status: ]High Density Digital Module area last read at 10/04/07 13:14:40

Hiah Density Digital Module
Status Read

Madule Mumber: 1 ~ | High Density Digital Input Madule Type: |DC-32 [O<E0)

Status Wiite ]

Address ] Description ] Walue ] Refresh
Paint Config STATUS
Digital Bank 0<FFFF F180 8300 m?gutESState Mazk 0w 00000000 00000000 "
Digital Poirt 0<FFFF F180 8303 OrnrLatch Mask O 00000000 00000000

0<FFFF F120 8310 Off-Latch Mask O 00000000 00000000

Analog Bank
Analog Point Paint State ] On-Latch Off-Latch ] Counter |4: Clear it

_Hwnoensy |7 gi o o 0 o |
2 0if il off 0
System  F 3 On On off 5 e
4 Dn On il 0
M 5 O o off 0
6 i On On 0
_ Datalog ¥ 7 off off oif 0 i
PID v g Off o off 0
9 On oif off 1
Ewvents 3 10 oFf off On 0
n On off ] 6
Communications ¥ 12 aff aff 0 il
13 il il il 0
Other 4 14 oif off oif 0
15 i oif off 0
16 il oif off 0 v

Close Help I

To clear latches for a point, highlight the point number and click the Clear On-Latch or Clear Off-Latch button.
To clear the counter for a point, highlight the point and click the Clear Counter button.

The change is immediately sent to the I/O unit, and the window is updated.
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SNAP High-Density Digital Output

For an output module, the current states appear, as bitmasks in hex and for each point.

23 Inspect Opto 22 Device

Device Mame: ]FH controller Li Optionz # Status: ]High Density Digital Module area last read at 1040407 13:24:24

High Density Digital Maodule
Status Read

Module Humber: i | High Density Digital Output Module Type: ODC-32-5RC [0=E1)

Status Write ‘
- - Address ] Description ] Walue | Refresh
Paint Config STATUS

Digital Bark 0«FFFF F180 8340 Paint State Mask 0 00000000 000041 CE .
Digital Paint
Analog Bank
#inalog Paint ‘ Point State [ ~ —r
High Density 10 g: —
2 g
Syztem 3 3
Scratch Pad  » g g;;
E
7
]
9

Datalog
FID L4
Ewvents » 10 Off
11 Off
Commurnications # 12 uli]
13 On
Other L4 14 O

Close | Help I

To turn a point on or off, highlight the point number and click the Turn On or Turn Off button.

The change is immediately sent to the I/O unit, and the window is updated.

Reading System Date and Time

SNAP PAC controllers and brains have a real-time clock. A SoftPAC controller uses the computer’s clock.

1. Toread the date and time on the device, click the Inspect button Q| in the PAC Manager main
window.

2. Inthe Inspect window, type the name of the device (or choose it from the drop-down list). Click System
> Date And Time.

The device’s date and time appear.
NOTE: Although you can change the date and time by clicking a cell in the Value column and typing in the new
number, then clicking Apply, there is a slight delay before the time is set on the unit. Other ways of setting time

may be more accurate, for example, using PAC Control to synchronize system date and time. See also “Setting
Up System Date and Time” on page 116 for another method.

Reading and Writing to the Scratch Pad Area

Before using this section, be sure to read “Event/Reaction Concepts”on page 127.

You can read the current state of Scratch Pad bits and current values in Scratch Pad integers, strings, and floats
using PAC Manager. You can also change these values in real time, which can be useful for testing. If you are
running PAC Control, make sure your changes do not conflict with strategy logic.

1. Toread or change the Scratch Pad area, click the Inspect button @ in the PAC Manager main window.
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2. Inthe Inspect Opto 22 Device window, type the IP address of the I/O unit (or choose it from the
drop-down list). Click Scratch Pad and then choose the area you want from the pop-up menu.

Scratch Pad Bits

The Scratch Pad bits window shows you the current state of the Scratch Pad bits (as of the Status date and
time) and the current On and Off masks. You can change any of these masks by clicking its cell in the Value
column and typing in the new mask, then clicking Apply.

Values are current as of the Status date and time.
Click Refresh to update values.

| \
8 Inspect Opto 22 Device i \ — *
Device Name: | 10.192,55.67 Ll Options ¥ | Status: | Scratch Pad Bits area last read at 05/04/16 11&-\48:26
_ ; \
Scratch Pad Bits ]

Status Read |

Status Write | G | Description | value | | Refresh |
DIRECT ACCESS
. 0xFFFF FODS 0000 Scratch Pad Bits Ox 00000000 00000000 Apply |
Wireless LAN  » |

MOMO ACCESS
0xFFFF FODS 0400 ON Mask 0x 00000000 00000000

Point Config | 0xFFFF FODS 0408 OFF Mask Ox 00000000 00000000
Digital Bank |
Digital Point |
Analog Bank |
Analog Point |
High Density |

System 3 |
Data Log 3 |
PID 3
Events 3 |
Communications |
Other 3 |

s | e | [ Auto Refresh I 15000  msec
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Scratch Pad Integers, Floats, and Strings

Scratch Pad Floats are used as the example here, but integers and strings are similar. Current values are shown
as of the Status date and time. To update values, click Refresh.

Change the value in the When all new values are
Value column. entered, click Apply.
= Inspect Opto 22 Device - *
Device Name: I 10,192,55.67 LI Optigns ¥ Status: | Scratch Pad Floats area last read at 05/04/16 11:52:52
Scratch Pad Floats
Status Read |

Status Write | Apply | Address | value |~ Re\'resh I
Oo OXFFFF FODE 2000 O Apply
Wireless LAN  » | O: OXFFFF FODS 2004 |
O: OXFFFF FODB 2008
= Clear Al
Paint Canfig | Os OXFFFF FOD 200C |
O OxFFFF FODE 2010
Digital Bank | Os OxFFFF FODS 2014 Select Al |
Digital Point | e  oxFFFFFoDB 2018 Unselect All |
Oz OxFFFF FODS 201C
ml [1s  oOxFFFFFODS 2020
Analog Point | Os OxFFFF FOD 2024
O w

0xFFFF FODS 2028

wl [J 11 OxFFFF FODS 202C
[0 12 OxFFFFFODS 2030

ﬂl []13  oxFFFF FODS 2034
SratchPad  » | [J 14  oxFFFF FODS 2033

[ 15  OxFFFF FODS 203C
Datalog  *» | []15  OxFFFF FODS 2040
o 5 [ 17  OxFFFF FODS 2044

118 OxFFFF FODS 2043

M 119  OxFFFF FODB 204C
Communications » | [120  0xFFFF FODS 2050

[J21  OxFFFFFODS 2054
M [J22  oxFFFF FODS 2058
o e | [™ Auto Refresh I 15000  msec

(== = R = = = T = N = Y = = T~ = T = = I = = = = I = =)

The Select All and Unselect All buttons control the check marks in the Apply column boxes. The Clear All
button puts all values at zero.

1. Tochange avalue in Scratch Pad integers, floats, or strings, click the cell in the Value column and type the
new value.

A check mark appears in the Apply column box. If you do not want to send a value, click the box to
uncheck it.

2. C(lick the Apply button to write the new values to the Scratch Pad.
All the checked items are changed.
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Data Logging

Data logging is normally configured in a configuration file (see page 87), but you can change it in the Inspect
window. Remember that changes made here cannot be saved to a configuration file, however. To change
configuration, with the 1/0 unit’s IP address in the Inspect window, click Data Log > Data Logging Configure.
For help, see the information in the steps on page 87.

To read the data in a data log you have set up, use PAC Manager’s Inspect window. See instructions on
page 89.To clear all data from a data log, see page 90.

Reading or Changing PID Loops

For information about PID loops, see page 63. PIDs are normally configured in a configuration file following
the steps on page 65. However, you can also configure, view, or change them using PAC Manager's Inspect
window. (Remember that changes made here cannot be saved to a configuration file.)

1. Inthe PAC Manager main window, click the Inspect button Q .
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

=

Device Name: | 10.199.59.99

Status Read
Status Read
Status Write ADDRESS - Refresh | |

T 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0} |
e OxFFFF F030 0008 Buay Flag 0

Paint Config 0xFFFF F030 0018 Loader Version R5.1lc |

j Options # Status: | Status Read area last read at 07/05/16 10:34:58

DESCRIFTION VALUE

= 0xFFFF FO30 0000
EREIE 0xFFFF FO30 0230

Memory Map Version
Current Boot Device

1
Flash Memory

Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016
Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A
High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3
ETHERENET 1 Interface
PID L 0xFFFF FO30 002E MAC Address 00-R0-3D-01-85-9C
= N 0xFFFF FO30 0034 IF Address 10.192.55.67
Y ,MWMW

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

Inspect Opto 22 Device

Device Name

Cookie Controller

EngineRm
SN Coil Portable :
. |SoftPaC [CRIPTION

Status W!lte Boider
Wireless LAN | Boter I Clea
——IChamber 1 s
. Chamber 2 J
Point Config g portable der Versid
= Cookie Controller iory Map V
Digital Ban EngineRm SRy
Digital Point S2fPAC mware Ver,
—: | |0xFFFF FO30 00BO0 Firmware Very
A ’ et P e

2. Inthe Device Name field, type the name (or IP address) of the 1/0 unit (or choose it from the drop-down

list). Click PID and choose PID Loops from the submenu.

% Inspect Opto 22 Device — X
Device Name: | 10.192.55.67 LI Options ¥ Status: | PID Loop area last read at 05/04/16 11:35:31
Information for this PID loop is
. . PID Loops
shown in the window. St
GID Loop Number: 0 vl )
Status Write |
. Address | Description | Value | ~ Refresh I
M STATUS
OxFFFF F210 0064 Current Value Of Input Apply |
Paint Config | 0xFFFF F210 0068 Current Value Of Setpoint
> 0xFFFF F210 000C Current Value Of Output 0.000000
Digital Bank | OxFFFFF210 0008 Current Value Of Feed Forward 0.000000
. . OxFFFF F210 0000 Last Scanned Value OF Input 0.000000
Digital Point | OxFFFF F210 0004 Lest Scanned Value OF Setpaint 0.000000
0xFFFF F200 0028 Scan Counter 0
ml OXFFFFF200 002C  Status Flags 00000000
Analog Point | OxFFFFF200 0030 Status Flags On Mask 00000000
0xFFFF F200 0034 Status Flags Off Mask 00000000
High Density | 0xFFFF F200 0000 Current Value Of Errar
0xFFFF F200 0004 Current Value Of P (Gain)
System » | OxFFFF F200 0008 Current Value OFf I (Integral)
OxFFFF F200 000C Current Value Of D {Derivative)
sgatchPad | 0xFFFF F200 0010 Current Value Of Integral
TUNING
Data Log 3 | 0xFFFF F210 0010 Gain 0.000000
0xFFFF F210 0014 Tune I {Integral) 0.000000
PID 13 0xFFFF F210 0018 Tune D (Derivative) 0.000000
0xFFFF F210 001C Feed Forward Gain 0.000000
Events > | CONFIGLRATION
o 0xFFFF F210 0050 Algorithm MNaone =
Communications ¥ | OxFFFF F210 0054 Mode Automatic =)
| OxFFFF F210 0038 Scan Time (seconds) 1.000000
Other D MwFFFF F210 NN4a4 MemMan Addrecs For Tnmt M ANANNNNN v
Help [~ AutoRefresh | 15000  msec

3. From the drop-down list, choose the PID loop number you want to configure, view, or change.

Existing PID loops are indicated by an asterisk (¥) next to the number.
4. To configure or change the PID, click inside the cell in the Value column and type the new value or

choose it from a drop-down list, if one is available. When you have finished making changes, click Apply
to send them to the 1/0 unit.

NOTE: If you are using PAC Control, it is easiest to tune PID loops in your PAC Control strategy running in Debug
mode. For details, see the PAC Control User's Guide (form 1700).
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Choose the event
number from the
drop-down list.

i 5 Digital Events - Expanded
afuﬁ
This event's - EventMumber [0 =
configuration data is StatusWike | = e o (raw
shown here. Paint Confia ress E\?;erl-?mn alue efresl |
T Digitajl e 0=FFFF FOD4 004C  Event Enable/Disable Apply
0«FFFF FOD4 0044 Usze which digital data for tigger? Diigitél Point State
Digital Paint O«FFFF FOD4 0000 Digital OM 0 40000000 00000000
O«FFFF FOD4 0003 Digital OFF 00000000 00000000
Analog Bank 0«FFFF FOD4 0044 Usze which scratch pad data for trigger? cratch Pad Bitz
OxFFFF FOD4 0010 Scratch Pad ON (x 00000000 00000000
Analog Point O«FFFF FOD4 0018 Scratch Pad OFF (x 00000000 00000000
0«FFFF FOD4 0040 Length of Delay Before Reaction [msec.] 1]
High Drengity
REACTION
System 3 0«FFFF FOD4 0044 Feaction Occurs Continuously
0«FFFF FOD4 0044 Usze which digital data for reaction”? Digital Point State
SoratchPad  » OxFFFF FOD4 0020 Digital OM (x 00000000 00000000
O«FFFF FOD4 0028 Digital OFF (x 00000000 00000000
Datalog 0x=FFFF FOD4 0044 Use which scratch pad data for feaction? Scratch Pad Bits
FID 3 OxFFFF FOD4 0030 Scratch Pad ON (x 00000000 00000000
OxFFFF FOD4 0038 Scratch Pad OFF (x 00000000 00000000
L CURRENT STATUS > Refresh
et O+FFFF FOD4 004C  Event State off 4
Other v 0«FFFF FOD4 0048 Time Remaining [mzec. ] 1]
0«FFFF FO40 0000 Current Y alue - Digital Point State [ 00000000 00000000
0=FFFF FODE 0000 Current Y alue - Scratch Pad Bits (0= 00000000 00000000
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For information on memory map addresses and what they contain, see the OptoMMP Protocol Guide (form
1465).

Reading or Changing Events and Event Messages

Digital, alarm, serial, timer, and Wiegand events are normally configured in a configuration file. Event
messages are configured in a configuration file if you are using PAC Control; otherwise, they are configured in
the Inspect window. See Chapter 4: Setting Up Events and Reactions for configuration steps on all events and
event messages.

However, you can read current events and also change their configuration in the Inspect window. Digital
Events are shown below as an example.

Current status of the event (as of the
Status date and time) is shown here.

=3 Inspect Opto 22 Device

Device Mame: |SB brain Status: |Expanded Digital Event arg last read at 10/05/07 18:08:27

j Optionz

Cloze | Help |

Reading or Changing Communications and Other Data

Other data on the I/O unit or standalone controller can also be read and changed using PAC Manager's Inspect
window. The following table shows where to find the data in the Inspect window and references page
numbers in this guide for information to help you understand what you are reading or how to change it:

To read or change Click this in the Inspect window For help, see

Security Communications > Network Security page 78
PPP Communications > PPP page 123
Streaming Communications > Streaming page 104
Email Communications > E-mail page 100
Modbus Communications > Modbus page 112
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To read or change Click this in the Inspect window For help, see

SNMP Agent Communications > SNMP page 96

Serial ports on brain or

Communications > Communication Port Control page 118
controller

In addition, you can read or write to any memory map address by clicking Other > Generic Read/Write. See
the memory map appendix in the OptoMMP Protocol Guide (form 1465) to make certain you have the correct
address before making any changes.

WRITING COMMANDS TO THE DEVICE

NOTE: If you are using the PAC Control Redundancy Kit and redundant controllers, do not use PAC Manager to work
with your controllers. Instead, use the PAC Redundancy Manager that comes with PAC Control Professional (version
R9.0 or higher).

Using OptoMMP Device Commands

CAUTION: These hardware commands directly affect the operation or configuration of the device. Be careful when
you use them, as they cannot be undone.

Saving Configuration to a Device's Flash Memory

Saving configuration data to the controller or I/O unit’s flash memory makes sure that the data is not lost
when power to the device is turned off.

If you are using a configuration file (as in most of Chapters 2, 3, and 4), you can choose to save configuration
data to flash memory when the file is loaded to the 1/0 unit. However, if you are writing configuration directly
to the device (as in this chapter), you'll need to follow these steps to save to flash.

Note that this command saves to flash the things you can configure in PAC Manager. It does not affect a PAC
Control strategy, which is saved to flash via PAC Control or PAC Terminal.

CAUTION: If you are using PAC Manager R9.0a or higher, PAC firmware R9.0a or higher, and loader version 6.0 or
higher, and if a controller has a microSD card installed and the card already contains configuration data, that data
will be overwritten. See the controller user’s quide for complete information about microSD.

1. Inthe PAC Manager main window, click the Inspect button @ .

2. Inthe Device Name field, type the name (or IP address) of the device, or choose it from the drop-down
list. Click Status Write.
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In the Operation Command list, highlight Store configuration to flash.

é Inspect Opto 22 Device

Device Name: | 10.192.50.11 Ll Options ¥ | Status: | Status Write area last read at 05/02/16 16:30:29
~Status Write
Status Read |
Status Write Address | Description | Value -
0xFFFF FO33 0004  Always BootP/DHCP On Powerup Mo Rl o
. OxFFFF FO38 0008 Degrees F/C Degrees F B3 ¥ |
Wireless LAN ¥ 0xFFFF FO330010  Comm Watchdog Time (msec), 0 = Disable 0
DxFFFF FO33 0014  TCP Minimum Retransmission Timeout (msec) 250
Paint Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
0xFFFF F038 001C TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
OxFFFF FO3& 0294 Digital Feature Scan Interval (msec) 1
Digital Point 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Anslog Bank DxFFFF F033 0298 Out Of Range Value (16-Bit) -32768.000
OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147483548.000
DxFFFF FO33 0054  Scanner Flaas 0x 00000000 e

Analog Point

High Density
System 4
ScratchPad  »
Data Log »
PID 3
Events 3
Communications #
Other 3

w_|

Operation

OptoMMP Device
Restart Device from powerup

~ Send Command |

Store configuration to flash
Erase configuration from flash k
Reset to defaults and Restart Device

microSD
Store configuration and IP settings to micraSD
Erase configuration and IP settings from microSC
Erase firmware from microsD
Erase strategy from microsD

Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration ]

[ Auto Refresh IISDDD msec

4. (lick Send Command.
The configuration data is stored to flash memory and a Success message appears.

Restarting the Device

Restarting the device is just like turning the power off and then turning it back on again. This command can
be used for both 1/0 units and controllers. For an I/O unit, if configuration data has not been saved to flash
memory, restarting resets points to their defaults.

For some configurations to take effect, the device must be restarted. A SNAP PAC controller must be restarted
after you configure its secondary IP address, for example. For an 1/0 unit, if you are using a configuration file (as
in most of Chapters 2, 3, and 4), you can choose to restart the unit when the file is loaded to the I/0 unit and
saved to flash memory. However, if you are writing configuration directly to the I/0 unit (as in this chapter),

after you store to flash, you need to follow these steps to restart it.
1. Inthe PAC Manager main window, click the Inspect button @l
2. Inthe Device Name field, type the name (or IP address) of the device, or choose it from the drop-down

list. Click Status Write.
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3. Inthe Operation Command list, highlight Restart Device from powerup.

é Inspect Opto 22 Device

Analog Point

High Density
System 4
ScratchPad  »
Data Log »
PID 3
Events 3
Communications #
Other 3

A Refresh |

Operation

microSD

Other

OptoMMP Device ~ Send Command |
Restart Device from powery
Store configuration to flash k

Erase configuration from flash
Reset to defaults and Restart Device

Store configuration and IP settings to micraSD
Erase configuration and IP settings from microSC
Erase firmware from microsD

Erase strategy from microsD

Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration ]

il‘ wvl

Device Name: | 10.192.50.11 Ll Options ¥ | Status: | Status Write area last read at 05/02/16 16:30:29
~Status Write

Status Read |

Status Write Address | Description | Value
0xFFFF FO33 0004  Always BootP/DHCP On Powerup Mo

. OxFFFF FO38 0008 Degrees F/C Degrees F

Wireless LAN ¥ 0xFFFF FO330010  Comm Watchdog Time (msec), 0 = Disable 0

DxFFFF FO33 0014  TCP Minimum Retransmission Timeout (msec) 250

Paint Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
0xFFFF F038 001C TCP Retransmission Attempts 5

Digital Bank 0xFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
OxFFFF FO3& 0294 Digital Feature Scan Interval (msec) 1

Digital Point 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000

Anslog Bank DxFFFF F033 0298 Out Of Range Value (16-Bit) -32768.000
OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147483548.000
DxFFFF FO33 0054  Scanner Flaas 0x 00000000 e

w_|

[ Auto Refresh IISDDD msec

4, C(lick Send Command.
The device is restarted and a Success message appears.

Resetting to Defaults and Restarting

Resetting the device to defaults erases configuration information from the device’s flash memory. (It does not

erase IP address settings nor PAC Control strategy files in a controller.) Resetting also does the following:

«  Ifthe device has PAC firmware R9.0a or higher and loader R6.0 or higher and a microSD card is present,
resetting erases PAC firmware, strategy, and IP address and configuration data from the card (does not

erase other data files or I/O coprocessor firmware)

«  (lears all point configuration and features, such as offsets and gains, custom scaling, latches, counters,

and minimum/maximum data
«  Turns off digital outputs and defaults all digital points to inputs
«  Setsanalog outputs to zero scale (0 counts)

o Restarts the device

Follow these steps to reset and restart the device:

1. Inthe PAC Manager main window, click the Inspect button Ql
2. Inthe Device Name field, type the name (or IP address) of the I/0 unit, or choose it from the drop-down

list. Click Status Write.
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3. Inthe Operation Command list, highlight Reset to defaults and Restart Device.

é Inspect Opto 22 Device

Device Name: | 10.192.50.11 j Options ¥ Status: | Status Write area last read at 05/02/16 16:30:29
Status Write
Status Read |
Status Write Address | Description | Value A Refresh
0xFFFF FO33 0004  Always BootP/DHCP On Powerup Mo =
. OxFFFF FO38 0008 Degrees F/C Degrees F Jid Apply
Wireless LAN ¥ 0xFFFF FO330010  Comm Watchdog Time (msec), 0 = Disable 0
0xFFFF FO38 0014 TCP Minimum Retransmission Tmeout (msec) 250
Paint Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
0xFFFF F038 001C TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
OxFFFF FO3& 0294 Digital Feature Scan Interval (msec) i
Digital Point 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bank OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
0xFFFF FO33 02B0  Out Of Range Value (32-Bit) -2147433543.000
0xFFFF FO38 0054  Scanner Flaos 0x 00000000 hd

Analog Point
High Density Operation
OptoMMP Device
Restart Device from powerup
3
HEEn Store configuration to flash
Erase configuration from flash
L3
Sl Reset to defaults and Restart Device k
Datalog »| | [mcosD
9 Store configuration and IP settings to micraSD
PID b Erase configuration and IP settings from microSC
Erase firmware from microsD
Events 3
Communications #
Other 3

Erase strategy from microSD

~ Send Command

Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration ]

™ AutoRefresh | 15000  msec

4. (lick Send Command.
The I/0 unit is set to defaults and restarted. A Success message appears.

Sending a Powerup Clear

The powerup clear command clears a flag that indicates the I/0 unit has lost and then regained power.
Normally a powerup clear command is automatically sent, so normally you won't need to use this command.
If you receive a powerup clear error message, however, you can use PAC Manager to send the command. Note
that a power loss means that any configuration data not stored to the I/0 unit's flash memory has been lost.
1. Inthe PAC Manager main window, click the Inspect button @

2. Inthe Device Name field, type the name (or IP address) of the device. Click Status Write.

3. Inthe Operation Command list, highlight Send powerup clear.

4. (lick Send Command.

The powerup clear is sent, and a Success message appears.

Using microSD Commands

NOTE: These commands require PAC Manager R9.0a or higher and PAC firmware R9.0a or higher. Use Status Read to
see the firmware version (see “Reading Basic Device Information” on page 147).

SNAP PAC S-series and R-series controllers manufactured from November 2008 to the present have a microSD
card slot that accommodates cards up to 2 GB. These cards can be used to log data, of course, but they can
also be used as a kind of boot disk for the controller, so that you can replace a failed controller with a new one
by simply putting the prepared microSD card into the new controller, turning the controller on, and
connecting it to the network. The new controller boots from the card and configures itself; you can then use
the controller's Reset button to save the data on the card to flash memory.
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Before using the card or any of these commands, be sure to read the section on microSD in the Maintenance
chapter of the controller user's guide. A few steps are repeated here for convenience, but the user’s guide has
the complete information.

Three types of information can be put on the card to use it as a boot disk:

«  PACfirmware files

«  Strategy files

«  Configuration data

Configuration data includes all current configurations (those that can be done in PAC Manager) plus the

controller's IP address and IP settings. The steps below show only how to add configuration data; see the
controller user's guide to add firmware and strategy files.

Putting Configuration Data on the microSD Card
1. Inthe PAC Manager main window, click the Inspect button Ql .

2. Inthe Device Name field, type the name (or IP address) of the device, or choose it from the drop-down
list. Click Status Write.

3. Inthe Operation Command list, highlight Store configuration and IP settings to microSD card.

X

%] Inspect Opto 22 Device -

Device Name: I 10.111.11.11 LI Options » | Status: | Status Write area last read at 05/02/16 16:30:29
~ Status Write
Status Read |
Status Write Address | Description | Value ~ Refresh |
0xFFFF FO38 0004  Always BootP /DHCP On Powerup Mo Rl
0xFFFF FO38 0008 Degrees F/C Degrees F = Apply |
Vireless LAN ¥ OxFFFF FO330010  Comm Watchdog Time {msec), 0 = Disable 0
OxFFFF FO33 0014  TCP Minimum Retransmission Timeout {msec) 250
Paoint Config OxFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
0xFFFF FO38 001C  TCP Retransmission Attempts 5
Digital Bank OxFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
= = OxFFFF FO33 0294 Digital Feature Scan Interval {msec) 1
Digital Point 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bank 0xFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
0xFFFF FO38 0260  Out Of Range Value (32-Bit) -2147483643.000
0xFFFF FO33 0054  Scanner Flaas Ox 00000000

Analog Point

High Density
System 3
ScratchPad  »
Data Log 3
PID 4
Events 3
Communications b
Other 3

w |

Operation
OptoMMP Device
Restart Device from powerup
Store configuration to flash
Erase configuration from flash
Reset to defaults and Restart Device

A Send Command |

Erase firmware from microsD
Erase strategy from microSD
Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration "

™ Auto Refresh IISDDD msec

4. C(lick Send Command.
The controller's IP settings and all current configuration data are saved to the card.

After you have replaced a controller with a new one by using the microSD card as a boot disk, you must save
the data from the card to the controller's flash memory, so it will be available in case the microSD card is
removed. Cycling power does not do this. Instead, follow the steps in the Maintenance chapter (microSD
section) of your controller's user’s guide.
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Using Other microSD Card Commands

You can also use the following commands with a microSD card in the controller. These commands require PAC
Manager R9.0a or higher and PAC firmware R9.0a or higher. Read microSD card information in the controller

user’s guide before using the card.

1.

2.

In the Inspect window, type the device’s name or IP in the Device Name field, click Status Write, and
choose the command you need in the Operation Command list:

- FErase Configuration from microSD—deletes all configuration and IP address data from the card.
Does not delete other data files, firmware, or strategy files on the card.

—  FErase Firmware from microSD—deletes firmware on the card, wherever it is located; also deletes
firmware command and response files. Does not delete data files or strategy files.

- Frase Strategy from microSD—deletes only the strategy from the card. Does not delete data files, IP
address and configuration data, or firmware files.

Click Send Command.

Clearing Configurations and Data Samples

You can use PAC Manager to clear the following configurations: digital events (both old and expanded), alarm
events, email, PID loops, and PPP. You can also clear data in the data log. (Note that some of these features do
not apply to some devices. See the comparison chart on page 9.)

1.
2.

3.

In the PAC Manager main window, click the Inspect button Q .

In the Device Name field, type the name (or IP address) of the I/0 unit. Click Status Write. In the Operation
Command list, scroll down to see commands listed under Other.

] Inspect Opto 22 Device

Device Name: | 10.192.50.11

Status Write
Status Read

Status Write
Wirgless LAN  #

Paint Config
Digital Bank
Digital Point
Analog Bank:
Analog Point
High Density

System 3
ScratchPad  »
Data Log 4
PID 3
Events 3
Communications #
Other 3

Operation

Store configuration and IP settings to micraSD A send Command
Erase configuration and IP settings from microSC

Erase firmware from microSD

Erase strategy from micraSD

th

er

Switch to loader mode

Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration

Clear Alarm Events configuration

Clear PPF configuration

Clear E-mail configuration

Clear PID Loops configuration

Clear Data Logging samples

Send powerup dear ]

Click the command you want:

- X
j Options ¥ Status: | Status Write area last read at 05/02/16 16:30:29
Address | Description | Value ~ Refresh
0xFFFF FO33 0004  Always BootP/DHCP On Powerup No =
OxFFFF FO33 0008 Degrees F/C Degrees F Jd Apply
0xFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable [u]
0xFFFF FO33 0014  TCP Minimum Retransmission Timeout {msec) 250
OxFFFF FO33 0018 TCP Initial Retransmission Timeout {msec) 3000
0xFFFF FO38 001C TCP Retransmission Attempts 5
0xFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
OxFFFF FO33 0294 Digital Feature Scan Interval {msec) 1
0xFFFF FO33 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32758.000
0xFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147483543.000
0xFFFF FO33 0054  Scanner Flaos Ox 00000000 v

[ AutoRefresh | 15000  msec

- (lear “Digital Events - Expanded” configuration (Clears digital events in PAC firmware 8.1 and higher.
For PAC firmware 8.0 and older, clears Timers configuration.)

—  Clear “Digital Events - Old" configuration (Clears digital events in PAC firmware 8.0 and older)
- Clear Alarm Events configuration
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—  Clear PPP configuration
- Clear E-mail configuration
- Clear PID Loops configuration
—  (lear Data Logging Samples
4. With the command you want highlighted, click Send Command.
The command is sent immediately to the I/O unit, and you see a Success message.
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Data is formatted differently for different addresses in the device’s memory map. Starting memory map
addresses are shown in PAC Manager; for a complete list of memory map addresses, see the OptoMMP
Protocol Guide (form 1465).

This section shows how to format and interpret various types of data when you are reading or writing to a
memory-mapped device.

Mask Data

Some data is in the form of a 32-bit or 64-bit mask—four or eight addresses, each holding eight bits. Fach bit
in the mask contains the data for one thing in a group: one channel, one module, one Scratch Pad bit, etc.

Mask Data for groov and SNAP I/0 units

For example, most high-density digital module data (for both groov and SNAP) and most SNAP digital bank
data is in this form (groov 1/0 units and groov RIO modules do not support banks). For example, to read the
state of SNAP digital channels in a bank, you would read the eight bytes starting at FFFFF0400000.

Here's how the data would be returned:

At address: FFFFF0400000 _— > FFFFF0400007

These bitnumbers:| 7 g | 5|4 (3|2 (1|0 — 7|6|5|4|3|2|1]|0

Show dataforthese points:| 3 | 2 | 1 g |3 |2 1|0 | — 3|l2(1|0|3|2|1]|0

On SNAP modules in
these positions in the rack:

15 14 _— 1 0

Therefore, at address FFFFF0400000:

This hex data: B 1
Equals this binary data:| 1 0 1 1 0 0 0 1
Showing the states:| On | Off | On | On | Off | Off | Off | On
Of these channels:| 3 2 1 0 3 2 1 0
On these modules: 15 14

Data from other addresses marked as masks is formatted in a similar way.
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Mask Data for Els

Unsigned 32-bit Integer Data

Much of the data in the memory map is in the form of unsigned integers, either one byte, two bytes, or four
bytes. With multiple bytes, since the memory-mapped devices use a Big Endian architecture, the high order
byte is in the low order address.

For example, SNAP digital bank counter data is in 4-byte unsigned integers. It takes four bytes to contain the
data for one channel. To read digital bank counter data for channel 0 on module 0, you would start with
address FFFFF0400100. The following table shows the pattern of bank counter data for the first few channels
on a SNAP rack:

OrNo | swor-l ocoLO O0WLWL| O«—™om| <D0~

O 0O O0o0o [ o B B e | [on B on I o B o | [ B on B o B o | ol el Jeniill nod — T v T

By‘lesatthese Ll e e B B B

[on Iy on B o B o | [ I on B o B o | [ B on B B o | [ B on I o B o0 | [on I on I o I o | O OO Qa

addresses- o o oo o o oo oo oo oo oo o o oo o o oo

O I S e i S ol e e i ol T S i ol B S S 3

o o0 oo o o oo oo oo oo oo o o o0 o o o0 oo
LLLL|CLLCL| LWL LW CCCL| LWL L] W Www|—

| W N Iy G | W 1 1 Iy Y | W T I Iy | W T I iy ' | W I I Sy I (I Iy Iy 1 1

Tl TE Tt i T T o e Tl T | R T o T TR T ) T TR TR T

bbb || b | bbb | bk W

{E it I ot I [ EIER bl ity [ EIERR I ¥ ity [ EIERR I ¥ ity [ EIERR 1 it | i Y T I Ll g
Show data for 0 1 2 3 0 1 —»

this point:

On the module in this 0 1

position on the rack: >

The most significant byte is at the lowest address. For module 0, channel 0, for example, you might receive the
following data:

At this address This binary data Equals this hex data 16 BB 18 87
FFFF FO40 0100 0001 0110 16 ——f

FFFF FO40 0101 1011 1011 BB

FFFF FO40 0102 0001 1000 18

FFFF F040 0103 1000 0111 87

The 32-bit integer for this reading would be 16 BB 18 87 (most significant byte at lowest address). This hex
figure correlates to the decimal value 381,360,263.

Remember that if you are processing this data using a Little Endian computer (such as an Intel-based PC), you
must convert the data from the Big Endian format in order to use it. Little Endian format is the opposite of Big
Endian; Little Endian places the most significant byte at the highest address.

Digital Channel Data (4-Channel Modules)

NOTE: For high-density digital modules, see “Mask Data” on page 196.

(Does not apply to groov I/0 or groov RIO modules, which have more than 4 channels.) For consistency in
starting addresses, data for individual digital channels has a length of four bytes. However, only the least
significant bit contains the data you're looking for.
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For example, to read the state of channel 0 on module 0, you would start with address FFFFFO800000. Data
would be returned as follows:

To read this inform ation:

Use these addresses:

These bits:

Contain this data (binary):

(hex):

IEEE Float Data

Point 0 on Modu

le 0: Point State

FFFFFO800000 | FFFFF0S00001 FFFFFO800002 | FFFFFO800003
76543210 76543210 76543210 76543210
00000000 00000000 00000000 00000001
0 0 0 0 0 0 0 | 1
L 1
| . F -
[gnore these Point state is ON.

For individual analog channels, values, counts, and minimum and maximum values for one channel are
located next to each other in the memory map. All are four bytes and are IEEE 754 floats.

For example, individual analog channel data for channels 0 and 1 on module 0 appears in these addresses:

Module  Channel Data Beginning Address Ending Address
0 0 Scaled units (E.U.*) FFFF F026 0000 FFFF F026 0003
Counts FFFF F026 0004 FFFF F026 0007

Minimum value (E.U.*) FFFF F026 0008 FFFF F026 000B

Maximum value (E.U.*) FFFF F026 000C FFFF FO26 000F

1 Scaled units (E.U.*) FFFF F026 0040 FFFF F026 0043

Counts

FFFF F026 0044

FFFF FO26 0047

Minimum value (E.U.*)

FFFF F026 0048

FFFF F026 004B

Maximum value (E.U.*)

FFFF F026 004C

FFFF F026 004F

* Engineering Units

IEEE 754 float format is as follows:

1 bit 8 bits
X XXXXXXXX
Sign Exponent

23 bits

XXXXXXKXKXXKXXXXKXKXXXX

Significand

Float calculation: (129" x [1 + Significand/223] x 2 (Exponent-127)

Example for Opto 22 memory map

At this address:

base address

base address + 1

base address + 2

base address + 3

This hex data:

In binary:| 0

In these bits:| 31

Equals (in decimal):| 0

Representing: | Sign

41 77 33 33
100 0001 O 1M1 011 0011 0011 0011 0011
30...23 22...0
130 7,811,891
Exponent Significand

Decimal = (-1)°x [1 +7,811,891/2%%] x 2 (130-127)
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For more information on floats and issues that may arise in their use, see the Using Floats Technical Note (form
1755) available on our website, www.opto22.com.

Analog Bank Data

(Does not apply to groov I/0 units or groov RIO modules.) Remember that the bank area of the memory map is
set up for four channels per module. Analog modules with more than four channels (points) will show data for
channels 0-3 only. If the analog modules you are using have only one or two channels, the addresses for the
upper two or three channels in each module will contain the following: for output modules, 0; for input
modules, FFFFFFFF.

For example, to read all bank analog channel values in scaled units, you would read 256 bytes starting at
address FFFFF0600000. Here's how data for two-channel input modules in positions 0 and 1 would appear:

Beginning Address Ending Address Data Format Module Channel
FFFF FO60 0000 FFFF F060 0003 four bytes—IEEE float 0 0
FFFF FO60 0004 FFFF FO60 0007 four bytes—IEEE float 1
FFFF FO60 0008 FFFF FO60 000B FFFFFFFF 2
FFFF FO60 000C FFFF FO60 000F FFFFFFFF 3
FFFF FO60 0010 FFFF FO60 0013 four bytes—IEEE float 1 0
FFFF FO60 0014 FFFF F060 0017 four bytes—IEEE float 1
FFFF FO60 0018 FFFF FO60 001B FFFFFFFF 2
FFFF FO60 001C FFFF FO60 001F FFFFFFFF 3
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6: Maintaining Devices

INTRODUCTION

This chapter includes step-by-step procedures for maintaining controllers and brains, including:

Viewing and changing IP addresses (below).
Loading new firmware (page 203).

To find out the current brain firmware version, see “Getting Device and Firmware Information—
Individual Device”on page 226.)

Maintaining files (page 217).

For other maintenance tasks, such as resetting the device to factory defaults or handling a device whose IP
address you don't know, see the controller or brain user’s guide.

CHANGING IP ADDRESSES

If you need to change an IP address or subnet mask on an Ethernet-based device, you can do so using PAC
Manager. You must know the current IP address in order to change it. The white sticker on the device may
show the IP address. If not, see the device's user guide for instructions.

SNAP PAC controllers and brains

E1 and E2 brain boards

SNAP Simple /0 brains

SNAP Ultimate and SNAP Ethernet brains with firmware version R5.0 or higher

If PAC Manager isn't already open it, start it. (For instructions, see the footnote on page 10.)
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CHANGING IP ADDRESSES

2. Inthe menu bar, click Tools > Change IP Settings.

& PAC Manager — O

File Toecls View Help
Dles|d| ¥|un| B B
é Change IP Settings for ETHERMET 1 ¥

Current IP Address: I . . . Read Current Settings

Port: 2001

Timeout (msec): I 10000

Mew IP Address: I . . . Chanage IP Settings

Subnet Mask:

Gateway

DNS Address:

3. Inthe Current IP Address field, type the IP address of the device whose address you want to view or
change. Click Read Current Settings to see the current subnet mask, gateway address, and DNS address.

= Change IP Settings for ETHERNET 1 X
Current IP Address: | 10 .20 . 30 . 40 Read CurrentSetﬁngsI
Port: 2001
Timeout (msec): 1000

Mew IP Address: I— Chanage IP Settings
Subnet Mask: I—
Gateway I—
DNS Address: I—

4. To change the IP address, subnet mask, or other addresses, enter the new numbers. Make sure you have
typed everything correctly. When everything is correct, click Change IP Settings.

After you confirm the change, a message appears stating that the change was successful and that the

device will restart. Restarting may take 10 to 20 seconds to complete. When you see the following

indicator, the device is ready for use with its new address:

—  The SNAP-PAC-51's, SNAP-PAC-R1’s, and SNAP-PAC-R1-B's STAT LED shows solid green or solid
orange when viewed from the top (green means a strategy is running; orange means no strategy is
running).

—  The SNAP-PAC-EB1's or SNAP-PAC-EB2’s STAT LED shows solid green.

Remember to write the IP address on the sticker or white area on the device.
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INSTALLING NEW FIRMWARE

NOTE: To load firmware on an R-series controller secured with a private key using PAC Terminal Secure Strategy
Distribution (SSD), see the technical note provided with the purchase of SSD. If you follow the procedures
documented here, you'll get an error.

All SNAP PAC controllers and brainsw, and SNAP serial communication modules, contain firmware.
If a new version of the firmware is released or if the firmware should become damaged, you can use PAC
Manager to load new firmware to the device.

Typically, firmware files are created for a specific series of products (for example, firmware for the R1 series,
which includes SNAP-PAC-R1, -R1-B, and R1-FM controllers). Firmware files have the file extension “bin.”
Sometimes we package firmware files for multiple series of products in a zip file. If you've downloaded a
firmware zip file from our website, you'll need to unzip it to access the individual .bin files.

To get the newest firmware file, you can use the Get Latest Firmware feature in PAC Manager (or any browser
like Google Chrome, Mozilla Firefox, and Microsoft Edge) to download the firmware from Opto 22's website?.

If your SNAP PAC controller has a microSD card slot, you can copy the necessary .bin files to the microSD card,
and then load the firmware from the card. This method can be easier if your PAC isn't networked. (For
instructions to load firmware from a microSD card, see the controller user's guide.)

Typically, PAC software requires a matching (or higher) version number of controller firmware. This is because
the firmware must be able to support new features in the software. It's usually OK to have controller firmware
that is newer (that is, has a higher version number) than the version of PAC software you have. There can be
exceptions, however—such as when a change in the firmware requires a matching change in the software.
PAC Control keeps track of the dependencies between different versions of controller firmware and software,
and will display a warning when the controller firmware is lower than the minimum version number
recommended for your software. (The warning is displayed in PAC Control when you try to go into Debug
mode to download a strategy.)

The steps to load new firmware depend on the type of device you have, and whether the device’s current
firmware is damaged.

«  Toload firmware for SB brains, see page 207.
«  Toload firmware for serial communication modules, see page 210.

«  Forall other controllers and brains (including SNAP Ultimate brains with firmware R5.0 or higher), see
page 204.

« Toload I/0 coprocessor firmware, see page 211.

«  Toreplace damaged firmware (indicated by three slow red blinks of the STAT LED after powerup), see
page 214.

Firmware Loading'’s Effect on Data in the Device

Successfully loading firmware to a controller or brain erases (clears) all data in volatile memory (RAM) and in
non-volatile memory (battery-backed RAM).3 This includes:

«  The PAC Control strategy
»  All strategy variables, including persistent variables
«  The PAC Control strategy’s Autorun flag

'In addition, rack-mounted controllers and brains manufactured starting in 2016 may contain an I/0 coprocessor,
which has its own firmware. For details, see page 211.

To download previous versions of Opto 22 firmware and software, go to our FTP site at
ftp://ftp.opto22.com/Public_Folders_(Unsecured)/Archives_(Software_and_Firmware)/

310 coprocessor firmware is not cleared when you update controller or brain firmware. For details, see page 211.
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/0 point, Event, and PID loop configurations
Scratch pad values

User files

Any other memory map configurations

The following items are cleared from flash memory:

The PAC Control strategy
The PAC Control strategy archive

If the following items have been stored to flash memory, they are not cleared by a firmware load:

/0 point, Event, and PID loop configurations.
Scratch pad values.
User files.

Some memory map configuration items. (Note that some memory map configuration items are cleared
by a firmware load. For details, see the OptoMMP Protocol Guide, form 1465.)

A successful firmware load also restarts the device. Restarting a device causes data in volatile memory and in
battery-backed RAM to be lost. This means that accumulated data (such as counts from analog and digital
totalizers) is reset. For these reasons, you shouldn't attempt to load firmware to devices that are running.

And what happens if you select the wrong IP address?

If the IP address you select is for an Opto 22 device that doesn’t match with the firmware type (for
example, your controller is a SNAP-PAC-R1 and you try to load EB2 firmware), nothing on your controller
is erased. PAC Manager simply displays an error in the Results area and it won't attempt to install the
firmware.

If you select an IP address that is not an Opto 22 device (for example, the IP address belongs to a network
printer), nothing on your controller is erased. PAC Manager displays an error in the Results area and it
won't attempt to install the firmware.

If you mistakenly select an IP address for an Opto 22 device that matches the firmware file (for example,

you load R1 firmware to an R1 unit that you don’t want to update), PAC Manager installs the firmware
with the same effects listed above.

For these reasons, you should be careful when selecting the IP addresses of devices to load firmware to.

Loading Controller and Brain Firmware (Except SB Brains)

For troubleshooting, see page 206.
For SB brains, see page 207.
To replace damaged firmware, see page 214.

Use the steps in this section to load PAC firmware on:

SNAP PAC controllers

SNAP PAC EB brains

E1 and E2 brain boards

SNAP Ultimate brains with firmware version R5.0 or higher

Before beginning, be sure to have:

1.

- Address information for the controller(s) and/or brain(s) that will receive the new firmware.

- The PAC firmware file for your product, or Internet access to download the firmware from our
website.

If PAC Manager isn't already open it, start it. (For instructions, see the footnote on page 10.)
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2. Click the Maintenance button .

## 1/0 Unit Maintenance *
r—Command

Firmware Filename: Get Latest Firmware P Addresses l Add... |
Install Module Firmware
Install IO Coprocessor Firmware I J 13%%:“? Modify |
Install CA Root Certificate Restart Confirmation Interval (sec) : 102030 42 =
Download File From 1O Unit l— Bt
Upload File To 1/0 Unit 1 Delete |
Delete File On IO Unit

Port: Ti t :
Read Filenames On IO Unit or TR (R —
Save Files To Flash I 2001 I 1000 |
Read Files From Flash
Clear Flash Files ™ synchronize to PC Time Loa—d---l

Sync 1O Unit to PC Time

Results |

Copy |
Select Al |
Clear Completed Results |

Close | Help |

3. Make sure Install Firmware is highlighted in the Command list.
If you already have the firmware file on your computer, network, or microSD card, skip to step 5.
If you need to get the new firmware file:
a. Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Downloads section of our website,
WWW.0pto22.com
b. On the Downloads webpage, choose the firmware for your part number, and then download it to
your PC. Firmware files have the file extension “bin.” Sometimes we package firmware files for
multiple series of products in a zip file. If you've downloaded a firmware zip file from our website,
you'll need to unzip it to access the individual .bin files.
5. In PAC Manager’s I/0 Unit Maintenance dialog box, click the browse button J and then navigate to
the firmware (.bin) file for your product.
Double-click the file to select it. The dialog box closes, and the path and filename appear in the Firmware
Filename field.
6. If the SNAP devices you want to update are displayed in the [P Addresses list, skip to step 7.

If you have previously saved a list of IP addresses and want to use the list, click Load to select and load the
saved list, and then skip to step 7.
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If the IP address you want isn't displayed, click Add, and then enter a device's IP address or host name, or
a range of consecutive IP addresses.

Choose one of these options to add IP addresses: =% Add P Address x
Type a single IP address here.
+ Add one IP Address [ Host Name

Enter a host name here. {* 1P Address: | 10 . 20 . 30 . 40

To enter a range of IP addresses, click here, \‘f‘ Host Mame:

and then enter the From and To addresses. "~
" Add a range of IP Addresses

oK | Cancel |

When you've finished adding IP addresses, click OK.

7. Inthe IP Addresses list, highlight the IP addresses to send firmware to. To select multiple devices, hold
down the Ctrl key as you click the devices.

NOTE: Do not multi-select daisy-chained or multi-dropped -EB series Ethernet brains. You must update their
firmware one device at a time.

In this example, these devices will receive the firmware update.

=5 /0 Unit Maintenance X
Command

Firmware Filenam Get Latest Firmwarex P Addresses Add...

Install Module Firmware —
c fe ktoplsnap- ..

Install IO Coprocessor Firmware | Wsers\jfemia\Desktoplsnap J Modify
1”513': CAd RTUt Certhjircate Restart Confirmation Interval (sec) : Wi
Download File From 1O Unit
Upload File To I/0 Unit 1 Delete
Delete File On IO Unit

Port: Ti t :
Read Filenames On I/0 Unit or IR pEE) -
Save Files To Flash 2001 1000
Read Files From Flash
Clear Flash Files I™ Synchronize to PC Time Load...

Sync 1O Unit to PC Time

You can change the amount of seconds PAC Manager waits before verifying the devices have restarted.

8. Ifyou have changed the OptoMMP port (see page 78), enter the correct port number in the Port field.

9. CAUTION: Loading firmware erases the current firmware in the selected device. You cannot undo
the erase. Make sure you've highlighted the IP addresses you want to update, and not others by
accident. For details, see “Firmware Loading’s Effect on Data in the Device”on page 203.

To load the firmware, click Execute.
The file is loaded to the SNAP devices, and progress is shown in the Results area.

When the file has completed loading and the devices are restarted, a “Success” message is displayed in the
Results area.

Troubleshooting

«  If, during the firmware update process, a Timeout error message appears in the Results area, you can try
temporarily disabling any firewalls on the computer running PAC Manager.

206 PAC Manager User's Guide



CHAPTER 6: MAINTAINING DEVICES

Firewalls, such as the ones that come with some anti-virus software programs and the built-in firewall in
Windows, can prevent PAC Manager from receiving FTP communications from the controller, which will
result in a timeout error. (Firewalls in a router shouldn't be a problem.)

You can reenable the firewalls after loading the firmware.
« If disabling firewalls is not an option, you can try

—  Connecting the PC directly to the controller or brain.

- Configuring a firewall exception for PAC Manager.

To configure a firewall exception in your system's anti-virus software, see the manufacturer's
instructions.

To configure a firewall exception in Windows, see page 9.

« Ifyou're using EB brains in a daisy-chain or multi-dropped configuration, you must update their firmware
one device at a time. This is because, after the firmware update, network communication is disrupted
when each brain in the chain is restarted.

«  Youmay encounter anissue if you're updating an R-series controller that has PAC firmware R9.2c or lower.
This issue is resolved, and details are available on our website, OptoKnowledgeBase article KB82101
http://www.opto22.com/site/knowledgebase/kb_view_article.aspx?aid=2059

»  You may encounter an issue in either of these situations:

- You're updating an R-series controller with a microSD card slot and PAC firmware R9.5a or lower.
(Wireless controllers are not affected.)

- AmicroSDHC card is inserted in your R-series controller when you're updating PAC firmware R9.5a or
lower. (Wireless controllers are not affected.)

These issues have been resolved. For details, see our website:

- OptoKnowledgeBase article KB86172
http://www.opto22.com/site/knowledgebase/kb_view_article.aspx?aid=2962

- OptoKnowledgeBase article KB86180
http://www.opto22.com/site/knowledgebase/kb_view_article.aspx?aid=2945

Loading SB Brain Firmware

These instructions apply to SNAP PAC SB brains. For other brains and controllers, see page 204.

NOTE: For an SB brain that has damaged firmware (indicated by three slow red blinks of the STAT LED after powerup),
see page 214.

Before beginning, make sure you have an Internet connection to obtain the firmware. Also, choose how you
will connect to the SB brain (for more information, see the brain user’s guide):

«  Through the S-series controller—see steps in “Installing SB Firmware Through the Controller,” below.

«  Directly from the PC to the brain (requires a PCI-AC48 adapter card in the PC)—see “Installing SB
Firmware Directly from PC to Brain”on page 209.

Installing SB Firmware Through the Controller
1. If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)
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2. Inthe PAC Manager menu bar, click Tools > Install Firmware via Ethernet.

Install Firmware via Ethernet *

% Install Firmware via Ethernet Connection
* SMAP-PAC R- and S-series controllers
* SNAP-PAC-EB1 and SMAP-FAC-EB2 brains
* SNAP-UP 1-ADS, SMAP-UP1-D&4, and SMAP-UP 1-M&4 brains (firmware version 5.0 ar newer required)
* SMAP-LCE controller
* E1and E2 brainboards

" Install Firmware via Ethernet Passthrough Connection
* SMAP-PAC-5B1 and SMAP-PAC-SB2 brains

Cancel |

3. (lickInstall Firmware Through Ethernet Passthrough Connection, and then click OK.

B Install Firmware via Ethernet Passthrough Connection *

Make sure the Opto 22 device is connected to an Opto 22 controller through
one of the controller's serial ports,

—Controller

IP: | 0.0.0.0 Port: | 2001 Timeout: |3000
Serial Port: ISeriaID vI Baud: I]]EZDD vl ¥ 2-Wire

—Opto 22 Device
Type: ISNAP-PAC-SBI LI Serial Address (0-255): I 0

Firmware File

Get The Latest Firmware

| B

Start Update I Abort Done

4. Inthe Controller section, enter the IP address of the controller. Leave the Port at 2001 unless you have
changed it. Choose the serial port on the controller that the brain is connected to, and make sure the
baud rate matches that on the brain. Change Timeout and 2-Wire if necessary.

5. Inthe Opto 22 device section, choose the type of SB brain and enter its serial address.
Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
WWW.0pto22.com

7. Choose the firmware for your part number from the list and download it to your PC.
If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

8. (lick the browse button J and locate the firmware file you just downloaded. Double-click the
filename.

208 PAC Manager User's Guide


http://www.opto22.com/site/downloads/dl_downloads.aspx?cid=4

CHAPTER 6: MAINTAINING DEVICES

The path and filename appear in the Filename field.
9. When all the fields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, the device is ready to
use.

Installing SB Firmware Directly from PC to Brain
This method requires a serial connection from the brain to the PC, via an RS-485 converter such as an Opto 22
PCI-AC48 adapter card.

1. If PAC Manager isn't already open it, start it. (For instructions, see the footnote on page 10.)
2. Inthe PAC Manager menu bar, click Tools > Install Firmware via Serial Connection.

Install Firmware via Serial Connection *

% Install via RS-485 Connection
* SMAP-PAC-5B1 and SMAP-PAC-5B82 brains

" Install via RS-232 Connection
* SMAP-UP1-ADS, SMAP-UP1-D&4, and SMAP-UP 1-M64 brains
* SMAP-LCE controller
* SNAP-B3000-EMET, SMAP-ENET-D&4, and SMAP-EMET-564 brains

Cancel

3. Click Install via RS-485 Connection.

B ° Install Firrnware via R5-485 Connection *

Make sure the Opto 22 device is connected to the computer's serial port via a
serial cable and an R5-485 adapter such as a PCI-AC4E.

—Computer

PC Serial Port: ICOM:[ vl Timeout {miliseconds): ISDDD
Baud Rate: |1152[JD 'I

—Opto 22 Device

Type: ISNAP-PAC-SBI LI Serial Address (0-255): I 0

Firmware File
Get The Latest Firmware

| B

Start Update I Abort Done

4. Inthe Computer section, choose the COM port the brain is connected to. Make sure the baud rate
matches that on the brain. Change the Timeout if necessary.

5. Inthe Opto 22 Device section, choose the type of SB brain and enter its serial address.

PAC Manager User's Guide 209



INSTALLING NEW FIRMWARE

Click the blue Get The Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
WWw.0pto22.com

Choose the firmware for your part number from the list and download it to your PC.
If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

Click the browse button J and locate the firmware file you just downloaded. Double-click the
filename.

The path and filename appear in the Filename field.
When all the fields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, the device is ready to
use.

Loading Serial Module Firmware

If you have a SNAP PAC I/0 unit, you can load new serial module firmware to a SNAP serial communication
module on the 1/0 unit.

1.

2.
3.
4

210

Make sure you have an Internet connection so you can download the new serial module firmware file.
If PAC Manager isn't already open it, start it. (For instructions, see the footnote on page 10.)

In the PAC Manager main window, click the Maintenance button .

In the Command list, highlight Install Module Firmware.

= 1/0 Unit Maintenance X

Command

Install Firmware Module Firmware Get Latest Firmware

Ad
| J 10.192.50.90

10.192.55.133
10.192,55.67
10.192.57.187

Install IO Coprocessor Firmware
Install CA Root Certificate
Download File From 1O Unit
Upload File To I/O Unit

Delete File On IO Unit

Read Filenames On IO Unit

Modify...
Module Position: fy

et

Delete

Save...

i

Clear Flash Files Load
Sync 1O Unit to PC Time

Results
Close | Help |

Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
WWW.0pto22.com

Choose the firmware for your part number from the list and download it to your PC.
If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

Click the browse button J and locate the serial module firmware file you just downloaded.
Double-click the filename.
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The path and filename appear in the Filename field.
8. Inthe Module Position field, type the serial module’s position on the rack (0-15).

9. Inthe IP Addresses list, highlight the IP address of the I/O unit the serial module is on. (If the correct IP
address is not shown, click Add to add it.)

You can load serial module firmware to multiple I/O units at the same time, but only if the modules are in
identical positions on all I/O units.

10. Click Execute.

The serial module firmware file is loaded to the I/0 unit and then loaded to the serial module, and a
Success message appears in the Results area.

Loading I/0 Coprocessor Firmware
For information about loading PAC firmware, see “Installing New Firmware” on page 203.

The SNAP PAC 1/0 coprocessor is a programmable chip that can be updated in newer Opto 22 rack-mounted
controllers and brains. It replaces an older, obsolete chip. The change has no effect on function or
performance.

The new programmable chip is included in Opto 22 rack-mounted controllers and brains, starting with the
date codes listed below.

NOTE: For devices manufactured during the month and year listed, use PAC Manager to find out if your device has
an /0 coprocessor. (For details, see page 212.)

Product Manufacturing Date Code (MM/YY)
SNAP-PAC-R1, -R1-FM, R1-W 06/16
SNAP-PAC-R1-B 01/16
SNAP-PAC-R2, -R2-FM, R2-W 02/16
SNAP-PAC-EB1, -EB1-FM, EB1-W 03/17 (See Note)
SNAP-PAC-EB2, -EB2-FM 08/16
SNAP-PAC-EB2-W 03/17
SNAP-PAC-SB1 05/17 (See Note)
SNAP-PAC-SB2 06/17 (See Note)

Special Note about EB1s, SB1s, and SB2s

As of November 14, 2017, the following products manufactured with I/0 coprocessors have firmware R3.0a. At
this time, you do not need to update the firmware in these products.

»  SNAP-PAC-EB1

«  SNAP-PAC-EB1-FM
e SNAP-PAC-EB1-W
«  SNAP-PAC-SB1

«  SNAP-PAC-SB2

Does My Product Have an I/0O Coprocessor?

A device's manufacturing date code can rule out whether the device has an I/0 coprocessor, but to know for
certain, you can inspect the device in PAC Manager.

Using the Manufacturing Date Code
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If your device is easily accessible, you can visually check its manufacturing date code to see when it was
manufactured. If it was manufactured before the dates listed in the table on page 211, it doesn't have a chip
that can be updated.

|P Address:

The manufacturing date code (month and
year in MM/YY format) appears in the top
half of a bisected circle, printed on a white
label attached to the device.

Using PAC Manager R9.5a or higher

1. In PAC Manager, click Tools > Inspect to open the Inspect Opto 22 Device window.
2. Inthe Device Name field, select or enter your device.

3. Look at the Value for /O Coprocessor Firmware Version.

If the Value is A0.0a or O (zero), your device does not have an I/0O coprocessor.

PP Y
OXFEEF 030 0026

I/0 Unit Hardware Revision (Year)

These devices don't have an /0
COProcessor.

AL, ;
OxFFEF F030 0026 I/0 Unit Hardware Revision (Year)

=] Inspect Opto 22 Device ?
L! 4 ! +| Options » ! Status: | Status Read area last read at 03/15/17 f

[~ Status Read
Status Read ;
Status Write ] ADDRESS DESCRIFTION VALUE

Device Name: I 10.20,30.40

Wireless LAN  » I

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System 3
ScratchPad  »

0xFFFF F030 0004
0xFFFF F030 0008

0xFFFF F030 0018
0xFFFF F030 0000
0xFFFF F030 0230
0xFFFF F030 001C
0xFFFF F030 O00AQ
0xFFFF F030 00BO

0xFFFF F030 0020
0xFFFF F030 0080
0xFFFF F030 0024
0xFFFF F030 0025
O0xFFFF F030 002&
O0xFFFF F030 024C

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version

PUC Beceiwved (

0

R6.2b

1

Flash Memory
R9.5d
11/07/2016
17:06:29

0x00000068
SHAP-FAC-RL
5

25

2009

R2.0d

i

This device has an

1/0 coprocessor.

You should update its
firmware.

0xFFFF F030 0028 Installed Ram 33554432 !

Using PAC Manager R9.4c or lower

1. To verify you can connect to your controller or brain, click Tools > Inspect.
Then, in the Device Name field, select or enter your device, and press Enter (or click Refresh).

2. Ifyou're connected, click Other > Generic Read/Write.

Datatog |
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a. Inthe Address: Ox FFFF field, type: F030024C
b. IntheType field, select: 32-Bit Integer
3. Click Refresh.

If the Value is not 0 (zero), your device has an 1/O coprocessor, and you should update its firmware.

= Inspect Opto 22 Device e

Device Name: J 10.20.30.40 _l +| v| Options » | Status: ]Cusmm area last read at 03/15/17 17:24:36

—Generic Read/Write
Status Read
Stams Write Address: 0x FFFF | FO30024C Type: |32-Bit Integer Length: i j

Wireless LAN  » Address

OxXFFFF FO30 024C' 33554691

0j nfi i

b L Bt PR P
A number in the Value field means the device has an I/0 coprocessor.
Your device's number may be different.
Address: 0x FFFF | FO30024C Type: |32-Bit Integer ‘__v_J Length:
Address Value

OxFFFF F030 024C| O

PP S| __]

This device doesn't have an 1/0 coprocessor.

Getting and Loading the 1/0 Coprocessor Firmware

/0 coprocessor firmware updates are posted on the Opto 22 website. To successfully load the I/0 coprocessor
firmware, you must have both:

»  PACManager R9.5a or higher

«  PACFirmware R9.5a or higher in the device that you're updating

If your device has PAC firmware R9.4c or lower and you aren't ready to upgrade to a newer version of PAC
firmware, follow these steps:

1. Temporarily load PAC firmware R9.5a (or higher).

2. Follow the instructions below to load the I/0 coprocessor firmware.

3. Load your previous version of PAC firmware (to overwrite the higher version you installed in step 1).

Previous versions of software and firmware are available from our FTP site:
ftp.//ftp.opto22.com/Public_Folders_(Unsecured)/Archives_(Software_and_Firmware)/

To get the I/0 coprocessor firmware update file:

Go to the Downloads section of the Opto 22 website, choose the firmware for your part number, and then
download it to your PC. Firmware files have the file extension “bin.”

NOTE: If your device is wireless, select the file for the comparable controller or brain. For example, if you have a
SNAP-PAC-R1-W, select the file for the R1 controller, SNAP-PAC-R1-10-Coprocessor-R3.0a.bin.

Sometimes we provide firmware files for multiple series of products in a zip file. If you've downloaded a
firmware zip file from our website, you'll need to unzip it to access the individual .bin files.

To load the I/0 coprocessor firmware:
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CAUTION:- Updating the /0 coprocessor firmware will reboot your controller or brain.
It will not overwrite your configuration data, but the reboot will cause accumulated data (such as counts from
analog and digital totalizers) to be reset.

1. In PAC Manager, open the I/O Unit Maintenance window (Tools > Maintenance).

2. Inthe Command list, select Install I/O Coprocessor Firmware.

3. (lick the Browse button, and then navigate to the folder containing the firmware files.
4, Select the firmware file for your controller or brain, and then click Open.

NOTE: If your device is wireless, select the file for the comparable controller or brain. For example, if you have a
SNAP-PAC-R1-W, select the file for the R1 controller, SNAP-PAC-R1-10-Coprocessor-R3.0a.bin.

5. Inthe IP Addresses list, click the device you want to update.
Use the Add button to add devices to the list.
To select multiple devices, hold down the Ctrl key as you click the devices.

NOTE: Do not multi-select daisy-chained or multi-dropped -EB series Ethernet brains. You must update their
firmware one device at a time.

6. Click Execute to load the firmware.
After the file is loaded and the devices are restarted, a “Success” message appears in the Results area.

If the load fails (for example, if the file you selected isn't compatible with your device), the device's I/0
coprocessor firmware is not changed or overwritten. However, the device will restart, and a “Fail” message
appears in the Results area.

If you select a device that does not have an I/0O coprocessor, or if the device has SNAP PAC firmware R9.4c or
lower, the Results area displays “Command not supported in the build,"and the device does not automatically
restart.

Replacing Damaged Firmware

If the STAT LED on a controller or brain blinks red slowly three times after powerup, the firmware in the device
is damaged. For details, see the Blink Codes section in the device's user guide.

Follow these steps to replace damaged firmware.

1. Make sure you have the following before beginning:
- Address information for the controller(s) and/or brain(s) that will receive the new firmware.
- Internet access to obtain new firmware from our website.

2. Follow instructions in the device's user guide to restart the device in failsafe bootloader mode. Watch for
the blink code to make sure the device is in this mode.

3. Attach the PC with PAC Manager to the controller or brain using a crossover cable or “straight-through”
Ethernet cable as required:

—  EB-series brains can be connected with either type of cable.

- Computers with a Gigabit Ethernet network interface controller (NIC) card can use either type of
cable (because the NIC card has the ability to adapt.)

—  ForR-series and S-series controllers that:

—  Have an SD card slot, use a straight-through Ethernet cable.

— Do not have an SD card slot, use a crossover cable.
—  For SB-series brains:

—  Connect through the S-series controller;

- Orconnect directly from the PC using a serial cable and a PCI-AC48 adapter card.
For more information on connections, see the device's user’s guide.
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4. If PAC Manager isn't already open it, start it. (For instructions, see the footnote on page 10.)

5. Inthe PAC Manager menu bar, click Tools > Install Firmware via Failsafe Bootloader Mode. Click OK at the
message about products it can be used with.

g¥ Loader Mode Firmware Update — >

Ethernet lEﬂﬂernet Pass-Through | Serial Direttl

Use the IP and Subnet of the Ethernet Adapter (MIC) on the computer (not the
Opto 22 device), Make sure the Opto 22 device is in loader mode and
connected to the computer via a cross-over cable.

Computer

IP Address of PC Ethernet NIC: | o .o .0 .0

Subnet of PC Ethernet NIC: | o .0 .0 .0
Opto 22 Device

Type: |5NAF‘-PAC-R1 ﬂ Timeout {milliseconds): ’W
Firmware File

Get The Latest Firmware

| H

Start Update | Done

6. Choose one:
—  Fora SNAP PAC controller or EB brain, click the Ethernet tab and continue with step 7.

—  Foran SBhbrain, if you're connecting to the brain through the S-series controller, click the Ethernet
Pass-Through tab and skip to step 8.

- Foran SB brain, if you're connecting serially from the PC to the brain, click the Serial Direct tab and
skip to step 9.

7. Foracontroller or EB brain, enter the IP address and subnet of the PC (not the controller or brain). Choose
the controller's or brain’s device type from the drop-down list. Skip to step 10.

8. Foran SBhbrain using Ethernet Pass-Through, do the following:

- Inthe Controller section, enter the IP address of the controller. Leave the Port at 2001 unless you
have changed it. Choose the serial port on the controller that the brain is connected to, and make
sure the baud rate matches that on the brain.

— Inthe Opto 22 device section, choose the type of SB brain and enter its serial address. Skip to
step 10.

9. Foran SBbrain using Serial Direct, do the following:

- Inthe Computer section, choose the COM port the brain is connected to. Make sure the baud rate
matches that on the brain.

— Inthe Opto 22 device section, choose the type of SB brain and enter its serial address. Go on to
step 10.

10. Click the blue Get Latest Firmware link.
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The link opens your browser and takes you to the Firmware Downloads section of our website,
WWW.0pto22.com

11. Choose the firmware for your part number from the list and download it to your PC.
If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

12. Click the browse button J and locate the firmware file you just downloaded. Double-click the
filename.

The path and filename appear in the Filename field.
13. When all the fields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, either repeat from
step 7 for another device, or click Done.

The device is now ready to use.

INSTALLING CA ROOT CERTIFICATES

NOTE: As part of the process of installing the certificate on the controller, the controller will be restarted to
activate the certificate. You may need to schedule a system shutdown to coordinate putting the certificate on the
controller and rebooting the controller.

To place a root certificate in the /pki/root-certs folder on your controller:
1. Inthe PAC Manager menu bar, click Maintenance .
2. Inthe Command list, select Upload File To I/O Unit.

3. Click the Browse button | and browse to the location of the certificate. Select the certificate, and then
click OK.

4. Inthe Destination field, type /pki/root-certs/ and the name you want the certificate to have on the
controller; for example:
/pki/root-certs/Equifax Secure Certificate Authority.cer

5. Select the IP address of the SNAP PAC device that you want to install the certificate on.

- ~
5 1/0 Unit Maintenance *
Command -
Install Firmware Filename:
Install Module Firmware e Sk

Install 1jO Coprocessor Firmware | C:\Equifax_Secure_Certificate_AL _l 99.999.98.920

; Modify...
Install CA Root Certificate e fy

Download File From I/0 Unit
oad File To I/ Unit J Jpkifroot-certs/Equifax_Secure_Ck Delete

Delete File On IO Unit

Read Filenames On IO Unit
Save Files To Flash Save...
Read Files From Flash
Clear Flash Files Load
Sync 1O Unit to PC Time

. e el G ettt o

e

Click Execute.

(Optional) Repeat steps 26 if you have additional certificates to install.
Select the Save Files To Flash command, and then click Execute.
Restart the SNAP PAC device to activate the certificates.

e No
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MAINTAINING FILES

The memory in a SNAP PAC controller or brain includes a substantial area available for file storage:

SNAP-PAC-S1 SNAP-PAC-S2
SNAP-PAC-S1-FM SNAP-PAC-S2-W 2.5MB
SNAP-PAC-S1-W
SNAP-PAG RIS SNAP.PAC-R2
SNAP-PAC-R2-FM 2.0 MB

SNAP-PAC-R1-FM

SNAP-PAC-R1-W SNAP-PAC-RZ-W

Limited only by the size of the hard

SoftPAC drive on the computer the software
runs on.

SNAP-PAC-EB1 SNAP-PAC-EB2

SNAP-PAC-EB1-FM SNAP-PAC-EB2-FM 2.0 MB

SNAP-PAC-EB1-W SNAP-PAC-EB2-W

In addition, beginning in early 2009, microSD slots were added to S-series and R-series PACs for removable
storage up to 2 GB.

In the file storage area or on a suitable removable disk, you can store any types of files. These files can be
sorted into directories or folders just as they can on a PC, and they are available for use within a PAC Control
strategy or an application you develop. For example, the SNAP device can read the files, add data to them, and
even send data from them via FTP to another device on the network.

For managing general data files on a microSD card, see instructions in the Maintenance chapter of the
controller user's guide. Do not use PAC Manager for general microSD file management. However, you can use
PAC Manager for some functions related to firmware, strategy, and configuration files on the card. See “Using
microSD Commands”on page 193.

To use PAC Control strategy logic to create and manage files, see “Communication Commands”in
Chapter 10 of the PAC Control User’s Guide.

Tools for Managing Files

There are several tools you can use to manage files. You can use FTP software or even Windows Explorer to
move files to and from the device via FTP, and you can use PAC Manager to move and manage files on the
device. Here are some additional details:

+  PACControl lets you programmatically work with the SNAP PAC controller or I/0 unit's file system,
within your control strategy. You can create files and folders on the device and write to, add data to, or
read them; receive file data via FTP; send all or part of the data in a file via FTP, and more. PAC Control
waorks with one /0 unit at a time. A PAC Control strategy can also FTP files to one or more other I/O units
or controllers.

»  PACManager's main advantage for file management over other commercially available FTP client
software is that it can work with multiple Ethernet devices at once, for example sending data via FTP to
ten 1/0 units at the same time, or deleting the same file from multiple I/O units simultaneously. However,
PAC Manager can see only the folders and files at the root of the device’s file system (not the names of
files within folders). For this reason, do not use PAC Manager for working with files on a microSD card in
the controller, as all of its files are in a directory.

«  Newer versions of Windows Explorer can be used for FTP operations with a single controller or 1/0 unit.
It's easy to drag and drop files and folders to the device, and you can see the complete file structure. You
may find that data isn't always refreshed correctly.
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«  Other FTP software products you can download may be more reliable than Windows Explorer; they
also may give you extra features like communication details, which are useful for debugging. Some may
not support filenames with spaces or other specific characters. They work with one device at a time.

«  You can also use a command prompt for FTP, again with one device at a time.

«  Note that FTP cannot be used through a firewall in the PC. Make sure any firewall in the computer is
disabled before you try to work with files. Firewalls in a router should not be a problem, however.

Keep the following limitations in mind as you work with files on controllers and /0 units:

Maximum length for filenames and directory names

127 characters

Filename characters allowed

All ASCII characters except *, ?, null, and /
NOTE: Some FTP client software may not allow spaces
or specific characters.

Path name component separator

/

Maximum number of files and directories that can be
open simultaneously

16

Maximum directory depth

Limited only by available memory
NOTE: PAC Manager reads only the root names; files
within folders are not listed.

Maximum number of files

Limited only by available memory. Each file uses 516
bytes of overhead plus its number of bytes rounded up
to the nearest multiple of 516 bytes.

Maximum number of directories

Limited only by available memory. Each directory uses
516 bytes.

Maximum amount of memory available in the
device’s file system

Approximately 2.5 MB on a SNAP PAC S-series, 2 MB
on a SNAP PAC R-series or EB brain (varies slightly
depending on the device’s firmware version). Data stor-
age on a SoftPAC controller is limited only by the size of
the hard drive on the computer the software runs on.

Maximum amount of memory available in removable
storage (per microSD card)

2 GB (available on S-series and R-series PACs)

When using the SNAP device as an FTP server, for example with an FTP client such as CuteFTP, you can use an
anonymous login. The device ignores any user ID or password.

CAUTION: Make sure you save files to flash memory if needed. If power to the controller or /0 unit is turned off, files
are destroyed unless they have been saved to flash. (Does not apply to files in removable storage.)

Moving Files to the SNAP PAC Controller or I/0 Unit

To move files to the SNAP PAC controller or I/0 unit, use any standard FTP client software or PAC
Manager. (Do not use PAC Manager for files on a microSD card.) A maximum of five devices can FTP files to a

SNAP controller or /0 unit simultaneously.

Follow these steps to move files to the SNAP device using PAC Manager:

1. If PAC Manager isn't already open it, start it. (For instructions, see the footnote on page 10.)
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2. Click the Maintenance button .

## 1/0 Unit Maintenance *
r—Command

1,-1513 Firare Firmware Filename: Get Latest Firmware IP Addresses l Add... |
Install Module Firmware
Install IO Coprocessor Firmware I J 13%%:“? Modify |
Install CA Root Certificate Restart Confirmation Interval (sec) : 102030 42 -
Download File From 1O Unit l— Bt
Upload File To 1/0 Unit 1 Delete |
Delete File On IO Unit . .
Read Filenames On 10 Unit ROIE T =g Save |
Save Files To Flash I 2001 I 1000
Read Files From Flash
Clear Flash Files ™ synchronize to PC Time Loa—d---l
Sync 1O Unit to PC Time

Results |

Copy |
Select Al |
Clear Completed Results |

Close | Help |

3. Inthe Command list, highlight Upload File To I/O Unit. Click the browse button J and locate the
source file you want to load.

4. Inthe Destination field, type the filename as you want it to appear on the SNAP PAC device.

The filename can be the same or different from the source filename. You can specify a path on the device
using the separator / For example, to place the file Product Categories.txt into the folder Products, you
would type: Products/Product Categories.txt Ifthefolderdoes not exist, it is created.

5. Ifthe IP address(es) of the device(s) you want to load the file to appear in the IP Addresses list, skip to
step 7. (Or, if you have previously saved a list of IP addresses, click Load to load the saved list.) If the
address(es) you need don't appear in the list, click Add.

=] Add IP Address >

* Add one IP Address / Host Mame
@ IPhAddress: | 1 .0 .0 .0

" Host Name: I

" add a range of IP Addresses

Frarm: I - - -
To: I . - -

oK I Cancel |

6. Enter the address or a range of consecutive addresses, then click OK.

The address(es) you entered appear in the 1/0 Unit Maintenance dialog box.
7. Highlight the IP addresses to load the file to.
8. (lick Execute.
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The file is loaded to the I/0 units, and a Success message appears in the Results area.

File to upload (source)

Path and filename on Highlighted IP addresses

) will receive file
/0 unit(s)
## 1/0 Unit Maintenance *
—Command \ 4 v
Install Firmware Filename: IP Addresses l Add...
Install Module Firmware S
C: fe ktoy o 10.192.50.90
Install IO Coprocessor Firmware I \serslyfemia\Desktop'Prod. J 10.192.55.183 Modify
Install CA Root Certificate Destination: 10I 192I 55-6? =

Download File From 1/ Unit
R [Products/Product Categories.t 10.192.57.187 Delete

Delete File On IO Unit
Read Filenames On IO Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

Results |

Upload File To IO Unit Capy |
10.192,55.67 - Success

Select All |

Clear Completed Results |

Save...

Load...

aali

Close | Help |

Moving Files from the SNAP PAC Controller or I/0 Unit

To move files from the SNAPPAC controller or I/0 unit, use any standard FTP client software or PAC
Manager (do not use PAC Manager for files on a microSD card), or use the FTP communication handle in a PAC
Control strategy. (In PAC Control, a maximum of 16 communication handles can be used simultaneously to
FTP files. For details, see “Communication Commands”in the PAC Control User’s Guide (form 1700).

Here's how to move files from the device using PAC Manager:
1. Inthe PAC Manager main window, click the Maintenance button .
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In the Command list, highlight Download File From 1/0 Unit.

= 1/0 Unit Maintenance X
Command
Install Firmware Filename: IF Addresses Add
Install Module Firmware | 10.192.50.90
Install I/0 Coprocessor Firmware 10.192.55.183 i
Install CA Root Certificate Destination: 10.192.55.67 —
Download File From 1O Unit 10.182.57. 187
Upload File To 1/0 Unit | = 13257 Delete

Delete File On IO Unit
Read Filenames On IO Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

Save...

Load

i

Results
Select All
Clear Completed Results
Close | Help |

In the Filename field, enter the filename (and path, if any) of the file on the controller or I/0 unit.
Forexample: Products/Product Categories.txt

In the Destination field, enter the path and filename where you want the file to go (or click the browse
button | tolocate the path, then type in the filename).

The filename can be the same or different from the source filename.

In the IP Addresses list, highlight the IP address of the SNAP PAC device you are downloading the file
from. (If it does not appear, click Add to add it to the list.)

Click Execute.
The file is loaded from the device, and a Success message appears in the Results area.

Reading Filenames

You can use PAC Manager to read and list the names of all files and folders in the root of the controller or I/0
unit. Note that files located inside folders (or folders inside folders) are not listed, even though they are there.
PAC Manager will not show any files on a microSD card. You can use a standard FTP software program to see
them.

1.
2.
3.

In the PAC Manager main window, click the Maintenance button .
In the Command list, highlight Read Filenames On I/0O Unit.

In the IP Addresses list, highlight the IP address of the SNAP PAC device you are reading. (If it does not
appear, click Add to add it to the list.)

Click Execute.
The list of root file and folder names appears in the Results area.
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All root-level files and
folders on the device
with the IP address
10.192.55.67.

Folders are designated
as <DIR>.

=5 /0 Unit Maintenance X
Command
Install Firmware IF Addresses Add
Install Module Firmware 10.192.50.90

Install IO Coprocessor Firmware

Install CA Root Certificate 10.182,55.183 Modify...
Download File From I/O Unit 10.192.55.67
10.152.57.187 Delete

Upload File To I/O Unit
Delete File On IO Unit
Read Filenames On 10 Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

Save...

aalis

Load...

Results
Read Filenames On IO Unit

10,192,55.67 - Success
Products, <DIR >, 2016/07/01 09:54:00 Select All
Clear Completed Results

Close | Help |

The listing shows the file or folder name, the file's size in bytes (or <DIR> for folders), and the date and
time it was placed there (in the format YYYY/MM/DD hh:mm:ss).

Deleting a File from a SNAP PAC Controller or I/0 Unit

You can also use PAC Manager to delete a file from one device or from several devices at once. (You cannot
use it to delete files on a microSD card.)

1.
2.
3.

In the PAC Manager main window, click the Maintenance button .

In the Command list, highlight Delete File On I/0 Unit.

In the Filename field, type the filename (and path, if any) of the file you want to delete.
Forexample: Products/Product Categories.txt

In the IP Addresses list, highlight the IP address(es) of the SNAP PAC device(s) you are deleting the file
from. (If the correct IP addresses are not shown, click Add to add an address or group of addresses, or if
you have saved a list of IP addresses, click Load to load the saved list.)

Click Execute.
The file is deleted and a Success message appears in the Results area.

Using Flash Memory with the File System

You can use PAC Manager to move files between the controller or I/0 unit's file system and its flash memory,

which stores files so they are not lost if the device loses power. Remember that flash memory is smaller than

the memory available for file storage; check the controller's or I/O unit’s data sheet for details. (You cannot use
PAC Manager with files on a microSD card.)

You can do any of the following on one or multiple devices:

Save all files in the file system to flash memory

Clear all file system files from flash memory (does not affect firmware, strategy files, or point configuration
data)

Load files from flash memory into the device's file system, replacing all files in the file system
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Follow these steps:
1. Inthe PAC Manager main window, click the Maintenance button .
2. Inthe Command list, highlight the command you want to use.

In the following example, Save Files To Flash is highlighted.

## 1/0 Unit Maintenance *
r—Command
Install Firmware IP Addresses | Add
Install Module Firmware 10.192.50.90
Install IO Coprocessor Firmware §
Install CA Root Certificate ' ' ' 3 odi
Download File From 1O Unit DL
10.192.57.187 Delete

Upload File To I/O Unit
Delete File On IO Unit
Read Filenames On I/0 Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

Results |

Save...

Load...

il

Copy |
Select Al |
Clear Completed Results |

Close | Help |

3. IntheIP Addresses list, highlight the IP address(es) of the device(s) you want the command to apply to. (If
the correct IP addresses are not shown, click Add to add an address or group of addresses, or if you have
saved a list of IP addresses, click Load to load the saved list.)

CAUTION: Make sure you have chosen the correct command and the devices you want to affect. You cannot
undo these commands.

4. C(lick Execute.
The command is executed and a Success message appears in the Results area.
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7: Troubleshooting

INTRODUCTION

If you are having difficulty using PAC Manager, here are some suggestions that may help. In addition, make
sure to check the Troubleshooting section in the device's user’s guide. If you cannot find the answers you need
in these guides, contact Opto 22 Product Support. For contact information, see page 4.

PAC MANAGER ERROR MESSAGES

When you send configurations to I/0 units in PAC Manager, you may see the following messages in the lower
part of the Send Configuration to I/0 Unit dialog box:

Message Notes

Could not open I/O unit: [IP address] or
An error occurred while connecting to /O Unit
[IP address].

Timeout error. Check basic communication with the device (See the
Troubleshooting appendix in the device’s user guide for help).
[number] points successfully configured. Success message.
Could not configure digital module [number], point [number].

Check the point to make sure it's correct for the module type installed.
Could not configure analog module [number], point [number].

Module [name] exists at position [number] but was not config-  Check configuration; an analog module is at this position but no points

ured have been configured on it yet.
Could not configure temperature. These configurations apply to the 1/O unit as a whole, not to individual
Could not configure watchdog. points. Contact Product Support for help. (See page 4.)

Save to Flash—Operation Failed.
Contact Product Support. (See page 4.)
Clear Flash on I/O Unit: [name of unit}—Operation Failed.

Communication could not be established with the restarted /0 PAC Manager successfully connected to the device but could not send
Unit it a PUC. Check cables and communication.

TROUBLE CONNECTING TO THE I/0 UNIT OR CONTROLLER

See the Troubleshooting section in the user's guide for your device:

«  SNAP PAC S-series—the SNAP PAC S-Series Controller User's Guide (form 1592)
e SNAP-PAC R-series—the SNAP PAC R-Series Controller User’s Guide (form 1595)
e SNAP PAC EB and SB brains—the SNAP PAC Brains User's Guide (form 1690)
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USING PAC MANAGER TO TROUBLESHOOT PROBLEMS

USING PAC MANAGER TO TROUBLESHOOT PROBLEMS

PAC Manager can be useful in troubleshooting problems with I/0 units and controllers. Before calling Opto 22
Product Support, you can use PAC Manager to get device and firmware information and view diagnostic
messages. To help with communication problems, you can change TCP settings. You can also check for
Ethernet errors, which indicate network problems.

Getting Device and Firmware Information—Individual Device

These steps provide information for one device at a time. To get information on all devices on the Ethernet
network at once, see page 228.

If you need to contact Opto 22 Product Support for assistance in using an I/0 unit or controller, it is helpful to
have device and firmware information at hand before you call us.

1. Start PAC Manager as follows:

- InWindows 7, press the Windows Start key
Project > PAC Manager 10.4.

- InWindows 10, press the Windows Start key [g
Enter key.

In the PAC Manager main window, click the Inspect button @
3. Inthe Device Name field, type the name (or IP address) of the device. Click Status Read.
This example shows a SNAP-PAC-S1; other devices are similar.

1, and then click All Programs > Opto 22 > PAC

,type PAC Manager 10.4 andthen pressthe

=] Inspect Opto 22 Device — X

Device Name: \ 10.192,50,20 j Options » Status: | Status Read area last read at 07/05/16 13:42:15

Status Read
Status Read |
Status Write hDDRESS DESCRIETION VALUE ~ Refresh |

. 0xFFFF F030 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0)
Wireless LAN  + OxFEFF F030 0008 Busy Flag 0
Point Config 0xFFFF F030 0018 Loader Version R6.0a
. 0xFFFF F030 0000 Memory Map Version 1
Digital Bank 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version R9.5a
0xFFFF FO30 00RO Firmware Version Date 07/05/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 07:58:52
Analog Point 0xFFFF F030 0020 Unit Type 0x0000007C

High Density 0xFFFF F030 0080 Unit Description SNRP-PAC-51
OxFFFF F030 0024 I/0 Unit Hardware Revision (Month) 11
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 22
FEED P 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2005
ScratchPad b OxFFFF F030 024C  I/0 Coprocessor Firmware Version AD.0a
0xFFFF F030 0028 Installed Ram 33554432

Data Log 3

ETHERNET 1 Interface

PID b 0xFFFF F030 002E MAC RAddress 00-A0-3D-01-48-FB
N 0xFFFF FO30 0034 IF Rddress 10.192.50.20
ven 0xFFFF F030 0032 Subnet Mask 255.255.192.0
ComaTCaiors 0xFFFF FO30 003C Gateway 10.192.51.50
0xFFFF FO30 0040 NS 10.192.60.91
Other » ETHERNET 2 Interface v
o | TEE | I~ AutoRefresh | 15000  msec

Keep this window open on your screen when you call Product Support.
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NOTE: Because the Status Read area is used for both standalone controllers and I/0 units, some items apply to some
devices and not others. The following items do not apply to standalone controllers:

Degrees F/C PID Loops Supported

Comm Watchdog Time (msec.) Digital Modules Supported

Scanner Flags Arcnet data

4-Channel Digital Scan Count Digital resets and interrupt failures since powerup
Analog & High Density Dig Scan Count Analog and Digital Scanners (msec per scan)
Smart Modules Present Module X - Times Discovered

For help in interpreting Status Read data, see page 149.

Viewing Diagnostic Messages

PAC Manager displays a Diagnostic Messages button (yellow exclamation mark) on the Status Read page
when any of the following conditions are detected:

The OptoMMP port is not set to the default value of 2001.

The Modbus port is not set to the default value of 502.

The SNMP port is not set to the default value of 161.

The FTP server port is not set to the default value of 21.

The Control Engine port is not set to the default value of 22001.
This device is set to Always BootP on Powerup.

The I/0 coprocessor firmware in this device needs to be updated.
The analog and high density digital scanner is turned off.'

The digital 4-channel scanner is turned off.!

The control engine is turned off.

'For more information about scanners, see “Scanner Flags”in “Changing Status Data” on page 152.

NOTE: If your SNAP-PAC R-series controller cannot communicate via the host port after attempting to update
firmware, see KB82101, Updating to firmware 9.2¢ or higher may fail on SNAP-PAC-R controllers, on the Opto 22
website.
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If you see the button, click it and read the diagnostic messages. They may help you solve problems or provide
useful information when you call Product Support.

Exclamation mark button

= Inspect Opto 22 Device - *

Device Name: I 10,192.55.67 LI Options # | Status: | Status Read area last read at 07/01/16 ﬁx{:m

~Status Read
Status Read I
Status Write | ADDRESS DESCRIFTION VALUE ~ Refresh

= 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
e | OxFFFF F030 0008 Buay Flag 0 |

Paint Config | 0xFFFF F030 0018 Loader Version R5.1lc

Digital Bark | 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point | O0xFFFF FO30 001C Firmware Version A9.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank | 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point | 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density | 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
HEEn ’l 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
Scratch Pad ,l 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3 |

ETHERENET 1 Interface

PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
S 0xFFFF FO30 0034 IF Rddress 10.192.55.67
| 0xFFFF FO30 0038 Subnet Mask 255.255.192.0
Commmrications ,l 0xFFFF FO30 003C Gateway 10.192.51.51
0xFFFF FO30 0040 DHS 10.192.60.31
Other >| ETHERNET 2 Interface W
Close | Help | [ Auto Refresh IISDDD msec

Getting Device and Firmware Information—Multiple Devices

You can get device type, IP address, and firmware information for all Opto 22 Ethernet-based devices on one
network, all at one time. This method is especially useful for making sure firmware is up to date on all devices.
Note that SNAP PAC SB brains are not included, since they are on a serial, not an Ethernet, network.

1. If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)
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2. Inthe PAC Manager menu bar, click Tools > Find Opto 22 MMP Devices.

=] Find Opto 22 MMP Devices ===
PMP Port: |00 Timeout: 3000 ms  Devices Found: 1]
MAC Address | IP Address | Firrnware | Unit Tupe |

Find Help
[_Fnd ]

3. (lick Find.

PAC Manager discovers all Ethernet-based Opto 22 memory-mapped devices on the network and lists
their MAC addresses, IP addresses, firmware versions, and unit types.

| Find Opto 22 MMP Devices [ e
MMP Port: | 2001 Timeout: |3000 ms Devices Found: 114
MAC Address | IP Address | Firmware | Unit Type -

00-AQ-30-02-07-58  10,192.50.100 R9.Zb 0x56 OPTOEMU-SNRDR1 | |
00-20-0C-30-B6-E0  10.192.1.44 AD.Da 0x353

00-AD-3D-01F8-48 10.192.55.178 RS.1a 0x5A OPTOEMU-5MR-3Y
00-AQ-30-01-24-5E  10.192.57.80 RS.2a 076 SMAP-PAC-EE1
00-AQ-30-01-09-76 10,192.50.11 R9.Zb 076 SMAP-PAC-EE1
00-AQ-30-00-44-D2  10.192.54.243 RO.1c 0x93 SMAP-UP 1-ADS
00-AQ-30-01-7B-7F 10.192.50.84 RB.2a 076 SMAP-PAC-EE1
00-AQ-30-00-0C-04 10,.192.56.211 R7.0a 0x98 SMAP-B3000-ENET
00-AQD-30-00-FB-C2  10.192.56.213 R7.0a 0x98 SMAP-B3000-ENET
00-AQD-30-00-0C-50  10,192.56.215 R7.0a 0x98 SMAP-B3000-ENET
00-AQD-3D0-00-FB-A2  10.192.56.214 R7.0a 0x98 SMAP-B3000-ENET
00-AQ-30-00-0C-5B  10,192.56.216 R7.0a 0x98 SMAP-B3000-ENET -
1| 1] 3

Help

TCP Settings

Retransmit timeout (RTO) refers to the length of time the controller or brain waits while communicating
before timing out. The RTO is determined by the controller or brain’s TCP/IP stack, and the stack continually
recalculates the RTO based on recent network traffic. If the network becomes busier, for example, the stack
automatically adjusts the RTO to a higher value.
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If the TCP/IP stack times out while trying to transmit data, it doubles the current RTO and tries again. This

process continues for five retries; after that, the device stops trying and sends a timeout message.

If you are receiving frequent timeout messages from the device, you can change the TCP parameters in PAC

Manager.

1. Start PAC Manager:

- InWindows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project
10.4 > PAC Manager 10.4.

- InWindows 10, click the Windows Start button and type Opto 22 > PAC Manager 10.4.

In the PAC Manager main window, click the Inspect icon @

3. Inthe Device Name field, type the name or IP address of the controller or I/0 unit.
Then, click Status Write.

| Inspect Opto 22 Device

= LX)

Device Name: | 10.192.50.45

j Options »

Status: | Status Write area last read at 02/19/15 14:45:45

WirelessLAN ¥ |

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

|

Operation

OxFFFF FO38 0004  Always BootP/DHCP On Powerup
OxFFFF FO38 0008 Degrees FjC
0xFFFF F038 0010 Comm Watchdog Time {(msec), 0 = Disable
0xFFFF F038 0014  TCP Minimum Retransmission Timeout {msec)
OxFFFF F038 0018 TCP Initial Retransmission Timeout {msec)
0xFFFF FO338 001C  TCP Retransmission Attempts

OxFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable
| UxFFFF FU3S U298 Digital Feature Scan Interval (msec)
0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval {msec)
OxFFFF FO38 0298 Out Of Range Value

OxFFFF FO38 0054  Scanner Flags
0xFFFF FO38 0154  Host Name

Mo
Degrees C
a

|OELD|'~1MP Device

CAUTION: Note the following recommended settings:

TCP Minimum Retransmission Timeout (msec):

TCP Initial Retransmission Timeout (msec):

TCP Retransmission Attempts:

TCP [dle Session Timeout (msec):

250
3000

5
240000

Send Commagﬂ "

250
3000

5
240,000

kg

1000
-32768.000
0x 00000000

m

Status Write
Status Read |
Status Write Address | Description | Value - Refresh

Apply

If you set these fields too low, you may not be able to communicate with the device at all—even through PAC
Manager—to fix the settings. Then you would have to reset the controller or I/O unit to factory defaults.

4. Change these four fields as necessary:
Minimum RTO sets an absolute minimum value for the RTO. The device's calculated RTO will never go

below this value.

Initial RTO sets the RTO for the first communication try. Be careful: since all future tries are based on this
value, if you set it too low for network conditions, a connection will never be made.

TCP Retransmits sets the number of times the device retries communication. Larger, busier networks

need a higher number of retransmits than smaller networks with less traffic.

TCP idle session timeout sets how long (in milliseconds) the device allows a session to remain open
without any activity. After this time, the device checks the session to make sure it is still good, and closes
it if it is not. The default is 240,000 milliseconds, or four minutes.

5. Click the Apply button to write your changes to the controller or I/O unit.
6. Inthe Operation Commands list, highlight Store configuration to flash. Click Send Command.
7. Inthe Operation Commands list, highlight Restart brain from powerup. Click Send Command.
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Checking Ethernet Errors
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If you are having problems communicating with the controller or I/O unit, follow troubleshooting suggestions
in the user's guide for the device.

You can use PAC Manager to check Ethernet errors reported by the SNAP PAC device. These errors indicate
network problems. You will need to know the device's IP address.

1.

2
3.
4

Ethernet Errors

If PAC Manager isn't already open, start it. (For instructions, see the footnote on page 10.)

In the PAC Manager main window, click the Inspect button (£ |
In the Device Name field, type the name (or IP address) of the controller or /0 unit. Click Status Read.
Scroll down until you see these items:

Ethernet Errors: Late Collisions

Ethernet Errors: Excessive Collisions

Ethernet Errors: Others

| Inspect Opto 22 Device

Device Name: | 10,192.55.67

Status Read
Status Read |

Status: | Status Read area last read at 07/01/16 12:25:23

~| options »

Status Write 0xFFFF F030 0068 TCP Retransmits 5 ~ Refresh |
OxFFFF F030 006C TCP Idle Session Timeout (msec.) 240000
. OxFFFF FO30 0108 ICP Idle Session Timecut Count i}
Wireless LAN  # |
- 0xFFFEF FO30 0070 Ethernet Errors: Late Collisions [i]
Paint Config OxFFFF FO30 0074 Ethernet Errors: Excessive Collisions 0
L OxFFFF F030 0078 Ethernet Errors: Others 1]
Digital Bank
Digital Point OxFFFF FO30 007C  Smart Modules Present 0x003C
{analog, serial, etc.)
Analog Bank 0xFFFF FO30 011C  PID Loops Supported BT
0xFFFF F030 0148 Digital Modules Supported 16
Analog Paint
High Density 0xFFFF F030 0100 Arcnet Reconfigs Detected a
0xFFFF F030 0104 Arcnet Reconfigs Initiated by I/0 Unit 0
5 0xFFFF F030 0120 Arcnet Transmit Attempts Since Powerup 1696606351
System OXFFEF FO30 0128 Arcnet ACKs 1696606339
SaatchPad  » OxFFFF FO30 0134 Arcnet Timecuts i}
0xFFFF F030 0124 Arcnet Other (node not found, etc) 12
Data Log 3 0xFFFF F030 0130 Arcnet Timeout Value (msec.) a
O0xFFFF F030 0138 Arcnet Receive Interrupts 1696606339
FID 3
Events b 0xFFFF F030 0110 Ethernet MAC Resets Since Powerup 1]
ven OxFFFF F030 0114 Dig. Output Point Resets Since Powerup 0
Communications ¥ 0xFFFF F030 0118 Dig. Interrupt Failures Since Powerup 0
Other 3 0xFFFF F030 0140 Analog & High Density Digital Scanner 6.070 msec/scan w
Close | Help \ [~ Auto Refresh | 15000  msec

All three of these items should have a value of zero. If any of these items has a value other than zero, you
may have a network problem.

Troubleshooting Serial Communication

If you need to troubleshoot serial communication over PPP, you can turn on logging for the port the modem
uses. Any data received or transmitted on the port is logged to a file on the controller, which you can retrieve
using FTP and analyze for problems.
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You can also log communication with a serial device or I/0 unit for troubleshooting, but since the log file logs
serial data sent only between PAC Control and the serial device or I/0 unit, it is easier to log communication in
your PAC Control strategy in these cases.

CAUTION: Logging adds significant overhead to serial communication. Do not enable logging unless you are
troubleshooting.

Creating the Log File

1.
2.

4.

In the PAC Manager main window, click the Inspect button Q A

In the Device Name field, type the name (or IP address) of the controller (or choose it from the
drop-down list).

Click Communications and choose Communication Port Control from the submenu.
The Inspect window shows the ports and features that apply to the controller you're inspecting.

=] Inspect Opto 22 Device — X

Device Mame: ‘ 10.192.50.21 j Options * Status: | Comm Port Control area last read at 07/05/16 12:04:58

Communication Port Control
Status Read
Status Write Address | Description | Value Iﬁl
COMMUNICATION PORT 0
) OXFFFFFO310400  Control Function For Communicaton Port0  PPP 1 Apply
Wireless LAN ¥ N o i
0xFFFF FO31 0404 Logging For Communication Port 0 Disabled =1

COMMUNICATION PORT 1

Point Config 0OxFFFF FO31 0408 Control Function For Communication Port 1 Mone j
OxFFFF FO31 040C Logging For Communication Port 1 Disabled =1

Digital Bank COMMUNICATION PORT 2
. . 0xFFFF FO31 0410 Control Function For Communication Port 2 Mone j
st OxFFFFFO310414  Logging For Commurnication Port 2 Disabled =

Analog Bank
Analog Paint
High Density

System 3
ScratchPad  »
Data Log 3
PID 3
Events 3
Communications »
Other 3

Close | Help | ™ AutoRefresh | 15000  msec

Find the port you're troubleshooting. In its Logging For Communication Port # field, click Disabled and
change it to Enabled.

Logging begins immediately.

Retrieving the Log File

1.

Before retrieving the log file, go back to the PAC Manager Inspect window and set Logging For
Communication Port # back to Disabled (see steps in the previous section).

When you disable logging, all data is flushed to the file.

Use an FTP client to retrieve the log file, which is located in the root directory of the controller's file
system and named Comm<x>.log (where <x> is the physical serial port number).

See "Maintaining Files”on page 217 for information on FTP clients, and “Moving Files from the SNAP PAC
Controller or I/0 Unit"on page 220 for how to retrieve the file.

Reading the Log File

In the log file, full duplex serial communication is transformed into a single stream using these rules:
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«  Data bytes are not transformed in any way. The binary data byte is logged.
« Adirection byte is prepended to every data byte: 0 = outgoing, T = incoming.
«  The data stream is terminated by a null character (ASCIl 0x00).

The maximum log file size is 16 kb. When it reaches the end, the log stream wraps to the beginning of the file.
To locate the oldest data in a wrapped file, search for a null character in place of a 1 or 0; since the null
terminates the log data stream, the next logged data byte is the oldest data byte in the file. If the null
character is at the end of the file, the file has not wrapped.

Troubleshooting Wireless LAN Communication

If you are having difficulty with wireless LAN communication on a Wired+Wireless controller or brain (part
number ending in -W), Opto 22 Product Support may ask you to log WLAN data.

1. (SNAP PAC controllers only) Make sure there is a microSD card to receive the log file.

If no card is in the microSD slot, no log file is created. (A card is not required for a SNAP PAC EB-W brain,
which has no card slot.)

2. Inthe PAC Manager main window, click the Inspect button @

3. Inthe Inspect window's Device Name field, type the name (or IP address) of the controller (or choose it
from the drop-down list).

4. (lick Wireless LAN and choose Wireless LAN Configure.

5. Change the WLAN Logging value as Product Support directs.

6. Enter the Network Key.

7. Click Apply. When asked to restart the device, click Yes.

The log is always written to the same file; path and filename on both controllers and brains is:
/sdcard0/ATHO.LOG

If the file already exists, new data is appended to the end of it.

The log file looks similar to this:

! ATHO.LOG - Notepad 9[[=1[E3;

File Edit Format View Help

00007d15 sdwrkr wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ00007d1l5 sdwrkr
wmi_statsEvent_rx() : EnterZ00007dl5 sdwrkr  ARG000 updating target statsC00008549 sdwrkr
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ00008549 sdwrkr wmi_statsevent_rx{) : Enter:
00008549 sdwrkr ARG6000 updating target statsZ00008d7d sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ00008d7d sdwrkr wmi_statseEvent_rx{) : EnterZ00008d7d sdwrkr
ARG6000 updating target statsIZ000095bl sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
000095b1 sdwrkr  wmi_statsevent_rx() : EnterZ000095bl sdwrkr  ARG000 updating target statsC
00009de5 sdwrkr wmi_control_rx({) : WMI_REPORT_STATISTICS_EVENTIDZ00009de5 sdwrkr
wmi_statsEvent_rx() : EnterZ00009de5 sdwrkr  ARG000 updating target stats-0000a6l9 sdwrkr
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000a6l19 sdwrkr wmi_statsevent_rx{) : Enter:
0000a619 sdwrkr ARG6000 updating target statsZ0000aed4d sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ0000aed4d sdwrkr wmi_statseEvent_rx{) : EnterZ0000aed4d sdwrkr
ARG6000 updating target statsIZ0000b681 sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
0000b681 sdwrkr  wmi_statsevent_rx() : EnterZ0000b681 sdwrkr  ARG000 updating target stats:C
0000beb5 sdwrkr wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000bebS sdwrkr
wmi_statsEvent_rx() : EnterZ0000beb5 sdwrkr  ARG000 updating target stats-0000c6e9 sdwrkr
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000c6e9 sdwrkr wmi_statsevent_rx{) : Enter:
0000c6e9 sdwrkr ARG6000 updating target statsZ0000cfld sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ0000cf1ld sdwrkr wmi_statsevent_rx{) : EnterZ0000cfld sdwrkr
ARG6000 updating target statsIZ0000d751 sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
0000d751 sdwrkr wmi_statseEvent_rx{) : Enterz0000d751 sdwrkr ARG000 updating target stats:
e T o T B i e Rt S et aTaTeTa Ty L

| >

Product Support will interpret the log file.
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FILE MENU

EDIT MENU

New. Displays the Create New Tag Database dialog, allowing you to specify the name and location of a new
tag database. If changes to the current configuration have not been saved, you will be asked if you wish to
save those changes before proceeding. Only one configuration may be open at a time.

Open. Displays the Open Tag Database dialog, allowing you to open a previously created tag database. If
changes to the current configuration have not been saved, you will be asked if you wish to save those changes
before proceeding. Note that only one configuration may be open at a time.

Close. Closes the current configuration. If changes to the configuration have not been saved, you will be
asked if you wish to save those changes.

Save. Displays the Save Tag Database dialog, allowing you to save your configuration to disk.

Save As. Displays the Save Tag Database As dialog, allowing you to define a new name and/or location for
the current configuration.

(Recent Tag Databases). The four most recently opened Tag Databases are listed below Save As on the
File menu. Selecting any of them is equivalent to choosing Open Tag Database from the File menu and
entering the tag database name.

Exit. Closes the current configuration file and exits PAC Manager. If changes to the current configuration have
not been saved, you will be asked if you wish to save those changes before exiting PAC Manager.

Cut. Has no current functionality.

Copy. Available when an I/0 Unit is highlighted in the tree view. When selected, the highlighted I/0 Unit will
be copied to the clipboard.

Paste. Pastes an I/0 Unit from the clipboard into the strategy tree. This item is enabled only when an 1/0 Unit
has been previously copied to the clipboard.
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TOOLS MENU

VIEW MENU

Select menu items in the Tools menu to inspect and manage SNAP PAC controllers and brains, including
configuring IP addresses, installing firmware, and exchanging files.

Send Configuration to I/0 Unit. After you have finished configuring I/0 units and saved the
configuration file, you must load the configuration file into the I/O unit's memory. This menu item opens the
Send Configuration To I/0 Unit dialog box.

Inspect. Opens the Inspect Opto 22 Device window. Select this menu item to view and change I/0 and other
configuration settings for a specific SNAP PAC controller or brain.

IMPORTANT: Configuration changes made to the I/0 Unit in the Inspect window are not saved in the PAC Manager
configuration file.

Maintenance. Displays the I/0 Unit Maintenance window. Select this menu item to upgrade firmware,
exchange files, and manage items in flash memory.

Assign IP Address. Displays the Assign IP Address dialog. Select this menu item to see all Opto 22 Ethernet
devices that are broadcasting DHCP or BootP requests. You can then assign IP addresses to these devices and
test the addresses to confirm proper communication.

Change IP Settings. Displays the Change IP Settings dialog box. Select this menu item to change the IP
address and related network settings on a SNAP PAC controller or brain.

Install Firmware via Ethernet. Opens the Maintenance dialog box, which is used to download new
firmware to SNAP PAC controllers and brains.

Install Firmware via Serial Connection. Launches the application OptoFlash-ENET, which is used to
download new firmware to SNAP Ethernet and SNAP Simple brains via a serial connection. See the online help
included with OptoFlash-ENET for more information.

Install Firmware via Failsafe Bootloader Mode. Provides a way to install firmware when the firmware
in the device is damaged. See “Replacing Damaged Firmware” on page 214.

Import/Copy I/0 Unit. Displays the Inspect Opto 22 Device window. This dialog enables you to save an 1/0
unit's flash memory image to a file on your hard disk. This image file can then be used to configure another 1/0
unit. Configuration information can also be read directly from an I/0 unit and sent directly to another /0 unit,
or imported into PAC Manager to create a new I/0 unit configuration that can be expanded upon.

Modbus Calculator. Converts an I/0 unit memory map address to a Modbus Unit ID and Register Address.
See "Determining Modbus Unit ID and Register Address”on page 114.

Find Opto 22 MMP Devices. Displays a dialog box you can use to find the MAC and IP addresses (see
“Find Opto 22 MMP Devices”on page 258) of all Opto 22 memory-mapped devices on the Ethernet network.

Toolbar. Toggles the display of the toolbar.

Status Bar. Toggles the display of the Status Bar.
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APPENDIX A: MENUS

Help Topics. Opens the PAC Manager Help file's index of topics.
Manuals. Provides the PAC Manager User’s Guides in PDF format.
Opto 22 on the Web. Provides links to downloads, product support, and the Opto 22 website.

About PAC Manager. Provides general information about PAC Manager, including the version number and
copyright information.
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B: Dialog Boxes

ADD/EDIT ANALOG POINT
Use this dialog box to add analog points or edit the configuration of existing analog points.

Name. Type in a name for the I/O point. The name must start with a letter and may contain letters, numbers,
and underscores (spaces are converted to underscores).

Description (optional). Enter a description of the point.

Type. When the channel can be configured as either an input or an output, select the type from the
drop-down list.

Module. Select the I/0 module or point type from the drop-down list. All available modules of the type
specified will be included.

Units. Each analog module has a default set of units. These units are displayed in this field. If you assign
custom units to the module (by clicking the Custom button), the custom units will appear here instead.

Zero Scale. The module’s default zero-scale value appears here. This can be changed to a custom value (by
clicking the Custom button).

Full Scale. The module’s default full-scale value appears here. This can be changed to a custom value (by
clicking the Custom button).

Default button. Click here to return the units, zero-scale value, and full-scale value to the defaults for the
module. This is useful if you have assigned custom units and values through the Custom button that you now
wish to ignore.

Custom button. Click here to display the Scale Analog Readings to assign custom units, zero-scale, and/or
full-scale values to the module. For example, you could change the voltage range of a 0—10 VDC module to be
interpreted instead as a pressure range of 20-200 psia.

Watchdog. Click No (the default) to disable a watchdog on this point, or click Yes to enable the watchdog
(available for outputs only). If you select Yes, a new field will appear to allow you to define the value to be
assigned to the output should the watchdog be triggered. Enter a value between the zero-scale and full-scale
values (described above).

A watchdog is triggered if no communication activity is detected on the bus for the amount of time specified
in the Watchdog field of this point’s I/0 unit.
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ADD/EDIT DIGITAL POINT

Use this dialog box to configure a digital point for an I/0 unit.

Name. Type in a name for the I/O point. The name must start with a letter and may contain letters, numbers,
and underscores (spaces are converted to underscores).

Description (optional). Enter a description of the point.

Type. When the channel can be configured as either an input or an output, select the type from the
drop-down list.

Module. Select the 1/0 module or point type from the drop-down list. All available modules of the type
specified will be included.

Features. Click here to view and select from the available features for the I/0 point you are configuring.
Features are available only if you are adding a point to a multifunction 1/0 unit. By default no feature is
selected.

For inputs, depending on the module and I/0 unit, you may be able to configure the module as a counter,
on-pulse, off-pulse, frequency, period, on-time totalizer, off-time totalizer, or quadrature counter feature. You
may be able to configure an output module as a time-proportional output (TPO).

Watchdog. This field, which appears only if you enable the watchdog, also has only two values. Click the
field and select On or Off from the drop-down list. Remember, watchdogs are available only for output
modules.

ADD/EDIT EVENT MESSAGE
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Use this dialog box to add a new event message or edit an existing event message.

Message Name. Type in a descriptive name for this event message. The message name is not sent to the
I/0 Unit. It is used only within PAC Manager to differentiate event messages from one another.

Message Text. For e-mail, serial, and SNMP event messages, type in the text to be sent as the message. For
MemMap Copying, this field holds the Source Memory Map address or the Source Data. Plugins can be used
in the message text. The text limit is 127 characters.

Streaming. To have the I/0 Unit periodically stream data back to a PC, select Enabled from the drop-down
list. You must first use Configure Streaming to set the host(s) to receive the streamed data.
Period (sec). Enter the interval in seconds at which streaming should take place. A value of 0 means that
data will be streamed only once.

E-mail. To have the I/0 Unit send the Message Text using e-mail, select Enabled from the drop-down list. You
must first use Configure E-mail to set the e-mail address that will receive the Message Text.

Period (sec). Enter the interval in seconds at which the e-mail should be sent. A value of 0 means that
the e-mail message will be sent only once.

Serial Module. To have the I/0 Unit send the Message Text as a string through a serial communication
module, select Enabled or Disabled from the drop-down list and enter the string to send in the Message Text
area. You must first use Configure Serial Modules to set serial modules and their ports.

Serial Ports Mask. Enter a mask representing the serial modules and ports to send the message
through. Bits 0-31 correspond to ports 0-31.
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SNMP Trap. To have the I/0 Unit send the Message Text as an SNMP trap, select Enabled from the
drop-down list. You must first use Configure SNMP Agent to set up SNMP system variables, community
groups, and management hosts.

Period (sec). Enter the interval in seconds at which to send the SNMP trap. A value of 0 means that the
trap will be sent only once.

Trap Type. Enter the trap type required by your SNMP management software. Refer to the
documentation for your SNMP management software for information on determining the required
SNMP trap type.

Priority. If you are using SNMP with an outgoing PPP (modem) connection and want the SNMP trap
stored in the I/0 Unit until the next communication, set Priority to Low. If you want the 1/0 Unit to
immediately dial out and send the trap, set Priority to High.

MemMap Copy Destination. To change the state of a digital point on a different /O Unit, or to copy data
from one memory map address to another, select Enabled from the drop-down list and complete the
MemMap Address, IP Address, Period (msec), and IP Port fields for the location the data is being copied to. In
the Message Text area, enter the source data or memory map location data is being copied from.

MemMap Address. Enter the destination memory map address in hexadecimal. You do not have to
include the leading FFFF.

Period (msec). Enter the interval in milliseconds at which the MemMap copy should take place. A value
of 0 means that the copy will be done only once.

IP Address. Enter the IP address of the destination I/0O Unit. Use 0.0.0.0 if copying to an address on the
same 1/0 Unit.

IP Port. Enter the IP port of the destination I/0 Unit. This field is ignored if copying to the same I/0 Unit.

ADD/EDIT I/0 UNIT

Use this dialog box to add a new I/0 Unit or edit an existing 1/0 Unit.

1.

No v ewhN

Enter a name for the I/0 unit. The name must start with a letter and may contain letters, numbers, and
underscores. Spaces are converted to underscores.

(Optional) Enter a description of the unit.

Select the type of /0 unit from the drop-down list.

Choose whether temperatures will be handled in Fahrenheit or Celsius.

Specify the communication port to use (2001, unless you have changed it for security purposes).
Enter the I/O unit’s IP address.

The Address List area shows IP addresses of the I/0 units that should receive this configuration. If you
have I/0 units that are exactly alike, list all of them here. That way you can download the configuration
file to all the 1/0 units at once. To list them, click Add and enter a single IP address or a range of addresses.
Select whether you want a Watchdog on the unit. The default is No (disabled). If you select Yes, a new
field appears; enter the Watchdog timeout value in seconds. The default timeout is 0.5 seconds.

When a watchdog is enabled, the I/0 unit monitors activity on the port. If no communication is received
for the specified interval, the unit automatically sets designated digital and analog I/O points to values
you have set in the Watchdog field of the Add/Edit Analog Point or Add/Edit Digital Point.

ADD/EDIT IP ADDRESS

Use this dialog box to add an IP Address or a range of IP Addresses that will all receive this 1/0 unit
configuration. Usually these are I/0 units that are exactly alike. Also use this dialog box to modify a single IP
address.
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Click either Add one IP Address or Add a range of IP Addresses.
For a single IP address, enter or change the address and click OK.

To add a range of IP addresses, enter the first address in the range in the From field. Enter the last IP
address in the To field. Then click OK.

ADD/EDIT MEMORY MAP VALUES

Use this dialog box to add a new Memory Map Value or edit an existing Memory Map Value.

Address. Type in a valid Memory Map Address. The address must be in hexadecimal and correspond to a
valid write area in the device's Memory Map. Use the OptoMMP Protocol Guide (form 1465) as a reference.

Value. Type in the value to send to the above address. The value may be in hexadecimal (integer types only)
or decimal. For hex, precede the value with Ox. (Based on this convention, PAC Manager will remember if your
value is in hex or decimal.)

Type. Select the type of Memory Map Value.

ADD/EDIT PID LOOPS

Use this dialog box to add or change PID loops on SNAP PAC brains, and R-series controllers. You can configure
up to 96 PID loops. Four algorithms are available to choose from.
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See also “Configuring PID Loops”on page 63.

1.
2.
3.

Enter a unique, descriptive name for the PID.

(Optional) Enter a description of the PID.

Select the type of input: I/O Point, Host, or PID Output.

- Ifthe PID’s process variable comes from an I/O point on the same unit, select 1/0 Point. Choose the
point from the drop-down list or type a point name to configure a new point.

- Ifthe PID’s process variable comes from an PAC Control strategy, select Host. Enter an initial value for
the input.

- Ifthe PID’s process variable is the output of another PID on this brain (a cascading control loop),
select PID Output. Choose the PID from the drop-down list.

(Optional) If you chose 1/0 Point or PID, check the Square Root box if the error should be calculated

based on the square root of the process variable (applies to flow control systems where volumetric flow is

proportional to the square root of a signal from a flow transducer).

Set the valid range of the process variable by entering the low range and the high range. (See below

for optional responses to out-of-range input.)

Choose the source for the setpoint: 1/0 Point, Host, or PID Output.

- To control the setpoint using a device such as a potentiometer, select I/O Point; choose an I/0 point
from the drop-down list or type a new point name.

- To control setpoint using PAC Control or PAC Display, select Host and enter an initial value.

- Ifanother PID loop will control the setpoint, select PID Output and choose the PID from the
drop-down list.

Choose the destination for the PID output: I/0 Point or Host. (To use the output for controlling the

setpoint or input of another PID, choose Host.)

Enter upper and lower clamp values to prevent the output from exceeding a desirable range. These

values should equal the range of the output point, if used. Or choose values to make sure that the output

device doesn't shut off (for example, keeping a circulation pump running regardless of the PID output) or
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that the output never reaches a destructively high setting (for example, keeping a motor below
maximum).

9. (Optional) Enter minimum and maximum change values. The output won't respond until the
minimum change is reached (for example, you may not want a heater to turn on to correct a 1 degree
error). Maximum change prevents too drastic a change in output (for example, you could limit the
increase in a pump’s output to prevent pipe breakage). The default for both minimum and maximum is
zero, which disables the feature.

10. Choose how the PID should respond (output options) if the input goes out of range. If no boxes are
checked, the PID will freeze output at the current value. To have PAC Control logic or an operator respond,
check Switch to manual mode. To force the output to a specific value, check Force output and type the
output values. NOTE: If both boxes are checked (forced output and manual mode), the output will be forced
and the PID put into manual mode; but if the PID is already in manual mode, the output will not be forced.

11. Choose algorithm: Velocity, ISA, Parallel, Interacting. See also “Algorithm Choices”on page 63.

12. Choose mode. Auto activates the PID. Manual requires that PAC Control logic or an operator control the
PID output.

13. Enter a scan rate to determine how often the input is scanned and the controller output is calculated.
Minimum value is 0.001 (1 millisecond). Scan time should be greater than system lag (the time it takes for
the controller output to have a measurable effect on the system). Also consider other PIDs and tasks on
the brain competing for processing power.

14. Enter a positive or negative value for Gain. Heating systems usually require a negative value and cooling
systems a positive value. NOTE: Gain is usually refined during the tuning process.

15. (Optional) Enter Feed Forward Initial and Feed Forward Gain values if you need to offset the
controller output in your application. These values are constants that are multiplied and added to the
controller output; often they are not used in PIDs.

16. (Optional) Enter Integral (Tune I) and Derivative (Tune D) settings if you know the desirable settings.
However, Integral and Derivative are not essential to basic configuration and are better determined in the
tuning process.

17. Click OK.

ADD/MODIFY NEW DEVICE

To add a new 1/0 Unit Name, click Options to open the Add New Device dialog box.

Device Name: Enter a name for the I/0 unit. You can use the IP address or any unique name. Change the
timeout if necessary.

Direct Connection to Ethernet Device: Use this option if there is a direct connection to the brain via an
Ethernet cable.

o [P Address or Hostname: Enter the IP address or hostname of an Ethernet /0 unit, such as a PAC EB-series
or PAC R-series device.

o Fthernet Port: Use the default of 2001 for Ethernet Port unless you have changed the port.

Direct Connection to Serial Device: Use this option if the I/O unit is connected directly to the PC using a
serial cable and a PCI-AC48 adapter card.

o PCSerial Port: Enter the serial port on the PC where the brain is connected.

«  PCBaud Rate: The baud rate on the PC must match the rate set on the brain.

o Serial Device Address: Enter the serial address of the brain.

Pass-Through Ethernet Controller to Serial Device: Use this option for SNAP-PAC-SB1 and SB2 brains
connected to a SNAP-PAC-51 or S2 controller.

«  IPAddress or Hostname: Enter the IP address or hostname of the S-series controller.
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«  Fthernet Port: Use the default of 2001 for Ethernet Port unless you have changed it.

«  Controller Serial Port. Enter the controller's serial port where the brain is connected. On a SNAP-PAC-S1, it's
Serial 2. On a SNAP-PAC-S2, it could be any port.

o Controller Baud Rate: The baud rate on the controller must match the rate set on the brain.
o  Serial Device Address: Enter the serial address of the brain.

o 2-Wire RS-485: Check this box for a 2-wire RS-485 connection. SNAP-PAC-S1 controllers support only
2-wire RS-485. SNAP-PAC-S2 controllers support 2-wire or 4-wire RS-485.

ASSIGN IP ADDRESS

Use this dialog box to assign IP addresses to Opto 22 devices, either by listening for devices sending DHCP or
BootP broadcasts, or by first creating a list of mappings.

NOTE: In order to assign IP addresses, you must be logged in with administrative rights.

See also “Assigning an IP Address” on page 8.

Each device ships from the factory with a unique MAC address (printed on a label on the device) and a default
IP address of 0.0.0.0, which is invalid. SNAP PAC, SNAP-LCE, SNAP Ultimate, SNAP Ethernet, and SNAP Simple
I/0 send out a BootP broadcast when first turned on. E1s and E2s send out a DHCP broadcast. In most cases,
you must give each of these devices a fixed, static IP address. See also “Assigning IP Addresses to SNAP PAC"on
page 9.

Assigning IP Addresses to SNAP PAC

If your network has a DHCP server, either assign a static IP address before connecting the device to the
network (preferred), or disable the server. Note the MAC address of each device that needs an IP address, and
turn on the device(s).

NOTE: SNAP PACs each have two separate Ethernet network interfaces. Each interface has a separate MAC address
and therefore takes a separate IP address. Only ENETT sends a BootP request. Once you have assigned this primary IP
address, you can assign the secondary address using the Inspect Opto 22 Device window.

Double-click the MAC address of the device in the upper list.

2. Inthe Mapping dialog box, enter the IP Address and Subnet Mask for the device. If it will be talking to a
device on another subnet, enter the Gateway (router) address. If it will talk only on the local subnet, leave
the gateway address all zeros (0.0.0.0). Leave the DNS address at 0.0.0.0 and the Host Name field blank.
Click OK.

3. Thenew IP address information appears in the upper list in the dialog box, and the device’s status
changes to Mapped. The address information also appears in the lower list to show that this device has
been mapped to this address.

4. With the device still highlighted, click Assign. The address is saved to flash memory and the status
changes to Static IP. To verify that the IP address has been successfully assigned, highlight the device in
the upper list and click Test. A DOS window opens and the IP address is pinged.

5. Forfuture reference, write the IP address next to the MAC address on the white sticker provided on the
device.

6. Tosave the list of IP address and MAC address mappings (the lower list in the dialog box), click Save List.

NOTE: Ifyou have a large number of devices or are on a separate network, you can create the mappings list first, save

it, and then load it into PAC Manager later. Devices that match the mappings receive their IP addresses as soon as
they appear in the upper list. Click Assign All to save them.
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ASSIGN SECONDARY IP ADDRESS

SNAP PAC controllers each have two, independent Ethernet network interfaces. With PAC Project Professional,
you can use these interfaces to segment the control network from the company network or for Ethernet link
redundancy. For more information, see the PAC Control User’s Guide (form 1700), the PAC Display User’s Guide
(form 1702) and the OptoOPCServer User's Guide (form 1439, available with the purchase of PAC Project
Professional or OptoOPCServer).

IMPORTANT: The two Ethernet interfaces will work only if they are on separate network segments, so the control
engine can clearly determine where to direct communication. For example:

ENET1 ENET2

IP Address: 192.168.0.12 10.0.05
Subnet Mask: 255.255.255.0 255.255.255.0

The first Ethernet interface, ENET1, sends a BootP broadcast and is assigned an IP address just like other Opto
22 devices (see "Assign IP Address” on page 244).

To assign an IP address to ENET2, follow these steps:
1. Make sure that ENET1 has already received an IP address.
2. Inthe PAC Manager main window, click the Inspect button.

3. Inthe Inspect window, enter the IP address for ENET1 and click Status Read. Status information for the
controller appears in the window. If the secondary IP address has not been assigned yet, the secondary IP
address information will show all zeros.

4. Click Status Write. Enter the IP address information for ENET2 in the Value column in the Secondary IP
Address, Secondary Subnet Mask, and (if necessary) Secondary Default Gateway fields. Click Apply. The
information is sent to the SNAP PAC, but it cannot communicate on the secondary interface until it is
restarted.

5. Inthe Operation Commands section, highlight Restart Device from powerup. Then click Send Command.

The SNAP PAC controller is restarted. You can check to make sure the controller is back on line by clicking
Status Read again and making sure the secondary IP address information is shown. To verify communication,
open PAC Manager on a PC that is on the same network segment as the secondary IP address, and use the
Inspect window to check status.

CONFIGURE E-MAIL

You can send an email message or page someone in response to an event. Use this dialog box to set up email
parameters. See “Configure Event Messages”on page 246 to set up the message itself.

IP Address and Port. Enter the IP address and port number of the Simple Mail Transfer Protocol (SMTP)
server the 1/0 unit will use to send email. You should be able to get this information from your network
administrator.

Timeout. Enter the length of time in milliseconds the 1/0 unit should wait for a response from the email
server. The default is 30,000.

From. Enter a valid email address that will identify the 1/0 unit to the person who receives the email.
To. Enter the email address of the person who will receive the email.

Subject. Enter a phrase that will indicate the purpose of the email to the person receiving it. Note that this
subject line applies to all email messages sent by this I/0 unit. Plugins can be used in this field. For example, if
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a similar email will be sent at intervals (such as an email of the data log), you can use the segid plugin to put a
sequence number at the end of each subject line. This plugin is in the format:

$! segid

So, for example, if you enter Ultimate Data Log $!_seqid_ in the subject field, the first email message will have
a subject line of Ultimate Data Log 0, the next message will have a subject line of Ultimate Data Log 1, and so
on. For information on other plugins, see “Using Plugins”on page 95.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the brain, save it to flash
memory, and restart the brain.

CONFIGURE EVENT MESSAGES

If you are using PAC Control or PAC Manager 9.0 or higher, configure event messages in the
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configuration file as shown on page 92.

If you are not using PAC Control or are using a PAC Manager version less than 9.0, you cannot
configure event messages in a configuration file. Instead, use PAC Manager's Inspect mode and follow the
steps below. Note that event messages are not available on SB brains, since messaging requires an Ethernet

connection.

1. Inthe PAC Manager main window, click the Inspect button
—  Ifyou have not used the Inspect window before, the window will not show any data. Select your

controller from the drop-down list.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.

= Inspect Opto 22 Device

Device Name: | 10.192.50.21

Status Read
Status Read
Status Write

Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density
System 3
ScratchPad  »
Data Log 3

Events 3
Communications
Other 3

Close |

FID

3

Status:

j Options »

Status Read area last read at 07/05/16 12:03:48

hDDRESS DESCRIFTION VALUE ~ Refresh |

0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}

0xFFFF FO30 0008 Busy Flag a

0xFFFF F030 0018 Loader Version RE6.la

0xFFFF FO30 0000 Memory Map Version 1

0xFFFF F030 0230 Current Boot Device Flash Memory

0xFFFF F030 001C Firmware Version R59.5a

0xFFFF FO30 00R0 Firmware Version Date 07/05/2016

0xFFFF F030 00BO Firmware Version Time 07:58:52

0xFFFF FO30 0020 Unit Type 0x0000007C

0xFFFF FO30 0080 Unit Description SNAP-FAC-51

0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 11

0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 22

0xFFFF FO030 002§ I/0 Unit Hardware Revision (Year) 2005

0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a

0xFFFF FO30 0028 Installed Ram 33554432
ETHERENET 1 Interface

0xFFFF FO30 002E MAC Rddress 00-A0-3D-00-D9-0B

0xFFFF FO30 0034 IF Address 10.192.50.21

0xFFFF FO30 0038 Subnet Mask 255.255.182.0

0xFFFF FO30 003C Gateway 10.192.51.50

0xFFFF FO30 0040 DNS 10.192.60.91
ETHERENET 2 Interface W

EY | ™ AutoRefresh | 15000  msec

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

= In

Status Rga

Status Wiits

Wireless LAN

spect Opto 22 Device

Cookie Controller
Cookie Controller
EngineRm

Coil Portable

Chamber 1

Chamber 2

Paint Config ol portable

(CRIFTION

rerup Clea
¥y Flag 1

der Versij

= Cookie Controller ory Map Vi
HD@E' B EngineRm mware Verd
Digital Point S2fPAC mware Ver,

1 i T | i
‘fJxFFFF FO30 00BO Firmware Very
A SF S e N P e

In the Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down

list).

Click Events and choose Event Messages from the submenu.

| Inspect Opto 22 Device

Device Name: | 10.182.55.67

Event Message
Status Read

Status Write |

j Options »

Event Message Mumber: |0 -

Status:

Event Message area last read at 07/05/16 13:31:00

Wireless LAN  »

Point Config
Digital Bank
Digital Paint
Analog Bank
Analog Point
High Density

System 3
Scratch Pad  #
Data Log 3
PID 4
Events 3
Communications ¥
Other 3

Close |

Address | Description Value |
MESSAGE
0xFFFF F120 0040 Message Text
0xFFFF F120 9000 Most Recent Message Sent
0xFFFF F120 0000 State Inactive a|
0xFFFF F120 0004 Scratch Pad Trigger ON O 00000000 00000000
0xFFFF F120 000C Scratch Pad Trigger OFF O 00000000 00000000
STREAMING
0xFFFF F120 0014 Enable Stream Packet Disabled =1
0xFFFF F120 0018 Stream Period (seconds) ]
E-MAIL
0xFFFF F120 001C Enable E-mail Message Disabled =1
0xFFFF F120 0020 E-mail Period (seconds) 0
SERIAL MODULE
0xFFFF F120 0033 Enable Serial Module Message Disabled R
0xFFFF F120 003C Serial Ports Mask O 00000000
SNMP
OxFFFF F120 0024 Enable SMMP Trap Disabled R
0xFFFF F120 0023 Trap Period (seconds) 0
0xFFFF F120 002C Trap Type 1]
OxFFFFF120 0030  Priority High =1

0xFFFF F120 3000
0xFFFF F120 8004
0xFFFF F120 8008
0xFFFF F120 800C

Help |

MEMMAP COPY DESTINATION
MemMap Address
IP Address of Destination
Port
Period (milliseconds)

O 00000000
0.0.0.0

i}

i}

Refresh |
Apply

™ Auto Refresh | 15000  msec

From the drop-down list, choose the lowest unused message number.
Unused message numbers have no asterisk.

For an email or serial message, or optionally for an SNMP message, enter the message text.

Message text is not sent in the streaming packet. Message text is limited to 127 characters. You can place
data from the I/O unit’s memory map into the message by using a plugin (see page 95). If you are
sending a serial message, make sure the text is formatted so the serial device that receives it will

understand it.
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10.

11.

12.
13.
14.

15.

Enter two masks indicating the Scratch Pad on and off bits that should trigger the message.
For help in figuring out the masks, see “Digital Point and Scratch Pad Masks”on page 132.

Streaming section: To send a stream of data as the message, choose Enabled from the drop-down list.
Enter how often in seconds to send the stream (0 sends it only once).

For information on streaming, see page 96.

E-mail section: To send an email message, choose Enabled from the drop-down list. Enter how often in
seconds to send the email (0 sends it only once).

Serial Module section: To send a message through a serial module to a serial device, choose Enabled from
the drop-down list. Enter a mask representing the modules and ports to receive the message.

Information in “Configuring Serial or Wiegand Events and Reactions”on page 140 may be helpful.

SNMP section: To send an SNMP trap as the message, change Disabled to Enabled. Enter how often to
send the trap (0 sends it only once). Also enter the trap type (determined by your SNMP management
software). If you are using SNMP with outgoing PPP and want the trap stored in the I/0 unit until the next
communication, set Priority to Low. If you want the I/O unit to immediately dial out and send the trap, set
Priority to High.

For information on SNMP, see page 96.

NOTE: SNMP messages must be acknowledged. You can do so in your application or in PAC Manager's Inspect
window: in the Message section, change the State to Acknowledge and click Apply.

Memmap Copy Destination section: To copy memory map data, complete this section using information
from "Copying Memory Map Data”on page 109.

When all fields are correct, click Apply.
Repeat from step 4 to configure additional event messages.
For each type of message you configure, make sure you also set up basic configuration:

Serial: See page 46
SNMP: See page 96
Email: See page 100
Streaming: See page 104

When you have finished configuring all event messages and any additional configuration required for
them, in the PAC Manager Inspect window, make sure the IP address shown is the correct one. Then click
the Status Write button in the upper-left part of the window.
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16. In the Operation Commands list, highlight Store configuration to flash.

Analog Bank

Analog Point

High Density
System 3
ScratchPad
Data Log 3
PID 3
Events 3
Communications ¥
Other 3

0xFFFF FO38 0280

= Inspect Opto 22 Device — X
Device Name: | 10.192,50,11 ;| Options * | Status: | Status Write area last read at 05/02/16 16:30:29
~Status Write
Status Read |
Status Write Address | Description | Valug
OxFFFF FO38 0004 Always BootP /[DHCP On Powerup Mo |
Wircless LAN > OxFFFF FO38 0008 Degrees FfC Degrees F =1 Apply |
| OxFFFF FO33 0010 Comm Watchdog Time (msec), 0 = Disable 0
0xFFFF FO38 0014  TCP Minimum Retransmission Timeout {(msec) 250
Point Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
OxFFFF FO33 001C  TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO33 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
= s OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Digital Point OxFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
OxFFFF FO38 0298  Out Of Range Value (16-Bit) -32768.000

-2147433648.000

Out Of Range Yalue {32-Bit)

0xFFFF FO38 0054  Scanner Flaas

Operation

OptoMMP Device

Restart Device from powerup
Store configuration to flash
Erase configuration from flash k
Reset to defaults and Restart Device

micraSD
Store configuration and IP settings to microSD
Erase configuration and IP settings from microSC.
Erase firmware from microSD
Erase strategy from microSD

Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration W

~ Send Command |

0x 00000000

™ Auto Refresh IISDUD msec

17. Click Send Command.
The configuration data is stored to flash memory and a Success message appears.

IMPORTANT: For the following configurations, you must also restart the unit for configuration to take effect:

Changes in TCP port for serial modules

Email configuration

Data logging interval

SNMP configuration

PPP configuration

18. If you have configured any of these items, in the Operation Commands list, highlight Restart /O Unit
from powerup. Click Send Command.

The I/0 unit is restarted and a success message appears.

CONFIGURE I/0 POINTS

SNAP 1/0 units are configured by first adding a SNAP module, then configuring each point on that module.
SNAP modules and points are listed in an expandable, tree-like view. The window is resizable.

1/0 Unit. Displays the I/0 unit on which 1/0 points are being configured.

Type. Displays the type of I/0 Unit for which points are going to be added. This field is for display purposes
only and cannot be modified.

Add. To add I/0 points to a SNAP I/0 Unit, you must first add a SNAP module to the I/0 Unit, then add I/0
points to that module.

To add a SNAP module to an I/0 Unit
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Highlight the location where the module will be added and click the Add button. In the Add Module
dialog that appears, select the type of module (Analog Input/Output or Digital Input/Output) and the
name of the SNAP module you are configuring. Click OK.

To add an I/0 point to a SNAP module

Double-clicka SNAP module in the list to see the point locations it contains. Highlight the location where
the point will be added and click the Add button. Depending on whether the 1/0 point being added is
analog or digital, enter configuration information for the new 1/0 point in either the Add/Edit Analog
Point or Add/Edit Digital Point.

Modify. To change an existing SNAP module or /0 point, highlight the item in the list and click the Modify
button. Change configuration information for the SNAP module or I/O point in the Add Module dialog, the
Add/Edit Analog Point or the Add/Edit Digital Point as necessary.

Delete. To delete an existing SNAP module or I/0 point, highlight the item in the list and click Delete. Before
deleting a SNAP module, you must first delete all I/O points associated with that module. When deleting I/0
points, note that only points having a reference count of zero can be deleted.

Move To. To move an I/0 point to an empty channel on another (or the same) I/0 Unit, highlight the point,
click Move To, and use the Move Point To to move the point. If the I/0 point is referenced in a PID loop or
event/reaction, you can move the point only within the same I/0 unit, not to another unit.

Expand All/Collapse All. To view or hide all I/O points in a SNAP I/0 unit, click the Expand All button or the
Collapse All button.

CONFIGURE 1/0 POINTS (G4EB2)
G4EB2 1/0 units are configured by adding a point for each G4 module.
1/0 Unit. Displays the I/0 unit on which 1/0 points are being configured.

Type. Displays the type of I/0 Unit for which points are going to be added. This field is for display purposes
only and cannot be modified.

Add. Points that have not been configured yet show as Not Used. Double-click the channel number for the
point you want to add. Enter configuration information for the new I/0 point. See “Configuring Digital Points
fora G4EB2"on page 38.

Modify . To change an existing point, highlight the item in the list and click the Modify button. See
“Configuring Digital Points for a G4EB2" on page 38.

Delete. To delete an existing point, highlight the item in the list and click Delete. When deleting 1/0 points,
note that only points having a reference count of zero can be deleted.

Move To. To move an I/0 point to an empty channel on another (or the same) I/0 Unit, highlight the point,

click Move To, and use the Move Point To to move the point. If the I/0 point is referenced in a PID loop or
event/reaction, you can move the point only within the same I/0 unit, not to another unit.

CONFIGURE 1/0 UNITS

This dialog box shows all the I/0 units in the current configuration and is the "home base” for configuring 1/0.
For more details on configuring I/0 and features, see Chapter 2: Configuring Devices.
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To resize the dialog box, move the mouse near any edge until the pointer turns into a two-way arrow, then
click and drag the border in any direction. To resize a column, click and drag the column dividers in the list
header, or double click the divider to expand the column just wide enough to display the longest item in the
column.

To configure a new I/0 unit, click Add or double-click anywhere in the list box below any configured units.
The Add/Edit I/0 Unit dialog box will appear.

To change an I/0 unit in the list, highlight it and click Modify and change the unit’s settings in the Add/Edit
I/0 Unit dialog box.

To remove an I/0 unit in the list, highlight it and click Delete. Only I/0 units with a reference count of zero
can be deleted.

To add or modify I/0 points for the highlighted I/0 unit, click I/0 Points. The Configure I/O Points dialog box
will appear.

To copy and save I/0 Unit configurations, click Import/Copy and select I/O units in the I/0 Unit
Import/Copy dialog box that appears.

To configure additional items, click the buttons shown below:

Click PID Loops to configure proportional-integral derivative (PID) loops on SNAP PAC brains or R-series
controllers.
«  (lick Modules and select a module type:
- Serial Modules
(see “Configuring RS-232 and RS-485/422 Serial Communication Modules” on page 46)
- Wiegand Modules
(see “Configuring Wiegand Modules” on page 51)
- Profibus Modules
(see “Configuring Profibus Modules”on page 53)
- Motion Modules
(see the SNAP PAC Motion Control User’s Guide, form 1673)
- SSIModules
(see “Configuring SSI (Serial Synchronous Interface) Modules”on page 54)
- CAN Modules
(see “Configuring CAN Modules”on page 55)
- HART Modules
(see “Configuring HART Modules”on page 59)
«  (lick Events and select an event to define or an event message to send as a reaction to an event.

«  (lick Scratch Pad to view and configure bitmask, integer, float, and string memory areas of a SNAP PAC
controller or brain.

NOTE: If you are using the Scratch Pad on a SNAP PAC S-series controller, you must first configure an I/0 unit to
represent the controller. Configure this I/O unit as a Generic OptoMMP Device, using the IP address for the
controller. (Do not add any points or configure other features.)

«  (lick Communications and select the type of communication to configure, for example, PPP, Modbus,
Security, Streaming, and so on.

«  C(lick Others to configure date and time, data logging, or 1/0 unit options you want to have saved in the
configuration file.
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CONFIGURE MEMORY MAP VALUES

Use this dialog box to assign values to specific memory map locations that are not otherwise included in
configuration files. These values will be sent to the I/O unit or controller when you send the configuration file.
For memory map addresses and valid values, see the OptoMMP Protocol Guide (form 1465).

NOTE: If you are using a SNAP PAC S-series controller, you must first configure an 1/0 unit to represent the controller.
Configure this I/0 unit as a Generic OptoMMP Device, using the IP address for the controller. (Do not add any points
or configure other features.)

The Memory Map Values List displays the Address, Value and Type of each Memory Map Value. The Address is

always represented in hexadecimal (hex). The Value field can contain hex or decimal values (integer types

only). If the value is in hex it is preceded by 0x. The Type field can be either 4-byte Int, 8-byte Int, Float, or

String.

«  Toaddanew Memory Map Value, click Add to open the Add/Edit Memory Map Values dialog box.

«  Tochange an existing Memory Map Value, highlight it and click Modify.

«  Todelete an existing Memory Map Value, highlight it and click Delete. To highlight more than one, hold
down the Ctrl key and click additional items in the list.

CONFIGURE PID LOOPS

Use this dialog box to configure proportional integral derivative (PID) loops on SNAP PAC brains, and R-series

controllers. You can configure up to 96 PID loops. Four algorithms are available to choose from. See also

“Configuring PID Loops”on page 63.

« Toadda PID, highlight the lowest available number in the list and click Add to open the Add/Edit PID
dialog box.

«  Tochange an existing PID, highlight it in the list and click Modify.

«  Todelete a PID, highlight it and click Delete.
Each PID must be configured with essential parameters and then individually tuned for efficiency. You can

configure PIDs through either PAC Manager or PAC Control, but for tuning PIDs, it's easier to use the graphic
tuning tools in PAC Control. (For details, see the PAC Control User’s Guide, form 1700.)

CONFIGURE PPP

Local IP Address. Enter the Local IP Address for the PPP interface on the I/0 unit. Enter the local Subnet
Mask only if you are using classless IP addressing. If you are not using classless IP addressing, leave the Subnet
Mask at zero, and the 1/0 unit will calculate the subnet mask.

IMPORTANT: The network address for the PPP interface must be different from the network ID for the Ethernet
interface. (The network address is obtained by ANDing the IP address and the subnet mask.)

Max Authentication Retries. Enter the maximum number of times a login/password combination can be
retried.

PPP Link Always Connected. If you want outgoing PPP to always be connected, so there is no need for
the I/0 unit to dial out, check this box.

Modem Initialization String. Change the modem initialization string and modem hangup string if
necessary. Make sure you use the setting to ignore DTR signal in the modem initialization string:
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The default modem initialization string is AT&D0"M~~~~

Consult the command reference that came with your modem to determine the correct initialization
command strings. A sample modem initialization string might look like this:
AT&F M~~AT&D0&KO"M~~AT&WO M~ ~AT&Y 0 M~~

The &F command sets the modem back to factory defaults. The AM tells the Ethernet I/O unit to insert a
carriage return. The ~ tells it to insert a 500ms pause. The &WO writes the current settings to NVRAM profile 0
on the modem. The &Y0 instructs the modem to use NVRAM profile 0 after resetting.

This initialization string is just a sample; command strings for your modem may differ.

Outgoing PPP. If the I/0 unit will send outgoing calls, complete the Outgoing PPP section:
Choose Enabled from the drop-down list.

In the Use Local IP Address field, choose Yes to have the I/0 unit use the Local IP Address you entered for the
PPP link; choose No to have the remote device assign the I/0 unit an IP address for the PPP link. The default is
No.

If you want the 1/0 unit to use the device the I/0 unit is calling as the default gateway for all communication,
choose Yes for Set As Default Gateway. The default is No.

Enter the Login and Password the I/0 unit should use for authentication when it calls the remote device.
In the Phone number field, enter the number the modem should dial for outgoing calls from the I/0 unit.

Change the following fields if necessary:

«  Inactivity Timeout—If the I/O unit sends no packets and receives no packets for this number of seconds
after the PPP session is negotiated, the modem will hang up. The default is 30.

«  Max Connect Time—The maximum amount of time in seconds an outgoing PPP connection can stay
connected after successful negotiation. Default is zero, which disables the timer.

«  Max Dial Retries—The number of times the I/0 unit will redial if the first attempt fails. Default is zero.

«  Retry Interval—The number of seconds the I/O unit will wait before trying to redial after the first attempt
fails. Default is zero.

«  Disable Time—If the maximum connect time or maximum number of retries has been reached, the
outgoing PPP dialer waits this number of seconds before doing anything. Default is zero.

Incoming PPP. If the I/0 unit will receive incoming calls via modem, complete the Incoming PPP section:
Choose Enabled from the drop-down list so the modem will listen for incoming calls.

If you want the I/0 unit to use the device calling the I/O unit as the default gateway for all communication,
choose Yes for Set As Default Gateway. The default is No.

Change the Inactivity Timeout if necessary. The default is 30.
Enter the Login and Password the /0 unit should accept for incoming calls.

In the Remote IP Address field, enter the IP address the I/O unit should give to devices that dial into the I/0
unit and ask for an address. This address must be on the same subnet as the local IP address.

Enter a modem listen string to make sure the modem automatically answers calls. The default modem listen
string is ATS0=1~M~ , which instructs the modem to answer any incoming calls on the first ring. Again, refer
to your modem’s command reference for the correct listen string.
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CONFIGURE PROFIBUS MODULES

(Not applicable to SB brains) Profibus modules (part number SNAP-SCM-PROFI) are a type of serial module.
Before configuring a Profibus module, see the SNAP Serial Communication Module User's Guide (form 1191)
for more information about these modules.
1. With the configuration file open, right-click the name of the I/O unit the Profibus module is on. From the
pop-up menu, choose Configure.
The Configure /0 Units dialog box opens.

=»| Configure I/O Units @

Address ‘Wwatchdog
Ethernet 0 . Enabled

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules :,—— Modules
Events 3 button
Scratch Pad  »
: Communications »
Others 3

4 | i

Cloze | Help |

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Profibus Modules
from the pop-up menu.

| Configure Profibus Modules @

Profibus bodule

MNumber. |0 | [ Used

Cancel Help

Address | Description | Yalue
MODULE INFORMATION
0=FFFF FOCO 0000 Maodule Type Dig/none [D-00)
0=FFFF FO34 7FO0 Maodule Subtype 1]
0«FFFF FO34 7FO2 Hardware Revizsion D ate Mis,
0«FFFF FO34 7FOR Loader Wersion Mis,
0«FFFF FO34 FFOA Firmware Yerzion Mis,
FORT A
0«FFFF FO34 8000 IP Part Mumber 22500
0«FFFF FO34 8004 Baud Rate 19200 =1
0=FFFF FO34 8003 Parity Ewen
0«FFFF FO34 8009 [rata Bits a
0«FFFF FO34 8004 Stop Bits 1
0«FFFF FO34 3008 Hardware Flow Contral? Ma
0=FFFF FO34 800C Power-up Test Meszage? Yes k|
0«FFFF FO34 8200 EOM Character List [0 00040000

3. Inthe Number field, choose the Profibus module’s position from the drop-down list. Click to put a check
mark in the Used box.
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If you need to change port numbers, enter the new numbers for each port in the TCP port Number field.

5. Change the Baud Rate and EOM Character List fields if necessary to match your Profibus devices. Choose
whether to have the module automatically send a Test Message when turned on (the default is Yes).

6. When data is correct, repeat from step 3 for additional Profibus modules.

7. When all Profibus modules are configured, click OK to close the dialog box and return to configuring I/0
units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the I/O unit
when you send the configuration data to the I/0 unit (see “Sending Configuration Data to the I/O Unit”on page 68).

CONFIGURE SERIAL MODULES

This dialog allows you to configure SNAP serial communication modules (part numbers SNAP-SCM-232 and
SNAP-SCM-485) for use with the I/0 unit. For each serial module port you want to use, click the corresponding
row and then enter or modify the values in the columns listed below. Most values can be changed by
selecting a new value from a drop-down list.

Status. To enable a port on a serial module, select the appropriate row and click the Status column. A
drop-down list is displayed with the choices Enabled, Disabled, and Clear. Choosing Enabled activates the
entire row and assigns default values to each column. Choosing Disabled deactivates the row but doesn't
change any values in the other columns. Choosing Clear deactivates the row and clears all the other columns.
Only the columns that are Enabled will be sent to the I/0 unit.

Module. The module location on the SNAP I/0 rack. This value cannot be changed.

Port. The serial module port being configured. Each serial module has two ports, A and B. This value cannot
be changed.

IP Port. The IP Port number for access to the serial port. The default value that appears should work for most
IP.communication, and changing this value shouldn't be necessary. If the IP port number is changed, however,
the I/0 unit must be restarted for the change to take effect.

Baud Rate. Choose the baud rate. The default is 9600.

Parity. Choose None, Odd, Even, Mark or Space from the drop-down list. The default is None.
Data Bits. Choose 8 or 7 from the drop-down list. The default is 8.

Stop Bits. Choose 1 or 2 from the drop-down list. The default is 1.

EOM Chars. Enter hexadecimal values representing the End Of Message characters that the 1/0 Unit should
be looking for. The default is 0DOA, which is the ASClI representation for carriage return and linefeed. A
maximum of eight hexadecimal digits may be entered.

Test Message. Select Yes in the drop-down list if you want the I/0 Unit to send a test message on powerup.
Select No if no test message is desired. The default value is Yes.

CONFIGURE SNMP AGENT

SysName. Enter the name assigned to the I/0 unit as a managed node within the SNMP management
system.
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SysLocation. Enter the physical location of the I/0 unit.
SysContact. Enter the ID of the contact person for the I/0 unit.

Community Groups. To set up the Community Groups you need, highlight a line in the list. Click the String
cell within the line and type the name of the group. Then click in the Read, Write, and Trap cells and choose
Yes or No from the drop-down list to indicate whether that group has privileges to read, write, and receive
traps.

Management Hosts. To set up Management Hosts, highlight a line in the list. Start with hosts on the local
network first, because the system sends messages to hosts in numeric order, and it stops sending messages
when it finds a host that it cannot connect to. Click the Community String cell and enter the name of the
community group the host belongs to. Click the Host IP Address cell and enter its IP address, including the
dots (for example, 10.192.55.60).

Version. From the drop-down list, choose the version of SNMP you are using.

Destination Port. 161 is the default port for SNMP communications. If you know that your application will
use a different port, enter the number of that port here.

Authentication/Cold Start Trap. To enable authentication or cold start traps, click the box to check it.

CONFIGURE STREAMING

Enable Streaming. To enable streaming, choose Yes from the drop-down list.

Enable I/0 Mirroring. |/0O mirroring is a separate function. It's generally not a good idea to use both
streaming and mirroring on the same |/O unit. See “Mirroring /O Point Data” on page 107 for more
information.

Interval. Enter how often in milliseconds you want the I/0 unit to send the streamed data. If you are
configuring streaming to use only as an event message, set the streaming interval to 0. Zero means that the
stream will be sent only once.

Use Default Streaming Area. To stream all addresses in the Streaming section of the I/0 unit's memory
map, click Use Default Streaming Area. For more information, see the memory map appendix in the OptoMMP
Protocol Guide (form 1465). (Note that the Streaming section does not include data from high-density digital
modules.)

To stream only part of the Streaming section, or to stream a different part of the memory map, click Specify
Streaming Area. Enter the starting address in the Memory Map Address field (the address must be entered in
hex), and enter the size in bytes of the data to stream in the Size Of Data field.

IP Port. Enter the IP port on the PCs or devices that receive the streamed data. Your application must refer to
this port number. Use the default of 5001 unless you know it is already being used for another purpose.

Stream Target. Enter the IP addresses of up to eight devices to receive the streamed data.

CONFIGURE WIEGAND MODULES

256

(Not applicable to SB brains) Wiegand modules are a type of serial module. Before configuring a Wiegand
module, see the (form 1191) for more information about these modules.
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With the configuration file open, right-click the name of the I/O unit the Wiegand module is on. From the
pop-up menu, choose Configure. The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

Mame Type
SMA

4

Part Address
Ethernet 0.

I

Cloze | Help |

‘Wwatchdog De Add...

Enabled
Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Madules a_—,—— Modules
Events 3 button
Scratch Pad  »
: Communications »
Others 3

Make sure the correct 1/0 unit is highlighted. Click the Modules button and choose Wiegand Modules
from the pop-up menu.

«p| Configure Wiegand Modules @
iegand Module
MNumber: |0 | [ Used
Addrezs | Dezcription | " alue
MODULE INFORMATION
0«FFFF FOCO 0000 Module Tepe Dig/rnone [Ox00)
0«FFFF FO34 8501 Module Subtype 0
0«FFFF FO34 8502 Hardware Revizion D ate M8
0«FFFF FO34 3506 Loader Version M8
O«FFFF FO34, 3504 Firmnware Wersion M8
FORT &
0«FFFF FO34 3600 IF Port Mumber 22500
0«FFFF FO34 3604 Format u] =1
0«FFFF FO34 3602 Data Length a7
0«FFFF FO34 360C Sibe Pogition |
0«FFFF FO34 3610 Site Length |
0«FFFF FO34 8614 Badge Poszition 18
0«FFFF FO34 3618 Badge Length 19
0«FFFF FO34 361C Farity Check, Mo
0«FFFF FO34 8620 Ewen Parity Position 0
O«FFFF FO34 3624 Odd Parity Pogition I
FORTE
0«FFFF FO34 3640 IF Port Mumber 225M
0«FFFF FO34 3644 Format u] =1
0«FFFF FO34 3648 Data Length a7
0«FFFF FO34 364C Sibe Pogition |
0«FFFF FO34 3650 Site Length |
0«FFFF FO34 8654 Badge Poszition 18
0«FFFF FO34 3658 Badge Length 19
0«FFFF FO34 365C Farity Check, Mo
0«FFFF FO34 86E0 Ewen Parity Position 0
0«FFFF FO34 3664 Odd Parity Pogition I
ok | Cancel Help
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3. Inthe Numberfield, choose the Wiegand module’s position from the drop-down list. Click to put a check
mark in the Used box.

4. Ifyou need to change port numbers, enter the new numbers for each port in the TCP port Number field:s.

5. Click the Format/Value cell, and from the drop-down list, choose a standard data format (shown by its
total data length) or choose C for custom.

NOTE: O is the 37-bit Opto 22 format used in a sample PAC Control strategy available for use with Wiegand
modules. For details, see the SNAP Serial Communication Module User's Guide (form 1191).

6. Change the following fields if necessary to match your Wiegand hardware device:
Data Length—total length of data in the transmission
Site Position—first bit of the site code
Site Length—Ilength of the site code, in bits
Badge Position—first bit of the badge code (should be the next bit after the site code)
Badge Length—Iength of the badge code, in bits
7. When data for both ports is correct, repeat from step 3 for additional Wiegand modules.

8. When all Wiegand modules are configured, click OK to close the dialog box and return to configuring I/0
units.

IMPORTANT: If you changed a TCP port number, you must save the change to flash and restart the I/O unit when you
send the configuration data to the I/O unit (see page 68).

9.  When you are ready to send all configuration data to the I/O unit, see “Sending Configuration Data to the
170 Unit"on page 68.

FIND OPTO 22 MMP DEVICES

Use this dialog box to find out the MAC addresses, IP addresses, firmware versions, and/or unit types of all
Opto 22 memory-mapped devices on the network. Opto 22 memory-mapped devices include SNAP PAC and
SNAP-LCE controllers, SNAP Ethernet, SNAP Ultimate, and SNAP Simple I/0 units, and E1 and E2 1/0 units.
(Opto 22 M4-series controllers with Ethernet cards are not included.)

CAUTION: You may have problems if your network includes old Opto 22 SNAP Ethernet brains with firmware version
R1.3m or earlier, or controllers with MASENET-100 adapter cards at firmware version R1.3k or earlier (these may be
affected by the Find feature even though it does not report them). These brains and adapter cards may have to be
rebooted ifyou use the Find feature. To avoid this problem, update the older devices to newer firmware first.

1. Leave the MMP Port at 2001 unless you have changed it for security purposes.
2. Adjust the Timeout if necessary for your network. Timeout is in milliseconds.

3. Click Find. All the Opto 22 MMP devices on your network are listed. The total number of devices is shown
in the Devices Found field.

4. If you want to copy device information to the clipboard, click Copy.

INSPECT OPTO 22 DEVICE

When you use the Inspect Opto 22 Device window, you are reading and writing directly to a specific SNAP PAC
controller or brain. You must have its IP address in order to do so. The type of device determines which areas
are supported.

CAUTION: Any configuration changes you make here are not saved in a configuration file.
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To use the Inspect Opto 22 Device window, enter the IP address of the device (or choose it from the
drop-down list). Then click the button on the left that corresponds to what you want to do:

Status Read. See basic information about a SNAP PAC controller or brain. See “Interpreting Status Data” on
page 149.

Status Write. Send commands to a device (such as Store configuration to flash), change the unit’s basic
configuration (such as whether degrees are shown in F or C), or assign the second IP address on a SNAP PAC
controller (see "Assign Secondary IP Address” on page 245).

Wireless LAN. Choose to configure a wireless LAN or view a wireless LAN's status. See “Configuring Wireless
LAN Communication (Wired+Wireless Models Only)”on page 22.

Point Config. Configure I/0 points. See “Configuring Analog and Digital Points and Features”on page 158.
Digital Bank, Analog Bank. Read |/0 points. See “Reading Analog and Digital Banks” on page 178.

Digital Point, Analog Point. Read or write to individual 1/0 points. See “Reading and Writing to Points”on
page 170.

High Density. Read or write to SNAP high-density digital points. See “Reading and Writing to SNAP
High-Density Digital Points”on page 181.

System. Read or change the date and time. See “Reading System Date and Time”on page 184.

Scratch Pad. Read or write to Scratch Pad Bits, Integers, Floats, and Strings. See “Reading and Writing to the
Scratch Pad Area”on page 184.

Data Log. Configure data logging and read the log. See “Data Logging”on page 187.
PID. Configure PID loops. See “Configuring, Viewing, or Changing PID Loops”on page 168.

Events. Read current events and change events; configure event messages. See “Configuring Event
Messages”on page 142.

Communications. Display information about and configure security, protocols, communication ports, and
a variety modules including serial modules (RS-232, RS-485/422, Wiegand, Profibus, Motion, SSI, CAN, and
HART modules). For information on how to configure these modules, see “Configuring 1/0 Modules and
Points"on page 35.

Other. Read or write to any address in the device’s memory map. For a complete list of memory map
addresses, see the OptoMMP Protocol Guide (form 1465).

I/0 UNIT IMPORT/COPY

Use this dialog box to import and copy 1/0 unit flash memory images. An 1/0 unit's flash memory contains
information about any settings that have been explicitly configured for that unit. A flash memory image saves
this information so it can be stored in a file or copied to another I/0 unit. The dialog box contains:

Existing I/0O Unit Flash Memory. Choose an existing I/0 unit. If you want to add or modify an I/0 unit,
click Options. For help, see “Add/Modify New Device” on page 243.
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I/0 UNIT MAINTENANCE

Previously Saved I/0 Unit Image File. Select this option and enter the filename of a flash memory
image file that you want to copy to another I/0 unit. You can also click the Browse button at the end of the
filename field and locate the image file using the standard File Open dialog box.

Read. After selecting an Image Source option, click Read to read a flash memory image from an 1/0 unit or an
existing flash memory image file. Note that the dialog box does not close when you click this button.

Send Image To I/0 Unit Flash Memory. Select this option and enter an 1/0 unit's IP address to copy the
selected flash memory image source to that unit.

Save To I/0 Unit Image File. Select this option and enter the name of a file that will store the flash
memory image. You can also click the Browse button at the end of the filename field and specify the name
and location of the image file using the standard File Save dialog box.

Create New I/0 Unit. Select this option to create a new I/0 unit in PAC Manager using the selected flash
memory image source. Since the source image does not contain an I/0 unit name, you will be prompted to
enter one. For more information, see “Creating a New |/O Unit from an Existing One”on page 28.

Send/Save/Create. After selecting an Image Destination option, click this button to copy the image source
to an I/0 unit, save the image source to a file, or create a new I/0 unit in PAC Manager. Note that the dialog
box does not close when you click this button, so you can repeat the Read-Send/Save/Create cycle as needed.

I/0 UNIT MAINTENANCE

To use the I/0 Unit Maintenance dialog box, see one of the following topics:

“Changing IP Addresses”on page 201
“Installing New Firmware” on page 203
“Maintaining Files”on page 217

For other maintenance tasks, such as resetting the device to factory defaults or handling a device whose IP
address you don't know, see the controller or brain user's guide.

MOVE POINTTO

Use this dialog to move an I/0 point from one I/O unit to a location on another (or the same) I/0 unit.

The 1/0 Units list displays all I/0 units that are compatible with the point being moved. The current I/O unit is

highlighted. The Points list displays all I/O points on the highlighted I/0 unit. Currently configured I/0 points

are in gray text, and open channels are marked Unused.

1. Selectan open channel on the current I/0 unit or select another I/0 unit (if available) from the 1/0 units
list and select one of its channels as the destination channel.

2. (Click OKto move the I/0 point to the specified channel.

SCALE ANALOG READINGS

260

|u

This dialog box is used to specify a custom scale factor that will convert from the “real” units of a module to

some engineering units which describe the process parameter being measured.

Scaled Units. Type the name of the new engineering units (EU) for the module here. (Simply delete the
default scale and type a new scale—for example, PSI.) As soon as you press Tab or click outside this field, the
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name of the new EU appears in the protected (grayed-out) Scaled columns in the Lower Value and Upper
Value areas of the dialog box.

Actual Lower Value. Provide the actual real-world lower value that you wish the scaled lower value to
correspond to. By default, the zero-scale value appears.

Note that inputs typically have under-range capability, which means you can specify a lower actual value less
than the zero-scale value. Outputs do not have under-range capability.

Actual Units. The actual units of the module appear here. They are displayed for reference only and cannot
be changed.

Scaled Lower Value. Type in the new scaled lower value here. This can be any floating point value.
Scaled Units. The name of the new units you typed in the Scaled Units field (above) appear here.

Actual Upper Value. Provide the actual real-world upper value that you wish the scaled upper value to
correspond to. By default, the full-scale value appears.

Note that inputs typically have over-range capability, which means you can specify an upper actual value
greater than the full-scale value. Outputs do not have over-range capability.

Actual Units. The actual units of the module appear here. They are displayed for reference only and cannot
be changed.

Scaled Upper Value. Type in the new scaled upper value here. This can be any floating point value, as long
as it is greater than the scaled lower value.

Scaled Units. The name of the new units you typed in the Scaled Units fields (above) appear here.

SEND CONFIGURATION TO I/0O UNIT

Use this dialog box to send configuration information to one or more I/0 Units.

1/0 Units List. The list on the left shows all the I/0 units in this configuration file. When you click a unit, the
Address List shows all the IP addresses associated with the highlighted unit. This is the address list you set up
in the Add/Edit I/0 Unit.

Sending Configuration Information

1. Highlight the I/O unit configuration(s) you want to send.

2. Highlight the IP addresses to receive the I/0 unit configuration. If you don't highlight any addresses, the
configuration will be sent to the entire list. If you highlight more than one I/0 unit configuration, each
unit configuration will automatically be sent to all the IP addresses associated with it.

3. Ifnecessary, change the Timeout field. The timeout field shows how long, in milliseconds, PAC Manager
will try to communicate with the I/0 unit before returning a timeout error.

4. To save the configuration file to flash memory as well as to RAM, check Save to Flash. To also restart the
unit, check Restart Device.

IMPORTANT: For the following configurations, you must save to flash and restart the I/0 unit in order any
changes to the configuration to take effect:

—  Changesin IP port for serial modules
- SNMP configuration
- Email configuration
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- PPP configuration
- Datalogging interval

Clearing Flash. To erase the flash memory of all highlighted 1/0 units in the list, click Clear Flash. Click
Details to show or hide the Status Area, which displays the results of the last Send or Clear Flash operation.
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A

accessing data log, 89
address, assigning IP address, 8
to multiple devices, 14
alarm
clearing configuration, 195
configuring, 138, 189
description, 137
trigger, 137
types, 137
algorithms for PIDs, 63
analog bank
data format, 198
reading, 178
analog module data format, 199
analog point
average filter weight, 71, 74
bipolar, 73
calibrating, 44, 174
clamping, 71, 74
configuring, 40, 157
features, /3
gain, 71
maximum value, 71
minimum value, 71
minimum/maximum value, 74
offset, 71
offsetand gain, 44, 74,174
reading, 173
scaling, 42, 71,73
unipolar, 73
viewing data, 157
watchdog, 71,73
writing to, 173
assigning IP address, 8, 14
average filter weight, 71, 74

B

bootloader mode, for loading firmware, 214

C

CA root certificate, 216
calibrating analog point, 44, 71, 174
CAN modules

configuring, 55
cascading events and reactions, 128
changing

/0 points automatically, 107

IP address, 201
clamping analog output point, 71, 74
clearing

configuration, 195

configuration data from flash memory, 69

data log, 90

file from I/0 unit, 222

files from flash memory, 222

resetting to defaults, 192
communicating with 1/0 unit

assigning IP address, 8

monitoring communication, 73
communicating with processor

IP address, 8
communication

dial-up, 123

modem, 123

PPP, 123

serial, 118

wireless, 22
community groups, 97
configuration data on microSD card, 193
configuration file, 26

adding analog point, 40

adding digital point, 35

adding I/0 unit, 31
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copying, 62
creating, 27
creating from a PAC Control strategy, 30
custom scaling, 42
loading to brain, 68
moving I/0 point, 61
configuration, clearing, 195
configuring
alarm events and reactions, 137
alarms, 138
CAN modules, 55
communications port, 118
copying I/0 configuration, 28
data logging, 87
data streaming, 104
date and time, 116
delayed reactions to events, 133
digital event/reactions, 131
email, 100
event messages, 92
event/reactions, 130
/0, 26, 157
/0 unit, 31
mistic 1/0 units, 7, 8
PID loops, 63, 168
PPP, 123
Profibus modules, 53
RS-232 and RS-485/422 serial modules, 46
Scratch Pad, 102
serial event/reactions, 140
serial modules, 167
serial ports on brain or controller, 118
serial synchronous interface (SS1) modules, 54
SNMP, 96
Wiegand event/reactions, 140
Wiegand modules, 51
wired network security, 78
wireless LAN, 22
control engine port, changing, 81, 84
controller
assigning IP address, 8
changing IP address, 201
control engine port, 81
restarting, 191
converting IEEE float, 198
copying
/0 configuration, 28
memory map data, 109
counter
description, 70, 72
quadrature, 72
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data
copying from memory map, 109
formatting and interpreting, 196
IEEE float format, 198
streaming, 92, 104
data format
2-channel analog modules, 199
digital bank counters, 197
digital channel, 197
IEEE float, 198
mask, 196
data logging
accessing data, 89
clearing data log, 90
configuring, 87, 187
values from memory map addresses, 87
date and time
configuring, 116

reading, 184
deadband, 139
deleting

configuration data from flash memory, 69
file from 1/0 unit, 222
deviation alarm, 137
diagnostic messages, 227
dial-up networking, 123
digital bank
counter data format, 197
reading, 178
digital channel
data format, 197
digital event/reactions
clearing, 195
configuring, 131, 189
description, 131
examples, 133
trigger, 133
digital point
configuring, 35, 157
counter, 70, 72
features, 70
latching, 70, 72
on high-density module, 181
quadrature counter, 70, 72
reading, 171
state, 70, 72
viewing data, 157
watchdog, 71,73
writing to, 171
disable host communication, 81
DNS Resolver, 99



downloading
see loading or installing

E

edge trigger, 137
email
clearing configuration, 195
configure DNS server, 99
configuring, 100, 189
message, 92
erase
configuration from microSD, 195
firmware from microSD, 195
strategy from microSD, 195
error messages, 225
Ethernet 2 IP address, assigning, 18
Ethernet errors, 231
EtherNet/IP
turning off protocol, 81
event message
configuring, 92, 189
plugins, 95
event/reaction, 131, 133, 189
cascading, 128
configuration steps (table), 130
configuring digital, 131
delayed, 133
Scratch Pad, 127
serial, 140
types, 129
Wiegand, 140
exclamation mark button, 227

F

failsafe bootloader mode, 214

file
clearing from flash memory, 222
deleting from file system, 222

loading from flash memory to file system, 222

reading filenames, 221
sending from I/0 unit, 220
sending to I/0 unit, 218
file storage, removable, 217
file system on brain or controller, 217
filter address, 84, 87
filter mask, 84, 87
filter weight, 74
find Opto 22 MMP devices, 228
firmware
effect on device data, 203
failsafe bootloader, 214

for serial module, 210
getting data about, 226, 228
loading to controller, 203
loading to I/0 unit, 203
replacing damaged, 214
flash memory, 69
clearing files, 222
loading files from, 222
saving configuration data to, 68, 190
saving file system files, 222
float
format, 198
IEEE, 198
Modbus, 112
flow control, 48
format
IEEE float, 198
Modbus float, 112
of counter data, 197
of data, 196

of data for 2-channel analog modules, 199

of digital channel data, 197
FTP
client software comparison, 217
default port, 78
limiting access to, /8
login, 80
password, 80
reading filenames, 221

sending files to and from I/O unit or controller,

217

G

G4EB2
configuring points, 38
gain, 44, 74,173,174
definition, /1
gateway address, 12

H

hardware, getting data about, 226, 228
help

troubleshooting, 225
high limit alarm, 137
high-density digital modules

reading or writing to points, 181
host communication, disabling, 81
host name

configure DNS server, 99
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| loading
configuration file, 68
files from flash memory, 222
firmware
effect on device data, 203

I/0 modules
configuring analog and digital, 26
configuring RS-232 and RS-485/422 serial mod-

viewin ul]e§,746 new firmware to 1/0 unit or controller, 203
Wing, new firmware to serial module, 210
I/0 point logging
clearing configuration, 195 data. 87

configuring, 35, 157

features, 70 serial port data, 231

wireless data, 233

Ioggmg data, 87 login for FTP, 80
mirroring, 107 . 137
reading, 170 low limit alarm,
reset points to defaults, 192
writing to, 170 M

/0 igging 3] MAC address, 9
changing I adres, 201 menagement hosts, 97
clearing files from flash memory, 222 P,

. . o mapping IP addresses, 14

copying between configuration files, 62 mack

deleting file, 222
file system, 217
getting files via FTP, 220
hardware commands, 190
loading files from flash memory, 222
reading basic information, 147/
restarting, 191
saving files to flash memory, 222
sending files via FTP, 218
IEEE float, 198
initializing Scratch Pad values, 102
installing
new firmware to I/0 unit or controller, 203
interacting algorithm for PID, 63
IP address
assigning, 8
assigning IP address to Ethernet 2, 18
assigning to multiple devices, 14
assigning wireless, 22
changing, 201
mapping, 14
ISA algorithm for PID, 63

data format, 196

digital point, 132

Scratch Pad, 132
maximum value, 71, 74
memory

saving configuration to, 190

saving files, 222
memory map

copying data, 109

logging data from, 87
message, 92

plugins, 95
microSD card, 217
microSD commands, 193, 195
minimum value, 71, 74
mirroring 1/0 point data, 107
mistic /0 units, 7, 8
MMP devices, finding, 228
Modbus/TCP

changing float format, 112

configuring, 189

default port, 78

limiting access to, /8

K memory map address conversion, 114
kernel, see firmware modem, 123

module types, 160

MOMO, 131
L mounting rack

M-series, 155
latch, 72 ,
definition, 70 SNAP PAC, 155

moving

level trigger, 133 files from 1/0 unit, 220
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files to I/0 unit, 218
/0 point in configuration file, 61
must-on, must-off, 131

N

network
find OptoMMP devices, 228
security on wired network, 78
security on wireless LAN, 22

o

off, 72
off-latch, 70, 72
offset, 44, 74,173,174
definition, 71
on, 72
on-latch, 70, 72
operation commands, 190
OptoMMP
default port, 78
find devices, 228
limiting access to, 78
OptoMMP device commands, 190

P

PAC Control, 127,147
and direct reads and writes, 147
and event/reactions, 127
copying configuration files from, 30
managing files on I/0 unit or controller, 217
protecting strategy, 81
parallel algorithm for PID, 63
password
for FTP, 80
peak, /1
PID loops
algorithms, 63
configuring, 63, 168
plugins, 95
point types, 160
port
changing, for security, 78
serial, on brain or controller, 118
ports for serial modules, 156
power
powerup clear, 193
restarting controller, 191
restarting I/0 unit, 191
powerup clear, 193
PPP

clearing configuration, 195
configuring, 123, 189
troubleshooting serial communication, 2371
primary IP address, assigning, 9
problems, troubleshooting, 225
processor
assigning IP address, 8
Product Support
getting device and firmware data, 226, 228
Profibus
configuring modules, 53
protecting PAC Control strategy, 81
protocol
default ports, 78
limiting access to, /8
turning off EtherNet/IP, 81

Q

quadrature counter, 70, 72

R

reaction

delayed, 133

digital, 131

example, 133

Scratch Pad, 127

trigger

analog, 137
digital, 133

reading

analog bank, 178

analog point, 173

data log, 89

digital bank, 178

digital point, 171

digital points on high-density modules, 181

filenames on file system, 221

/0 points, 170

/0 unit information, 147

Scratch Pad, 184

system date and time, 184
registered management hosts, 97
removable storage, 217
reset points to defaults, 192
reset to defaults and restart device, 192
Restart device from powerup, 191
retransmit timeout (RTO), 229
root certificate, 216
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S message, 92
trap types, 97
SSImodules
configuring, 54
state of digital point, 70, 72
Status Read information, 149
store configuration and IP settings to microSD, 194
store configuration to flash, 190
strategy
effect of firmware download, 203
protecting, 81
streaming data, 92, 104, 189
subnet mask, 9

saving
configuration to flash memory, 68, 190
file system files to flash memory, 222
scaling
analog point, 42
description, 71,73
scanner flags, 154
Scratch Pad, 127
masks, 132
reading, 184
setting initial values, 102
writing to, 184
secondary IP address, assigning, 18

security, 22, 78, 189 T

sengTi)\l/?/ggr 8c(l)ear 193 TCP/IP

serial ’ " ’ settings, 229
stack, 229

communication, troubleshooting, 231
event/reactions, 140, 189
message, 92

time, system, 116, 184
timed events, 135

. o timeout, 229
ports on brain or controller, configuring, 118 . o
. timer, configuring, 195
serial modules
traps, 97

2-wire or 4-wire mode, 48
CAN, 55

flow control, 48

loading firmware, 210
port numbers, 156

troubleshooting, 225
diagnostic messages, 227
Ethernet errors, 231
getting device and firmware data, 226, 228
serial communication, 231

Proﬁbus, >3 4 Status Read data, 149
serial synchronous interface, 54 TCP settinas. 229
Wiegand, 51 9

serial modules (RS-232, RS-485/422) wireless communication, 233

configuring, 46
serial synchronous interface U

configuring modules, 54 .
setting offset and gain, 44, 174 UDP and streaming data, 104
SMTP

Configure DNS server, 99 V
SNAP PAC controller

assigning IP address

Ethernet 2, 18

valley, 71
velocity algorithm for PID, 63
viewing module and point data, 157

primary, 9
file system, 217
SNAP PACREST API, 2, 79 W
SNMP . watchdog, 73
access privileges, 97 definition. 71
agent, 97 A !
Wiegand

community groups, 97
configuring, 96, 189
default port, 78
limiting access to, 78
management hosts, 97

configuring modules, 51

event/reactions, 140, 189
wireless LAN

configuring, 22

troubleshooting, 233
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writing
to analog point, 173
to digital point, 171
to digital points on high-density modules, 181
to /0 points, 170
to Scratch Pad, 184
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